Note:

Before using this information and the product it supports, read the information in "Notices" on page 359.

This edition applies to version 5, release 2, modification 9 of IBM Spectrum Control (product numbers 5725-F93, 5725-G33, 5725-Y23, and 5725-Y24) and to all subsequent releases and modifications until otherwise indicated in new editions.

This edition replaces SC27-6588-00

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

About this guide ........................................ v
Who should read this guide ............................ v
Publications ............................................. v
  Accessing publications online ...................... v
  IBM Redbooks ....................................... vii
  Translation .......................................... vii
  Providing feedback about publications .......... vii
IBM Spectrum Control Service Management
Connect community .................................. viii
Contacting IBM Software Support ............... viii
Reporting a problem ................................ viii
Conventions used in this guide ..................... ix

New for IBM Spectrum Control Version
5.2.9 ................................................ xii

Chapter 1. Getting started .......................... 1
Managing resources ................................ 4
Configuring and administering ................. 7
Navigation ........................................... 8

Chapter 2. Product licenses ....................... 15
Functions that are available based on role and
license ................................................ 16

Chapter 3. Product overview ..................... 23
Architecture ........................................... 23
Interfaces for IBM Spectrum Control ......... 24
Starting IBM Spectrum Control ............... 25
Navigation ........................................... 26
Replication products ............................... 31
Key concepts ....................................... 32
  Data collection .................................. 32
  Performance monitoring and troubleshooting 33
  Applications and departments ................. 35
  Storage optimization ............................ 36
  Cloud configuration ............................. 37
  Provisioning storage ............................ 42
  Storage reclamation ............................. 46
IBM Spectrum Control VASA provider ....... 47
vSphere Web Client extension for IBM Spectrum
Control .............................................. 48
Alerts ................................................ 49
Reporting .......................................... 51
Units of measurement for storage data ....... 51
Role-based authorization ........................ 52
Fabrics and zones ................................ 53
Agents ............................................... 56

Chapter 4. Scenarios ................................. 59
Optimizing the performance of storage virtualizers
  Redistributing volume workloads to balance 59
  pools ............................................. 60
  Analyzing and re-tiering volumes in pools on tier
  1 .................................................. 61
  Collocating volumes .............................. 63
  Monitoring capacity usage at different levels of
  a business hierarchy ............................ 64
  Comparing storage usage in each department .... 66
  Using applications and subcomponents to monitor
capacity and space usage ........................ 68
  Viewing storage capacity and usage trends .... 69
  Limiting a set of storage to provision in the vSphere
Web Client extension ............................... 71
  Viewing NPIV connections between server ports
  and switch ports in a fabric ..................... 72

Chapter 5. Managing resources .................. 75
Adding resources .................................... 75
  Resources that you can monitor .................. 75
  Required user roles for monitoring resources 80
  Adding storage systems .......................... 81
  Adding fabrics and switches ..................... 85
  Adding hypervisors ................................ 88
  Adding servers ................................... 91
Removing resources .................................. 98
Collecting data ...................................... 98
  Collecting asset and status data ............... 99
  Collecting performance data ..................... 103
  Collecting information about shares on storage
  systems .......................................... 110
Alerting and event processing .................... 111
  Alert severities .................................. 113
  Defining alerts ................................... 113
Viewing and modifying alert definitions .......... 121
Viewing and modifying alert notification
settings ............................................. 124
  Viewing alerts ................................... 127
  Acknowledging alerts ............................ 129
  Removing alerts .................................. 130
Viewing information about resources .......... 130
  How information is organized ................... 130
  Dashboard view ................................... 133
  Viewing information about top-level resources 137
  Viewing information about internal, object, and
  related resources ................................ 138
Monitoring the status and condition of resources
  How the condition of a resource is determined 141
  Viewing the overall condition of resources .... 144
  Viewing the condition of specific types of
  resources ........................................ 144
  Viewing the status of resources ................ 145
  Acknowledging the condition and status of
  resources ......................................... 146
Monitoring the performance of resources ....... 149
  Viewing performance information ............... 150
  Viewing performance alerts and threshold
  violations ........................................ 164

© Copyright IBM Corp. 2001, 2016
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor and administering applications and departments</td>
<td>165</td>
</tr>
<tr>
<td>Applications</td>
<td>169</td>
</tr>
<tr>
<td>Departments</td>
<td>178</td>
</tr>
<tr>
<td>Application and department hierarchies</td>
<td>184</td>
</tr>
<tr>
<td>Exporting information about applications and departments</td>
<td>185</td>
</tr>
<tr>
<td>Viewing the data paths of resources</td>
<td>187</td>
</tr>
<tr>
<td>Resources that you can view in a data path</td>
<td>188</td>
</tr>
<tr>
<td>Navigating in a data path</td>
<td>191</td>
</tr>
<tr>
<td>Viewing information about top-level resources</td>
<td>191</td>
</tr>
<tr>
<td>Viewing information about internal resources</td>
<td>191</td>
</tr>
<tr>
<td>Zooming in</td>
<td>192</td>
</tr>
<tr>
<td>Zooming out</td>
<td>192</td>
</tr>
<tr>
<td>Changing the layout</td>
<td>192</td>
</tr>
<tr>
<td>Saving the display settings</td>
<td>193</td>
</tr>
<tr>
<td>Printing a view</td>
<td>193</td>
</tr>
<tr>
<td>Exporting a data path to a file</td>
<td>193</td>
</tr>
<tr>
<td>Provisioning storage</td>
<td>193</td>
</tr>
<tr>
<td>Configuring IBM Spectrum Control for provisioning</td>
<td>194</td>
</tr>
<tr>
<td>Provisioning storage with the IBM Spectrum Control GUI</td>
<td>211</td>
</tr>
<tr>
<td>Provisioning storage with the vSphere Web</td>
<td>216</td>
</tr>
<tr>
<td>Client extension</td>
<td></td>
</tr>
<tr>
<td>Optimizing storage tiering</td>
<td>219</td>
</tr>
<tr>
<td>Setting the tier level of storage pools</td>
<td>220</td>
</tr>
<tr>
<td>Analyzing tiering by servers</td>
<td>220</td>
</tr>
<tr>
<td>Analyzing tiering by hypervisors</td>
<td>220</td>
</tr>
<tr>
<td>Analyzing tiering by storage virtualizers</td>
<td>220</td>
</tr>
<tr>
<td>Analyzing tiering by storage pools</td>
<td>221</td>
</tr>
<tr>
<td>Analyzing tiering by volumes</td>
<td>221</td>
</tr>
<tr>
<td>Tiering volumes by I/O density and I/O rate</td>
<td>221</td>
</tr>
<tr>
<td>Modifying the criteria for analyzing tiering</td>
<td>222</td>
</tr>
<tr>
<td>Optimizing storage pools</td>
<td>222</td>
</tr>
<tr>
<td>Balancing pools</td>
<td>223</td>
</tr>
<tr>
<td>Modifying the criteria for balancing pools</td>
<td>223</td>
</tr>
<tr>
<td>Criteria for identifying the pools that require balancing</td>
<td>224</td>
</tr>
<tr>
<td>Reclaiming storage</td>
<td>225</td>
</tr>
<tr>
<td>Viewing storage reclamation</td>
<td>225</td>
</tr>
<tr>
<td>Viewing storage reclamation by storage system</td>
<td>226</td>
</tr>
<tr>
<td>Excluding volumes from reclamation analysis</td>
<td>226</td>
</tr>
<tr>
<td>Transforming and migrating volumes</td>
<td>227</td>
</tr>
<tr>
<td>Modifying the period for analyzing performance data</td>
<td>228</td>
</tr>
<tr>
<td>Modifying the properties of resources</td>
<td>228</td>
</tr>
<tr>
<td>Opening the management GUI for a resource</td>
<td>231</td>
</tr>
<tr>
<td>Opening the DS Storage Manager GUI for a DS8000</td>
<td>231</td>
</tr>
<tr>
<td>Exporting information to a file</td>
<td>232</td>
</tr>
<tr>
<td>Customizing lists of resources, tasks, and alerts</td>
<td>233</td>
</tr>
<tr>
<td>Filtering lists</td>
<td>234</td>
</tr>
<tr>
<td>Sorting lists</td>
<td>234</td>
</tr>
<tr>
<td>Showing, hiding, and reordering columns in lists</td>
<td>235</td>
</tr>
<tr>
<td>Managing tasks</td>
<td>236</td>
</tr>
<tr>
<td>Viewing tasks</td>
<td>236</td>
</tr>
<tr>
<td>Managing tasks for provisioning</td>
<td>240</td>
</tr>
<tr>
<td>Managing tasks for tiering storage, balancing pools, and transforming storage</td>
<td>242</td>
</tr>
<tr>
<td>Renaming tasks</td>
<td>247</td>
</tr>
<tr>
<td>Deleting tasks</td>
<td>248</td>
</tr>
<tr>
<td>Appendix A. Reference</td>
<td>251</td>
</tr>
<tr>
<td>Alerts</td>
<td>251</td>
</tr>
<tr>
<td>Triggering conditions for alerts</td>
<td>252</td>
</tr>
<tr>
<td>Triggering actions and notifications for alerts</td>
<td>281</td>
</tr>
<tr>
<td>Performance data</td>
<td>283</td>
</tr>
<tr>
<td>Performance metrics</td>
<td>283</td>
</tr>
<tr>
<td>Cinder driver for IBM Spectrum Control</td>
<td>338</td>
</tr>
<tr>
<td>Planning to deploy the Cinder driver</td>
<td>339</td>
</tr>
<tr>
<td>Setting up the Cinder driver environment</td>
<td>341</td>
</tr>
<tr>
<td>Requirements for installing the Cinder driver</td>
<td>342</td>
</tr>
<tr>
<td>Cinder driver package contents</td>
<td>343</td>
</tr>
<tr>
<td>Installing the Cinder driver</td>
<td>344</td>
</tr>
<tr>
<td>Uninstalling the Cinder driver</td>
<td>345</td>
</tr>
<tr>
<td>Configuring the Cinder driver</td>
<td>346</td>
</tr>
<tr>
<td>Learn more about the Cinder driver</td>
<td>347</td>
</tr>
<tr>
<td>Limitations and known issues for the Cinder driver</td>
<td></td>
</tr>
<tr>
<td>Opening IBM Spectrum Control on Windows operating systems</td>
<td>348</td>
</tr>
<tr>
<td>Opening IBM Spectrum Control GUIs and CLIs</td>
<td>348</td>
</tr>
<tr>
<td>Accessing administration tools</td>
<td>350</td>
</tr>
<tr>
<td>Appendix B. Accessibility features for IBM Spectrum Control</td>
<td>353</td>
</tr>
<tr>
<td>Appendix C. Accessibility features for Tivoli Storage Productivity Center for Replication</td>
<td>355</td>
</tr>
<tr>
<td>Notices</td>
<td>359</td>
</tr>
<tr>
<td>Privacy policy considerations</td>
<td>361</td>
</tr>
<tr>
<td>Trademarks</td>
<td>361</td>
</tr>
<tr>
<td>Glossary</td>
<td>363</td>
</tr>
<tr>
<td>A</td>
<td>363</td>
</tr>
<tr>
<td>B</td>
<td>363</td>
</tr>
<tr>
<td>C</td>
<td>363</td>
</tr>
<tr>
<td>D</td>
<td>364</td>
</tr>
<tr>
<td>E</td>
<td>364</td>
</tr>
<tr>
<td>F</td>
<td>364</td>
</tr>
<tr>
<td>G</td>
<td>364</td>
</tr>
<tr>
<td>H</td>
<td>365</td>
</tr>
<tr>
<td>J</td>
<td>365</td>
</tr>
<tr>
<td>L</td>
<td>365</td>
</tr>
<tr>
<td>M</td>
<td>365</td>
</tr>
<tr>
<td>N</td>
<td>365</td>
</tr>
<tr>
<td>P</td>
<td>365</td>
</tr>
<tr>
<td>R</td>
<td>366</td>
</tr>
<tr>
<td>S</td>
<td>366</td>
</tr>
<tr>
<td>T</td>
<td>367</td>
</tr>
<tr>
<td>V</td>
<td>367</td>
</tr>
<tr>
<td>Z</td>
<td>367</td>
</tr>
<tr>
<td>Index</td>
<td>369</td>
</tr>
</tbody>
</table>
About this guide

IBM Spectrum Control™ manages storage infrastructure by centralizing, automating, and simplifying the management of complex and heterogeneous storage environments. This guide provides task-oriented user information that helps you to obtain optimal product performance.

Who should read this guide

This publication is intended for administrators and users who want to learn how to use IBM Spectrum Control to monitor and manage storage resources and infrastructure.

Administrators and users must be familiar, or become familiar, with the following concepts:

- Storage Area Network (SAN)
- Simple Network Management Protocol (SNMP)
- Storage provisioning, optimization, performance, tiers, and cloud configuration
- IBM® DB2®
- Jazz™ for Service Management
- IBM Tivoli® Common Reporting
- vSphere Web Client extension and VASA

Publications

A number of publications are provided with IBM Spectrum Control.

IBM Tivoli Storage Productivity Center for Replication is no longer installed with IBM Spectrum Control. For current Tivoli Storage Productivity Center for Replication users who upgrade to IBM Spectrum Control, Tivoli Storage Productivity Center for Replication will remain available. See IBM Knowledge Center for any earlier versions of Tivoli Storage Productivity Center for Replication publications.

The following section describes how to access these publications online.

Accessing publications online

Information about installing, configuring, using, upgrading, and uninstalling IBM Spectrum Control and related products is available online.

Use Table 1 on page vi to view and download these publications. Translated documents are available for some products.
<table>
<thead>
<tr>
<th>Product</th>
<th>Online location</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Spectrum Control</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/SS5R93/">http://www.ibm.com/support/knowledgecenter/SS5R93/</a></td>
</tr>
<tr>
<td>IBM Copy Services Manager (formerly known as IBM Tivoli Storage Productivity Center for Replication)</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/SSESK4">http://www.ibm.com/support/knowledgecenter/SSESK4</a></td>
</tr>
<tr>
<td>IBM WebSphere® Application Server</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/SSEQTP/mapfiles/product_welcome_was.html">http://www.ibm.com/support/knowledgecenter/SSEQTP/mapfiles/product_welcome_was.html</a></td>
</tr>
<tr>
<td>Jazz for Service Management</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/SEKCU/welcome">http://www.ibm.com/support/knowledgecenter/SEKCU/welcome</a></td>
</tr>
<tr>
<td>IBM System Storage® DS3000, IBM System Storage DS4000® or IBM System Storage DS5000®</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/">http://www.ibm.com/support/knowledgecenter/</a></td>
</tr>
<tr>
<td>IBM System Storage DS6000®</td>
<td><a href="http://www.redbooks.ibm.com/abstracts/sg246781.html">http://www.redbooks.ibm.com/abstracts/sg246781.html</a></td>
</tr>
<tr>
<td>IBM System Storage DS8000®</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/">http://www.ibm.com/support/knowledgecenter/</a></td>
</tr>
<tr>
<td>IBM System Storage DS® Open Application Programming Interface publications</td>
<td><a href="http://www.ibm.com/support/docview.wss?uid=ssg1S7001160">http://www.ibm.com/support/docview.wss?uid=ssg1S7001160</a></td>
</tr>
<tr>
<td>IBM XIV® Storage System</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/STJTAG/">http://www.ibm.com/support/knowledgecenter/STJTAG/</a></td>
</tr>
</tbody>
</table>
Table 1. Locations of publications for IBM Spectrum Control and related products (continued)

<table>
<thead>
<tr>
<th>Product</th>
<th>Online location</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM DB2 Database for Linux UNIX and Windows</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/SSEPGG/welcome">http://www.ibm.com/support/knowledgecenter/SSEPGG/welcome</a></td>
</tr>
<tr>
<td></td>
<td>For more information about IBM System Storage N series, see</td>
</tr>
<tr>
<td>IBM Cognos® Business Intelligence</td>
<td><a href="http://www.ibm.com/support/knowledgecenter/SSEP7">http://www.ibm.com/support/knowledgecenter/SSEP7</a></td>
</tr>
</tbody>
</table>

IBM Redbooks

The IBM Redbooks® are publications about specialized topics.

You can order publications through your IBM representative or the IBM branch office serving your locality. You can also search for and order books of interest to you by visiting the IBM Redbooks home page at http://www.redbooks.ibm.com

Translation

Translated publications are available from IBM Knowledge Center, which is available in certain translated languages. It is displayed in the language that is appropriate for the browser locale setting.

When a locale does not have a translated version, the information is displayed in English, which is the default language. Translations of the PDFs are available when the information is translated.

Providing feedback about publications

Your feedback is important to help IBM provide the highest quality information.

To provide comments or suggestions about the product documentation, go to the following location for IBM Spectrum Control: http://www.ibm.com/support/knowledgecenter/SS5R93/Click Add Comment on the welcome page or on individual topic pages in a specific release. You must have an IBM ID and password to add a comment.
IBM Spectrum Control Service Management Connect community

Connect, learn, and share with Service Management professionals: product support technical experts who provide their perspectives and expertise.

Access Service Management Connect at https://www.ibm.com/developerworks/servicemanagement/. Use Service Management Connect in the following ways:

- Become involved with transparent development, an ongoing, open engagement between other users and developers of IBM products. You can access early designs, sprint demonstrations, product roadmaps, and prerelease code.
- Connect one-on-one with the experts to collaborate and network about IBM and the Storage Management community.
- Read blogs to benefit from the expertise and experience of others.
- Use wikis and forums to collaborate with the broader user community.

Contacting IBM Software Support

You can contact IBM Software Support by phone, and you can register for support notifications at the technical support website.

- Go to the IBM Spectrum Control technical support website at http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Productivity_Center.
  To receive future support notifications, sign in under Subscribe to support notifications. You are required to enter your IBM ID and password. After you are authenticated, you can configure your subscription for IBM Spectrum Control technical support website updates.
- Customers in the United States can call 1-800-IBM-SERV (1-800-426-7378).
- For international customers, go to the IBM Spectrum Control technical support website to find support by country. Expand Contact support and click Directory of worldwide contacts.


The support website offers extensive information, including a guide to support services; frequently asked questions (FAQs); and documentation for all IBM Software products, including Redbooks and white papers. Translated documents are also available for some products.

When you contact IBM Software Support, be prepared to provide identification information for your company so that support personnel can readily assist you. Company identification information might also be needed to access various online services available on the website. See “Reporting a problem.”

Reporting a problem

Provide the IBM Support Center with information about the problems that you report.

Have the following information ready when you report a problem:

- The IBM Spectrum Control version, release, modification, and service level number.
- The communication protocol (for example, TCP/IP), version, and release number that you are using.
- The activity that you were doing when the problem occurred, listing the steps that you followed before the problem occurred.
- The exact text of any error messages.

Conventions used in this guide

Information is given about the conventions that are used in this publication.

This publication uses several conventions for special terms and actions, and for operating system-dependent commands and paths.

The following typeface conventions are used in this publication:

**Bold**
- Flags that display with text
- Graphical user interface (GUI) elements (except for titles of windows and dialogs)
- Names of keys

*Italic*
- Variables
- Values that you must provide
- New terms
- Words and phrases that are emphasized
- Titles of documents

**monospace**
- Commands and command options
- Flags that display on a separate line
- Code examples and output
- Message text
- Names of files and directories
- Text strings that you must type, when they display within text
- Names of Oracle Java™ methods and classes
- HTML and XML tags that display like this, in monospace type

For syntax notations, remember the following details.
- In AIX®, the prompt for the root user is #.
- In AIX and Linux, the commands are case-sensitive, so you must type commands exactly as they are shown.
New for IBM Spectrum Control Version 5.2.9

New features and enhancements are available in IBM Spectrum Control™ Version 5.2.9.

The following features and enhancements are now available:

- "Storage reclamation"
- "Port names"
- "Enhanced platforms"

Storage reclamation
To identify the volumes that are not being used, the storage systems in your data center that you add for monitoring are regularly analyzed. Criteria such as volume performance and host connections are considered. This function provides the following benefits:

- You can reclaim unused storage capacity and more effectively allocate volume space on your block storage systems.
- You can view the amount of storage that can be reclaimed in each of the storage systems that are monitored.
- You can use the volume reclamation recommendations to reclaim unused storage space and use your storage more efficiently. By reclaiming the volumes, you can reduce costs by recycling existing storage space instead of purchasing new storage media.

The following figure shows the reclaimable capacity for tiered and non-tiered storage, and a list of the reclaimable volumes on the Reclaimable Capacity page:

Port names
IBM Spectrum Control now displays the switch blade number, port number, and blade names just as they were defined in other tools, such as Brocade Network Advisor. On a list of switches, the Name column displays the port names that you defined by using the switch management tools. The Port number column now shows only the port number information.

Enhanced platforms
IBM DB2 Version 10.5 Fix Pack 6 is now included with IBM Spectrum Control. If you already have a version of DB2 that is supported by IBM...
Spectrum Control Version 5.2.9, for example DB2 Version 10.1, then you are not required to upgrade to DB2 Version 10.5 Fix Pack 6.

For a list of the supported DB2 versions, go to [http://www.ibm.com/support/docview.wss?uid=swg27047043#Databases](http://www.ibm.com/support/docview.wss?uid=swg27047043#Databases)

**Limitations and known issues**

For information about limitations and known issues that might occur when you use IBM Spectrum Control Version 5.2.9, see [http://www.ibm.com/support/docview.wss?uid=swg21974306](http://www.ibm.com/support/docview.wss?uid=swg21974306)

**Related information:**

- [New for IBM Spectrum Control Version 5.2.8](http://www.ibm.com)
- [Knowledge Centers for Tivoli Storage Productivity Center Version 5.2.7 and earlier](http://www.ibm.com)
Chapter 1. Getting started

Learn about the key tasks for setting up IBM Spectrum Control for managing the resources and infrastructure in a storage environment. The getting started guide provides a list of tasks in sequential order for helping you to learn how to install, configure, and use IBM Spectrum Control.

Complete the following tasks to install and set up IBM Spectrum Control for monitoring and managing storage resources. Click the included links to learn more information about each task.

Table 2. Tasks for getting started with IBM Spectrum Control

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
</table>
| Planning for installation and upgrades. | The time that you invest in planning directly affects your ease of implementation. Planning includes the following tasks:  
  • Ensuring that your systems meet hardware and software requirements  
  • Becoming familiar with the operating systems, storage resources, agents, and communication protocols that can be used with IBM Spectrum Control  
  • Ensuring that ports are open for use  
  • Understanding authentication and role-based authorization  
  • Understanding the requirements for specific types of resources |  
  - Hardware requirements  
  - Software requirements  
  - TCP/IP ports used by IBM Spectrum Control  
  - Planning for IBM Spectrum Control authentication and authorization  
  - Planning for resources  
For more information about the software and resources that are supported by IBM Spectrum Control, see IBM Spectrum Control interoperability matrix at http://www.ibm.com/support/docview.wss?uid=swg21386446 |
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installing or upgrading IBM Spectrum Control</strong></td>
<td>If you have a previous version of IBM Spectrum Control installed, you can upgrade it to the current version. If you do not have a previous version, you can use the following methods to install it:</td>
<td>You can run the installation process as a GUI wizard or through a command line in silent mode.</td>
</tr>
</tbody>
</table>
| **Single-server environment**                             | **Install IBM Spectrum Control and its components on a single server.**                                                                                                                                       | • [Upgrading and migrating][1]  
• [Installing DB2][1]  
• [Installing IBM Spectrum Control in a single-server environment][1]  
• [Installing IBM Spectrum Control in a multiple-server environment][1]  
• [Install Jazz for Service Management and Tivoli Common Reporting][1]                                                    |
| **Multiple-server environment**                            | **Install IBM Spectrum Control on multiple servers if you are monitoring large storage environments, where one server is not sufficient to manage all the IBM Spectrum Control components.**                        |                                                                                                  |
| When you install IBM Spectrum Control, the following components are also installed: |                                                                                                                                                |                                                                                                  |
| **DB2 (required)**                                        | IBM Spectrum Control stores the information that it collects about storage resources in a DB2 database.                                                                                                       |                                                                                                  |
| **Jazz for Service Management and Tivoli Common Reporting (optional)** | **Install these components if you want to use IBM Spectrum Control reports in the web-based GUI.**                                                                                                        |                                                                                                  |
| Starting the IBM Spectrum Control GUI.                    | The IBM Spectrum Control GUI runs in a web browser and can be accessed from anywhere that you have a web browser and connectivity to a network.                                                             | “Starting IBM Spectrum Control” on page 25                                                       |
| Adding resources for monitoring.                          | Before you can monitor the resources in your environment, you must add them to IBM Spectrum Control. You can add the following resources for monitoring:                                                   | “Adding resources” on page 75                                                                     |
| Deploying Storage Resource agents on servers (optional).  | You can deploy Storage Resource agents on servers that you want to monitor. Deploy agents if you want to complete the following tasks:                                                                       | For more information about Storage Resource agents, see “Adding servers” on page 91.            |
|                                                           | • Collect storage usage and trending information about servers (scans)  
• Collect database application information  
• Discover the fabrics that are visible to a server  
• Enforce storage policies  
• Collect zone information                                                                                                               | For a list of the servers where you can deploy Storage Resource agents, see IBM Spectrum Control interoperability matrix at [http://www.ibm.com/support/docview.wss?uid=swg21386446][2] and go to the Agents, Servers, and Browsers section. |

---

[1]: #table-of-contents
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
</table>
| Collecting data about resources. | Determining the information that you want to gather about storage resources is critical to helping you implement a storage management strategy. When you determine the types of information you want to collect about your resources, you can select the data collection jobs that you want to run. | • “Adding resources” on page 75  
• “Collecting data” on page 98 |
| Probes | Probes collect status, asset, and capacity information about resources. | |
| Performance Monitors | Performance monitors collect metrics that measure the performance of storage systems and switches. | |
| Tip: | Probes and performance monitors are automatically scheduled when you add resources for monitoring. | |
| Configuring how alerts are received. | In the web-based GUI, enable alert notifications. Alerts can define notification actions that send email, generate Simple Network Management Protocol (SNMP) traps, or generate IBM Tivoli Netcool/OMNIbus events. To receive these types of alert notifications, you must configure IBM Spectrum Control to direct the notifications to a specific email address, SNMP destination, or Tivoli Netcool/OMNIbus server. | • Configuring alert notifications |
| Specifying the alerts that are generated when a problem is detected on monitored storage. | Determining when and how you are alerted to conditions or violations within your storage environment is important to helping you maintain and administer storage resources. Alerts are triggered by conditions that are detected during data collection and event processing. To set up and manage alerts, complete the following tasks: | • “Defining alerts” on page 113  
• “Viewing and modifying alert notification settings” on page 124  
• “Viewing all alerts” on page 127  
• “Triggering conditions for alerts” on page 252 |
| • For each resource that you want to monitor for issues, specify the conditions and performance thresholds that can trigger alerts. | |
| • Determine how you want to be notified when alerts are triggered. | |
| • View, acknowledge, and remove alerts that are detected. For alerts that are triggered by performance threshold violations, you can view a chart of the historical performance of the resource that violated a threshold. | |
Table 2. Tasks for getting started with IBM Spectrum Control (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring data retention (optional).</td>
<td>Specify how long to retain the data that is collected about resources and the log files that are generated by IBM Spectrum Control. By specifying the number of weeks for history retention, you can control the amount of data that is retained and available for historical analysis and charting. The longer that you retain data, the more informative your analysis, but the more storage space that is required to store that data. Default retention settings are provided.</td>
<td>Configuring history and data retention</td>
</tr>
<tr>
<td>Configuring authentication and user access.</td>
<td>Determine the authentication mechanism and authorization level for users. The authentication mechanism determines the user groups to which you can assign roles. Roles determine the IBM Spectrum Control functions that are available to the users in a group. In the web-based GUI, you can assign the following roles to groups of users: • Administrator • Monitor • External Application</td>
<td>Authorizing users</td>
</tr>
</tbody>
</table>

Managing resources

Learn about the key tasks for getting started with monitoring and managing storage resources.

After installing IBM Spectrum Control and adding resources for monitoring, complete the following tasks to manage your storage environment.

Table 3. Tasks for monitoring and managing resources

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring the performance of resources.</td>
<td>Collect and view key performance metrics about resources and specify alerts to be notified of threshold violations. Use metrics to measure, identify, and troubleshoot performance issues and bottlenecks in your storage. Threshold violations alert you when the performance of a monitored resource falls outside of a specified range.</td>
<td>• ”Monitoring the performance of resources” on page 149 • Reporting in IBM Spectrum Control</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>Learn more</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Monitoring the capacity of resources.    | View detailed information about the capacity of monitored resources in the web-based GUI. You can view capacity information for storage systems, servers, hypervisors and their internal resources, such as volumes, pools, disks, and virtual machines. For example, you can view the total amount of storage space that is committed to a volume, the amount of allocated space that is used by a volume, and the amount of space that is allocated to a volume and is not yet used. You can also use the optional Cognos Business Intelligence reporting tool to view and create capacity reports about multiple resources. Use the information that is collected about storage capacity to help with the capacity planning of the storage within your organization. | • “Viewing information about resources” on page 130  
• Reporting in IBM Spectrum Control  
• Click the Help icon in the web-based GUI to view descriptions of the capacity information that is displayed for resources. |
| Monitoring the status of resources.      | Monitor the status and condition of resources to identify potential problem areas in a storage environment. On the dashboard in the IBM Spectrum Control GUI, you can view a high-level summary of the statuses for each type of resource. From the dashboard, you can drill down to view the individual status for each monitored resource. | • “How the condition of a resource is determined” on page 141  
• Viewing the overall status of a storage environment  
• Viewing the status of individual resources  
• Viewing the status of internal resources |
| Viewing the relationships between resources. | In the web-based GUI, you can generate a graphical or tabular representation of the relationships between host connections, servers, hypervisors, virtual machines, storage systems, and the fabrics through which they are connected. View data paths to monitor status and pinpoint problem areas in the path of monitored storage throughout your environment. You can also use the optional Cognos BI reporting tool to view reports about the relationships between resources. For example, you can view a report about the end-to-end relationship of all the servers in your environment to back-end storage. | • Viewing data paths  
• Viewing relationship reports in the Cognos BI reporting tool |
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring and managing applications and departments.</td>
<td>Storage resources can be grouped together to represent data modeling concepts such as applications, subcomponents (member applications), departments and subdepartments to create a business hierarchy. The monitoring and management of applications and departments enables you to perform capacity trending, health monitoring, and performance troubleshooting for the storage resources in your environment.</td>
<td></td>
</tr>
</tbody>
</table>
|                                                                      | In IBM Spectrum Control, you can create applications and departments, add applications and departments, use a filtering criteria to add resources to the applications, remove related resources from within the context of applications, remove applications and departments, view key properties and view detailed storage information for applications and departments. | • “Creating applications” on page 171  
• “Adding subcomponents” on page 175  
• “Adding applications to departments” on page 182  
• “Using filters to assign resources to applications” on page 172  
• “Removing resources from applications” on page 177  
• “Viewing information about applications” on page 176  
• “Creating departments” on page 180  
• “Adding and creating subdepartments” on page 181  
• “Viewing information about departments” on page 182 |
| Identifying hot spots of high utilization.                          | IBM Spectrum Control collects detailed information about storage system pools, including utilization values. The utilization value is an estimate of the average daily utilization of the physical resources such as controllers, disks, ports, and nodes that are associated with the pool. | • “Redistributing volume workloads to balance pools” on page 60  
• “Analyzing and re-tiering volumes in pools on tier 1” on page 61  
• “Collocating volumes” on page 63                                                                                                    |
| Setting up self-service provisioning.                               | Storage provisioning is the process of assigning storage to optimize the performance of a storage environment. To provision storage with IBM Spectrum Control, create service classes and capacity pools to classify and separate storage resources. After configuration, use the web-based GUI, vSphere Web Client extension, or other tool with those service classes and capacity pools to provision storage. | “Provisioning storage” on page 42                                                                         |
|                                                                      | In the web-based GUI, you are guided through the steps for provisioning volumes or shares. IBM Spectrum Control then recommends storage placement that is based on storage system free space and performance data. If you agree with the recommendation, IBM Spectrum Control can implement the provisioning. |                                                                                                                                                           |
### Table 3. Tasks for monitoring and managing resources (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Provisioning storage in a virtual storage environment.</strong></td>
<td>If you maintain virtual storage in a VMware vSphere environment, you can use the vSphere Web Client extension for IBM Spectrum Control to complete provisioning tasks and to view information about storage resources in the vSphere Web Client. The client includes details about performance and asset, copy services, and fabric information.</td>
<td><img src="#" alt="Provisioning storage with the vSphere Web Client extension” on page 216" /> <img src="#" alt="“Limiting a set of storage to provision in the vSphere Web Client extension” on page 71" /></td>
</tr>
</tbody>
</table>
| **Running reports and setting up report scheduling and delivery.** | Use reports to view detailed information about the condition, capacity, and performance of resources. IBM Spectrum Control provides multiple user interfaces for running reports.  
**Cognos BI reporting tool (optional)**  
You can use the optional Cognos BI reporting tool to run, schedule, and deliver predefined and custom reports. These reports include information about storage capacity, assets, and performance of storage systems, switches, fabrics, servers, hypervisors, and their internal resources.  
**vSphere Web Client**  
Use the vSphere Web Client extension to view reports about virtual environments and storage resources. You can view reports that are customized to use information from IBM Spectrum Control. The reports include fabric connections, storage mapping information, and performance metrics for storage systems. | ![Reporting in IBM Spectrum Control](#) ![Reporting in a vSphere environment](#) |

**Related concepts:**
- Chapter 5, “Managing resources,” on page 75

Use IBM Spectrum Control to monitor and manage the resources and storage infrastructure in an enterprise environment. In the GUI, you can view the condition, capacity, performance, and relationships of storage resources.

---

**Configuring and administering**

Learn about the key tasks for getting started with configuring and administering IBM Spectrum Control and its related components.

Complete any of the following tasks to customize IBM Spectrum Control for your environment and administer its components.
Table 4. Tasks for configuring and administering IBM Spectrum Control

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Learn more</th>
</tr>
</thead>
</table>
| Configuring IBM Spectrum Control. | Configure IBM Spectrum Control according to the standards within your organization, including the following tasks:  
- Customizing lists of resources, tasks, and alerts  
- Enabling reports in the optional Cognos Business Intelligence reporting tool  
- Configuring how alerts are received  
- Configuring data retention  
- Configuring authentication and user access  
- In the vSphere client, you can configure the vSphere client and VASA provider | • “Customizing lists of resources, tasks, and alerts” on page 233  
- If the Cognos BI reporting tool is not enabled, you must install Jazz for Service Management and IBM Tivoli Common Reporting. For more information, see Install Jazz for Service Management and Tivoli Common Reporting  
- Configuring the vSphere Web Client extension for IBM Spectrum Control  
- Configuring the VASA provider |
| Administering DB2 and IBM Spectrum Control. | After IBM Spectrum Control is installed and configured, complete the following administering tasks as needed:  
- Administering resources and data sources  
- Starting and stopping IBM Spectrum Control servers  
- Checking the status of IBM Spectrum Control components  
- Packaging log files for IBM Software Support  
- Changing passwords for IBM Spectrum Control components  
- Administering DB2 and backing up the database repository | • Administering resources and data sources  
• Starting and stopping the IBM Spectrum Control servers  
• Checking IBM Spectrum Control status  
• Packaging log files for IBM Software Support  
• Changing passwords  
• Administering DB2 |

Navigation

The IBM Spectrum Control GUI provides many of the functions for managing a storage environment. To access the functions in this GUI, use the menu bar at the top of the main window.

<table>
<thead>
<tr>
<th>GUI element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page banner | Use the banner at the top of every page in the GUI to complete the following tasks:  
- View the name of the product license that is active.  
- Access resource pages and main product functions from the menu bar.  
- View the ID and role of the user who is logged in to the GUI. The role of a user determines the product functions that are available to that user. For more information about roles, see “Role-based authorization” on page 52  
- Access the online help to view information about the currently displayed page and the overall product. |
<table>
<thead>
<tr>
<th>GUI element</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Home**    | Use the dashboard to view the overall status of monitored resources and identify potential problem areas in a storage environment. You can learn about:  
  • Condition and usage of resources  
  • Entities that consume storage on those resources  
  • Number and status of unacknowledged alert conditions that are detected on the monitored resources  
  • Most active storage systems in your environment. |
| **Dashboard** | Use performance monitors to collect information about the performance of storage systems and switches. This information includes key performance metrics and notifications of threshold violations. |
| **Performance Monitors** | Use alerts to be notified when certain configuration, status, and performance conditions are detected on monitored resources. |
| **Alerts** | Manage the tasks that are created when you complete the following actions:  
  • Assign storage to servers, hypervisors, or a cluster.  
  • Place volumes on the tiers that match the workload requirements of the volume.  
  • Move or convert volumes.  
  • Move volumes from overutilized pools to pools that are less used. |
| **Tasks** | View information about the overall condition of IBM Spectrum Control. You can view information about the servers on which the product is installed. This information includes component server and database status, certain server alerts and database connection alerts, server file-system capacity information, and remote volume-performance information. |
| **System Management** | You can learn about:  
  • Condition and usage of resources  
  • Entities that consume storage on those resources  
  • Number and status of unacknowledged alert conditions that are detected on the monitored resources  
  • Most active storage systems in your environment. |
### GUI element | Description
--- | ---
**Storage** | Add storage systems for monitoring and view asset, status, and performance information about their internal and related resources. You can also complete the following actions to manage and administer storage systems:
- Modify the schedules for data collection.
- View the data path of connected resources.
- Assign storage to servers, hypervisors, or a cluster.
- Place volumes on the tiers that match the workload requirements of the volume.
- Move or convert volumes.
- Move volumes from overutilized pools to pools that are less used.
- Add resources to a capacity pool.
- Open management GUIs.
- Update login credentials.
- Acknowledge conditions and statuses.

**Servers** | Add servers and hypervisors for monitoring and view asset and status information about their internal and related resources. You can also complete the following actions to manage and administer these resources:
- Deploy Storage Resource agents to servers for full monitoring.
- Modify the schedules for data collection.
- View the data path of connected resources.
- Assign storage to servers, hypervisors, or a cluster.
- Modify and upgrade Storage Resource agents.
- Acknowledge conditions and statuses.

**Network** | Add switches and fabrics for monitoring and view asset, status, and performance information about their internal and related resources. You can also complete the following actions to manage and administer these resources:
- Modify the schedules for data collection.
- View the data path of connected resources.
- Setting or modifying the zoning policy.
- Open the management GUI for a switch.
- Acknowledge conditions and statuses.
<table>
<thead>
<tr>
<th>GUI element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Groups              | Add applications and departments to combine resources that are grouped by applications and departments. Applications and departments are used to monitor and view status, capacity, and performance information, and view details about their related resources. You can also complete the following actions to manage and administer applications and departments:  
  • Create applications and departments to model data for storage resources, allowing for enhanced capacity trending and performance troubleshooting.  
  • View the status of resources that make up the applications and departments.  
  • Create resource filters to automatically add resources to applications.  
  • Add resources directly to applications and add applications to existing applications and departments.  
  • Add departments to existing departments.  
  • View subcomponent (member application) information to support hierarchical levels of storage grouping.  
  • Remove applications and departments.                                                                                                                   |
| Advanced Analytics  | Configure IBM Spectrum Control for provisioning, optimizing, and reclaiming storage. The GUI guides you through the steps for managing your storage such as creating service classes and capacity pools to provision storage and creating tiers to optimize storage placement.  
  You can complete the following tasks:  
  • Provision servers, hypervisors, or a cluster  
  • Optimize storage by re-tiering volumes and balancing pools  
  • Reclaim storage that is not being used                                                                                                                   |
| Cognos (optional)   | Use the web-based GUI when you want to individually view details about resources, for example when you want to troubleshoot a resource.  
  You can also use the optional Cognos Business Intelligence reporting tool to analyze multiple storage systems, switches, servers, and hypervisors. For example, you can compare performance metrics across multiple storage systems. You can also view a report about the aggregate volume load that is on a server or hypervisor.  
  Use the Cognos BI reporting tool to schedule reports to run on different systems and with different options. You can specify schedules and output formats for the reports, and different ways to share the reports.  
  When you click a Cognos BI reporting option, a separate browser tab is opened.  
  For information about how to get started with the Cognos BI reporting tool, see [http://www.ibm.com/support/knowledgecenter/SSSR93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_c_getting_started_reports.html](http://www.ibm.com/support/knowledgecenter/SSSR93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_c_getting_started_reports.html) |
Complete the following actions to customize IBM Spectrum Control for your environment:

- Modify the authentication repository and assign IBM Spectrum Control roles to user groups. Roles determine the product functions that are available to users.
- Specify how long to retain the data that is collected about resources and the log files that are generated by IBM Spectrum Control.
- Review the distribution of capacity in your storage environment to determine whether you have sufficient capacity to meet the demands of your tiered storage.

Keyboard navigation

Most of the features of the IBM Spectrum Control GUI are accessible by using the keyboard. For those features that are not accessible, equivalent function is available by using the command-line interface (CLI), except as noted in the product release notes.

You can use keys or key combinations to perform operations and initiate many menu actions that can also be done through mouse actions. The following sections describe the keys or key combinations for different parts of the GUI:

For navigating in the GUI and the context-sensitive help system:

- To navigate to the next link, button, or topic within a panel, press Tab.
- To move to the previous link, button, or topic within a panel, press Shift+Tab.
- To select an object, when the object is in focus, press Enter.

For actions menus:

- To navigate to the grid header, press Tab.
- To reach the drop-down field, press the Left Arrow or Right Arrow key.
- To open the drop-down menu, press Enter.
- To select the menu items, press the Up Arrow or Down Arrow key.
- To start the action, press Enter.

For filters:

To specify a filter option and text:

1. Press Tab to navigate to the magnifying glass icon.
2. Press the Up Arrow or Down Arrow key to navigate the filtering list.
3. Press Enter to select a filtering option.
4. When a filtering option is selected, the cursor moves to the filter text box. Type the filter text and press Enter. To reset a filter, press Enter.

For text fields:

- To navigate to text fields, press Tab.
- To navigate to the fields that are available for editing, press Tab.
- To navigate to the next field or to the Submit button, press Tab.

For tables or lists:
• To navigate between column headers, focus on a column header and use the Left Arrow and Right Arrow keys to move to other column headers.

• To navigate between data cells, focus on a data cell and use the Left, Right, Up, Down, Pageup, and Pagedown Arrow keys.

• To sort a column, focus on a column header and press Enter. The focus remains on the column header after the sort occurs.

• To change the size of a column, focus on the column header, hold Shift+Control, and press the Left or Right Arrow keys.

• To follow a link in a data cell, focus on a data cell and press Shift+F9.

• To open a menu for a table row, focus on the row and press Shift+F10.

• To select consecutive rows, select the first row and hold Shift, press the Up or Down Arrow keys to go to the last row in the range, and press the Space bar to add the new rows to the selection.

• To select non-consecutive rows, select a row and hold Control, press the Up or Down Arrow keys, and press the Space bar to add the new row to the selection.

Restriction: For Chinese languages, the keyboard combination Control+Space bar is not enabled for selecting multiple rows at the same time.
Chapter 2. Product licenses

Multiple product licenses are available for IBM Spectrum Control, formerly known as IBM Tivoli Storage Productivity Center. Each license determines the features that you can access from the IBM Spectrum Control GUI, command-line interface, and the API. You can review the features that are included with each license and determine which license meets your storage management needs.


These licenses provide the following features:

• Single dashboard view of the storage environment, which enables you to manage storage systems, hypervisors, servers, and networks

• Capacity and usage monitoring, as well as management and planning for the heterogeneous storage environment

• Performance monitoring for storage systems and networks

• Health and alerting for storage systems, hypervisors, servers, and networks

• Modeling of departments and applications to understand the consumer view of the environment

• Administrative tools, such as:
  – VMware vCenter plug-in, which enables you to manage and provision virtual storage in a vSphere environment, and to view reports about storage systems that are monitored by IBM Spectrum Control
  – Reports from IBM Cognos(R) Business Intelligence, which provides reporting and analytics information

This license includes a license for IBM Copy Services Manager (formerly known as IBM Tivoli Storage Productivity Center for Replication). Copy Services Manager manages 2-site replication, 3-site replication, and advanced copy services. You can learn more about how to download and install Copy Services Manager at [http://www.ibm.com/support/knowledgcenter/SSESK4](http://www.ibm.com/support/knowledgcenter/SSESK4)

The IBM Spectrum Control Standard Edition license is priced by the capacity of the storage systems that it manages.

The IBM Spectrum Control Standard Select Edition license is priced by the number of storage enclosures that it manages.

**IBM Spectrum Control Advanced Edition and IBM Spectrum Control Advanced Select Edition**

These licenses contain everything that is in the IBM Spectrum Control Standard Edition license, and the following features:

• Analytics-driven, tiered-storage optimization that automatically moves data to the most cost-effective tier

• Pool balancing

• Block storage provisioning

• Storage reclamation
• Application-aware snapshot-based protection that is offered by IBM Spectrum Protect™ Snapshot (formerly known as IBM FlashCopy® Manager)

The IBM Spectrum Control Advanced Edition license is priced by the capacity of the storage systems that it manages.

The IBM Spectrum Control Advanced Select Edition is priced by the number of storage enclosures that it manages.

The IBM Tivoli Storage Productivity Center license is now IBM Spectrum Control Standard Edition.

IBM Spectrum Control Advanced Edition is a new software-only product that offers the same functions as the Storage Analytics Engine product that was part of IBM Virtual Storage Center.

To view a complete list of devices that can be used with IBM Spectrum Control, go to [http://www.ibm.com/support/docview.wss?uid=swg21386446](http://www.ibm.com/support/docview.wss?uid=swg21386446) Click the appropriate release under Storage.

Table 5 shows the IBM Spectrum Control licenses and their names from previous releases.

<table>
<thead>
<tr>
<th>Name of IBM Spectrum Control license</th>
<th>Name of Tivoli Storage Productivity Center Version 5.1 license</th>
<th>Name of Tivoli Storage Productivity Center Version 5.2.1 through 5.2.7 license</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Spectrum Control Standard Edition</td>
<td>Tivoli Storage Productivity Center</td>
<td>Tivoli Storage Productivity Center</td>
</tr>
<tr>
<td>IBM Spectrum Control Standard Select Edition</td>
<td>Tivoli Storage Productivity Center Select</td>
<td>Tivoli Storage Productivity Center Select</td>
</tr>
<tr>
<td>IBM Spectrum Control Advanced Edition</td>
<td>Tivoli Storage Productivity Center Advanced or IBM SmartCloud® Virtual Storage Center</td>
<td>IBM SmartCloud Virtual Storage Center Storage Analytics Engine</td>
</tr>
<tr>
<td>IBM Spectrum Control Advanced Select Edition</td>
<td>Tivoli Storage Productivity Center Advanced or IBM SmartCloud Virtual Storage Center</td>
<td>IBM SmartCloud Virtual Storage Center Storage Analytics Engine</td>
</tr>
</tbody>
</table>

Functions that are available based on role and license

Your IBM Spectrum Control role and product license determine the functions that are available in the product.

Users who are assigned the Administrator role or the Monitor role can use product functions. The functions that are available depend on the role that is assigned to the user:

**Administrator role**

Users who are assigned the Administrator role have access to all monitoring and administrative functions and are limited only by license restrictions.

**Monitor role**

Users who are assigned the Monitor role can view information about
monitored resources and other objects such as tasks, alerts, and service classes. They can acknowledge alerts and resource statuses, open logs, and open management GUIs. Users who are assigned the Monitor role do not have access to administrative functions, with the following exceptions:

- They can assign storage pools to tiers.
- They can be granted permission in a service class to provision storage by using the service class. If so, they can use the Provision Storage wizard to create a provisioning task. Users can delete provisioning tasks that they create. If the service class specifies that administrator approval is not required, the users can run or schedule the provisioning tasks that they create.

To use some functions, you must have the IBM Spectrum Control Advanced Edition license. If you have the IBM Spectrum Control Standard Edition license or the IBM Spectrum Control Standard Select Edition license, the following functions are not available:

- Storage tier optimization. The Analyze Tiers wizard is not available.
- Pool balancing. The Balance Pools wizard is not available.
- Block storage provisioning. You are not able to provision volumes by using either the Provision Storage wizard or the vSphere Web Client extension. However, there are no license restrictions for file storage provisioning, therefore, Network Attached Storage (NAS) file shares can be provisioned.

The following table outlines the functions available by role. Some functions are restricted to the Administrator role. Functions that are restricted to the IBM Spectrum Control Advanced Edition license are also shown. In addition to the restrictions listed in this table, users who are assigned the Monitor role do not have access to user management functions.

**Table 6. Role and license restrictions**

<table>
<thead>
<tr>
<th>Resource or object</th>
<th>Functions available by role</th>
<th>Functions that require the IBM Spectrum Control Advanced Edition</th>
</tr>
</thead>
</table>
| Performance monitors | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
- View information about the switch or storage system that is being monitored  
- Open performance monitor logs  
- Export performance monitor information to a file | All functions are available, depending on role. |
|                     | Users who are assigned the Administrator role can also complete the following administrative actions:  
- Start or stop a performance monitor  
- Schedule a performance monitor | |

Chapter 2. Product licenses 17
Table 6. Role and license restrictions (continued)

<table>
<thead>
<tr>
<th>Resource or object</th>
<th>Functions available by role</th>
<th>Functions that require the IBM Spectrum Control Advanced Edition</th>
</tr>
</thead>
</table>
| Alerts             | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
|                    | • View information about alerts                                                          | All functions are available, depending on role.                  |
|                    | • Remove alerts                                                                         |                                                                  |
|                    | • Acknowledge alerts                                                                    |                                                                  |
|                    | • Enable and disable alerts                                                             |                                                                  |
|                    | • Export alert information to a file                                                    |                                                                  |
|                    | Users who are assigned the Administrator role can also define alert definitions and edit alert notification settings. |                                                                  |
| Tasks              | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
|                    | • View information about tasks                                                          | All functions are available, depending on role.                  |
|                    | • Open task logs                                                                        |                                                                  |
|                    | • Export task information to a file                                                     |                                                                  |
|                    | If a user assigned the Monitor role has permission to provision storage by using a service class, the user can delete provisioning tasks that the user creates. If the service class does not require administrator approval, the user can also schedule and run the provision tasks that the user creates. |                                                                  |
|                    | Users who are assigned the Administrator role can also complete the following administrative actions:  
|                    | • Run tasks                                                                             |                                                                  |
|                    | • Schedule tasks                                                                        |                                                                  |
|                    | • Delete tasks                                                                          |                                                                  |
| Storage systems    | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
|                    | • View information about storage systems                                                | Optimize storage tiering                                         |
|                    | • Acknowledge storage system status                                                     |                                                                  |
|                    | • Open the management GUI or element manager for a storage system                       |                                                                  |
|                    | • Export storage system information to a file                                           |                                                                  |
|                    | Users who are assigned the Administrator role can also complete the following administrative actions:  
<p>|                    | • Add and remove storage systems                                                        |                                                                  |
|                    | • Schedule data collection jobs                                                         |                                                                  |
|                    | • Optimize storage tiering                                                              |                                                                  |
|                    | • Add storage systems to capacity pools                                                 |                                                                  |
|                    | • Administer connections                                                                |                                                                  |</p>
<table>
<thead>
<tr>
<th>Resource or object</th>
<th>Functions available by role</th>
<th>Functions that require the IBM Spectrum Control Advanced Edition</th>
</tr>
</thead>
</table>
| Volumes           | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
  • View information about volumes  
  • Acknowledge volume status  
  • Export volume information to a file  
  Users who are assigned the Administrator role can also complete the following administrative actions:  
  • Transform storage volumes  
  • Optimize storage tiering  
|                  | • Transform storage volumes  
  • Optimize storage tiering |
| Pools             | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
  • View information about pools  
  • Acknowledge pool status  
  • Export pool information to a file  
  Users who are assigned the Administrator role can also complete the following administrative actions:  
  • Add pools to capacity pools  
  • Balance pools  
  • Optimize storage tiering  
|                  | • Balance pools  
  • Optimize storage tiering |
| Shares            | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
  • View information about shares  
  • Export pool information to a file  
|                  | All functions are available, depending on role. |
| Servers           | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
  • View information about servers  
  • Acknowledge server status  
  • View and collect logs  
  • Export server information to a file  
  If a user assigned the Monitor role has permission to provision storage by using a service class, the user can provision storage to servers.  
  Users who are assigned the Administrator role can also complete the following administrative actions:  
  • Add and remove servers  
  • Schedule data collection jobs  
  • Provision storage to servers  
  • Modify Storage Resource agents  
|                  | • Provision block storage.  
  There are no license restrictions for provisioning file storage.  
  • Optimize storage tiering. |
<table>
<thead>
<tr>
<th>Resource or object</th>
<th>Functions available by role</th>
<th>Functions that require the IBM Spectrum Control Advanced Edition</th>
</tr>
</thead>
</table>
| **Hypervisors**    | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
• View information about hypervisors  
• Acknowledge hypervisor status  
• Export hypervisor information to a file  
If a user who is assigned the Monitor role has permission to provision storage by using a service class, the user can provision storage to hypervisors.  
Users who are assigned the Administrator role can also complete the following administrative actions:  
• Add and remove hypervisors  
• Schedule data collection jobs  
• Provision storage to hypervisors  
• Administer connections | Provision block storage.  
There are no license restrictions for provisioning file storage. |
| **Switches**       | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
• View information about switches  
• Acknowledge switch status  
• Open the management GUI or element manager for a switch  
• Export switch information to a file  
Users who are assigned the Administrator role can also complete the following administrative actions:  
• Add and remove switches  
• Schedule data collection jobs  
• Administer connections  
• Enable automatic zoning | Enable automatic zoning |
<table>
<thead>
<tr>
<th>Resource or object</th>
<th>Functions available by role</th>
<th>Functions that require the IBM Spectrum Control Advanced Edition</th>
</tr>
</thead>
</table>
| Fabrics           | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
|                   | • View information about fabrics  
|                   | • Acknowledge fabric status  
|                   | • Export fabric information to a file  
|                   | Users who are assigned the Administrator role can also complete the following administrative actions:  
|                   | • Add and remove fabrics  
|                   | • Schedule data collection jobs  
|                   | • Administer connections  
|                   | • Enable automatic zoning |
|                   | **Note:** For Cisco fabrics, you must remove individual switches using the Switch panels. When the last switch of a fabric is removed, the fabric is removed. |
|                   | Enable automatic zoning |
| Service classes   | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
|                   | • View information about service classes  
|                   | • Export service class information to a file  
|                   | Users who are assigned the Administrator role can also complete the following administrative actions:  
|                   | • Create service classes  
|                   | • Modify service classes  
|                   | • Delete service classes |
|                   | Create block-storage service classes.  
|                   | There are no license restrictions for working with file-storage service classes. |
| Capacity pools    | Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:  
|                   | • View information about capacity pools  
|                   | • Export capacity pool information to a file  
|                   | Users who are assigned the Administrator role can also complete the following administrative actions:  
|                   | • Create capacity pools  
|                   | • Modify capacity pools  
<p>|                   | • Delete capacity pools |
|                   | All functions are available, depending on role. |</p>
<table>
<thead>
<tr>
<th>Resource or object</th>
<th>Functions available by role</th>
<th>Functions that require the IBM Spectrum Control Advanced Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications and departments</td>
<td>Users who are assigned the Monitor or Administrator role can complete the following monitoring actions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- View information about applications and subcomponents</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- View information about departments and subdepartments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- View related resources assigned to applications and departments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Users who are assigned the Administrator role can also complete the following administrative actions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Create applications and departments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Create filters to add resources</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Modify filters to change resources</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remove filters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add resources to applications directly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remove resources from applications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add applications as members of other applications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Create departments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add departments to other departments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add applications to departments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All functions are available, depending on role.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3. Product overview

IBM Spectrum Control provides a set of policy-driven automated tools for managing storage capacity, availability, events, performance, and resources. It can reduce the complexity of managing a storage environment by centralizing, simplifying, and optimizing storage tasks that are associated with storage systems, storage networks, performance troubleshooting, and capacity management.

Because it is policy-based, IBM Spectrum Control can detect potential problems and automatically adjust storage and resources that are based on the policies and actions that you define. For example, it can notify you when a server or storage system is running out of disk space or warn you of impending storage hardware failure. By alerting you to these and other issues that are related to your stored data, you can use IBM Spectrum Control to prevent unnecessary system and application downtime.

IBM Spectrum Control provides the following benefits and functions:
- Simplifies the management of storage infrastructures
- Manages, administers, and provisions SAN-attached storage
- Monitors and tracks performance of SAN-attached devices
- Monitors, manages, and controls (through zones) SAN fabric components
- Manages the capacity utilization and availability of file systems and databases

Architecture

The IBM Spectrum Control consists of several components that form the infrastructure of its storage-management functions.

Data server
This component is the control point for product scheduling functions, configuration, and event information. It also includes functions that schedule data collection and discovery for the Device server.

Device server
This component discovers, gathers information from, analyzes performance of, and controls storage subsystems and SAN fabrics. It coordinates communication with and data collection from agents that scan SAN fabrics and storage devices.

Web server
IBM Spectrum Control uses the WebSphere Application Server as the web application server to host its GUI, storage management API for cloud, and VMware vSphere web client extension.

Alert server
This component manages the complex event processing that is related to alerting on the condition of resources and their attributes. The ability to detect and be notified about configuration, capacity, and performance changes within a storage environment is important to helping you maintain and administer storage resources.
Jazz for Service Management and Tivoli Common Reporting (optional)
If you plan to use the optional Cognos Business Intelligence reporting tool, you must install Jazz for Service Management and Tivoli Common Reporting.

Tivoli Common Reporting includes Cognos BI reporting tool. You can use this tool to create reports and view predefined reports to analyze multiple storage systems, switches, servers, and hypervisors.

For large storage environments where one server is not sufficient to manage all the IBM Spectrum Control components, you can install the product on multiple servers. In this type of environment, Jazz for Service Management and Tivoli Common Reporting can run on a separate server.

Database
A single database instance serves as the repository for all IBM Spectrum Control components.

Agents
Storage Resource agent, CIM agents, and SNMP agents gather host, application, storage system, and SAN fabric information and send that information to the Data server or Device server.

GUI
Use the IBM Spectrum Control web-based GUI to manage the storage infrastructure in an enterprise environment.

CLI
Use the command-line interface (CLI) to issue commands for key IBM Spectrum Control functions.

Interfaces for IBM Spectrum Control
IBM Spectrum Control provides multiple user interfaces for managing the storage infrastructure in an enterprise environment.

Web-based GUI
This interface runs in a web browser and includes the ability to monitor, manage, and troubleshoot storage resources. You can also report on the condition, capacity, and performance resources in the optional Cognos Business Intelligence reporting tool. You can access this interface from anywhere that you have a web browser and connectivity to a network.

Cognos BI reporting tool (optional)
This interface runs in a web browser. Use this interface to view predefined reports and create custom reports about IBM Spectrum Control. You can access the reports from the web-based GUI, and work with the reports in the Cognos BI reporting tool. The Cognos BI reporting tool is included in Tivoli Common Reporting. For more information about how to use the Cognos BI reporting tool to view and create reports about IBM Spectrum Control, see Reporting in IBM Spectrum Control.

Command-line interface
Use this interface to run IBM Spectrum Control commands from a command prompt. For more information about CLI commands, see the IBM Spectrum Control Command-Line Interface Reference.

Related concepts:
Chapter 5, “Managing resources,” on page 75
Use IBM Spectrum Control to monitor and manage the resources and storage infrastructure in an enterprise environment. In the GUI, you can view the condition, capacity, performance, and relationships of storage resources.
Starting IBM Spectrum Control

You can start IBM Spectrum Control by opening a web browser and entering a web address for the IBM Spectrum Control logon page. For example, you might enter https://storage.example.com:9569/srm.

Before you start IBM Spectrum Control, ensure that you are using a supported web browser. For a list of web browsers that you can use with IBM Spectrum Control, see IBM Spectrum Control interoperability matrix at http://www.ibm.com/support/docview.wss?uid=swg21386446. In the Agents, Servers and Browser column, click the version of IBM Spectrum Control that is installed on your system. On the next page, click Web Browsers to find the web browsers that you can use.

Start the IBM Spectrum Control GUI to administer and monitor the condition, capacity, and relationships of the resources within your storage environment.

1. On a server running the Windows operating system, start IBM Spectrum Control GUI. If you are not on a server running the Windows operating system, start a web browser and enter the following address in the address field:

   https://host_name:port/srm

   In the preceding address, specify the following values:

   **host_name**
   The IBM Spectrum Control server. You can specify the host name as an IP address or a Domain Name System (DNS) name.

   **port**
   The port number for IBM Spectrum Control. The default port number for connecting to IBM Spectrum Control by using the HTTPS protocol is 9569. However, this port number might be different for your site. For example, the port number might be different if the default port range was not accepted during installation. If the default port number does not work, ask your IBM Spectrum Control administrator for the correct port number.

   **Tip:** If you have a non-default port, check the value of the WC_defaulthost_secure property in TPC_installation_directory/web/conf/portdef.props file.

2. From the IBM Spectrum Control logon page, type your user name and password and click Log in. The IBM Spectrum Control GUI opens in the browser.
Navigation

The IBM Spectrum Control GUI provides many of the functions for managing a storage environment. To access the functions in this GUI, use the menu bar at the top of the main window.

<table>
<thead>
<tr>
<th>GUI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page banner</td>
<td>Use the banner at the top of every page in the GUI to complete the following tasks:</td>
</tr>
<tr>
<td></td>
<td>• View the name of the product license that is active.</td>
</tr>
<tr>
<td></td>
<td>• Access resource pages and main product functions from the menu bar.</td>
</tr>
<tr>
<td></td>
<td>• View the ID and role of the user who is logged in to the GUI. The role of a user determines the product functions that are available to that user. For more information about roles, see “Role-based authorization” on page 52.</td>
</tr>
<tr>
<td></td>
<td>• Access the online help to view information about the currently displayed page and the overall product.</td>
</tr>
<tr>
<td>GUI element</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Dashboard   | Use the dashboard to view the overall status of monitored resources and identify potential problem areas in a storage environment. You can learn about:  
  - Condition and usage of resources  
  - Entities that consume storage on those resources  
  - Number and status of unacknowledged alert conditions that are detected on the monitored resources  
  - Most active storage systems in your environment. |
| Performance Monitors | Use performance monitors to collect information about the performance of storage systems and switches. This information includes key performance metrics and notifications of threshold violations. |
| Alerts      | Use alerts to be notified when certain configuration, status, and performance conditions are detected on monitored resources. |
| Tasks       | Manage the tasks that are created when you complete the following actions:  
  - Assign storage to servers, hypervisors, or a cluster.  
  - Place volumes on the tiers that match the workload requirements of the volume.  
  - Move or convert volumes.  
  - Move volumes from overutilized pools to pools that are less used. |
<p>| System Management | View information about the overall condition of IBM Spectrum Control. You can view information about the servers on which the product is installed. This information includes component server and database status, certain server alerts and database connection alerts, server file-system capacity information, and remote volume-performance information. |</p>
<table>
<thead>
<tr>
<th>GUI element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Storage     | Add storage systems for monitoring and view asset, status, and performance information about their internal and related resources. You can also complete the following actions to manage and administer storage systems:  
  - Modify the schedules for data collection.  
  - View the data path of connected resources.  
  - Assign storage to servers, hypervisors, or a cluster.  
  - Place volumes on the tiers that match the workload requirements of the volume.  
  - Move or convert volumes.  
  - Move volumes from overutilized pools to pools that are less used.  
  - Add resources to a capacity pool.  
  - Open management GUIs.  
  - Update login credentials.  
  - Acknowledge conditions and statuses. |
| Servers     | Add servers and hypervisors for monitoring and view asset and status information about their internal and related resources. You can also complete the following actions to manage and administer these resources:  
  - Deploy Storage Resource agents to servers for full monitoring.  
  - Modify the schedules for data collection.  
  - View the data path of connected resources.  
  - Assign storage to servers, hypervisors, or a cluster.  
  - Modify and upgrade Storage Resource agents.  
  - Acknowledge conditions and statuses. |
| Network     | Add switches and fabrics for monitoring and view asset, status, and performance information about their internal and related resources. You can also complete the following actions to manage and administer these resources:  
  - Modify the schedules for data collection.  
  - View the data path of connected resources.  
  - Setting or modifying the zoning policy.  
  - Open the management GUI for a switch.  
  - Acknowledge conditions and statuses. |
<table>
<thead>
<tr>
<th>GUI element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>Add applications and departments to combine resources that are grouped by applications and departments. Applications and departments are used to monitor and view status, capacity, and performance information, and view details about their related resources. You can also complete the following actions to manage and administer applications and departments: • Create applications and departments to model data for storage resources, allowing for enhanced capacity trending and performance troubleshooting. • View the status of resources that make up the applications and departments. • Create resource filters to automatically add resources to applications. • Add resources directly to applications and add applications to existing applications and departments. • Add departments to existing departments. • View subcomponent (member application) information to support hierarchal levels of storage grouping. • Remove applications and departments.</td>
</tr>
<tr>
<td>Advanced Analytics</td>
<td>Configure IBM Spectrum Control for provisioning, optimizing, and reclaiming storage. The GUI guides you through the steps for managing your storage such as creating service classes and capacity pools to provision storage and creating tiers to optimize storage placement. You can complete the following tasks: • Provision servers, hypervisors, or a cluster • Optimize storage by re-tiering volumes and balancing pools • Reclaim storage that is not being used</td>
</tr>
<tr>
<td>Cognos (optional)</td>
<td>Use the web-based GUI when you want to individually view details about resources, for example when you want to troubleshoot a resource. You can also use the optional Cognos Business Intelligence reporting tool to analyze multiple storage systems, switches, servers, and hypervisors. For example, you can compare performance metrics across multiple storage systems. You can also view a report about the aggregate volume load that is on a server or hypervisor. Use the Cognos BI reporting tool to schedule reports to run on different systems and with different options. You can specify schedules and output formats for the reports, and different ways to share the reports. When you click a Cognos BI reporting option, a separate browser tab is opened. For information about how to get started with the Cognos BI reporting tool, see <a href="http://www.ibm.com/support/knowledgecenter/SSSR93_5.2.9/com.ibm.spectrum.sc.doc/faq0_c_getting_started_reports.html">http://www.ibm.com/support/knowledgecenter/SSSR93_5.2.9/com.ibm.spectrum.sc.doc/faq0_c_getting_started_reports.html</a></td>
</tr>
</tbody>
</table>
### GUI element | Description
--- | ---
Settings | Complete the following actions to customize IBM Spectrum Control for your environment:
• Modify the authentication repository and assign IBM Spectrum Control roles to user groups. Roles determine the product functions that are available to users.
• Specify how long to retain the data that is collected about resources and the log files that are generated by IBM Spectrum Control.
• Review the distribution of capacity in your storage environment to determine whether you have sufficient capacity to meet the demands of your tiered storage.

#### Keyboard navigation

Most of the features of the IBM Spectrum Control GUI are accessible by using the keyboard. For those features that are not accessible, equivalent function is available by using the command-line interface (CLI), except as noted in the product release notes.

You can use keys or key combinations to perform operations and initiate many menu actions that can also be done through mouse actions. The following sections describe the keys or key combinations for different parts of the GUI:

**For navigating in the GUI and the context-sensitive help system:**

- To navigate to the next link, button, or topic within a panel, press Tab.
- To move to the previous link, button, or topic within a panel, press Shift+Tab.
- To select an object, when the object is in focus, press Enter.

**For actions menus:**

- To navigate to the grid header, press Tab.
- To reach the drop-down field, press the Left Arrow or Right Arrow key.
- To open the drop-down menu, press Enter.
- To select the menu items, press the Up Arrow or Down Arrow key.
- To start the action, press Enter.

**For filters:**

To specify a filter option and text:
1. Press Tab to navigate to the magnifying glass icon.
2. Press the Up Arrow or Down Arrow key to navigate the filtering list.
3. Press Enter to select a filtering option.
4. When a filtering option is selected, the cursor moves to the filter text box. Type the filter text and press Enter. To reset a filter, press Enter.

**For text fields:**

- To navigate to text fields, press Tab.
- To navigate to the fields that are available for editing, press Tab.
- To navigate to the next field or to the Submit button, press Tab.

**For tables or lists:**

---
• To navigate between column headers, focus on a column header and use the Left Arrow and Right Arrow keys to move to other column headers.
• To navigate between data cells, focus on a data cell and use the Left, Right, Up, Down, Pageup, and Pagedown Arrow keys.
• To sort a column, focus on a column header and press Enter. The focus remains on the column header after the sort occurs.
• To change the size of a column, focus on the column header, hold Shift+Control, and press the Left or Right Arrow keys.
• To follow a link in a data cell, focus on a data cell and press Shift+F9.
• To open a menu for a table row, focus on the row and press Shift+F10.
• To select consecutive rows, select the first row and hold Shift, press the Up or Down Arrow keys to go to the last row in the range, and press the Space bar to add the new rows to the selection.
• To select non-consecutive rows, select a row and hold Control, press the Up or Down Arrow keys, and press the Space bar to add the new row to the selection.

**Restriction:** For Chinese languages, the keyboard combination Control+Space bar is not enabled for selecting multiple rows at the same time.

### Replication products

Tivoli Storage Productivity Center for Replication and IBM Copy Services Manager, which is built on existing replication technology, are the replication tools available for use with IBM Spectrum Control.

### Availability

Tivoli Storage Productivity Center for Replication is available under the following conditions:

- In Tivoli Storage Productivity Center V5.2.7 and earlier, Tivoli Storage Productivity Center for Replication is automatically available.
- In IBM Spectrum Control V5.2.8 and later, Tivoli Storage Productivity Center for Replication is only available if you upgrade from Tivoli Storage Productivity Center V5.2.7 or earlier.

IBM Copy Services Manager is available with every IBM Spectrum Control V5.2.8 or later license.

### Information about Tivoli Storage Productivity Center for Replication

Information about how to use Tivoli Storage Productivity Center for Replication is available in the IBM Knowledge Center for Tivoli Storage Productivity Center V5.2.7. Use the following links to view this information:

<table>
<thead>
<tr>
<th>Task</th>
<th>Link to related information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about Tivoli Storage Productivity Center for Replication and its key concepts</td>
<td><a href="#">Product overview</a></td>
</tr>
</tbody>
</table>

---

Chapter 3. Product overview 31
Table 7. Information about Tivoli Storage Productivity Center for Replication (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Link to related information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan for using the product.</td>
<td>➡️ Planning</td>
</tr>
<tr>
<td>Starting Tivoli Storage Productivity Center for Replication</td>
<td>➡️ Starting the GUI</td>
</tr>
<tr>
<td>View scenarios that illustrate how replication can be used.</td>
<td>➡️ Scenarios</td>
</tr>
<tr>
<td>Manage replication components, including setting up the management</td>
<td>➡️ Managing replication</td>
</tr>
<tr>
<td>servers, adding storage connections and paths, creating sessions</td>
<td></td>
</tr>
<tr>
<td>and copy sets, setting up data replication, performing planned</td>
<td></td>
</tr>
<tr>
<td>maintenance, and recovering from a disaster.</td>
<td></td>
</tr>
<tr>
<td>Use CLI commands to access functions within the product.</td>
<td>➡️ CLI commands</td>
</tr>
<tr>
<td>View information about configuration files</td>
<td>➡️ Configuration files</td>
</tr>
<tr>
<td>View explanations of messages that might be generated when you use</td>
<td>➡️ Messages</td>
</tr>
<tr>
<td>the product</td>
<td></td>
</tr>
</tbody>
</table>

Information about IBM Copy Services Manager

IBM Copy Services Manager provides automation for 2-site replication, 3-site replication, and advanced copy services from a single point of control across multiple platforms. To learn more about how to download and install it, see ➡️ IBM Copy Services Manager.

Key concepts

This section contains a technical overview that will help you understand how IBM Spectrum Control works. An understanding of the concepts in this section will help you use IBM Spectrum Control effectively.

Data collection

To help you implement a storage management strategy, it is critical that you determine the information that you want to gather about the resources within your environment. You can schedule different data collection jobs depending on the types of information that you want to gather and the resources that you want to monitor.

Use probes and performance monitors to collect detailed information about resources. You must schedule and run these data collection jobs before you can complete other tasks within IBM Spectrum Control, such as viewing reports, setting alerts, viewing data paths, and managing storage systems.
You schedule probe and performance monitor jobs for a resource when you add the resource for monitoring. After you add the resource, you can modify the probe and performance monitor job schedules on the list and details pages for the resource. For example, to modify the probe job schedule for a storage system, go to the Storage Systems page or the Storage System details page in the web-based GUI.

Schedule data collection jobs to gather the following types of information:

**Asset and status information**
Use [probes](#) to collect asset, storage statistics, and status information about resources. You can run probes on all the resources that are monitored by IBM Spectrum Control.

**Performance monitoring**
Use [performance monitors](#) to collect metrics that measure the performance of switches and storage systems.

**Performance monitoring and troubleshooting**
IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes key performance metrics and notifications of threshold violations that can help you measure, identify, and troubleshoot performance issues and bottlenecks in your storage.

To monitor the performance of resources and check for threshold violations, complete the following tasks:

- Add resources for monitoring and schedule data collection
- Define performance thresholds
- View and troubleshoot performance issues

**Collect performance data**

Before you can troubleshoot and view reports about performance, you must collect data about monitored resources. Performance monitors are data collection jobs that gather performance information about resources. This information includes metrics that measure the performance of the components within a resource. Metrics measure the performance characteristics of volumes, ports, and disks on storage systems and switches. IBM Spectrum Control provides many different metrics for measuring performance. For example, some key metrics for storage systems are I/O rate in I/O operations per second, data rate in MiB per second, and response time in milliseconds.

You can use metrics in IBM Spectrum Control to track growth or change in I/O rates, data rates, and response times. In many environments, I/O and data rates grow over time, and response times increase as those rates increase. This relationship can help with “capacity planning” for your storage. As rates and response times increase, you can use these trends to project when more storage performance and capacity is required.

**Define performance thresholds**

Performance thresholds alert you when the performance of a monitored resource falls outside of a specified range and might represent a potential problem. When you define a performance threshold for an internal component of a resource,
a specific metric that you want to measure and its boundary values. When the performance of a resource falls outside the boundary values, a threshold violation occurs.

For example, you can define a performance threshold that alerts you when the overall back-end response time for a managed disk on a SAN Volume Controller exceeds a certain value. The overall back-end response time is a metric that measures the average number of milliseconds that it takes to service each I/O operation on a managed disk.

**View and troubleshoot performance issues**

After data collection and performance thresholds are configured, you can use the web-based GUI to complete the following tasks:

- Measure, compare, and troubleshoot the performance of switches, storage systems, and their internal resources.
- Review the threshold violations and alerts that were triggered when the performance of a resource fell outside of a specific range.
- View performance information in a chart or table format to help you quickly identify where and when performance issues are occurring. The chart is a visual representation of how the performance of resources trend over time.
- Customize views of performance so that you can analyze specific resources and metrics during time ranges that you specify.
- Drill down into resources to view detailed information about the performance of internal and related resources. For example, if a SAN Volume Controller storage system is shown in the chart, you can quickly view and compare the performance of its internal and related resources, such as disks, volumes, ports, managed disks, and back-end storage.
- Implement server-centric monitoring of SAN resources without requiring a Storage Resource agent. When you add an agentless server for monitoring, IBM Spectrum Control automatically correlates that server with the ports on known host connections. If matches are found between the server and host connections on monitored storage systems, you can view the performance of the internal resources that are directly associated with the SAN storage that is assigned to the server. For example, if a SAN Volume Controller maps two volumes to the server, you can view the performance of those volumes and the related managed disks.
- Export performance information to a CSV file. A CSV file is a file that contains comma-delimited values and can be viewed with a text editor or imported into a spreadsheet application.
- In the optional Cognos Business Intelligence reporting tool, you can also view and create performance reports about multiple resources.

**Related concepts:**

"Monitoring the performance of resources" on page 149

IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes key performance metrics that can help you measure, identify, and troubleshoot performance issues and bottlenecks in your storage.

**Related tasks:**

"Adding resources" on page 75

You must add resources to IBM Spectrum Control before you can collect data, generate reports, and manage storage that is related to those resources.

**Related reference:**
IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes metrics that measure the performance of volumes, ports, and disks. You can view performance information or specify alerts for when the performance of a resource falls outside a specified range.

Related information:

IBM Spectrum Control provides multiple user interfaces for viewing reports about the storage infrastructure in an enterprise environment.

**Applications and departments**

IBM Spectrum Control provides storage grouping to define resources that utilize application and department business modeling. The information can be used to view the performance of resources that belong to an application and the capacity growth of a department. The pages for the monitoring and management of applications and departments are aligned with user scenarios. For example, capacity trending, resource health monitoring and performance troubleshooting.

To manage and administer applications and departments, complete the following tasks:

- Create applications and departments to model data for storage resources, allowing for enhanced capacity trending and performance troubleshooting.
- View the status of resources that make up the applications and departments.
- Create resource filters to automatically add resources to applications.
- Add resources directly to applications.
- Add applications to existing applications and departments.
- Add departments to existing departments.
- View subcomponent (member application) information to support hierarchical levels of storage grouping.

**Applications**

An application is a program or a project that consumes storage resources within an organization and interfaces with other enterprise groups that are important to the running of a business. Use IBM Spectrum Control to model the storage usage that is consumed in your environment by assigning the usage to applications to see the overall health status.

An application can be part of a department and have its own subcomponents (member applications) that are used to create a five level deep hierarchy. Applications that are grouped together can range from large line of business systems to specialized software, in a department, that runs on either client computers or servers. For example, an application might be an automated billing system within the Finance department, VMware running in the Information Technology department or an email marketing system that is part of the Marketing department.

The Applications page shows capacity information about the applications that are monitored by organization and interfaces with other enterprise groups that are important to the running of a business. Use IBM Spectrum Control to view and manage the resources that are defined to the applications. If the application is associated with a department, information about that department is also shown.
Departments

A department is a division within a business. Use IBM Spectrum Control to model the storage capacity that is consumed in your department for your business environment, in accordance with other department members.

A department can be hierarchical in its organizational layout. For example, a department might use 15 applications and be part of another five departments. A department might share storage resources with another department, subdepartment or an application even if they do not belong in the same hierarchy. For example, in a collaboration scenario, a single IBM SAN Volume Controller might be shared by multiple departments.

The Departments page shows storage capacity information about the top level departments, the subdepartments and any applications that belong to the department that are monitored by IBM Spectrum Control.

Storage optimization

Storage optimization tasks optimize the resources in your storage environment. You can use the web-based GUI to create tasks to balance pools, re-tier volumes, or transform volumes that are in storage virtualizer pools.

Balancing the workload of volumes across storage pools

Use the Balance Pools wizard to balance the workload of volumes across pools on the same tier. The pools are analyzed and recommendations are generated to move volumes from pools with high-activity values to pools with low-activity values.

Re-tiering volumes

Use the Analyze Tiering wizard to re-tier volumes to balance pools or to tier volumes based on the criteria that you set in tiering policies. For example, you can tier volumes that are based on the volume workload or on file usage, or both. Depending on the conditions that are set in the tiering policy, recommendations are generated. For example, you can reduce storage costs by moving volumes with low workloads to lower or less expensive tiers. You can also improve performance and use storage more efficiently by moving volumes with heavy workloads to the tiers that best meet their workload requirements.

Transforming volumes

Use the Transform Storage wizard to complete the following tasks for one or more volumes in storage virtualizer pools:

- Move volumes from one storage virtualizer pool to another pool in the same storage virtualizer pool.
- Move volumes in a storage virtualizer pool to a pool that is enabled for Easy Tier®.
- Convert fully allocated volumes to thin-provisioned volumes and convert thin-provisioned volumes to fully allocated volumes.
- Convert fully allocated volumes to compressed volumes and convert compressed volumes to fully allocated volumes.
The pools are analyzed and recommendations are generated. For example, analysis occurs to ensure that there is sufficient space in the pool to convert volumes or add volumes.

**Related tasks:**

- "Optimizing storage pools” on page 222
  Analyze the activity of pools and resolve performance hot spots by redistributing volumes across each storage tier.
- "Optimizing storage tiering” on page 219
  To optimize the placement of volumes on storage tiers, analyze the tiering of volumes in your storage environment.
- "Managing tasks for tiering storage, balancing pools, and transforming storage” on page 242
  To optimize the resources in your storage environment, use tiering storage, balancing pools, and transforming-storage tasks. Use the Tasks page in the web-based GUI to manage all the tasks that are used by IBM Spectrum Control to optimize storage. Use resource list and resource detail pages to manage the optimization tasks for resource types and for specific resources.

**Related reference:**

- "Criteria for identifying the pools that require balancing” on page 224
  To identify the pools that require balancing, performance data is collected to determine the relative activity of pools on the same tier. The performance capability of pools is preserved by setting an activity limit for each tier of storage.

**Cloud configuration**

To take advantage of the simplified provisioning and optimization capabilities that are available by using the web-based GUI, some configuration is required.

To provision storage, you are required to specify only the storage capacity and storage quality that is required. After volumes are created, IBM Spectrum Control can analyze and optimize volume performance. To take advantage of these capabilities, create service classes and, optionally, capacity pools.

A tutorial of cloud configuration concepts is available in the web-based GUI. In the menu bar, go to Advanced Analytics > Cloud Configuration, and click Learn the Concepts.

**Service classes**

A service class is a set of properties that describe capabilities and characteristics of storage resources. A service class typically describes a particular quality of service, and is used during provisioning to describe storage requirements. For example, a block-storage service class specifies properties such as a required RAID level, and whether storage resources must be able to encrypt or thin provision volumes.

Service classes simplify provisioning requests by representing a level or type of storage quality. When you are requesting storage, only the required capacity and service class must be specified. Before you can provision storage, you must create service classes that describe the capabilities and characteristics of the storage you want to be able to provision. Service classes can later be modified or deleted as the needs of your installation change.

**Block-storage service classes**

A block-storage service class describes attributes and capabilities of block storage resources. When you provision volumes, you specify the requirements by using a
block-storage service class. Based on the requirements of the service class, IBM Spectrum Control identifies a storage pool for the volume.

**File-storage service classes**

A file-storage service class describes attributes of file storage resources. The file storage resources include Network Attached Storage (NAS) filers, Network Shared Disks (NSDs), and file systems. When you provision shares, you specify the requirements by using a file-storage service class. Based on the requirements of the service class, IBM Spectrum Control identifies a file system or IBM SONAS NSD for the share. Space on an IBM SONAS NSD is allocated if a new file system is required or an existing file system requires more space.

**Service class properties**

A service class represents storage resources with common traits. These common traits are the service class properties, and collectively describe a particular quality of service. Before you create service classes, consider the levels of storage quality that you want to have available for provisioning requests. For block storage, for example, you can organize service classes by storage tier or RAID level. Some service class properties are used during provisioning to identify the best location for storage placement. Other service class properties determine how the storage is configured, and reflect the performance, reliability, or security considerations for the level of service.

In addition to the standard properties of a service class, you can create your own properties by using custom tags. Custom tags can represent any common trait that storage systems must have. For more information about creating your own properties by using custom tags, see [“Custom tags” on page 40.](#)

Block-storage service classes can specify the following properties:

- Storage tier or range of storage tiers
- RAID level
- Whether volume virtualization is required or not allowed. This property is available only when at least one IBM storage virtualizer is managed by IBM Spectrum Control. The IBM storage virtualizers include SAN Volume Controller, Storwize V7000, and Storwize V7000 Unified.
  
  If volume virtualization is required, the VDisk mirroring property specifies whether volumes are mirrored to a second storage pool, which uses different backend storage, on the same IBM storage virtualizer.
- Whether volumes must be thin provisioned or must not be thin provisioned.
  
  When a thin-provisioned volume is created in a DS8000, an extent space efficient (ESE) volume is created.
  
  If thin provisioning is required, you can specify thin-provisioning configuration properties for the IBM storage virtualizers and IBM XIV Storage System. The following properties might be available:
  
  - If the volume is created on an XIV, the locking behavior configuration property affects the volume that is created.
  - If the volume is created on an IBM storage virtualizer, the following configuration properties affect the volume that is created:
    - Allocated space
    - Auto-expand
    - Warning level
- Grain size

- Whether volumes are compressed. This property is applied only when an IBM storage virtualizer has at least one I/O group that contains a compressed volume. If there are no existing compressed volumes in an I/O group, IBM Spectrum Control will not create compressed volumes.

This property is available only when the thin provisioning property is enabled.

- A multipathing policy. If a server has a Storage Resource agent (SRA) and uses an IBM System Storage Multipath Subsystem Device Driver (SDD), the server multipathing policy is used to configure the driver. If provisioning is initiated from the vSphere Web Client extension for IBM Spectrum Control, the VMware vSphere multipathing policy is used to configure the multipath driver on the hypervisor.

If a multipathing policy is set, and fabrics are managed by IBM Spectrum Control, the following properties affect how the storage system is connected to the host:

- Whether the storage system and the client host are connected through fully redundant paths
- Number of paths between the storage system and the client host

- If at least one DS8000 Encryption Group is discovered by IBM Spectrum Control, the following properties are available and affect the storage placement and configuration of volumes:
  - Whether volumes must be encrypted
  - If volumes must be encrypted, the DS8000 encryption group to use

File-storage service classes have the following properties:

- Whether dedicated storage is required, or whether shared storage is allowed. In other words, whether the file system from which the NAS share is provisioned can contain other NAS shares.

- Fileset type. The fileset type is either an independent fileset with its own allocated nodes, or a dependent fileset allocated on the file system.

- Access path host name replacement. For more information, see "Special consideration for provisioning by using the VMware vSphere Web Client extension" on page 41.

**Predefined service classes**

To illustrate service classes, a set of predefined service classes are provided. From the Service Classes page in the web-based GUI, you can view any of these service classes for more information. Select a service class and then select **Actions > View / Modify**. To display help information about a service class property, complete the following steps:

1. Move the mouse pointer over the field or control.
   A question mark icon is displayed next to the field.

2. Move the mouse pointer over the question mark icon to display an explanation of the property.

The following sample block-storage service classes are provided for illustration.

**Gold**  The Gold service class represents the highest-performing storage resources for mission-critical applications.

**Silver**  The Silver service class represents high-performing storage resources for applications in production.
**Bronze**

The Bronze service class represents standard storage resources for non-mission-critical applications.

The following sample file-storage service classes are provided for illustration.

**NormalIsolation**

The NormalIsolation service class describes normal isolation file storage by specifying that shared storage is allowed. The file system from which the NAS share is provisioned can contain other NAS shares.

**EnhancedIsolation**

The EnhancedIsolation service class describes enhanced isolation file storage by specifying that dedicated storage is required. The file system from which the NAS share is provisioned cannot contain other NAS shares.

**Custom tags**

During provisioning, IBM Spectrum Control determines candidates for storage placement by comparing the requirements of a service class with the known capabilities, configuration, and performance of the available storage systems. You can think of the storage placement determination as a filtering process. IBM Spectrum Control filters the set of available storage resources against properties of the service class until only the storage resources that can satisfy all of the requirements remain.

In addition to the standard properties of a service class, you can create custom requirements for the service class by specifying up to three custom tags. To provide the service class, storage resources must have all the same tags that are specified in the service class.

When you specify tags on a block-storage service class, only pools that have all the same tags are candidates for provisioning. If a pool is not tagged, any tags on the containing storage system also apply to the pool.

When you specify tags on a file-storage service class, only file systems and NSDs that have all the same tags are candidates for provisioning. If a file system or NSD is not tagged, any tags on the containing storage system also apply to the internal resource.

During provisioning, IBM Spectrum Control filters candidates for provisioning against the custom tags.

Before you create service classes, consider whether there are any special requirements for provisioning that are not addressed by the standard properties of the service class. If so, tag the appropriate storage resources to satisfy custom requirements of a service class. When you are defining the service class, specify the custom tags that are required.

**Adding users to a service class**

By default, only administrators can provision storage. However, an administrator can add users to a service class to grant them permission to provision by using the service class. In order for an administrator to grant permission to provision to a user, the user must be assigned to the Monitor or External Application role.
When you are granting users permission to provision by using a particular service class, you can also specify whether execution of provisioning plans created by these users requires administrator approval. The requirement for administrator approval applies to all non-administrative users who are added to the service class, and also applies to external applications such as the vSphere Web Client extension. Approval cannot be required for some non-administrative users and not for others.

Before you create service classes, consider whether you want to allow users to request their own storage. Consider whether you want user provisioning requests to require administrator approval.

**Associating capacity pools with a service class**

Before you create service classes, consider whether certain storage requests must always be satisfied from a particular set of resources. If so, you can associate one or more capacity pools with a service class. For example, suppose that a set of storage resources are allocated to a particular department of your business. All storage requests for that department must be satisfied by those storage resources. In this case, you can add all the storage resources to a capacity pool and associate that capacity pool with a service class. You can also add the members of the department to the service class. The department members can then request their own storage as needed. However, the requests can be satisfied only by the storage resources that are allocated to the department.

When you are configuring capacity pools and service classes, keep in mind that a storage resource can be a member of only one capacity pool. Adding storage resources to a capacity pool is not a viable approach if the resources are already members of another capacity pool. Consider specifying custom tags to achieve the same result. In the preceding example, suppose that some or all of the storage resources that are allocated to the department are already members of capacity pools. In this case, you can instead tag the storage systems and the service class with matching tags to achieve the same result. With either approach, only the storage systems that are allocated to the department are candidates for provisioning when storage is requested by using the service class.

**Special consideration for provisioning by using the VMware vSphere Web Client extension**

When a file share is provisioned by the VMware vSphere Web Client extension, an access path to the share is provided by IBM Spectrum Control. By default, the path includes the cluster name of the file storage system in which the share is created. A cluster name must be a valid host name that is registered with a Domain Name System (DNS) server. If the cluster name is not valid, the share is not accessible under the access path that is returned by IBM Spectrum Control.

To address this situation, you can set one of its custom tags for a file storage system to specify an access path host name replacement. A file-storage service class can specify which of the file storage system custom tags contains the access path host name replacement.

If file shares are provisioned by using the VMware vSphere Web Client extension, determine whether you must set access path host name replacements.

**Capacity pools**

Capacity pools are groups of storage resources. You can use capacity pools to separate storage resources in any way that serves the needs of your environment.
or business. Configure capacity pools to track the used and available space for block and file storage on any set of storage resources. Provisioning requests can also be restricted to resources in a capacity pool.

The following types of storage resources can be grouped into capacity pools:
- Storage systems
- Storage pools
- File systems of file storage systems
- IBM SONAS Network Shared Disks (NSDs)

You can organize storage resources into capacity pools in any way that serves your business needs. For example, you can separate the storage resources that are allocated for separate divisions of your business into separate capacity pools. You can then track the storage use for each division separately, and restrict provisioning requests to the appropriate set of storage resources.

**Tracking used and available space in a capacity pool**

You can track the used and available space for any set of storage resources by adding the storage resources to a capacity pool. From the Capacity Pools pane of the web-based GUI, you can view the total capacity of the resources, and monitor the following capacity measurements:
- Used file space
- Available file space
- Used block space
- Available block space

**Restricting a provisioning request to a capacity pool**

You can use capacity pools to define a set of storage resources from which provisioning requests must be satisfied. When you are requesting storage by using the Provision Storage wizard or the vSphere Web Client extension, you can specify a capacity pool. If you do, the provisioning request is restricted to resources in the capacity pool. Only those resources are candidates for provisioning.

You can also associate a service class with capacity pools. If a service class is associated with capacity pools, provisioning requests for the service class must specify, and be constrained to, one of the associated capacity pools. Because you can also grant non-administrative users permission to provision storage by using the service class, associating capacity pools with the service class restricts the users to a specific set of resources.

**Provisioning storage**

The Provision Storage wizard simplifies the steps for submitting provisioning requests. When you use the Provision Storage wizard, you concern yourself only with which service class is needed for the new volumes or shares, and how much capacity you require.

**Storage requirements**

In the Provision Storage wizard, you specify your storage requirements by specifying a service class. Certain properties of the service class describe capabilities that storage resources must have in order to provide the service class.
For example, when you provision volumes, a block-storage service class specifies properties such as a storage tier, a RAID level, and whether the pool must be able to encrypt or thin provision volumes.

A service class typically represents a quality or service. For example, IBM Spectrum Control provides predefined block-storage service classes named Gold, Silver, and Bronze. Gold represents the highest-performing storage resources, and Silver and Bronze represent lesser levels of storage quality.

The different levels of storage quality that are provided by each service class are defined by the service class properties. For example, each service class specifies a different required storage tier that depends on the level of service that is required. Because the Gold service class is for mission critical applications, it sets thin provisioning off.

When you use the Provision Storage wizard, you concern yourself only with which service class is required. If you are unfamiliar with the service classes, however, you can open a separate window to view service class information. If you have Administrator privileges, you can modify or create service classes.

**Storage constraints**

IBM Spectrum Control identifies the storage resources that can provide the capacity and the service class from a set of storage resources. This set might be all the storage resources that are known to IBM Spectrum Control, or it might be constrained to a subset of those resources. In particular, your site can create capacity pools. *Capacity pools* are groups of storage resources. You can use capacity pools to separate storage resources in any way that serves the needs of your environment or business. For example, a capacity pool might contain the storage resources that are allocated to a particular department or division of your business.

A service class might restrict storage placement to one or more capacity pools. If the service class you are provisioning from restricts placement, you must select one of the allowed capacity pools. If the service class does not restrict storage placement, you can specify that candidates for provisioning can be selected from all storage resources that are known to IBM Spectrum Control, all storage resources in any capacity pool, or storage resources in a particular capacity pool. If you are unfamiliar with the capacity pools that you can select when you are using the Provision Storage wizard, you can open a separate window to view capacity pool information. If you have Administrator privileges, you can modify or create capacity pools.

If the fabrics are managed by IBM Spectrum Control, the set of storage resources might be further constrained by your zoning policy. If the zoning policy is not configured to automatic zoning, only storage systems with connectivity to the server or hypervisor are candidates for storage placement.

**Provisioning volumes**

**Restriction:** To provision volumes, you must have the IBM Spectrum Control Advanced Edition license.

To provision volumes, you select one or more servers or hypervisors and start the Provision Storage wizard. You can request one or more volumes. For each volume, you specify a volume name, the capacity that is required, a service class, and, optionally, a capacity pool. For each volume, IBM Spectrum Control identifies the
storage pools that can provide the capacity and the service class. From the set of pools that can provide the capacity and service class, IBM Spectrum Control identifies the best location for the storage. The best location for the storage is based on the unallocated volume space in the pool and performance data. Preference is first given to storage pools and systems that already contain volumes for the selected server or hypervisor. Preference is then given to systems that have available performance data.

On storage systems, volumes are allocated in increments of a set unit size that depends on the storage system type. Depending on the storage system that was identified as the best location for the storage, the volumes that are allocated might be larger than the capacity you requested for the following reasons:

- On SAN Volume Controller, Storwize V7000, and Storwize V7000 Unified, volumes are allocated in increments of an extent size. The extent size is set when the MDisk group is created. The capacity that you requested is rounded up, if necessary, to the full extent size.
- On a DS8000, volumes are allocated in increments of a 1 GiB fixed extent size. The capacity that you requested is rounded up, if necessary, to the full extent size.
- On an XIV, volumes are allocated in fixed increments of 16 GiB. The capacity that you requested is rounded up, if necessary, to complete the 16 GiB increment.

**Provisioning shares**

To provision a share, you select one or more servers or hypervisors and start the Provision Storage wizard. You specify the capacity that is required for the share, a service class, and information about how to export the share. IBM Spectrum Control identifies the file systems and Network Shared Disks (NSDs) that can provide the capacity and the service class. From the set of file systems and NSDs that can provide the capacity and service class, IBM Spectrum Control identifies the best location for the storage. The best location for the storage is based on the available space on the file system or NSD.

**The provisioning task**

When you complete the steps of the Provision Storage wizard, IBM Spectrum Control creates a provisioning task for the share or volume. If you request multiple volumes, a separate task is created for each unique service class and capacity pool combination you specify in your volumes request. If a requested volume is not constrained to a capacity pool, the set of all available storage resources is considered the capacity pool. If you have Administrator privileges, you can save, run, or schedule provisioning tasks.

In the service class, an administrator can grant users permission to provision by using the service class. In the service class, an administrator can also specify whether scheduling or running provisioning tasks that are created by using the service class requires administrator approval. If you are a user with permission to provision by using the service class, and administrator approval is not required, you can save, run, or schedule the task. If administrator approval is required, you can only save the task. If you save the task, an administrator can later schedule or run it.

Although IBM Spectrum Control identifies the best location for storage when it creates the provisioning task, the implementation of the task might fail. For
example, the implementation of the task might fail because of changes in the environment that occur after the task is created and before it is run. The implementation of the task might also fail because of storage system restrictions that are not considered when the task is created.

**Viewing task details and logs**

When a provisioning task is running, you can view its status in a details page. If you run the provisioning task immediately after you complete the steps of the Provision Storage wizard, the details page is already displayed. You can also display details of a provisioning task from the Tasks page. From the details page, you can open logs for the provisioning task. The logs show the steps that are taken by the task during processing and include detailed information about any warnings or errors.

**Tracking**

In the Provision Storage wizard, you can specify a ticket identifier for tracking purposes. The ticket identifier is associated with the provisioning task, and with any volume or share that is created by the provisioning task.

The ticket identifier can be viewed by showing the Ticket column in the Volumes page or the Shares page. The ticket identifier can also be viewed in the properties notebook for a volume or share.

**Tip:** If you request multiple volumes, a separate provisioning task is created for each unique service class and capacity pool combination you specify in your volumes request. By specifying a ticket identifier when you request the volumes, you can easily track the set of provisioning tasks and volumes that are created by the single request.

**Storage configuration**

Whether you are provisioning volumes or shares, IBM Spectrum Control configures the storage and resources as specified by certain properties of the service class, and, in the case of volumes, according to your zoning policy.

When you provision volumes, IBM Spectrum Control configures volumes and resources according to properties of the service class:

- If the service class requires thin provisioning, the volume is created in a pool that can thin provision volumes. During provisioning, other properties of the service class are used to configure the thin provisioned volume for the particular type of storage system that contains the pool. Because you configure thin provisioned volumes differently for the different storage system types, the service class has a unique set of thin provisioning properties for each type.
- If the service class specifies a multipathing policy for servers, the IBM System Storage Multipath Subsystem Device Driver (SDD) on the server is configured to use that policy. For the SDD to be configured, a Storage Resource agent (SRA) must be running on the server. If a VMware vSphere multipathing policy is specified for hypervisors, the policy is configured only if provisioning is initiated from the vSphere Web Client extension for IBM Spectrum Control.

When you are provisioning volumes, if automatic zoning is enabled, new zones might be created to connect a server to the storage system. Existing zones are used...
if the server already has connectivity to the storage system. Otherwise, one or more new zones are created between a host initiator port and a controller, node, or module port.

When you provision shares, IBM Spectrum Control configures at least one file access protocol for the file share.

**Storage reclamation**

You can use volume reclamation recommendations to reclaim unused storage capacity in your environment and use your storage more efficiently.

The block storage systems in your data center that you add for monitoring are regularly analyzed. You can view a list of the volumes that are allocated space but are not used for storing data. By reclaiming the volumes, you can recycle existing storage space instead of purchasing new storage media.

The following figure shows an overview of storage reclamation:

Reclamation recommendations which are based on capacity data are available after a device probe, while recommendations which are based on performance data are
available after the specified analysis period. By default, capacity data for one day
and performance metrics about the I/O activity for 14 days are collected. Volumes
are identified as reclaimable if, for example, they have no I/O activity over the
previous 14 days or if they are not assigned to servers.

For a more thorough analysis, you can change the number of days for which
performance metrics are collected. If you shorten the analysis period, less data is
used to determine I/O activity. When you extend or shorten the analysis period, it
is also changed for other optimization features such as tiering and balancing.

To identify volumes that can be reclaimed, you enable performance monitoring for
the block storage systems. Only block storage systems that support performance
monitoring can be analyzed for I/O activity.

Restriction: Volumes are identifiable as reclaimable in IBM Spectrum Accelerate
storage systems based on I/O activity. Information about the assignment of
volumes to servers is not available.

Supported storage systems: Go to IBM Spectrum Control interoperability matrix
and then click the release number in the Storage column.

IBM Spectrum Control VASA provider
IBM Spectrum Control VASA provider enables the IBM Spectrum Control
administrator to bring visibility of IBM Spectrum Control managed storage
resources to a vCenter server administrator.

About vSphere API for Storage Awareness APIs Providers
(VASA)
VASA enables coordination between VMware vCenter and storage arrays. It is
designed to provide built-in storage insight to support VM storage provisioning,
assist with storage troubleshooting and enable new DRS-related use cases for
storage.

VASA benefits
For VMware vSphere users, the IBM Spectrum Control VASA provider improves
the ability to monitor and automate storage-related operations in VMware
environments.

A IBM Spectrum Control storage administrator can share certain IBM Spectrum
Control alerts and storage capabilities for resources that are mapped to a vCenter
server.

The IBM Spectrum Control VASA provider provides the underlying connectivity
for alerts and information to be shared.

IBM Spectrum Control VASA provider architecture
This figure shows the IBM Spectrum Control VASA provider running on a IBM
Spectrum Control connected to both the VMware vCenter server and the managed
storage resources.
A IBM Spectrum Control storage administrator can share certain IBM Spectrum Control alerts for resources that are mapped to a vCenter server.

The IBM Spectrum Control VASA provider provides the underlying connectivity, and is automatically deployed and running after a IBM Spectrum Control installation. You must register a IBM Spectrum Control server to view its information in vCenter storage reports and views.

vSphere Web Client extension for IBM Spectrum Control

With the vSphere Web Client extension for IBM Spectrum Control, you can manage virtual storage in a vSphere environment. You can use the vSphere Web Client extension to complete provisioning tasks and to view information about storage resources in the vSphere Web Client.

Provisioning storage in the vSphere Web Client extension

You can use the vSphere Web Client extension to provision storage capacity on storage systems that are monitored by IBM Spectrum Control. You can provision file and block storage and use the service classes and capacity pools that you create in IBM Spectrum Control. Additionally, you can choose to create data stores on your storage volumes.

Viewing storage reports in the vSphere Web Client extension

You can use the vSphere Web Client extension to view information about the storage systems that are monitored by IBM Spectrum Control. You can view the mapping of your virtual storage resources to storage systems that are monitored by IBM Spectrum Control. You can view metrics for your storage systems. You can also view information about the fabric that is connected to a storage adapter. From the storage reports, you can click links to open the resources in the IBM Spectrum Control GUI.
**vSphere supported locales**

The locales that are supported by the vSphere Web Client extension for IBM Spectrum Control depend on the vSphere support. In vSphere 5.x, the following locales are supported:

- English: en_US
- German: de_DE
- Japanese: ja_JP
- Simplified Chinese: zh_CN
- French: fr_FR
- Korean: ko_KR

When a locale does not have a translated version, the vSphere Web Client extension is displayed in English, which is the default language.

**Related concepts:**

- “Provisioning storage with the vSphere Web Client extension” on page 216

You can use the vSphere Web Client extension for IBM Spectrum Control to manage and monitor your virtual environment and storage devices.

**Related information:**

- Reporting in the stand-alone GUI

Use reports to view detailed information about the storage resources in your environment. These reports are organized into different types and categories and provide both summary and detailed information depending on your needs.

**Alerts**

Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.

Conditions that generate alerts are detected during data collection and event processing. For some storage systems such as IBM Spectrum Accelerate and the XIV, events are polled every minute from the resource.

For other resources, events are subscription-based, where the resource itself or a data source such as a CIM agent sends the events to IBM Spectrum Control when conditions change on the resource. Examples of storage systems that use subscription-based event processing include SAN Volume Controller, Storwize V7000, Storwize V7000 Unified, FlashSystem V840, and FlashSystem V9000. For these storage systems, a probe is automatically run when many events are received from the storage system in a short time period. To avoid performance bottlenecks, probes are run only every 20 minutes.

**Triggering conditions for alerts**

The conditions that trigger alert notifications depend on the type of resource that you are monitoring. In general, the following types of conditions can trigger alerts:

- An attribute or configuration of a resource changed
- The capacity of a resource fell outside a specified range
- The performance of a resource fell outside a specified range
The storage infrastructure was changed, such as a new or removed resource
Data is not being collected for a resource

For example, you can use performance thresholds to be notified when the total I/O rate for storage systems falls outside a specified range. This information can help you identify areas in your storage infrastructure that are over used or under used. IBM Spectrum Control provides many metrics for measuring performance and determining violations of the thresholds that you specify.

**Alert notifications and triggered actions**

When an event occurs and triggers an alert, the alert is written to a log. You can also select one or more other ways to be notified of the event. These alert notifications include SNMP traps, IBM Tivoli Netcool/OMNibus events, login notifications, entries in Windows event log or UNIX syslog, and emails. Additionally, if a Storage Resource agent is deployed on a monitored server, you can run a script or start an IBM Tivoli Storage Manager job in response to the alert.

**Acknowledging alerts:** Some alerts are triggered by conditions that commonly occur and can be ignored. In such cases, you acknowledge these alerts to indicate that they were reviewed and do not require immediate resolution. By acknowledging alerts, you can more quickly identify other alerts that must be reviewed and resolved.

**Prerequisites for using alerts**

The following conditions must be met to successfully use alerts:

- Data collection schedules are configured and scheduled to run regularly. For example, to detect violations of performance thresholds, you must run performance monitors to collect performance data about resources. Running performance monitors regularly also helps to establish a history of performance for trending analysis.

- If you want to be notified about an alert in some way other than an entry in the log file, such as using SNMP traps, IBM Tivoli Netcool/OMNibus events, or email, you must configure those alert destinations before you use the alert.

- If an alert is triggered based on an SNMP trap from the monitored resource, you must properly configure the SNMP server of the monitor resource to enable IBM Spectrum Control to listen to SNMP traps. The default port number is 162, and the default community is public.

**Related concepts:**

[“Alerting and event processing” on page 111](#)

Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.

**Related tasks:**

[“Acknowledging alerts” on page 129](#)

Some alerts in IBM Spectrum Control are triggered by conditions that commonly occur and can be ignored. In such cases, you acknowledge these alerts to indicate that they were reviewed and do not require immediate resolution. By acknowledging alerts, you can more quickly identify the other alerts in lists that must still be reviewed and resolved.
Reporting

Use reporting functions to view overview and detailed information about your storage.

View detailed information about the capacity of monitored resources in the web-based GUI. You can view capacity information for storage systems, servers, hypervisors and their internal resources, such as volumes, pools, disks, and virtual machines. For example, you can view the total amount of storage space that is committed to a volume, the amount of allocated space that is used by a volume, and the amount of space that is allocated to a volume and is not yet used.

You can also use the optional Cognos Business Intelligence reporting tool to view predefined reports and create custom reports about the resources managed by IBM Spectrum Control. You access reports from the IBM Spectrum Control GUI, and work with the reports in the Cognos BI reporting tool. Tivoli Common Reporting provides the Cognos BI tool for IBM Spectrum Control reports.

You can use the Cognos BI reporting tool to view over 70 predefined reports about the capacity and performance of your resources in Tivoli Common Reporting. Charts are automatically generated for most of the predefined reports. Depending on the type of resource, the charts show statistics for space usage, workload activity, bandwidth percentage, and other statistics.

You can schedule reports and specify to create the report output in HTML, PDF, and other formats. You can also configure reports to save the report output to your local file system, and to send reports as email attachments.

You must collect information about your environment before you can use reports to view details about the storage resources in it. You can use monitoring jobs in IBM Spectrum Control such as probes and performance monitors to gather comprehensive information and statistics about your storage resources.

Units of measurement for storage data

IBM Spectrum Control uses decimal and binary units of measurement to express the size of storage data.

Decimal units such as kilobyte (KB), megabyte (MB), and gigabyte (GB) are commonly used to express the size of data. Binary units of measurement include kibibyte (KiB), mebibyte (MiB), and gibibyte (GiB). Table 8 compares the names, symbols, and values of decimal and binary units.

<table>
<thead>
<tr>
<th>Binary</th>
<th>Decimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Value (base 2)</td>
</tr>
<tr>
<td>kibibyte (KiB)</td>
<td>2^{10}</td>
</tr>
<tr>
<td>mebibyte (MiB)</td>
<td>2^{20}</td>
</tr>
<tr>
<td>gibibyte (GiB)</td>
<td>2^{30}</td>
</tr>
<tr>
<td>tebibyte (TiB)</td>
<td>2^{40}</td>
</tr>
<tr>
<td>pebibyte (PiB)</td>
<td>2^{50}</td>
</tr>
<tr>
<td>exbibyte (EiB)</td>
<td>2^{60}</td>
</tr>
</tbody>
</table>
Binary units of measurement express the size of data more accurately. When you compare the size of 100 KB to 100 KiB, the difference is relatively small, 2.35%. However, this difference grows as the size of the data values increases. When you compare the size of 100 TB to 100 TiB, the difference is 9.06%.

In general, IBM Spectrum Control uses base 2 values for memory and disk space values, and base 10 values for space on physical hard drives.

Table 9 shows the percentage difference between decimal and binary values across a range of data sizes.

Table 9. Percentage difference between decimal and binary units

<table>
<thead>
<tr>
<th>Decimal value</th>
<th>Binary equivalent of decimal value</th>
<th>Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 kilobytes (KB)</td>
<td>97.65 kibibytes (KiB)</td>
<td>2.35%</td>
</tr>
<tr>
<td>100 megabytes (MB)</td>
<td>95.36 mebibytes (MiB)</td>
<td>4.64%</td>
</tr>
<tr>
<td>100 gigabytes (GB)</td>
<td>93.13 gibibytes (GiB)</td>
<td>6.87%</td>
</tr>
<tr>
<td>100 terabytes (TB)</td>
<td>90.94 tebibytes (TiB)</td>
<td>9.06%</td>
</tr>
<tr>
<td>100 petabytes (PB)</td>
<td>88.81 pebibytes (PiB)</td>
<td>11.19%</td>
</tr>
<tr>
<td>100 exabytes (EB)</td>
<td>86.73 exbibytes (EiB)</td>
<td>13.27%</td>
</tr>
</tbody>
</table>

Role-based authorization

Roles determine the functions that are available to users of IBM Spectrum Control. When a user ID is authenticated to IBM Spectrum Control through the GUI, CLI, or APIs, membership in an operating system or LDAP group determines the authorization level of the user.

In Version 5.2, the roles that were previously defined in IBM Spectrum Control were consolidated into a smaller set of roles. The following table shows how the roles in versions earlier than 5.2 are mapped to the current set of roles:

Table 10. How roles in previous versions of IBM Spectrum Control are mapped to the roles in version 5.2 and later

<table>
<thead>
<tr>
<th>Roles in previous versions</th>
<th>Roles in version 5.2 and later</th>
<th>Authorization level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Superuser</td>
<td>Administrator</td>
<td>This role has full access to all monitoring and administrative functions. At least one group must have the Administrator role. Note: When IBM Spectrum Control is first installed, the following operating system groups are assigned the Administrator role:</td>
</tr>
<tr>
<td>Productivity Center admin</td>
<td></td>
<td>Windows: Administrators</td>
</tr>
<tr>
<td>Disk administrator</td>
<td></td>
<td>UNIX and Linux: root</td>
</tr>
<tr>
<td>Fabric administrator</td>
<td></td>
<td>AIX: system</td>
</tr>
<tr>
<td>Data administrator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tape administrator</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 10. How roles in previous versions of IBM Spectrum Control are mapped to the roles in version 5.2 and later (continued)

<table>
<thead>
<tr>
<th>Roles in previous versions</th>
<th>Roles in version 5.2 and later</th>
<th>Authorization level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk operator</td>
<td>Monitor</td>
<td>This role has access to the following read-only functions:</td>
</tr>
<tr>
<td>Fabric operator</td>
<td></td>
<td>• Viewing and exporting information about monitored resources</td>
</tr>
<tr>
<td>Data operator</td>
<td></td>
<td>• Viewing, acknowledging, and removing alerts</td>
</tr>
<tr>
<td>Tape operator</td>
<td></td>
<td>• Viewing tasks and data collection jobs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Viewing data paths</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Opening management GUls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Opening logs</td>
</tr>
<tr>
<td>This role did not exist in versions 5.1 or earlier.</td>
<td>External Application</td>
<td>This role enables users of other applications to use the provisioning capability of IBM Spectrum Control to provision storage. For example, a VMware user with this role can provision storage in the vSphere GUI by using the vSphere Web Client extension for IBM Spectrum Control. If you assign the External Application role to the user, you must also assign one or more service classes to the user. This role does not enable users to log in to the IBM Spectrum Control GUI.</td>
</tr>
</tbody>
</table>

Tips:

- To determine the role of the user who is logged in, click the user icon in the upper-right corner of any page in the GUI.
- If a user belongs to multiple groups and the groups have different roles, the role with the highest level of authorization is granted to the user. For example, if a user belongs to a group that is assigned the Administrator role and also belongs to a group that is assigned a Monitor role, the user is granted the authorization of the Administrator role.
- If a user is not a member of a group that is assigned a IBM Spectrum Control role, no access is granted to that user.
- If you have been assigned the Monitor role, you can only open and view logs from the Data Collection page for the selected resource.
- The IBM Spectrum Control installation program adds the administrator, external application, and monitor roles to the IBM Spectrum Control installation user.

Fabrics and zones

Use the IBM Spectrum Control to learn more about fabrics and zones.

Monitoring fabrics and zones in the GUI

You can monitor switches and fabrics in the IBM Spectrum Control GUI. You can also enable automatic zoning so that new zones are created during storage provisioning, if necessary, to connect a server to a storage system.
You can use the GUI to add switches and fabrics for monitoring. You can add the following types of switches:

- Brocade
- Cisco
- Other switches

After switches and fabrics are probed, you can view detailed status and performance information about the switches and fabrics. You can also test the connection to the switch or fabric.

Information that you can view about a fabric includes the following properties:

- The fabric type
- The number of physical and virtual switches in the fabric
- The number of ports that are on all the switches in the fabric
- The number of switch ports that are online and connected to other ports in a fabric
- The name of the principal switch of the fabric

Information that you can view about a switch includes the following properties:

- The number of ports on a switch
- The number of ports that are connected to a storage resource
- The name of the fabric where a switch is a member
- The name of the vendor or manufacturer for a switch

From the Details page of a fabric, you can open the Zone Sets page to view information about the zone sets on the fabric, and to identify which is the active zone set.

You can enable automatic zoning in the GUI. When automatic zoning is enabled, IBM Spectrum Control creates new zones during provisioning if new zones are needed to connect the storage system with the server. When you set the zoning policy, you can specify whether zone changes from automatic zoning are made to the active zone set, or to a new inactive active zone set.

Zones, zone aliases, and zone sets
Zones, zone aliases, and zone sets allow logical grouping of ports and storage devices within a storage area network. This section describes zoning concepts and elements.

In a storage area network a zone is a logical grouping of ports to form a virtual private storage network. Zones that belong to a single SAN can be grouped into a zone set, which can be activated or deactivated as a single entity across all switches in the fabric. A zone set can contain one or more zones, and a zone can be a member of more than one zone set. Using zoning, you can automatically or dynamically arrange fabric-connected devices into logical groups across a physical fabric.

Ports and devices in a zone are called zone members. A zone can contain one or more zone members. Ports that are members of a zone can communicate with each other, but they are isolated from ports in other zones. Devices, however, can belong to more than one zone. A zone alias is a collection of zone members. A zone alias can be added to one or more zones.
Note: In some cases, inactive zones might not have any zone members. Activating an inactive zone set that contains empty zones will fail if a switch does not support empty zones in active zone definitions.

Zone membership can be specified by:

- The N_Port_Name of the N_Port connected to the switch (also known as WWN zoning or port name zoning)
- The N_Port address identifier assigned during fabric login (also known as PortId or FCID zoning)
- The Node_Name associated with the N_Port
- The Domain identification (Domain_ID) and physical port ID of the Switch Port to which the N_Port is attached (also known as domain port zoning)
- An alias name

Zoning supports the use of aliases, which are meaningful names assigned to devices. An alias can also be a group of devices that are managed together to make zoning easier.

There are two types of zoning:

**Hardware zoning (port zoning)**
In hardware zoning (also called port zoning), the members of a zone are the physical ports on a fabric switch.

**Software zoning (WWN zoning)**
Software zoning uses the Simple Name Server (SNS) that runs inside a fabric switch. It is based on the node WWN or port WWN of the zone members to be included. Software zoning lets you create symbolic names for the zones and zone members.

A *default zone* is a group of devices that are not members of the active zone set. These can communicate with each other but not with members of any other zone. Default zoning is enabled by default. You can use a switch element manager to configure the Default Zone option to enable or disable the default zone independently of the active zone set.

**Note:**
1. If the default zone is disabled, devices that are not members of the active zone set cannot communicate.
2. If the default zone is disabled and no zone set is active, no devices can communicate.
3. If default zoning is enabled, deactivating the active zone set makes all devices members of the default zone. If default zoning is disabled, all communication stops.
4. If you activate one zone set while another zone set is active, the currently active zone set is deactivated.
5. If your EFC Manager manages multiple fabrics, ensure that you have the correct zone set for the fabric you are currently updating.

You can view zones in SANs using the topology viewer console. Fabric Manager lets you view zone membership.

**Note:** Certain types of switches and the types of agents configured can affect the zoning operations that you can perform.
Switch zoning capabilities
When you select a fabric in which to perform zoning operations, Fabric Manager determines the capabilities of the switches in the SAN and limits the zoning operations based on that information.

To see a list of supported switches and their capabilities, default values, ranges, and possible effects, go to [http://www.ibm.com/support/docview.wss?uid=swg27027300](http://www.ibm.com/support/docview.wss?uid=swg27027300)

Zoning for Cisco MDS 9000 devices:
Cisco switches support virtual SANs (VSANs), which is the logical partitioning of a fabric into multiple fabrics. The overall network is referred to as the physical infrastructure, and the logical fabrics are the VSANs. Fabric Manager provides basic zone discovery for the Cisco MDS 9000 series of devices using the FC-GS-3 protocol.

The following tasks are supported:
• Creating, deleting, and updating zones
• Creating, deleting, updating, activating, and deactivating zone sets

Fabric Manager supports these zone member types:
• N_Port WWN
• FC ID (the fibre channel ID of an N_port attached to the switch)

Unsupported zone and zone member types are displayed as non-standard on the topology display. Fabric Manager does not allow zone management of zones and zone sets that contain unsupported members.

Brocade switches in zones:
Brocade switches support some non-standard zones such as quick loop zones, fabric assist zones, and protocol zones. If the switch configurations have these zones already defined, Fabric Manager preserves them and does not modify them in any way. If they are part of a zone set that is active at some time, the devices that are part of such zones that are also online are displayed in the topology Zone View.

You can create, change, and delete non-standard zones by using the Brocade switch management application.

Note: IBM Spectrum Control allows you to add empty zones to an inactive zone definition. Activation of a zone set containing empty zones may still fail if the switch does not support empty zones in active zone definitions.

Agents
The IBM Spectrum Control uses agents to gather data: Common Information Model (CIM) agents, Storage Resource agents, and SNMP agents.

Common Information Model agents
Common Information Model (CIM) agents enable communication between storage devices, such as storage systems and fabric switches, and IBM Spectrum Control. Each storage device that you want to manage must have a CIM agent either installed or embedded unless it is a device that uses Native API connection.
CIM agents are provided by the vendor of the storage subsystem or fabric switch. Each vendor provides unique agent code for their family of storage devices. This code implements a Common Information Model Object Manager (CIMOM) that conforms to the Storage Management Initiative Specification (SMI-S) of the Storage Networking Industry Association (SNIA).

The CIM agent enables communication between the storage device and IBM Spectrum Control. Commands and responses are transmitted between IBM Spectrum Control and the CIM agent using an XML transport layer. The CIM agent to storage device layer uses a vendor-specific proprietary interface.

The CIM agent usually must be installed and configured, so that it can identify the storage devices with which it communicates. Some storage devices, such as fabric switches, contain embedded CIM agents and so do not require that CIM agents be installed. In these cases, IBM Spectrum Control must be configured to point directly to the storage devices that contain the embedded CIM agents.

CIM agents can be referred to as SMI-S providers, CIM proxy agents, and CIMOM agents. CIM agents can be embedded in the device or installed on a separate computer.

Note:
- Do not install multiple CIM agents on a single computer because of port conflicts.
- Do not install a CIM agent on the system where a IBM Spectrum Control server component is installed.

Storage Resource agents
Use Storage Resource agents to collect information about storage resources such as servers, virtual machines, workstations, and HBAs.

You must deploy Storage Resource agents on resources where you want to gather the following information:
- Asset information
- File and file system attributes
- Network-attached storage (NAS) device information
- Topology information

Tip: You can also monitor servers without deploying a Storage Resource agent. When you add an agentless server, IBM Spectrum Control correlates information about that server with the known host connections on monitored resources. If a match is made between the server and a monitored resource, you can view topology information and the capacity and performance of the storage that is assigned to that server. For more information about when to deploy a Storage Resource agent or add an agentless server, see “Adding servers” on page 91.

SNMP agents
An SNMP agent, also called an out-of-band agent, is software that runs on a switch. IBM Spectrum Control uses SNMP to retrieve information about the switch and the fabric that the switch is a member of.

Be sure that your SNMP agents point to each switch in the Storage Area Network (SAN) that you want to manage.
SNMP agents are necessary for retrieving virtual storage area network (VSAN) information for Cisco switches. For Brocade fabrics, if no SMI agent is configured for the Brocade switches, SNMP agents are necessary for retrieving zoning information for Brocade switches.

IBM Spectrum Control uses SNMPv3 (preferred) or SNMPv1 to probe switches and fabrics, and uses SNMPv2 or SNMPv3 to collect performance data. Some switches are configured to use SNMPv3 by default.

**IBM Spectrum Control Monitoring Agent**

The IBM Spectrum Control Monitoring Agent can be used by the IBM Tivoli Enterprise Monitoring Server to monitor systems in your enterprise. This agent is an optional program you can install and use in your enterprise.

IBM Tivoli Monitoring monitors and manages system and network applications on a variety of operating systems, tracks the availability and performance of your enterprise system, and provides reports to track trends and troubleshoot problems. The IBM Spectrum Control Monitoring Agent participates in that environment.

For performance reasons, install the IBM Spectrum Control server on a separate system from the IBM Tivoli Monitoring server. You can install the IBM Spectrum Control Monitoring agent on any system you want to monitor.


To use the IBM Spectrum Control Monitoring Agent, install this agent on the system you want to monitor.

To view the type of reports that are displayed by the IBM Spectrum Control Monitoring Agent, see [http://www.ibm.com/support/knowledgecenter/SS5R93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_c_using_tpcma.html](http://www.ibm.com/support/knowledgecenter/SS5R93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_c_using_tpcma.html).
Chapter 4. Scenarios

This section contains scenarios which illustrate how to perform specific tasks using IBM Spectrum Control.

The provided scenarios set out situations that can be solved using IBM Spectrum Control. When using these scenarios you should remember the following:

- The scenarios are intended to be step-by-step instructions that you follow to complete a specific job. Each scenario contains multiple tasks that must be followed in the order given.
- Specific values are given in the scenarios, such as user name, IP Address, probe name, and so forth. These are for illustration purposes only and you must replace them with values appropriate for your system.
- The scenarios do not provide in-depth conceptual information about the tasks. See the appropriate topics in the IBM Spectrum Control Knowledge Center for more information about the concepts behind the tasks.
- You will complete a scenario successfully if you follow the instructions correctly and your system performs as expected.

Optimizing the performance of storage virtualizers

In these scenarios, you balance pools and analyze tiering to help resolve performance hotspots and manage storage resources efficiently.

You can optimize the placement of volumes on the following storage virtualizers:
- SAN Volume Controller
- Storwize V7000
- Storwize V7000 Unified block storage

Learn more: For information about the components that can be used with IBM Spectrum Control Version 5.2 (or later), see [IBM Spectrum Control interoperability matrix](http://www.ibm.com/support/docview.wss?uid=swg21386446)

To optimize the placement of volumes in storage virtualizer pools, you must complete the following tasks:
- Probe the storage virtualizers.
- Set the tier level of the storage pools that you want to analyze.
- Collect performance data to analyze the pools and volumes.

When you run the analysis to balance pools, you optimize storage performance by redistributing volume workloads across pools on the same tier.

With run the tiering analysis, you optimize storage performance by specifying thresholds to move volumes to higher and lower tiers.

Related tasks:

- "Optimizing storage tiering" on page 219

To optimize the placement of volumes on storage tiers, analyze the tiering of volumes in your storage environment.
“Optimizing storage pools” on page 222
Analyze the activity of pools and resolve performance hot spots by redistributing volumes across each storage tier.

“Managing tasks for tiering storage, balancing pools, and transforming storage” on page 242
To optimize the resources in your storage environment, use tiering storage, balancing pools, and transforming-storage tasks. Use the Tasks page in the web-based GUI to manage all the tasks that are used by IBM Spectrum Control to optimize storage. Use resource list and resource detail pages to manage the optimization tasks for resource types and for specific resources.

**Redistributing volume workloads to balance pools**
In this scenario, you identify performance hot spots and then run the balance pools analysis to help resolve them.

The pools that you want to analyze are on a SAN Volume Controller with two DS8000 back-end storage systems.

If the activity deviation percentage of the pool exceeds the threshold set for the pool, which is > 10 %, the pool is identified as a candidate for balancing. If the activity deviation percentage of the pool lies within the threshold range set for the pool, which is < −10 % to > +10 %, the pool is considered to be balanced.

**Tip:** On the Pools page, the activity level of the pool is shown in the **Activity** column. The difference between the activity level of the pool and all of the other pools on the same tier and storage system is shown in the **Activity Deviation (%)** column.

To balance the pools, you open the Balance Pools wizard.
1. From the Storage menu, click Storage Systems.
2. To group the pools by storage system, click the Storage System column heading.

   **Tip:** Examine the activity deviation percentage values for the pools. Select pools with low and high activity levels on each of the tiers that you want to balance so that the volumes can be moved from high-activity pools to low-activity pools.
3. Right-click the pools on the tiers that you want to balance and then click Balance Pools.
4. Specify the number of days for estimating the activity of the pools.
5. Click Analyze.

The Balance Analysis task opens.

Click Execute to implement the recommendations. To create a schedule, click Schedule > Analysis.

**Related tasks:**
- “Optimizing storage pools” on page 222
- “Modifying the criteria for balancing pools” on page 223

**Related reference:**
- “Criteria for identifying the pools that require balancing” on page 224

To identify the pools that require balancing, performance data is collected to determine the relative activity of pools on the same tier. The performance capability of pools is preserved by setting an activity limit for each tier of storage.

**Analyzing and re-tiering volumes in pools on tier 1**

In this scenario, you analyze the current placement of volumes in pools on tier 1 so that you can move volumes with low workloads from tier 1 to tier 2 or tier 3 pools.
The pools that you want to analyze are on a SAN Volume Controller with two DS8000 storage systems. The pools on the storage virtualizer are assigned to tier 1, tier 2, and tier 3.

**Tip:** You can tier volumes by I/O rate or I/O density.

To ensure that the pools that are selected as destination pools for the volumes can handle the additional workload, you specify the maximum I/O rates for pools on each tier of storage. Only the pools with I/O rates below the maximum I/O rate can be selected as destination pools for the volumes.
1. From the **Storage** menu, click **Storage Systems**.
2. Right-click the storage virtualizer and click **View Details**.
3. In the navigation pane, click **Pools**. To organize the pools by tier level, click the **Tier** column heading.
4. Select the pools on tier 1, right-click and then click **Analyze Tiering**.
5. Select all of the pools on tier 2 and tier 3 as target pools, and then click **Next**.
6. Enter 14 as the number of days for analyzing the pools.
7. Set the threshold for moving volumes from tier 1 to tier 2. The volumes with I/O rates above the threshold that you set remain in the tier 1 pools. The volumes with I/O rates below the threshold that you set are moved down to tier 2 pools.
8. Set the threshold for moving volumes from tier 2 to tier 3. The volumes with I/O rates above the threshold that you set remain in the tier 2 pools. The volumes with I/O rates below the threshold that you set are moved down to tier 3 pools.
9. Set the maximum I/O rate for pools on each tier.
10. Click **Analyze**.

The **Analyze Tiering** task is shown.

Click **Execute** to implement the recommendations. To create a schedule, click **Schedule > Analysis**. Alternatively, you can modify the criteria that you set for analyzing the volumes on the **Tasks page** and run the analysis again.

**Related tasks:**

"Modifying the criteria for analyzing tiering” on page 222

When a task is created after you run the tiering analysis, you can modify the criteria for tiering the volumes.

---

**Collocating volumes**

In this scenario, you want to minimize the exposure of servers to multiple back-end storage systems by collocating volumes that are assigned to the same hypervisor or server. You can enforce the collocation of volumes when you enter the criteria for analyzing tiering and balancing pools.

To ensure that volumes in the same storage pool that are assigned to the same server or hypervisor are kept together, you want to enforce the collocation of volumes. By enforcing the collocation of volumes, you prevent the placement of related volumes in destination pools that might be on multiple back-end storage systems.

**Multiple host connections to the same hypervisor or server**: If the volumes in the source pool that are assigned to the same hypervisor or server are assigned to different host connections, the collocation of the volumes is affected. In such cases, if volumes require optimization, the volumes that are assigned to the same host connection are kept together. To view information about the host connection for the volume, right-click the volume, select **View Details**, and then click the **Host Connections** tab.

1. From the **Storage** menu, click **Pools**.
2. Right-click the pools that you want to analyze, and then click **Analyze Tiering**.
3. Select the target storage pools.
4. On the Optimize the Placement of Volumes page, ensure that **Colocate volumes** is set to **Yes**.

-----

Chapter 4. Scenarios  63
5. Click Analyze.

If a volume requires re-tiering, a recommendation is generated to move all of the volumes that are assigned to the same server to the same destination pool. If none of the target pools has sufficient space to accommodate all of the volumes, then recommendations to move the volumes are not generated.

**Related tasks:**

- [“Optimizing storage pools” on page 222](#)
  Analyze the activity of pools and resolve performance hot spots by redistributing volumes across each storage tier.

- [“Optimizing storage tiering” on page 219](#)
  To optimize the placement of volumes on storage tiers, analyze the tiering of volumes in your storage environment.

- [“Modifying the criteria for analyzing tiering” on page 222](#)
  When a task is created after you run the tiering analysis, you can modify the criteria for tiering the volumes.

---

**Monitoring capacity usage at different levels of a business hierarchy**

The monitoring and management of applications and departments enables you to monitor storage capacity usage, recognize trends, monitor health status, and troubleshoot performance of the storage resources in your business organization.

The department model comprises these main elements:

- The department
- The subdepartments that the department contains
- The applications, or the application subcomponents, or both that the department uses

In the following scenario, you want to create a department model that monitors the capacity and space usage of the Books Sales department, and these subdepartments:

- Wholesale
- Retail
- Online

To monitor the capacity and space usage of the departments, you add the applications that the department and its subdepartment use to each of the subdepartments.

The department model that you create determines how you can view capacity usage and space information. To view the total capacity and space usage of a department regardless of the subdepartments that the department contains, you create a department and add the applications and subcomponents to the department.

If, however, you want to see the capacity and space usage of the department and its subdepartments, you create a department hierarchy by adding subdepartments to departments. You then add the applications and application subcomponents that each subdepartment uses to the subdepartments. You can then view capacity and space usage for the department and for the individual subdepartments.
You can create more complex models of departments by adding subdepartments to subdepartments. In the following illustration, the department model is extended to include two more layers of subdepartments under the Wholesale subdepartment.

To monitor the capacity and space usage of the departments in your business organization, complete the following tasks:

- Create the Book Sales department.
- Create the Wholesale, Retail, and Online departments to represent the subdepartments.
- Add the Wholesale, Retail, and Online as subdepartments to the Book Sales department.
- Create the Book Sales DB application and the Wholesale Transactions, Retail Transactions and Online Transactions applications to represent the subcomponents that are used by the departments.

Different applications require different storage capabilities, and different levels of performance and uptime. The storage requirements of the departments are constantly growing and they need to modify their behaviors in a way that justifies the cost of their actions concerning storage utilization. The data modeling of storage resources using the application and department concept enables you to plan and implement a chargeback system if necessary.

Related concepts:

“Departments” on page 178

View information about departments and structure the hierarchy to mirror your business organization. Monitor the detailed information about capacity and space usage that is collected for departments and subdepartments, and monitor the performance of the applications and the application subcomponents that are added to departments and subdepartments.

Related tasks:

“Creating departments” on page 180

To model the storage capacity that is consumed in a department for your business environment, in accordance with other department and application members, create departments for monitoring in IBM Spectrum Control.
“Adding and creating subdepartments” on page 181
To further enhance your data modeling at the department level and to add to your overall business hierarchy for monitoring, add an existing subdepartment or create a new subdepartment.

“Viewing information about departments” on page 182
You can view detailed information about departments for use in storage capacity monitoring and performance troubleshooting. You can view additional information on the applications and subdepartments that are used to establish a hierarchical business structure.

“Creating applications” on page 171
To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

“Adding subcomponents” on page 175
You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.

Comparing storage usage in each department
In this scenario, you compare the storage usage in each department within your organization to spot a potential storage usage issue.

To monitor the capacity and space usage of a department, you create the department and subdepartments, and you add the application subcomponents to the subdepartments.

You want to monitor the capacity and space usage of departments in an organization that sells books.

The sales department of the organization, Book Sales, has these subdepartments:
- Wholesale
- Retail
- Online

Although you can add applications and application subcomponents when you create departments, it is easier and quicker to create the applications and application subcomponents beforehand.

You want to know the total amount of storage space that the Book Sales department uses, and you want to know the amount of space that each subdepartment uses. To know how much space the Book Sales and its subdepartments use, you must associate the department and its subdepartments with the applications that they use. For example, the Book Sales department and
its subdepartments use a database application named Book Sales DB. The Book Sales DB application contains these subcomponents:

- Wholesale Transactions
- Retail Transactions
- Online Transactions

To create the department and subdepartments, you complete these tasks:

1. You create the Wholesale department and add the applications and application subcomponents that the subdepartment uses.
2. You create the Retail department and add the applications and application subcomponents that the subdepartment uses.
3. You create the Online department and add the applications and application subcomponents that the subdepartment uses.
4. You create the Book Sales department. You do not have to add applications or subcomponents to the Book Sales department because the Book Sales department inherits the applications and application subcomponents that are added to the subdepartments.
5. You add the Wholesale, Retail, and Online departments as subdepartments to the Book Sales department.

When you complete adding the departments and associating the departments with the applications that are used by the departments, you can view the information that is collected about the departments on the Departments page and on the details page for the department.

You want to target what department and what storage resources might be responsible for a change or an upward trend in significant storage usage. By correctly classifying the department or departments you can properly plan to archive or switch the storage within the organization.

Related concepts:

- Departments” on page 178
  View information about departments and structure the hierarchy to mirror your business organization. Monitor the detailed information about capacity and space usage that is collected for departments and subdepartments, and monitor the performance of the applications and the application subcomponents that are added to departments and subdepartments.

Related tasks:

- “Creating departments” on page 180
  To model the storage capacity that is consumed in a department for your business environment, in accordance with other department and application members, create departments for monitoring in IBM Spectrum Control.

- “Adding and creating subdepartments” on page 181
  To further enhance your data modeling at the department level and to add to your overall business hierarchy for monitoring, add an existing subdepartment or create a new subdepartment.

- “Viewing information about departments” on page 182
  You can view detailed information about departments for use in storage capacity monitoring and performance troubleshooting. You can view additional information on the applications and subdepartments that are used to establish a hierarchical business structure.
To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.

**Using applications and subcomponents to monitor capacity and space usage**

To monitor the performance, capacity, and space usage of the applications in your business organization, create applications and subcomponents. You can also add applications to departments so that storage capacity and usage can be monitored in an overall business hierarchal manner.

You can create a simple application model, which consists of an application and use a filter to associate the storage resources that the application uses with the application. Alternatively, you can create a complex application model that comprises an application and application subcomponents and then add filters to associate the storage resources that each application subcomponent uses with each of the subcomponents.

Besides creating applications to monitor the performance, capacity, and space usage of the applications in your business organization, you also create applications to add them to departments. When you add applications to departments, you can monitor the capacity and space usage of the departments and you can monitor the performance of the storage resources that are associated with the applications that each department uses.

To monitor the capacity of an application, you create an application model that is based on the following elements:

- The application
- The subcomponents that the application contains
- The applications, application subcomponents, or both that are added to the department

In the following scenario, you want to create an application model that monitors the capacity, space usage, and performance of the Book Sales DB application. The application model that you want to create comprises these application subcomponents:

- Wholesale Transactions
- Retail Transactions
- Online Transactions
To understand how capacity is trending for storage in an application and subcomponents, complete these tasks:

1. Create the Book Sales DB application.
2. Create the Wholesale Transactions, Retail Transactions and Online Transactions applications to represent the subcomponents.
3. Add the Wholesale Transactions, Retail Transactions, and Online Transactions as subcomponents to the Book Sales DB application.
4. Create the Book Sales department and the Wholesale, Retail, and Online subdepartments to be associated with the applications.

Related concepts:

“Applications” on page 169
View information about storage area network resources that you can model by using applications in your business environment. The monitoring and management of applications enables you to perform capacity trending, health monitoring, and performance troubleshooting tasks.

Related tasks:

“Creating applications” on page 171
To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

“Adding subcomponents” on page 175
You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.

“Viewing information about applications” on page 176
You can view information about the application that you created as related resources, filters that are used to populate the application with resources, any subcomponents, capacity trending and performance information.

**Viewing storage capacity and usage trends**

You can view the capacity and usage trends of storage resources used by an application and subcomponents to diagnose how much storage a particular application is using in relation to the other applications and departments in the business hierarchy.
You want to understand how capacity is trending for storage that is used by the Book Sales DB application and the Wholesale Transaction, Retail Transactions and Online Transactions subcomponents and the association the application has with the Book Sales department and subdepartments.

The storage resources that are used by the application and that are used by each subcomponent are associated with the application and its subcomponents. For example, the storage resources are assigned as follows:

1. Create a database application called Book Sales DB and assign resources that use the volumes on the IBM® Storwize V7000 with names that begin with \texttt{bksales} for storing sales transactions.

2. Create the subcomponent applications named Wholesale Transaction, Retail Transactions and Online Transactions.

3. Assign the volumes on the IBM Storwize V7000 with names that begin with \texttt{bksales_ws} to the Wholesale Transactions subcomponent, which is used for storing wholesale sales transactions.

4. Assign the volumes on the IBM Storwize V7000 with names that begin with \texttt{bksales_rt} to the Retail Transactions subcomponent, which is used for storing retail sales transactions.

5. Assign the volumes on the IBM Storwize V7000 with names that begin with \texttt{bksales_ol} to the Online Transactions subcomponent, which is used for storing online sales transactions.

\textbf{Note:} On the Create Filter page, you can specify a name pattern to determine which volumes to include. For volumes, you can specify name patterns to determine from which servers, storage systems, or pools the volumes are selected. You can then click \texttt{Preview} to view the volumes that are selected for inclusion in your application.

To monitor space usage for the Book Sales department and its subdepartments, you associate the Book Sales DB application and the Wholesale, Retail, and Online Transactions subcomponents of the application as follows:

- You associate the Book Sales DB application with the Book Sales department.
- You associate the Wholesale subdepartment with the Wholesale Transactions subcomponent.
- You associate the Retail subdepartment with the Retail Transactions subcomponent.
- You associate the Online subdepartment with the Online Transactions subcomponent.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{application_subcomponent_assigned_resources_department_association.png}
\caption{The application, subcomponent, assigned resources and department association}
\end{figure}
You can view the capacity information that is collected about the application on the Applications page. You can also view capacity information for each application and subcomponent on the details page. When you complete adding the departments and associating the departments with the applications that are used by the departments, you can view the information that is collected about the departments on the Departments page and on the details page for the department.

Related concepts:

“Applications” on page 169
View information about storage area network resources that you can model by using applications in your business environment. The monitoring and management of applications enables you to perform capacity trending, health monitoring, and performance troubleshooting tasks.

Related tasks:

“Creating applications” on page 171
To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

“Adding subcomponents” on page 175
You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.

“Adding applications to departments” on page 182
To further enhance the data storage modeling in a business environment and see the storage capacity that is used at the different levels of your business hierarchy, add applications to departments. The departments you select from the Add to Department page become parents of the selected applications.

“Viewing information about applications” on page 176
You can view information about the application that you created as related resources, filters that are used to populate the application with resources, any subcomponents, capacity trending and performance information.

Limiting a set of storage to provision in the vSphere Web Client extension

In this scenario, a storage administrator limits the storage that a vSphere user can provision.

You plan to dedicate two storage pools to be used with vSphere. You want to allow a vSphere user to provision storage by using the vSphere Web Client extension for IBM Spectrum Control. You want to define the two storage pools as the resources that the user can use.

1. Create a capacity pool that the vSphere user can provision from. Place the two storage pools that you designated as provisioning targets for vSphere in the capacity pool. To add storage pools to the capacity pool, follow the instructions in “Adding resources to capacity pools” on page 200.

2. Create a service class and specify that the service class can be used to provision storage only from the capacity pool. To create the service class, follow the instructions in “Creating service classes” on page 194.

3. Create a user ID for the vSphere user and assign the External Application role to that ID. To assign the role to the user, follow the instructions that are provided in the product documentation at http://www.ibm.com/support/
4. Associate the user with the service class. To associate the user with the service class, follow the instructions in “Modifying service classes” on page 196.

When you complete these tasks, a vSphere user can provision storage by using the vSphere Web Client extension, but they are limited to the service class that was created. Because the service class is associated with the capacity pool that contains your designated vSphere storage pools, you limited where the vSphere user can provision data.

Related concepts:
“Cloud configuration” on page 37
To take advantage of the simplified provisioning and optimization capabilities that are available by using the web-based GUI, some configuration is required.

Related tasks:
“Provisioning block storage” on page 216
Use the vSphere Web Client extension for IBM Spectrum Control to provision block storage on IBM Spectrum Control. You can also have a data store created on the storage volume.

“Provisioning file storage” on page 217
Use the vSphere Web Client extension for IBM Spectrum Control to provision file storage on IBM Spectrum Control.

Viewing NPIV connections between server ports and switch ports in a fabric

In this scenario, a storage administrator views the N-Port ID Virtualization (NPIV) connections between the server ports and the switch port in the fabric. With NPIV, multiple node ports can be logically connected to one switch port.

You want to view connectivity information for a switch port that has NPIV connections.

1. In the menu bar, go to Network > Switches. Double-click the switch that you want to view, or right-click the switch and click View Details.

   **Tip:** Alternatively, in the menu bar, go to Network > Fabrics. Double-click the fabric that you want to view, or right-click the fabric and click View Details. In the Internal Resources section, click Switches. Double-click the switch that you want to view, or right-click the switch and click View Details.

2. In the Internal Resources section, click Ports. You can view details about the ports, including the number of NPIV connections.

3. In the Connected NPIV Ports column for the port that you want to view, click the number of ports. You can view the following information about the NPIV connections:
   - In the Connected NPIV Ports tab, you can view details about the NPIV connections, such as the port type and the name of the connected resource. The port type can be N_Port (end node port) or NP_Port (proxy node port).
   - In the Connectivity tab, you can view details about the physically connected end-node port.
Tip: If IBM Spectrum Control does not differentiate between the physical and logical connections for the switch port, the details about the NPIV connections are displayed in the Connectivity tab. The Connected NPIV Ports tab is not displayed.
Chapter 5. Managing resources

Use IBM Spectrum Control to monitor and manage the resources and storage infrastructure in an enterprise environment. In the GUI, you can view the condition, capacity, performance, and relationships of storage resources.

Use the vSphere Web Client extension for IBM Spectrum Control to manage a vSphere virtual storage environment. You can complete provisioning tasks and view information about storage resources in the vSphere Web Client extension.

Adding resources

You must add resources to IBM Spectrum Control before you can collect data, generate reports, and manage storage that is related to those resources.

Related concepts:

“Alerting and event processing” on page 11
Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.

Related reference:

“Triggering conditions for alerts” on page 252
Define alerts so that IBM Spectrum Control automatically notifies you when certain conditions or events are detected on monitored resources. Such conditions are the triggering conditions for the alert. The specific conditions that can trigger alerts depend on the type of resource that is being monitored.

Resources that you can monitor

You can use IBM Spectrum Control to monitor storage systems, servers, hypervisors, fabrics, and switches. Information about these top-level resources includes information about their internal resources and related resources. Internal resources are components that exist in a top-level resource. Related resources are external to a top-level resource, but are related to it through assigned storage, a network connection, or virtual hosting.

Information about object storage systems includes information about their object resources and related resources. Object resources are resources in a GPFS cluster, such as accounts and containers, that enable the GPFS cluster to be used as an object storage system.

Fabrics

A fabric is a network of hubs, switches, adapter endpoints, and connecting cables that support a communication protocol between devices. The following table shows the internal resources and related resources that you can monitor for fabrics.
**Table 11. Fabric resources that you can monitor.**

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Internal resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switches</td>
<td>Hypervisors</td>
</tr>
<tr>
<td></td>
<td>Inter-switch</td>
<td>Servers</td>
</tr>
<tr>
<td></td>
<td>connections</td>
<td>Storage systems</td>
</tr>
<tr>
<td></td>
<td>Blades</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ports</td>
<td>NPV switches</td>
</tr>
<tr>
<td></td>
<td>Zone sets</td>
<td>(Cisco switches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in NPV mode and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Brocade switches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in Access</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gateway mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discovered ports</td>
</tr>
</tbody>
</table>

**Hypervisors**

A *hypervisor* is a layer of software or a physical device that manages multiple, virtual instances of operating systems on the same hardware. Hypervisors that you can monitor include VMWare vSphere data sources such as ESX, ESXi, and vCenter servers. If a hypervisor is part of a cluster, information about that cluster is also available.

The following table shows the internal resources and related resources that you can monitor for hypervisors.

**Table 12. Hypervisor resources that you can monitor.**

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Internal resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Virtual machines</td>
<td>Storage systems</td>
</tr>
<tr>
<td></td>
<td>Controllers</td>
<td>Fabrics</td>
</tr>
<tr>
<td></td>
<td>Disks</td>
<td>Switches</td>
</tr>
<tr>
<td></td>
<td>Data stores</td>
<td>Cluster</td>
</tr>
<tr>
<td></td>
<td>VMDKs</td>
<td></td>
</tr>
</tbody>
</table>

**Servers**

A *server* is a computer or host that is connected to a network and provides an access point to that network. If a server is part of a cluster, information about that cluster is also available. You can monitor the following internal resources and related resources for servers.
Table 13. Server resources that you can monitor.

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Internal resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Controllers</td>
<td>Storage systems</td>
</tr>
<tr>
<td></td>
<td>Disks</td>
<td>Fabrics</td>
</tr>
<tr>
<td></td>
<td>Volume groups</td>
<td>Switches</td>
</tr>
<tr>
<td></td>
<td>File systems and logical volumes</td>
<td>VMDKs</td>
</tr>
<tr>
<td></td>
<td>Shares and exports</td>
<td></td>
</tr>
</tbody>
</table>

**Storage systems**

A *storage system* is a device, such as a Redundant Array of Independent Disks (RAID) controller that creates and manages other storage devices. A storage virtualizer is a storage system that virtualizes storage space from internal storage or from another storage system.

Storage systems can be configured for block storage, file storage, a combination of block and file storage, or a combination of file and object storage. The method that a storage system uses for managing data determines the internal resources or object resources that are monitored.

The following tables show the internal resources, object resources, and related resources that you can monitor for block, file, and object storage systems.

**Block storage systems**
### Table 14. Block storage system resources that you can monitor.

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Internal resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Disks</td>
<td>Back-end storage systems</td>
</tr>
<tr>
<td></td>
<td>External disks</td>
<td>Fabrics</td>
</tr>
<tr>
<td></td>
<td>Host connections</td>
<td>Hypervisors</td>
</tr>
<tr>
<td></td>
<td>I/O groups</td>
<td>Servers</td>
</tr>
<tr>
<td></td>
<td>Managed disks</td>
<td>Switches</td>
</tr>
<tr>
<td></td>
<td>Modules</td>
<td>Virtualizer storage systems</td>
</tr>
<tr>
<td></td>
<td>, Nodes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ports</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RAID arrays</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Volumes</td>
<td></td>
</tr>
</tbody>
</table>

### File storage systems

### Table 15. File storage system resources that you can monitor.

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Internal resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Disk Controllers</td>
<td>Back-end storage systems</td>
</tr>
<tr>
<td></td>
<td>Clusters</td>
<td>Fabrics</td>
</tr>
<tr>
<td></td>
<td>Disks</td>
<td>GPFS clusters</td>
</tr>
<tr>
<td></td>
<td>Shares</td>
<td>Hypervisors</td>
</tr>
<tr>
<td></td>
<td>Filesets</td>
<td>Servers</td>
</tr>
<tr>
<td></td>
<td>File systems</td>
<td>Switches</td>
</tr>
<tr>
<td></td>
<td>Network shared disks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Nodes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Snapshots</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quotas</td>
<td></td>
</tr>
</tbody>
</table>

### Object storage systems
Table 16. Object storage system resources that you can monitor.

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Object resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Accounts</td>
<td>Back-end storage systems</td>
</tr>
<tr>
<td></td>
<td>Containers</td>
<td>Fabrics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GPFS clusters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hypervisors</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Servers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Switches</td>
</tr>
</tbody>
</table>

Switches

A switch is a network infrastructure component to which multiple nodes attach. In IBM Spectrum Control, you can monitor Fibre Channel (FC) switches. The following table shows the internal resources and related resources that you can monitor for switches.

Table 17. Switch resources that you can monitor.

<table>
<thead>
<tr>
<th>Top-level resource icon</th>
<th>Internal resources</th>
<th>Related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inter-switch connections</td>
<td>Fabrics</td>
</tr>
<tr>
<td></td>
<td>Blades</td>
<td>Hypervisors</td>
</tr>
<tr>
<td></td>
<td>Logical switches</td>
<td>Servers</td>
</tr>
<tr>
<td></td>
<td>Parent switches</td>
<td>Storage systems</td>
</tr>
<tr>
<td></td>
<td>Ports</td>
<td>Switches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discovered ports</td>
</tr>
</tbody>
</table>

Related tasks:

“Adding ESX and ESXi hypervisors” on page 88
Add ESX and ESXi hypervisors for monitoring by IBM Spectrum Control.

“Adding storage systems” on page 81
To monitor a storage system, configure a connection to the storage system and schedule the collection of data.

“Adding fabrics and switches” on page 85
Add fabrics and switches for monitoring.

“Adding servers” on page 91
Add servers for monitoring. You can add a server by deploying a Storage Resource agent, or you can add an agentless server.
Required user roles for monitoring resources

To monitor storage systems and hypervisors, you must provide a user name and password for logging in to those resources. The role or user group that is assigned to the user name determines the data collection and provisioning functions that you can use with a resource.

The following roles are associated with the user names that IBM Spectrum Control uses to log in to resources. Specify user names when you add a resource for monitoring. These roles are different from IBM Spectrum Control roles, which are assigned to users that log in to IBM Spectrum Control.

Table 18. Required roles for storage system and hypervisor users

<table>
<thead>
<tr>
<th>Resource</th>
<th>Required role for performance monitors</th>
<th>Required role for probes</th>
<th>Required role for provisioning</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS6000</td>
<td>Monitor role or greater</td>
<td>Monitor role or greater</td>
<td>Administrator, Physical operator, or Logical operator</td>
</tr>
<tr>
<td>DS8000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAN Volume Controller</td>
<td>Monitor¹ or Administrator</td>
<td>Monitor</td>
<td>Administrator</td>
</tr>
<tr>
<td>IBM Storwize family</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storwize V7000 Unified (block storage)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FlashSystem V840</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storwize V7000 Unified (file storage)</td>
<td>Performance monitoring is not available</td>
<td>Monitor</td>
<td>Administrator, or Export Administrator + Storage Administrator. For more information about roles, see IBM Knowledge Center for IBM SONAS.</td>
</tr>
<tr>
<td>IBM SONAS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Spectrum Accelerate</td>
<td>Any role</td>
<td>Any role</td>
<td>Provisioning is not available</td>
</tr>
<tr>
<td>IBM Spectrum Scale (file storage)</td>
<td>Any role</td>
<td>Root or non-root²</td>
<td>Provisioning is not available</td>
</tr>
</tbody>
</table>
Table 18. Required roles for storage system and hypervisor users (continued)

<table>
<thead>
<tr>
<th>Resource</th>
<th>Required role for performance monitors</th>
<th>Required role for probes</th>
<th>Required role for provisioning</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Spectrum Scale (object storage)</td>
<td>Performance monitoring is not available</td>
<td>The Keystone admin role. Information is collected only for the object storage accounts and containers that the user has access to. If you want to monitor all accounts and containers, the user must also be assigned the role that is defined in the <code>reseller_admin_role</code> configuration option in the Swift proxy server. The default value for the <code>reseller_admin_role</code> option is <code>ResellerAdmin</code>.</td>
<td>Provisioning is not available</td>
</tr>
<tr>
<td>XIV</td>
<td>Any role</td>
<td>Any role</td>
<td>Storage administrator</td>
</tr>
<tr>
<td>Hypervisors (such as ESX, ESXi, and vCenter Servers)</td>
<td>Performance monitoring is not available</td>
<td>A role that has permission to browse through data stores. For example: Administrator role or Virtual Machine Power User role.</td>
<td>• Provisioning within the IBM Spectrum Control: any role • Provisioning with the vSphere Web Client extension: Storage administrator or Administrator roles.</td>
</tr>
</tbody>
</table>

Notes:
• 1 Administrator authority is required for full performance monitoring. You can also use the Monitor role, but with that role you cannot change the frequency at which performance data is collected. To change the frequency in that case, you must use the SAN Volume Controller CLI with administrator authority.
• 2 You can add GPFS clusters and GSS systems as a non-root user, but that user must have privileges to run a set of specified administration commands using the `sudo` command on the cluster node.

Adding storage systems
To monitor a storage system, configure a connection to the storage system and schedule the collection of data.

To add a storage system, you must have Administrator privileges.

You can add the following types of storage systems for monitoring:
SAN Volume Controller, IBM Storwize family, IBM FlashSystem V840 Enterprise Performance Solution, and IBM FlashSystem V9000 storage systems run IBM Spectrum Virtualize™ to virtualize their storage. In this documentation, IBM Spectrum Virtualize is used to refer collectively to SAN Volume Controller, Storwize, FlashSystem V840, and FlashSystem V9000 storage systems.

For a complete list of the versions of storage systems and CIM agents that you can add, see [IBM Spectrum Control interoperability matrix for storage systems](http://www.ibm.com/support/docview.wss?uid=swg27039840).

1. To add a block storage system, go to Storage > Block Storage Systems. To add a file storage system, go to Storage > File Storage Systems. To add an object storage system, go to Storage > Object Storage Systems.

2. Click **Add Storage System**.

3. Click the icon for the type of storage system that you want to add.

   **Tip:** Click **Storwize Family** to add the following storage systems:
   - IBM® Storwize® V3500
   - Storwize V3700
   - Storwize V5000
   - Storwize V7000

4. Complete the connection information for the storage system and schedule the collection of data.

The storage system is added for monitoring. A probe is automatically run to collect status and asset information about the storage system.

Storage systems can be configured for block storage, file storage, a combination of block and file storage, or a combination of file and object storage. The method that a storage system uses for managing data determines the internal resources and object resources that are monitored.

When the collection of data is complete, you can view status information and capacity data about the storage system on the resource list page for the block, file, or object storage system. For example, for block storage systems, you can view the information on the Block Storage Systems page.

**Enabling the default alerts for storage systems:** To enable the default alerts for a resource so that you are automatically notified when certain conditions are
detected, you must view the alert definitions for that resource. For example, to view the alert definitions for a block storage system, go to Storage > Block Storage Systems, right-click a storage system, and select Edit Alert Definitions. The default alerts are automatically enabled for the storage system after you access the Edit Alert Definitions page.

Monitoring IBM Spectrum Scale without requiring root privileges
Enable users that do not have root privileges on a GPFS™ cluster node to monitor IBM Spectrum Scale™ storage systems.

Before you add the IBM Spectrum Scale storage system for monitoring, complete this task.

To grant access to the user, make the following changes to the sudoers file on the cluster node that is used for authentication:

- Add the set of administration commands that are required to monitor the storage system.
- Associate the user with the set of administration commands.

1. Log on to the cluster node that is used for authentication with a user name that has root privileges.
2. To edit the sudoers file, enter the following command:
   visudo -f /etc/sudoers
3. Add the following command aliases to the sudoers file. The command aliases contain the commands that the user must be able to issue to monitor the storage system.

   Important: Each command alias must be on a single line without line breaks.

   ```
   Cmd_Alias TPC_GPFS_MMCMD = /usr/lpp/mmfs/bin/mmsdrquery, /usr/lpp/mmfs/bin/mmlsconfig, /usr/lpp/mmfs/bin/mmgetsrvt, /usr/lpp/mmfs/bin/mmlsnodeclass, /usr/lpp/mmfs/bin/mmlsfs, /usr/lpp/mmfs/bin/mms, /usr/lpp/mmfs/bin/mmlsnode, /usr/lpp/mmfs/bin/mmlsfilesset, /usr/lpp/mmfs/bin/, /usr/lpp/mmfs/bin/mmlssnapshot, /usr/lpp/mmfs/bin/mmrepquota
   ```

   ```
   Cmd_Alias TPC_GPFS_MMDSH = /usr/lpp/mmfs/bin/mmdsh -N * /usr/lpp/mmfs/bin/mmdsh -N -f 20000 -N * /usr/lpp/mmfs/bin/mmdsh -N * /sbin/blockdev --getsize64*, /usr/lpp/mmfs/bin/mmdsh -N * /usr/bin/getconf DISK_SIZE*, /usr/lpp/mmfs/bin/mmdsh -N * /bin/cat*release, /usr/lpp/mmfs/bin/mmdsh -N * /usr/bin/lsb_release -a
   ```

   ```
   Cmnd_Alias TPC_GPFS_CMDS = TPC_GPFS_MMCMD, TPC_GPFS_MMDSH, TPC_GPFS_OTHER
   ```

   4. To enable the user to issue the commands, add the following lines after the command aliases:

   ```
   Defaults:user_name !requiretty
   user_name ALL=(ALL) NOPASSWD: ALL
   ```

   where user_name is the user name that you enter when you add the storage system for monitoring.

   The user that you added to the sudoers file can now monitor the IBM Spectrum Scale storage system.
Verifying that probe data can be collected for IBM Spectrum Scale with object storage

To probe object storage, the IBM Spectrum Control server must be able to connect to the OpenStack Swift and Keystone endpoints that are used to access object services.

To verify that the server can access the object services, complete these steps:

1. List the URLs for the Keystone and Swift services by running commands on a GPFS cluster node that is configured for object storage. Run the following commands with a user name that has root privileges:
   ```bash
   $ source /openrc
   openstack endpoint list
   ```

2. Ensure that the IBM Spectrum Control server can connect to the IP addresses and host names that are included in the Keystone and Swift services URLs. For example, the URL for the Keystone service might be http://gpfs420proto1:5000/v3. The IBM Spectrum Control server must be able to connect to the gpfs420proto1 host name.

Configuring the collection of performance data for IBM Spectrum Scale

Configure the collection of information about the performance of IBM Spectrum Scale file storage systems.

To collect performance data, you must first configure the IBM Spectrum Scale performance monitoring tool on the GPFS cluster. Then, use the IBM Spectrum Control GUI to schedule the collection of performance data.

1. Configure the sensor component of the IBM Spectrum Scale performance monitoring tool by editing the /opt/IBM/zimon/ZIMonSensors.cfg file on the sensor nodes.

   Set the host property in the collectors section of the file to the GPFS cluster node where the collector component is running. The host property must be set to one of the following options:
   - An IP address that can be reached by the IBM Spectrum Control server
   - A host name that resolves to an IP address that is reachable by the IBM Spectrum Control server

2. Enable the following sensors on each node for which you want to collect performance data: CPU, Memory, GPFSNode, GPFSFileSystem.

3. Start the collector component of the performance monitoring tool on a single GPFS cluster node. The collector can run on any node.

4. Start the sensor component of the performance monitoring tool on each node for which you want to collect performance data. By default in IBM Spectrum Scale version 4.1.1, the sensors are started only on protocol nodes.

5. To receive data from the performance monitoring tool, ensure that the IBM Spectrum Control server can connect to port 9084 on the GPFS cluster node where the collector component is running.

6. Schedule the collection of performance data by creating a performance monitor in the IBM Spectrum Control GUI. You can create performance monitors in the GUI when you add resources for monitoring or you can create them later.

A performance monitor is created for the IBM Spectrum Scale storage system. If a successful probe run is completed for the resource, the performance monitor runs according to the defined interval.
To check the progress of a performance monitor, you can complete the following actions:

- **View** the Performance Monitor Status column on the File Storage Systems page.
- From the File Storage Systems page, right-click a row, and select **Data Collection > Open Performance Monitor Logs**.

To learn more about configuring the performance monitoring tool, see [IBM Knowledge Center](http://www.ibm.com/support/knowledgecenter/STXKQY_4.1.1/com.ibm.spectrum.scale.v4r11.adv.doc/bl1adv_PMToverview.htm).

### Configuring OpenStack access to monitor the object storage system

Configure OpenStack access for the user name that is used to monitor the IBM Spectrum Scale object storage system.

Before you add the IBM Spectrum Scale object storage system for monitoring, ensure that the user name that you use to monitor the storage system has access to object storage accounts.

**Tip:** The terms "account" and "project" mean the same thing. Swift, the OpenStack object storage service, uses the term "account" and Keystone, the OpenStack identity service, uses the term "project."

1. Set the object storage account and the domain for the user. By default, the domain is set to **Default** and cannot be modified after you create the user account. Choose one of the following actions:
   a. To set the account and domain when you create a user account, use the following command:
      ```sh
      openstack user create --domain domainname --project projectname --password Password username
      ```
   b. To set the account and the domain for an existing user name, use the following command:
      ```sh
      openstack user set --project projectname username
      ```

2. Assign the admin role for an object storage account to the user name. Use the following command:
   ```sh
   openstack role add --user username --project projectname admin
   ```

3. To monitor all accounts on the object storage system, assign to the user name the role that is defined in the `reseller_admin_role` configuration option in the Swift proxy server. The default value for the `reseller_admin_role` option is ResellerAdmin. For example, use the following command:
   ```sh
   openstack role add --user username --project projectname ResellerAdmin
   ```

   **Restriction:** If you do not assign the ResellerAdmin role, information is collected only for the object storage accounts that the user has admin access to.

To learn more about configuring and assigning user roles in OpenStack, see [OpenStack User Guide](http://docs.openstack.org/user-guide-admin/manage_projects_users_and_roles.html).

### Adding fabrics and switches

Add fabrics and switches for monitoring.

For a Cisco switch to successfully receive and respond to queries from IBM Spectrum Control, the following basic requirements must be met:
IBM Spectrum Control can use SNMPv3 (preferred) or SNMPv1 for probes. Switches that IBM Spectrum Control collects performance data from must use the SNMPv2 or SNMPv3 protocols. Some switches are configured to use SNMPv3 by default.

If the switch uses an SNMP agent, the Fibre Alliance FC Management MIB (FA MIB) and Fibre Channel Fabric Element MIB (FE MIB) must be enabled on the switch.

IBM Spectrum Control can use SNMP agents as data sources for switches and fabrics, although SMI-S agents are preferred for Brocade switches and fabrics. When SNMP agents are used, the SNMPv3 protocol is preferred, but switches that IBM Spectrum Control probes must support the SNMPv1 protocol at least, and switches from which IBM Spectrum Control collects performance data from must support the SNMPv2 protocol at least.

When using the SNMPv1 or SNMPv2 protocols, the community string that is configured in IBM Spectrum Control must match one of the community strings that are configured on the switch with read access. Cisco switches must additionally have a community string match for write access. The default community strings in IBM Spectrum Control are “public” for read access and “private” for write access. Other community strings can be defined on the switches, but are not used. Community strings are not relevant when using the SNMPv3 protocol.

SNMP access control lists must include the IBM Spectrum Control system. Some lists automatically include all hosts while others exclude all by default.

In the web-based GUI, you can add switches and fabrics for monitoring at the same time. You can add the following types of switches:

- Brocade
- Cisco
- Other fabric vendors

For a complete list of the switches and their versions that you can add, see the switches and directors information in the IBM Spectrum Control interoperability matrix at [http://www.ibm.com/support/docview.wss?uid=swg21386446](http://www.ibm.com/support/docview.wss?uid=swg21386446).

Help tips in the GUI: To view descriptions of the information that you must enter for a fabric or switch, hover the mouse pointer over the related help icons in the wizard.

1. In the menu bar, go to Network > Switches.
2. Click Add Switch.
3. Select the vendor: Brocade, Cisco or Other.
4. Specify how you want to discover the switches and the fabrics that are connected to the switches. For Cisco switches and fabrics, you must use SNMP agents. For Brocade and other vendors, you can use the vendor's CIM support as an alternative to SNMP.
<table>
<thead>
<tr>
<th>Type of switch agent</th>
<th>Steps</th>
</tr>
</thead>
</table>
| SNMP agents | For Cisco, Brocade or other vendors, do the following:  
  - Specify the version of SNMP: v3 (preferred) or v1.  
  - If you choose to use v3, specify the **User name** and associated **Authentication password**. Select an **Authentication protocol** and an **Encryption protocol**.  
  - If you choose to use v1, define the **Read community** and the **Write community**.  
  - Identify the **Host name or the IP address** of each switch you want to add.  
  **Note:** For Cisco fabrics based on SNMPv3, both authentication protocol and authentication password are mandatory. For Brocade and other fabric vendors, authentication is not mandatory when managing or adding switches using SNMPv3. |
| CIM agents | For Brocade switches and fabrics, do the following:  
  - Select **Monitor with Network Advisor** to use a CIM agent on Network Advisor. The switches that are managed by the agent are automatically discovered. After this step, you can also specify to use Simple Network Management Protocol (SNMP) data sources for the switches. You can use SNMP for redundancy.  
  - Select **Monitor without Network Advisor** if you do not want to use a CIM agent as the data source. In this case, you are prompted to add switches and their fabrics through SNMP agents.  
  For other vendors:  
  - Select **Use CIM agent as data source** if you want the switches that are managed by the CIM agent to be automatically discovered. After this step, you can also select to use SNMP agents for the switches.  
  - Do not select **Use CIM agent as data source** if you do not want to use a CIM agent as a data source. In this case, you are prompted to add switches and their fabrics through SNMP agents. |

5. Specify the display name and location of the switches and fabrics that are discovered. For switches that were discovered through a CIM agent, you can also select to monitor them through SNMP. When you add a Brocade director switch as an SNMP data source, use the IP address or host name of the chassis, rather than the IP address or host name of the primary or secondary core routing blades.

6. Schedule data collection for the switches and fabric. The type of resource determines the data collection jobs that you can schedule:  
  - Fabrics: probes  
  - Switches: probes, performance monitors  
  Probes collect status and asset information. Performance monitors collect metrics that measure performance.

7. Complete the wizard.

The fabric or switch is added for monitoring. A probe is automatically run to collect status and asset information about the resource.

When the collection of data is complete, you can view status information about the fabric or switch on the Fabrics page or Switches page.
Enabling the default alerts for resources: To enable the default alerts for a resource so that you are automatically notified when certain conditions are detected, you must view the alert definitions for that resource. For example, to view the alert definitions for a switch, go to Network > Switches, right-click a switch, and select Edit Alert Definitions. The default alerts for the switch are automatically enabled after you access the Edit Alert Definitions page.

Agent types for switch and fabric functions
Depending on the functions that you want to enable, you can use CIM or SNMP agents to monitor switches and fabrics.

The vendors of switches can help you determine which agents to use.

Table 19. Agent types for switch and fabric functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Brocade</th>
<th>Cisco</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor performance</td>
<td>CIM agent or SNMP agent</td>
<td>SNMP agent</td>
<td>Other fabric vendor switches cannot be used for performance monitoring.</td>
</tr>
<tr>
<td>Collect information about switches and switch ports</td>
<td>Recommended: CIM agent</td>
<td>SNMP agent</td>
<td>CIM agent or SNMP agent</td>
</tr>
<tr>
<td>Collect information about topology connectivity</td>
<td>Recommended: CIM agent</td>
<td>SNMP agent</td>
<td>CIM agent or SNMP agent</td>
</tr>
<tr>
<td>Collect information about zoning information and zone control</td>
<td>Recommended: CIM agent</td>
<td>SNMP agent</td>
<td>CIM agent</td>
</tr>
<tr>
<td>Generate alerts</td>
<td>Recommended: CIM agent</td>
<td>SNMP agent</td>
<td>CIM agent or SNMP agent</td>
</tr>
</tbody>
</table>

Tips:
1. If there are Brocade virtual fabrics in your storage environment, use only CIM agents for your switches and fabrics.

Adding hypervisors
You can add hypervisors for monitoring by IBM Spectrum Control. Hypervisors include VMware vSphere data sources such as ESX and ESXi, and vCenter Server systems. When you add vSphere data sources, you can then collect data, generate reports, and manage storage that is related to those resources.

To add a hypervisor, you specify connection information for the ESX or ESXi data source. You can add multiple hypervisors by specifying connection information for a vCenter Server system.

Adding ESX and ESXi hypervisors
Add ESX and ESXi hypervisors for monitoring by IBM Spectrum Control.
You can add an ESX or ESXi hypervisor by specifying connection information for that hypervisor. For a complete list of hypervisors that you can add, see the IBM Spectrum Control interoperability matrix at [http://www.ibm.com/support/docview.wss?uid=swg21386446](http://www.ibm.com/support/docview.wss?uid=swg21386446) and go to the Agents, Servers and Browsers section.

1. In the menu bar, go to Servers > Hypervisors.
2. Click Add Hypervisor.
3. Select ESX/ESXi and enter connection information about the hypervisor.
4. Schedule a probe of the hypervisor.
5. Follow the instructions in the wizard to add the hypervisor.

The hypervisor is added for monitoring. A probe is automatically run to collect status and asset information about the hypervisor.

When the collection of data is complete, you can view status information and capacity data about the hypervisor on the Hypervisors page.

**Enabling the default alerts for hypervisors:** To enable the default alerts for a resource so that you are automatically notified when certain conditions are detected, you must view the alert definitions for that resource. For example, to view the alert definitions for a hypervisor, go to Servers > Hypervisors, right-click a hypervisor, and select Edit Alert Definitions. The default alerts are automatically enabled for the hypervisor after you access the Edit Alert Definitions page.

**Related tasks:**

- [“Adding vCenter Server systems” on page 90](#)

For IBM Spectrum Control to monitor multiple hypervisors, you must first add a vCenter Server system.

**Checking permissions to browse data stores:**

Determine if the user name that you specified for a VMware data source has permission to browse through the data stores on a hypervisor.

When you add a VMware data source in IBM Spectrum Control, the user name that you specify must have permission to browse through the data stores on VMware. IBM Spectrum Control must browse through the data stores to collect information from the hypervisors. However, the "Read Only" role as defined by VMware does not allow IBM Spectrum Control to browse the data stores. You can use the "Virtual Machine Power User" role if you do not want to use the Administrator role, or you can create a custom role with the required permissions.

To verify that a VMware user is assigned the correct role and privileges to monitor VMware data sources, follow these steps:

1. Ensure that the user role has the required VMware datastore permissions by completing the following steps:
   a. Connect the vSphere Web Client to the VMware data source. The data source can be an ESX server, a vCenter Server Appliance, or a vCenter Server.
   b. From the Inventories view, select Hosts and Clusters.
   c. Select a host, and click the Related Objects tab.
   d. View the datastores by clicking the Datastores tab.
e. Right-click a datastore, and select File Browser. If you can view the Files tab for the datastore, your browse permission is working correctly.

2. Determine the role that is assigned to the user by logging in to the vSphere Web Client by using the administrator user ID. From the Administration view, select Roles. Verify the role name that is assigned to the user.

3. Determine the privileges that are assigned to the role by selecting the user’s role and clicking Privileges. Expand the privilege groups to view the specific privileges.

4. Optional: If you must edit the privileges for the role, select the role and click the Edit role action icon. Select privilege groups or expand to select specific privileges.

For more information about VMware user roles, go to the VMware documentation center and search for vSphere users and permissions.

Adding vCenter Server systems
For IBM Spectrum Control to monitor multiple hypervisors, you must first add a vCenter Server system.

When you add vCenter Server version 5.1 or later, you can deploy the vSphere Web Client extension for IBM Spectrum Control and register the latter as a VASA provider. You can then provision storage, view reports, and publish alerts in the vSphere Web Client about storage that is monitored by IBM Spectrum Control.

You can add multiple hypervisors by specifying connection information for a vCenter Server system. For a complete list of hypervisors and vCenter Server systems that you can add, see the IBM Spectrum Control interoperability matrix at http://www.ibm.com/support/docview.wss?uid=swg21386446 and go to the Agents, Servers and Browsers section.

1. In the menu bar, go to Servers > Hypervisors.
2. Click Add Hypervisor.
3. Select VMware vCenter and enter connection information about the vCenter Server system.
4. Optional: To deploy the vSphere Web Client extension for IBM Spectrum Control and register IBM Spectrum Control as a VASA provider, in the Deploy vSphere extension page, enter your credentials. For VMware vCenter Server, enter a user name and password for the vSphere administrator user. For IBM Spectrum Control, enter a user name and password for a IBM Spectrum Control user ID. You must have Administrator, Monitor, or External Application authority to deploy the extension. If you entered a vSphere administrator user name and password for the vCenter Server system, enter only the IBM Spectrum Control credentials.
5. Schedule a probe for the hypervisors that were discovered.
6. Follow the instructions in the wizard to add the vCenter Server system.

After a vCenter Server system is added for monitoring, probes collect status and asset information about its hypervisors.

When the collection of data is complete, you can view status information and capacity data about the hypervisors on the Hypervisors page.

Enabling the default alerts for hypervisors: To enable the default alerts for a resource so that you are automatically notified when certain conditions are
detected, you must view the alert definitions for that resource. For example, to view the alert definitions for a hypervisor, go to Servers > Hypervisors, right-click a hypervisor, and select Edit Alert Definitions. The default alerts are automatically enabled for the hypervisor after you access the Edit Alert Definitions page.

Related tasks:

- “Adding ESX and ESXi hypervisors” on page 88
- Add ESX and ESXi hypervisors for monitoring by IBM Spectrum Control.
- “Checking permissions to browse data stores” on page 89

Determine if the user name that you specified for a VMware data source has permission to browse through the data stores on a hypervisor.

Adding servers

Add servers for monitoring. You can add a server by deploying a Storage Resource agent, or you can add an agentless server.

Choose which type of server to add and which method you use to add the server.

To determine which type of server to add, follow these guidelines:

*Table 20. Choosing the type of server to add*

<table>
<thead>
<tr>
<th>Condition</th>
<th>Add an agentless server</th>
<th>Deploy a Storage Resource agent to a server</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to view the monitored resources to which a server is connected.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>You want to view the amount of storage that the server is assigned from other monitored resources.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>You want to view the performance of the SAN-related resources that are connected to the server.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>The restrictions within your organization prohibit the deployment of agents to a server.</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>You want to view information about the resources that are internal to a server. Internal resources include controllers, disks, volume groups, file systems, logical volumes, shares, exports, and directories.</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

You can use several methods to add one or more servers for monitoring. Use the following information to determine the method that best meets the needs of your environment:

**Manually**

Add one server by manually entering configuration information.
From a File List
Add one or more servers by importing configuration information from a comma-delimited file.

From Discovered Servers
Add one or more servers that are members of a Windows domain. If you select this method, the Add Server wizard automatically searches for servers that are in the Windows domain where IBM Spectrum Control is installed. When you select to add one server from the list of discovered servers, you can configure more information about that server. When you select to add multiple servers, the servers are automatically created without additional configuration information.

Restriction: This method is available only when you add an agentless server. You cannot use this method when you add a server by deploying a Storage Resource agent.

Example: Server-centric monitoring of SAN resources without an agent

In IBM Spectrum Control, you can view the connectivity of all your top-level resources in a SAN environment. These resources include servers, hypervisors, fabrics, switches, and storage systems. In previous releases, to get a complete view of the connectivity between servers and other top-level resources, you were required to deploy Storage Resource agents on all of those servers. However, in some environments it was not always possible to deploy Storage Resource agents, and thus a complete view of all resource relationships was not available. In IBM Spectrum Control V5.2 and later, you can add servers without deploying Storage Resource agents and still view the overall connectivity and performance of SAN storage that is assigned to those servers.

When you add an agentless server for monitoring and specify its worldwide port names, IBM Spectrum Control automatically correlates that server with the ports on known host connections. If matches are found between the server and host connections on monitored storage systems, the following information can be determined:

• The amount of SAN storage that is assigned to the server.
• The storage systems that are mapping volumes to the server.
• The relationships between the server and other monitored resources.

If performance monitors collect data about the related storage systems, you can also view the performance of the internal resources that are directly associated with storage that is assigned to the server. For example, if a SAN Volume Controller maps two volumes to the server, you can view the performance of those volumes and the related managed disks.

Adding servers without Storage Resource agents
Add agentless servers for monitoring. An agentless server is a server or virtual machine that is monitored by IBM Spectrum Control but does not have a Storage Resource agent deployed to it.

When you add an agentless server, enter its IP address or host name and other optional information such as its OS type, location, and ports. IBM Spectrum Control uses this information to correlate the agentless server with the storage systems, fabrics, and switches that are being monitored. For example, the ports that you enter for an agentless server are compared to the ports on host connections for
monitored storage systems. If there is a match between the server and a host connection, you can view the connectivity between the server and storage system and the capacity of volumes that are assigned to the server.

Use any of the following methods to add agentless servers for monitoring:
• Add a server by manually entering its information.
• Add a server from a host connection on a monitored storage system.
• Add a server from a discovered port that is connected to a monitored switch.
• Add a server from a discovered port that is connected to a monitored fabric.

Add an agentless server by manually entering its information.
1. In the menu bar, go to **Servers** > **Servers**.
2. Click **Add Server**.
3. Ensure that the **Deploy an agent for full server monitoring** check box is cleared.
4. Select a method for adding a server and complete the steps.

Add a server from a host connection on a monitored storage system.
Use this method when you want to configure a host connection to represent a physical server. When you select a host connection, you are specifying the internal resources (volumes, ports) that belong to that server from the perspective of the related storage system.

To add an agentless server that is based on a known host connection, complete the following steps:
1. In the menu bar, go to **Storage** > **Block Storage Systems**.
2. Right-click a storage system and select **View Details**.
3. Click **Host Connections** to view a list of host connections that are mapped to a storage system.
4. Right-click a host connection and select **Add Server**. This action is not available under the following conditions:
   • A Storage Resource agent or agentless server is already associated with the host connection.
   • The host type of the host connection is configured for SAN Volume Controller.
5. Enter information about the server and assign ports.
6. Complete the wizard.

Add a server from a discovered port that is connected to a monitored switch.
Discovered ports are ports on resources that are not monitored by IBM Spectrum Control but are visible to a monitored switch. To add an agentless server that is based on a discovered port, complete the following steps:
1. In the menu bar, go to **Network** > **Switches**.
2. Right-click a switch and select **View Details**.
3. Click **Discovered Ports** to view a list of unmanaged ports that are visible to the switch.
4. Right-click an unknown port and select **Add Server**.
5. Enter information about the server and assign ports.
6. Complete the wizard.
After the wizard is complete, the port is removed from the list of discovered ports and added as a server to the list of related resources for the switch.

**Add a server from a discovered port that is connected to a monitored fabric.**

Discovered ports are ports on resources that are not monitored by IBM Spectrum Control but are connected to ports on a monitored fabric. To add an agentless server that is based on a discovered port, complete the following steps:

1. In the menu bar, go to **Network > Fabrics**.
2. Right-click a switch and select **View Details**.
3. Click **Discovered Ports** to view a list of unknown ports that are connected to ports in the fabric.
4. Right-click an unknown port and select **Add Server**.
5. Enter information about the server or virtual machine and assign ports.
6. Complete the wizard.

After the wizard is complete, the port is removed from the list of discovered ports and added as a server to the list of related resources for the fabric.

**Help tips in the GUI:** To view descriptions of the information that you must enter for a server, hover the mouse pointer over the related help icons in the wizard.

**Restrictions:**

- The host name or IP address of an agentless server can be up to 24 characters in length and must contain valid characters. You can enter the following characters when you enter a host name or IP address:
  - A through Z (uppercase characters)
  - a through z (lowercase characters)
  - 0 through 9 (numeric characters)
  - Special characters: -, . (period)
- If the location of an agentless server exceeds 64 characters, it is truncated when the server is added. To avoid the truncation, ensure that the location value for an agentless server is equal to or less than 64 characters in length.

**File List:**

Add one or more agentless servers by importing configuration information from a comma-delimited file. IBM Spectrum Control reads the entries in the file and automatically adds the corresponding servers.

The input file for importing server information can contain entries for one or more servers. Each line in the file represents a server that you want to add. Information about each server must be organized in the following format:

```
host name or IP address,OS type,machine type,location,WWPN
```

where:

- **host name or IP address** is required for each server entry. An IP address can be in an IPv4 or IPv6 format. You must include a host name or IP address for each server that you want to add. The host name or IP address can be up to 24 characters in length and must contain valid characters. You can enter the following characters when you enter a host name or IP address:
- A through Z (uppercase characters)
- a through z (lowercase characters)
- 0 through 9 (numeric characters)
- Special characters: - (minus) . (period)

- OS type is optional and represents the operating system of the server. The OS type for a server must be one of the following values:
  - Windows
  - Linux
  - AIX
  - Solaris
  - HP-UX

- Machine type is optional and determines if the server is a physical device or a virtual machine. The machine type for a server must be one of the following values:
  - Physical
  - Virtual

- Location is optional and represents the physical location of the server. If the location of an agentless server exceeds 64 characters, it is truncated when the server is added. To avoid the truncation, ensure that the location value for an agentless server is equal to or less than 64 characters in length.

- WWPN is optional and represents the worldwide port name that is associated with the server. You can include one or more WWPNs for each server. The value for World Wide Port Name (WWPN) must be 16 hexadecimal characters in length. If the WWPN for a server entry is already associated with a server that is being monitored, that WWPN is not created for the server.

**Example**

```
host1,Windows,Virtual,San Jose,2100000056AE45B2,2100000056AE45B3 # Comment
host5,Linux,Physical,London,2100000056EC45A4,21000000565E4FB6
systemxyz.storage.widgets.com,Solaris,,Chicago,21000000567E5FB7
198.51.100.22,HPUX,Virtual,,21000000569E7FB9
2001:DB8:0:0:0:0:0:0,Windows,Physical,Tokyo,21000000569E7FB9
```

**Tip:** If you add many servers in the same input file, the adding process might require some time to complete. To run the process in the background, click **Close** on the Add Server window. If you remain on the Servers page, a message is displayed when the servers are added. If you leave the Servers page during processing, a message is not displayed. To confirm that the servers were added, you must go back to the Servers page and refresh the list.

**Restrictions**

Keep in mind the following restrictions when you import server information from an input file:

- Each line in the file represents one server.
- Enter a "#" at the beginning of a line to comment out a line. The server on that line is not added when the list is imported in the add server wizard.
- If there are syntax problems in the file, then none of the servers in the file are added.

**Adding servers with Storage Resource agents**

Add servers by deploying Storage Resource agents. Deploy Storage Resource agents if you want to enable full server monitoring.
To add a server, you must have Administrator privileges.

For each installation of IBM Spectrum Control, you can deploy only one Storage Resource agent on each server. If you attempt to deploy additional Storage Resource agents on a server, the deployments fail.

1. In the menu bar, go to **Servers > Servers**.
2. Click **Add Server**.
3. Select **Deploy an agent for full server monitoring**.
4. Select a method for adding a server. You can choose one of the following methods:
   - Add a server by manually entering information about the server and the Storage Resource agent.
   - Add one or more servers by importing configuration information from a comma-delimited file.
5. On the **Deploy Agent** page, configure deployment information for the Storage Resource agents.
   If you add multiple servers with different operating systems, separate configuration pages are displayed for agents that are deployed on Windows servers and agents that are deployed on UNIX servers.
6. On the **Configure** page, schedule the deployment of the Storage Resource agents.
   If you are deploying agents on multiple servers, a time span is calculated during which the agents are deployed. The agents are deployed at regular intervals during the time span to avoid excessive load on the IBM Spectrum Control server.
7. Schedule the time and frequency that probes are run for the servers.
   If you add multiple servers, a time span is calculated during which the servers are probed.
8. To add the servers, click **Finish**.

A probe is automatically run for a server after the agent is successfully deployed.

Use **Agent State** on the **Servers** page to monitor the status of the agent deployment.

**Enabling the default alerts for servers:** To enable the default alerts for a resource so that you are automatically notified when certain conditions are detected, you must view the alert definitions for that resource. For example, to view the alert definitions for a server, go to **Servers > Servers**, right-click a server, and select **Edit Alert Definitions**. The default alerts for the server are automatically enabled after you access the Edit Alert Definitions page.

**File List:**

Add one or more servers with Storage Resource agents by importing the configuration information from a comma-delimited file.

The web-based GUI guides you through the following steps for adding servers:
- Select the input file.
- Configure deployment information.
- Schedule the agent deployment and data collection for the servers.
The comma-delimited file that you use to import the configuration information for servers can contain entries for a single server or multiple servers. Each line in the file represents a server that you want to add. The information about each server must be organized in the following format:

```plaintext
host name or IP address,OS type,location,custom tag 1,custom tag 2,custom tag 3
```

where:

- **host name or IP address** is required for each server entry. An IP address can be in an IPv4 or IPv6 format. A host name or IP address can contain the following characters or symbols:
  - A - Z (uppercase characters)
  - a - z (lowercase characters)
  - 0 - 9 (numeric characters)
  - Symbols: - . : _

- **OS type** is required and represents the operating system of the server. The OS type for a server must be one of the following values:
  - Windows
  - Linux
  - AIX
  - Solaris
  - HP-UX

- **location** is optional and represents the physical location of the server. The location value can be up to 64 characters in length. If the length exceeds 64 characters, the location value is truncated when the server is added.

- **custom tag 1**, **custom tag 2**, and **custom tag 3** are optional and represent any additional information that you want to provide about the server. The custom tag values can be up to 64 characters in length. If the length exceeds 64 characters, the custom tag value is truncated when the server is added.

**Tip:** The custom tags can be displayed on the Servers page or can be included as report columns when you generate reports for the server.

**Example**

```plaintext
host1,Windows,San Jose,Accounting department
host5,Linux,London,Finance department
198.51.100.22,HP-UX,,Computing department
2001:0DB8:0:0:0:0:0:0,Windows,Tokyo
```

**Tips:**

- If the comma-delimited file contains entries for multiple servers, it might take some time to add the servers. To confirm that the servers are added, check the Status column on the Servers page.

- To comment out a line, enter a "#" at the beginning of the line. The server on that line is not added when the list is imported.

**Example:**

```plaintext
# host1,Windows,San Jose,Accounting department
```

- If there are syntax problems in the file, none of the servers in the file are added.
Removing resources

Remove resources that you no longer want to monitor with IBM Spectrum Control.

1. In the menu bar, go to the type of resource that you want to remove.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. Right-click the resource and click Remove.

   **Note:** To remove a Cisco fabric, you must remove all the switches in that fabric. The Cisco fabric is then automatically removed.

3. Click Remove to confirm that you want to remove the resource.

When you remove a resource, it is no longer monitored by IBM Spectrum Control. All the data that is associated with the resource, including historical data, is removed from the database. All the scheduled tasks and data collection jobs for the resource are canceled.

Collecting data

Determining the data that you want to gather about storage resources is critical to helping you implement a storage management strategy. IBM Spectrum Control provides different jobs for collecting data. When you determine the types of data that you want to collect about resources, schedule the corresponding data collection jobs for those resources.

**Table 21. Data collection jobs, resources, and related tasks**

<table>
<thead>
<tr>
<th>Data collection job</th>
<th>Resources</th>
<th>Related tasks</th>
</tr>
</thead>
</table>
| Probe               | Storage systems, Servers, Hypervisors, Fabrics, Switches | • Schedule a probe when you add a resource for monitoring.  
|                     |                                    | • Modify the schedule for a probe at any time on the list and details pages for a resource. For example, to modify the schedule for a block storage system, go to the Block Storage Systems page or the details page for the block storage system.  |

Learn more...
### Table 21. Data collection jobs, resources, and related tasks (continued)

<table>
<thead>
<tr>
<th>Data collection job</th>
<th>Resources</th>
<th>Related tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance monitor</strong></td>
<td>Block storage systems</td>
<td>• Schedule a performance monitor when you add a resource for monitoring.</td>
</tr>
<tr>
<td></td>
<td>File storage systems</td>
<td>• Modify the schedule for a performance monitor at any time on the Performance page, and on the list and details pages for the resource.</td>
</tr>
<tr>
<td></td>
<td>Object storage systems</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switches</td>
<td></td>
</tr>
</tbody>
</table>

#### Collecting asset and status data

Use probes to collect asset, status, and storage data about monitored resources in your environment. Probes are also used to discover information about new or removed disks and file systems. You can view information about probes on the resource list and resource details pages, for example, the Block Storage Systems page, or the Block Storage Systems details page.

#### Creating probes

Probes are data collection jobs that collect status and asset information about your storage resources. You can create probes when you add resources for monitoring or after you add the resources for monitoring.

You can create probes for one or more resources at the same time.

1. To schedule a probe for a resource, choose one of the following options from the menu bar

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

**Tip:** For switches, probes also collect asset and topology information about the fabrics that include those switches.

2. Locate the resources that you want to probe.
3. Select the resource rows and click **Actions > Data Collection > Schedule**.
4. On the Data Collection Schedule window, set the probe to **Enabled**.
5. Enter the time of the data collection, select the frequency, and then click **Save**.

If you are scheduling probes for multiple resources, a time span is calculated during which the resources are probed. The resources are probed at different times during the time span to avoid excessive load on the server. A message is displayed that confirms that probe schedules are created for the resources.
Probe schedules are created for the resources that are selected. The probe jobs run according to the modified schedule. If you disabled the probes, IBM Spectrum Control stops collecting asset and status data for the monitored resources.

You select three storage systems, storage_system_a, storage_system_b, and storage_system_c. A probe schedule was defined for storage_system_c, but not for storage_system_a and storage_system_b. You set the time and frequency fields, and set the probe to Enabled. When you click Save, probe schedules are created for storage_system_a and storage_system_b. The probe schedule that was defined for storage_system_c remains unchanged.

**Verifying that a probe is running for a resource**

Verify that a probe is running for a resource to ensure that IBM Spectrum Control is collecting asset and status information about the resource.

To verify that a probe is running for a resource, use the resource list page in the web-based GUI.

1. From the menu bar, go to a resource list page for a resource type. For example, to verify that a probe is running for a storage system, go to Storage and select the type of storage system you want to monitor.
2. Locate the resource that you want to check.
3. View the Probe Status column. A value of Successful or Running indicates that the probe is collecting asset and status information about the resource. The Last Successful Probe column shows the most recent date and time when the probe successfully collected data.
4. Optional: If the Probe Status column shows a status of Failed or Warning, right-click the resource and click Data Collection > Open Probe Logs to view the messages in the log file.
5. Optional: If the Probe Status column shows a status of Never probed, right-click the resource and click Data Collection > Schedule to schedule a probe for the resource.

**Modifying probes**

Probes are data collection jobs that collect status and asset information about monitored resources in your environment. To modify a probe in IBM Spectrum Control, use the resource list page for the monitored resource in the web-based GUI.

You can modify the schedule for multiple probes at the same time.

1. From the menu bar, go to the resource list page for a resource type. For example, to modify a probe schedule for a storage system, go to Storage and select the type of storage system you want to monitor.
2. Locate the resources that you want to probe.
3. Select the resource rows and click Actions > Data Collection > Schedule.
4. On the Data Collection Schedule window, modify the schedule for the probes, and click Save.

If you are scheduling probes for multiple resources, a time span is calculated during which the resources are probed. The resources are probed at different times during the time span to avoid excessive load on the IBM Spectrum Control server.

The following rules are used to determine the settings for the probe fields when you open the Data Collection Schedule window:
If probes are enabled for all of the selected resources, the Enabled value is displayed. If probes are disabled for all of the selected resources, the Disabled value is displayed. Otherwise, the state field for the probes is blank.

For the time and frequency fields, if the selected resources have the same value for the field, the value is displayed. If the resources have different values for the field, the field is blank.

The probe jobs run according to the modified schedule. If you disabled the probes, IBM Spectrum Control stops collecting asset and status data for the monitored resources.

The changes that you make to the probe schedule are applied to all the resources that you select. For example, you select two servers with different probe frequency values. Probes are disabled for both servers. When you open the Data Collection Schedule window, the probe status field is set to Disabled and the frequency field is blank. You set the status field to Enabled and the frequency field to Every 2 days. When you click Save, the probe is enabled with the new frequency value for the two servers that you selected.

**Configuring alerts for probes**

Configure the alert notifications that are generated if a probe fails to run.

You can define alerts for a resource if you want to be notified when the following conditions occur:

- The status of its probe is error or warning. An error status occurs when a probe did not complete and no data was collected about a resource. A warning status occurs when a probe completes, but might not have collected a complete set of data.
- A specified amount of time has passed since a probe collected data about a resource. You can use this type of alert to be notified when up-to-date configuration and status data is not being collected about a resource and its existing data might be stale.

To define an alert for the probe that collects data about a resource, complete the following steps:

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. Right-click a resource in the list and click Edit Alert Definitions.
3. To enable the Probe Status alert for an attribute, click the corresponding switch icon and select a status to be alerted on. You can use this alert to be notified when a probe is only collecting partial data about a resource or not collecting any data.
4. To enable the **Last Successful Probe** alert for an attribute, click the corresponding switch icon and specify how much time can pass before an alert is generated. You can use this alert to be notified when up-to-date configuration and status data is not being collected about a resource and its existing data might be stale.

5. Click **Save**.

**Starting probes**

To immediately collect data about resources, use the **Start Probe** action in the web-based GUI.

If a probe job is not defined for the resource, use the **Schedule** action to create a probe.

You can start probes for multiple resources at the same time.

**Tip:** When you start a probe for a switch, the probe gathers statistics about the fabric that the switch is a part of.

1. From the menu bar, go to the resource list page for a resource type. For example, to start a probe for a storage system, go to **Storage** and select the type of storage system you want to monitor.
2. Locate the resources that you want to probe.
3. Select the resource rows and click **Actions > Data Collection > Start Probe**. The **Start Probe** action is available for the resources that you select if at least one of the resources meets the following criteria:
   - A probe job is defined for the resource.
   - The probe job is enabled.
   - The probe job is not currently running.

The probe status changes to **Running**.

Probes are started for all the resources that meet the criteria. For example, you select two storage systems, **Storage_System_a** and **Storage_System_b**. Probes are enabled for both of the storage systems and a probe is running for **Storage_System_a**. The probe is started for **Storage_System_b** when you select **Start Probe**. **Storage_System_a** is not affected by the action because a probe is already running for the resource.

**Viewing probes for a specific resource**

You can view information for specific resources on the resource details pages. For example, use the Storage Systems details page to view the date and time when data was last collected.

1. In the menu bar in the web-based GUI, go to a type of top-level resource. For example, if you want to view the resource information for a storage system, go to **Storage** and select the type of storage system you want to monitor.
2. Locate the resource that you want to view information for.
3. Right-click the resource row and select **View Details**.
4. In the General section of the resource details page, click **Data Collection**.

The Data Collection pane is displayed, which contains information about the data collection jobs that are defined for the resource.
**Viewing probe logs**

A probe log file is created for each run of a probe on a storage resource. Probe logs include detailed information about the status, actions, and progress of a probe.

1. In the menu bar in the web-based GUI, go to a resource list page for a resource type. For example, to view the probe logs for a storage system, go to **Storage** and select the type of storage system you want to monitor.

2. Locate the resource that you want to view.

3. Right-click the resource row, and select **Data Collection > Open Probe Logs**.

   **Restriction:** If you select multiple rows, the **Open Probe Logs** action is not available.

   The Logs page opens and shows log entries for the most recent run of the probe.

4. Optional: On the Logs page, to view a previous probe log, select a log from the **Select a log** list.

5. Optional: To view only the log entries that have a Warning or Error status, select an option from the **Show all** list. You can choose to view only entries that have the following statuses:
   - ![Error] Only error entries
   - ![Warning] Only warning entries
   - ![Error] ![Warning] Error and warning entries

6. Optional: To view an explanation of the message that is associated with a log entry, click the link in the **ID** column.

You can view the following information on the Logs page:
   - The overall status of a probe. The icon that is shown in the Select a log list represents the most critical status that was generated by an action in the job run.
   - The status for each probe action.
   - The date and time when an action was completed. The date, time, and time zone of an action is shown in the Date and Time column.
   - The description of an action.

**Collecting performance data**

Before you can monitor the performance of the resources in your environment, you must collect data about those resources. IBM Spectrum Control uses performance monitors to collect metrics for measuring the performance of storage systems and switches. Use the Performance Monitors page to view and manage performance monitors and to track threshold violations.

You must schedule and run performance monitors before you can complete other tasks, such as optimizing storage tiering, balancing pools, and running performance reports.

Before you can view performance information for resources, you must complete the following tasks:
   - Add the storage system or switch for monitoring by IBM Spectrum Control.
   - Schedule a performance monitor to collect performance data about the resource.
• Define a performance alert so that you are notified when the performance of a resource might represent a potential problem. For example, you can define an alert threshold that notifies you when the total I/O port rate for a storage system falls outside a specified range.

The performance information that is gathered by IBM Spectrum Control includes metrics that measure the performance of volumes, ports, and disks. You can view performance metrics on resource list and detail pages for switches and storage systems. For example, you can view performance metrics that are related to switches in the Performance tab on the Switches page.

Creating performance monitors
Performance monitors are data collection jobs that collect metrics for measuring the performance of storage systems and switches. You can create performance monitors in the web-based GUI when you add resources for monitoring or at a later time.

To create performance monitors, you must have Administrator privileges.

To create performance monitors for resources in your environment, you can use the list and detail pages for the resources. For example, to create performance monitors for switches, use the Switches page. You can create performance monitors for multiple resources at the same time.

Restrictions:
• You can define only one performance monitor for a resource.
• You can create performance monitors for the following resources only:
  – Storage systems
  – Switches that are managed by a CIM agent
1. From the menu bar, go to a resource list page for a resource type. For example, to create performance monitors for storage systems, go to Storage and select the type of storage system you want to monitor.
2. Locate the resources that you want to monitor.
3. Select the resource rows and click Actions > Data Collection > Schedule.
4. On the Data Collection Schedule window, set the performance monitors to Enabled. You can set a performance monitor to Enabled only if the probe is set to Enabled.
5. Select the interval for the performance monitors, and click Save. The interval represents the number of minutes over which samples of performance data are averaged. If you are creating performance monitors for multiple resources, the interval list displays the performance monitor intervals that are common to all resources. For example, you select two storage systems. Storage_System_a specifies performance monitor intervals of 5 minutes, 10 minutes, and 15 minutes. Storage_System_b specifies intervals of 10 minutes, 15 minutes, and 20 minutes. The interval list displays intervals of 10 minutes and 15 minutes.

Restrictions:
Note the following restrictions when you create performance monitors:
  a. If you specify a 1-minute interval for performance monitors, data collection samples might be inconsistent lengths. The inconsistent lengths occur because it might take longer than 1 minute to collect the data on some systems. The inconsistent lengths can cause the data in the historical line chart to be misleading. This problem can also occur for the 5-minute summary chart when a 1-minute interval was specified for data collection.
Check the messages in the job log to determine the length of time that data collection takes for a resource. If the data collection takes longer than 1 minute, consider changing the interval to 5 minutes. You can use a 1-minute interval when you want to troubleshoot a resource.

b. If you specify a 1-minute interval, the amount of data that is stored in the database repository increases significantly. IBM Spectrum Control stores only 7 days of sample data that is collected at 1-minute intervals.

Performance monitors are created for the resources that are selected, and that meet the criteria. For example, you select three storage systems, Storage_System_a, Storage_System_b, and Storage_System_c. You enable the performance monitors and set the interval field. When you click Save, performance monitors are created for Storage_System_a and Storage_System_b. Storage_System_c is not affected by the action because you cannot configure performance monitors for that storage system.

If a successful probe run is completed for a resource, the performance monitor runs according to the defined interval.

To check the progress of a performance monitor, you can complete the following actions:

- From the resource list page, right-click a resource row, and select Data Collection > Open Performance Monitor Logs. You can view detailed informational, warning, and error messages that are related to the performance monitor. Use this information to troubleshoot any errors that might occur when the performance monitor runs.
- View the Performance Monitor Status column on the resource list page.

### Verifying that a performance monitor is running for a resource

Verify that a performance monitor is running for a resource to ensure that IBM Spectrum Control is collecting performance metrics about the resource. Use performance monitors to collect metrics about the performance of storage systems and switches.

To verify that a performance monitor is running for a resource, use the resource list page in the web-based GUI.

1. From the menu bar, go to a resource list page for a resource type. For example, to verify that a performance monitor is running for a storage system, go to Storage and select the type of storage system you want to monitor.
2. Locate the resource that you want to check.
3. View the Performance Monitor Status column. A value of Completed or Running indicates that the performance monitor is collecting performance metrics about the resource. The Last Successful Monitor column shows the most recent date and time when the performance monitor successfully collected data.
4. Optional: If the Performance Monitor Status column shows a status of Running with problems, Completed with warnings, Failed, or Canceled, you can view the logs to troubleshoot the error or warning messages. To view the performance monitor logs, right-click the resource row and click Data Collection > Open Performance Monitor Logs.
5. Optional: If the Performance Monitor Status column shows a status of Disabled, to enable the performance monitor for the resource, right-click the resource row and click Data Collection > Schedule. On the Data Collection Schedule page, select Enabled.
**Tip:** You can set the performance monitor to **Enabled** only if the probe is set to **Enabled**. If a probe is set to **Disabled**, the performance monitor cannot run.

**Modifying performance monitors**

To modify all of the performance monitors that are used by IBM Spectrum Control, use the Performance Monitors page in the web-based GUI. To modify performance monitors for specific resources, use the resource list and resource detail pages.

To modify performance monitors, you must have Administrator privileges.

You can modify the schedule for multiple performance monitors at the same time.

You can enable or disable performance monitors and modify the interval. The interval represents the number of minutes over which samples of performance data are averaged.

1. In the menu bar in the web-based GUI, go to **Home > Performance Monitors**.
   - Detailed information about all performance monitors is shown in the **Performance Monitors** tab.
2. Locate the performance monitors that you want to modify.
3. Select the performance monitor rows and click **Actions > Schedule**.
4. On the Data Collection Schedule window, modify the schedule for the performance monitors.
   - If you select multiple performance monitors, the following rules are used to determine the field settings when you open the Data Collection Schedule window:
     - If all of the performance monitors that you select are enabled, the **Enabled** value is displayed. If all of the performance monitors are disabled, the **Disabled** value is displayed. Otherwise, the state field for the performance monitors is blank.
     - If the performance monitors have different interval values, the interval field is blank. If the performance monitors have the same interval value, the value is displayed.
   - Intervals that are common to all performance monitors that you select are displayed in the interval list. For example, you select performance monitors for two storage systems. **Storage_System_a** specifies performance monitor intervals of 5 minutes, 10 minutes, and 15 minutes. **Storage_System_b** specifies intervals of 10 minutes, 15 minutes, and 20 minutes. The interval list displays intervals of 10 minutes and 15 minutes.
5. Click **Save**.

The changes are applied to all the performance monitors that are selected. The performance monitors run according to the modified schedule. If you disabled a performance monitor, IBM Spectrum Control stops collecting performance metrics for the storage system or switch.

To check the progress of the performance monitors, you can complete the following actions on the Performance Monitors page:

- View information such as the status of the performance monitor and the most recent date and time when performance data was collected about a resource.
- Right-click the performance monitor row, and select **Open Logs**. You can view detailed informational, warning, and error messages that are related to the performance monitor job. Use this information to troubleshoot any errors that might occur when the job runs.
Configuring alerts for performance monitors

Configure the alert notifications that are generated if a performance monitor fails to run.

You can define alerts for a storage system or switch if you want to be notified when the following conditions occur:

- The status of its performance monitor is error or warning. An error status occurs when a performance monitor did not complete and no performance data was collected about a resource. A warning status occurs when a performance monitor completes, but might not have collected a complete set of performance data.
- A specified amount of time has passed since a performance monitor collected data about a resource. You can use this type of alert to be notified when up-to-date performance data is not being collected about a resource and its existing data might be stale.

To define an alert for the probe that collects data about a resource, complete the following steps:

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
</tbody>
</table>

2. Right-click a resource in the list and click Edit Alert Definitions.
3. To enable the Performance Monitor Status alert for an attribute, click the corresponding switch icon ( ) and select a status to be alerted on. You can use this alert to be notified when a performance monitor is only collecting partial data about a resource or not collecting any data.
4. To enable the Last Successful Monitor alert for an attribute, click the corresponding switch icon ( ) and specify how much time can pass before an alert is generated. You can use this alert to be notified when up-to-date performance data is not being collected about a resource and its existing data might be stale.
5. Click Save.

Starting and stopping performance monitors

To start or stop performance monitors for storage systems and switches, use the Performance Monitors page in the web-based GUI.

To start or stop performance monitors, you must have Administrator privileges.

You can start or stop performance monitors for multiple resources at the same time.

Restriction: A successful probe must be completed on the resource before a performance monitor can start. If a successful probe is not run, you cannot start the performance monitor for the resource.

1. In the menu bar in the web-based GUI, go to Home > Performance Monitors.
2. Click the Performance Monitors tab.
3. Locate the performance monitors that you want to start or stop.
4. Select the performance monitor rows and click **Actions > Start** or **Actions > Stop**.

Performance monitors are started or stopped for all the resources that meet the criteria. For example, you select two storage systems, Storage_System_a and Storage_System_b. Performance monitors are enabled for the storage systems and both resources are probed. A performance monitor is running for Storage_System_a but not for Storage_System_b. The performance monitor is started for Storage_System_b when you select **Start**. Storage_System_a is not affected by the action because a performance monitor is already running for the resource.

Starting or stopping a performance monitor has the following effects:

- **Start**:
  Starting a performance monitor starts the immediate collection of data from the monitored resource. The status of the performance monitor changes to **Running**.

- **Stop**:
  Stopping a performance monitor stops the collection of performance data from the resource. If a performance monitor is running, it stops. Performance data is not collected from the resource until you restart the performance monitor. The status of the performance monitor changes to **Canceled**.

To check the progress of the performance monitor, you can complete the following actions on the Performance Monitors page:

- View information such as the status of the performance monitor and the total number of threshold violations that were detected during the last sampled time of the performance monitor.
- Right-click the performance monitor row, and select **Open Logs**. You can view detailed informational, warning, and error messages that are related to the performance monitor. Use this information to troubleshoot any errors that might occur when the performance monitor runs.

**Viewing performance monitors**

To view all of the performance monitors that IBM Spectrum Control uses to collect metrics for measuring the performance of resources, use the Performance Monitors page. To view the performance monitors for specific resources, use resource list and resource details pages.

**Viewing all performance monitors:**

To view all of the performance monitors that IBM Spectrum Control uses to collect metrics for measuring the performance of storage systems and switches, use the Performance Monitors page in the web-based GUI.

The Performance Monitors page displays one row for each storage system or switch that IBM Spectrum Control is monitoring. If a performance monitor is not scheduled for a resource, the status column is set to **Disabled** for the performance monitor row.

Before IBM Spectrum Control can collect performance metrics for a resource, the resource must fulfill the following conditions:

- A probe must be run for the resource.
- For switches, the switch must be managed by a CIM agent.

1. In the menu bar in the web-based GUI, go to **Home > Performance Monitors**. On the **Performance Monitors** tab, the information about performance monitors
is organized into columns. These columns include the status of performance
monitors, the names of the monitored resources, and the most recent dates and
times when data was successfully collected.

2. Optional: View the status icons at the top of the page to view a summary of
performance monitor statuses. This summary includes the number of
performance monitors that have a Running, Running with problems, Failed, or
Not Running status.

Viewing performance monitors for specific resources:

To view the performance monitors for specific storage systems and switches, use
the resource detail pages in the web-based GUI. For example, use the Storage
Systems detail page to view performance monitor information for a specific storage
system.

If performance monitor information is not displayed on the resource detail page,
this indicates that the resource does not support the collection of performance
metrics by IBM Spectrum Control.

1. In the menu bar in the web-based GUI, go to a type of top-level resource. For
example, if you want to view the performance monitor for a storage system, go
to Storage and select the type of storage system you want to monitor.

2. Right-click a resource in the list, and select View Details. The resource detail
page is displayed.

In the General section, the number next to Data Collection represents the
number of data collection jobs that are associated with the resource. For
example, Data Collection (2) indicates that you can view a performance
monitor and a probe for the resource.

The icon next to the Data Collection link represents the most critical status of
the data collection jobs that are associated with the resource. For example, if a
job failed, the following icon is shown:

Data Collection (2) 

3. In the General section, click Data Collection to view information about the
performance monitor for the switch or storage system. On the Data Collection
pane, you can view information such as the status of the most recent run of a
performance monitor, the performance monitor interval, and the most recent
data and time that data was successfully collected.

Tip: You can use the columns on the resource list pages to view information
about the performance monitors that are defined for storage systems or
switches. For example, use the Storage Systems page to view performance
monitor information for storage systems.

Viewing performance monitors logs:

Use performance monitor logs to view detailed information about the status,
actions, and progress of a performance monitor. You can use this information to
troubleshoot any errors that might occur when a performance monitor is running.

Performance monitor logs contain informational, warning, and error messages that
are related to each action that is taken during the processing of a performance
monitor.

1. In the menu bar in the web-based GUI, go to Home > Performance Monitors.
2. In the **Performance Monitors** tab, locate the performance monitor that you want to view.

3. Right-click the performance monitor row, and select **Open Logs**.

   **Restriction:** If you select multiple rows, the **Open Logs** action is not available. The Logs page opens and shows log entries for the most recent performance monitor log. A new log file is created when you stop and restart a performance monitor.

4. Optional: On the Logs page, to view a previous performance monitor log, select a log from the **Select a log** list.

5. Optional: To view only the log entries that have a Warning or Error status, select an option from the **Show all** list. You can choose to view only entries that have the following statuses:
   - Only error entries
   - Only warning entries
   - Error and warning entries

6. Optional: To view an explanation of the message that is associated with a log entry, click the link in the **ID** column.

The information on the Logs page is automatically updated every 30 seconds. New entries are added to the end of a log. You can view the following information on the Logs page:

   - The overall status of a performance monitor. The icon that is shown in the **Select a log** list represents the most critical status that was generated by an action in the job run.
   - The status for each performance monitor action.
   - The date and time when an action was completed. The date, time, and time zone of an action is shown in the **Date and Time** column.
   - The ID of the message that is associated with an action. You can click the value in the **ID** column to view more information about a message.
   - The description of an action.

**Tip:** You can use the navigation and search functions of the web browser to locate information on the page.

### Collecting information about shares on storage systems

To collect information about shares in file systems, you must modify the **TPCD.config** file. When you provision shares, you can then view such information as the name of the share, the name of the file system, and the protocols that are used to share files.

Set the **saveNonRoot** parameter to **saveNonRoot=1** in the **TPCD.config** file to view the information that is collected about shares in the web-based GUI.

1. Open the **TPCD.config** file.

   **For Windows operating systems:**

   By default, the **TPCD.config** file is in the **TPC_installation_directory\data\config\** directory.
For Linux or UNIX operating systems:

By default, the TPCD.config file is in the TPC_installation_directory/data/config/ directory.

Where TPC_installation_directory is where IBM Spectrum Control is installed.

2. In the [server] section of the TPCD.config file, change the value of the saveNonRoot parameter to 1 as shown in the following example:

```
saveNonRoot=1
```

3. Save the TPCD.config file.

4. Restart the Data server.

When you provision new shares, you can view information about the shares on the Provisioning task page in the web-based GUI. On the Shares page, you can view more information about shares, such as the servers that have access to the share.

---

**Alerting and event processing**

Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.

Conditions that generate alerts are detected during data collection and event processing. For some storage systems such as IBM Spectrum Accelerate and the XIV, events are polled every minute from the resource. For IBM Spectrum Scale, status change events are polled frequently, typically within minutes. For other resources, events are subscription-based, where the resource itself or a data source such as a CIM agent sends the events to IBM Spectrum Control when conditions change on the resource.

Examples of storage systems that use subscription-based event processing include SAN Volume Controller, Storwize V7000, Storwize V7000 Unified, FlashSystem V840, and FlashSystem V9000. For these storage systems, a probe is automatically run when many events are received from the storage system in a short time period. To avoid performance bottlenecks, probes are run only every 20 minutes.

The conditions that trigger alert notifications depend on the type of resource that you are monitoring. In general, the following types of conditions can trigger alerts:

- An attribute or configuration of a resource changed
- The capacity of a resource fell outside a specified range
- The performance of a resource fell outside a specified range
- The storage infrastructure was changed, such as a new or removed resource
- Data is not being collected for a resource

For a list of conditions that can trigger alerts, see [“Triggering conditions for alerts” on page 252](#).

**Defining alerts**

To set up alert definitions so that you are notified when certain conditions are detected on monitored resources, you must complete the following tasks:
Adding resources for monitoring by IBM Spectrum Control.

Enabling the default alert definitions for a resource.

Specifying the conditions that trigger alerts.

Configuring how you are notified when alert conditions are detected.

Collecting data about resources.

Viewing and managing alerts and alert definitions

After alert definitions are set up and alerts are being triggered, you can complete the following tasks to manage those alert definitions and triggered alerts:

Disabling alert definitions.

Related tasks:

Related reference:

Related tasks:

Related reference:
Define alerts so that IBM Spectrum Control automatically notifies you when certain conditions or events are detected on monitored resources. Such conditions are the *triggering conditions* for the alert. The specific conditions that can trigger alerts depend on the type of resource that is being monitored.

**Alert severities**

IBM Spectrum Control determines the severity of alert conditions that it detects on monitored resources. Use the severity level to help determine the priority in which you resolve alerts.

Each severity is represented by an icon in the web-based GUI.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Critical</td>
<td>An alert with a Critical severity represents a serious problem on a resource or on its internal resources. Resolve these problems as soon as possible. Review the condition that triggered an alert for more information about the problem.</td>
</tr>
<tr>
<td>✔️</td>
<td>Critical - Acknowledged</td>
<td>An alert with a Critical severity was acknowledged. A Critical - Acknowledged severity indicates that an alert was reviewed and is either resolved or can be ignored.</td>
</tr>
<tr>
<td>🚨</td>
<td>Warning</td>
<td>An alert with a Warning severity represents potential problems on a resource or on its internal resources. Resolve these problems after you fix any critical alerts. Review the condition that triggered an alert for more information about the problem.</td>
</tr>
<tr>
<td>✔️</td>
<td>Warning - Acknowledged</td>
<td>An alert with a Warning severity was acknowledged. A Warning - Acknowledged severity indicates that an alert was reviewed and is either resolved or can be ignored.</td>
</tr>
<tr>
<td>📈</td>
<td>Informational</td>
<td>An alert with an Informational severity does not represent a problem, but is intended to provide information about actions related to a resource.</td>
</tr>
<tr>
<td>✔️</td>
<td>Informational - Acknowledged</td>
<td>An alert with an Informational severity was acknowledged. An Informational - Acknowledged severity indicates that an alert was reviewed and can be ignored.</td>
</tr>
</tbody>
</table>

**Defining alerts**

Define how and when you are alerted to changes in the configuration, attributes, and performance of monitored resources.

**Defining alerts for attribute and capacity changes**

You can define alerts that are triggered when the attributes or capacity of a resource changes. Attributes represent the key properties and configuration of a resource, such as status, versions, removals, discoveries, and data collection status. Capacity represents storage statistics such as available and used space, total space for disk, file systems, volumes, and pools, and reserved space.

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
</tbody>
</table>
2. Right-click a resource in the list and click Edit Alert Definitions.
3. Click the type of resource that you want to alert on. You can alert on one or more attributes of the resource itself, its internal resources, or a combination of both. For example, for a switch, you can alert on the attributes of the switch itself, and on the attributes of its blades, inter-switch connections, and ports.
4. Click the category of the attributes that you want to alert on.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Attributes for the key properties of a resource, such as status, version changes, removals, discoveries, state, and data collection status.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Attributes for capacity statistics of a resource, such as available and used space, total space for disk, file systems, volumes, and pools, and reserved space.</td>
</tr>
<tr>
<td>Performance</td>
<td>Attributes for the performance of storage systems and switches, such as I/O rates, data rates, response times, and port frame rates.</td>
</tr>
</tbody>
</table>

5. To enable the alert for an attribute, click the corresponding switch icon ⬅️. 

**Tip:** To disable the alert for an attribute, click the switch icon ⬅️ again. When you disable an alert, notifications are not generated for that attribute.

6. Specify the criteria for generating an alert. Use criteria such as greater than or equal to, less than or equal to, storage values, and time measurements to customize the conditions under which attributes generate alerts. For example, for a capacity attribute such as Available Disk Space, you can specify that an alert is generated when the amount of available space on a resource's disks is less than or equal to 50 GiB. The operator (less than or equal to) + a specified amount of space (50) + the unit of measurement (GiB) is the criteria that determines if an alert is generated.

**Tips:**
- Not all attributes require criteria for generating alerts. The category and type of an attribute determines whether you can specify criteria and the options that you can select.
- Some attributes can use the operators such as is, is not, and contains. For example, for the Firmware attribute on a DS8000 storage system, select the operator contains. Then, in the value field, type R5 to be notified if the firmware is at the R5 level rather than at a later version such as R6.3, R6.2, or R6.3. This alert definition might be useful if you want to be notified when the firmware for a storage system was reverted to a previous version for some reason.
7. Assign a severity to an alert. Assigning a severity can help you more quickly identify and address the critical conditions that are detected on resources. The severity that you assign depends on the guidelines and procedures within your organization. Default assignments are provided for each alert.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Info" /></td>
<td>Assign this severity to alerts that might not require any action to resolve and are primarily for informational purposes. For example, assign an informational severity to alerts that are generated when a new pool is added to a storage system.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Assign this severity to alerts that are not critical, but represent potential problems. For example, assign a warning severity to alerts that notify you when the status of a data collection job is not normal.</td>
</tr>
<tr>
<td><img src="image" alt="Error" /></td>
<td>Assign this severity to alerts that are critical and need to be resolved. For example, assign a critical severity to alerts that notify you when the amount of available space on a file system falls below a specified threshold.</td>
</tr>
</tbody>
</table>

8. Specify how you are notified of alert violations and if you want a script to be run.

9. Specify how often you are notified of alerts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not suppress alerts</td>
<td>Receive alert notifications whenever an alert violation is detected.</td>
</tr>
<tr>
<td>Only alert once until problem clears</td>
<td>Receive one notification for an alert violation, even if the condition is violated multiple times.</td>
</tr>
<tr>
<td>Only generate alerts every</td>
<td>Receive one notification when an alert is initially violated. The alert is suppressed and no notifications are sent until both the specified time has passed and the alert is triggered again.</td>
</tr>
<tr>
<td>Do not alert until the condition is violated for more than</td>
<td>Do not receive notifications for an alert unless the violation is not cleared for longer than the specified time.</td>
</tr>
</tbody>
</table>

10. Optional: Duplicate an alert. Use this action when you want to define another alert for the same attribute but with different criteria and settings. Duplicating alerts can be helpful in the following situations:

   - When you want to generate separate warning alerts and critical alerts for different conditions on the same attribute.
     For example, for a capacity attribute such as Available Disk Space, you might want to define the following alerts:

     - Define a warning alert ![Warning](image) to be generated when the amount of available space on a resource's disks is less than or equal to 50 GiB.
• Duplicate the alert, but this time, specify a critical severity when the amount of available space on a resource's disks is less than or equal to 10 GiB.

• When you want to send alert notifications to different people based on the severity of an alert.

In the previous example for the Available Disk Space attribute, you can configure the notification settings so that warning alerts are sent to junior administrators, while critical alerts are sent to more senior administrators to resolve.

11. Click Save.

Conditions that generate alerts are detected during data collection and event processing. For some storage systems such as IBM Spectrum Accelerate and the XIV, events are polled every minute from the resource. For IBM Spectrum Scale, status change events are polled frequently, typically within minutes. For other resources, events are subscription-based, where the resource itself or a data source such as a CIM agent sends the events to IBM Spectrum Control when conditions change on the resource.

You can view information about alert violations at the following locations in the GUI:

Table 22. Locations where you can view alert violations for attribute and capacity alerts.

<table>
<thead>
<tr>
<th>Task</th>
<th>Location in GUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>View all alerts</td>
<td>In the menu bar, select Home &gt; Alerts.</td>
</tr>
</tbody>
</table>
| View all the alerts that were generated for storage systems | 1. In the menu bar, select one of the following options:  
   - Storage > Block Storage Systems  
   - Storage > File Storage Systems  
   - Storage > Object Storage Systems  
2. Click the Alerts tab. |
| View the alerts for a specific storage system | 1. In the menu bar, choose one of the following options:  
   - Storage > Block Storage Systems  
   - Storage > File Storage Systems  
2. Double-click a storage system.  
3. Click Alerts in the General section. |
| View all the alerts that were generated for switches | 1. In the menu bar, select Network > Switches.  
2. Click the Alerts tab. |
| View the alerts for a specific switch | 1. In the menu bar, select Network > Switches.  
2. Double-click a switch.  
3. Click Alerts in the General section. |
| View all the alerts that were generated for fabrics | 1. In the menu bar, select Network > Fabrics.  
2. Click the Alerts tab. |
| View the alerts for a specific fabric | 1. In the menu bar, select Network > Fabrics.  
3. Click Alerts in the General section. |
| View all the alerts that were generated for hypervisors | 1. In the menu bar, select Servers > Hypervisors.  
2. Click the Alerts tab. |
Table 22. Locations where you can view alert violations for attribute and capacity alerts (continued).

<table>
<thead>
<tr>
<th>Task</th>
<th>Location in GUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the alerts for a specific hypervisor</td>
<td>1. In the menu bar, select Servers &gt; Hypervisors.</td>
</tr>
<tr>
<td></td>
<td>2. Double-click a hypervisor.</td>
</tr>
<tr>
<td></td>
<td>3. Click Alerts in the General section.</td>
</tr>
<tr>
<td>View all the alerts that were generated for servers</td>
<td>1. In the menu bar, select Servers &gt; Servers.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Alerts tab.</td>
</tr>
<tr>
<td>View the alerts for a specific server</td>
<td>1. In the menu bar, select Servers &gt; Servers.</td>
</tr>
<tr>
<td></td>
<td>2. Double-click a server.</td>
</tr>
<tr>
<td></td>
<td>3. Click Alerts in the General section.</td>
</tr>
</tbody>
</table>

**Defining alerts for performance metrics**

You can define alerts that are triggered when the performance of a storage system or switch falls outside a specified threshold.

To define a performance alert, select a metric that you want to measure and specify a threshold value. When the performance of that resource falls outside the threshold, an alert is generated. For example, you can define an alert that notifies you when the back-end response times for managed disks on a SAN Volume Controller exceed 35 milliseconds per read operation. The Overall Back-end Response Time is a metric that measures the average number of milliseconds that it takes to service each read operation on a managed disk.

**Tip:** You cannot apply different thresholds to internal resources of the same type. For example, a storage system has two ports, Port A and Port B. You cannot set different threshold values for each port on the storage system. When you define a performance alert for ports, its threshold value is applied to all of the ports on the storage system.

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
</tbody>
</table>

2. Right-click a resource in the list and click **Edit Alert Definitions**.
3. Click the type of resource that you want to alert on. You can alert on the performance of the resource itself, its internal resources, or a combination of both. For example, for a switch, you can alert on the performance of the switch itself, and on the performance of its inter-switch connections and ports.
4. Click **Performance**.
5. Click **Add Metrics**.
6. Select one or more metrics to alert on and click **OK**. Metrics are available for measuring and alerting on the performance of volumes, ports, and disks. The type of storage system or switch determines the metrics that you can select.
7. To enable the alert for a performance metric, click the corresponding switch icon (겠습니다).
Tip: To disable the alert for a performance metric, click the switch icon again. When you disable an alert, notifications are not generated for that metric.

8. Specify the criteria for generating an alert. Criteria includes an operator and a threshold value.
   a. Select an operator. An operator determines if an alert is triggered when the performance of a resource is greater than or equal to or less than or equal to the specified threshold value.
   b. Enter a threshold value. For example, to trigger an alert if the Total I/O Rate for a storage system is greater than or equal to 500 ops/s, enter the value 500.

Tips for threshold values:
   • IBM Spectrum Control provides recommended values for threshold values that do not vary much between environments. For example, the default threshold values for Port Send Bandwidth Percentage are greater than or equal to 75% for warning alerts, and greater than or equal to 85% for critical alerts.
   
   However, for metrics that measure throughput and response times, thresholds can vary because of workload, model of hardware, amount of cache memory, and other factors. In these cases, there are no recommended values. To help determine threshold values for a resource, collect performance data over time to establish a baseline of the normal and expected performance behavior for that resource. After you determine a set of baseline values, define alerts to trigger if the measured performance behavior falls outside the normally expected range.
   
   • For some metrics, lower values might indicate more stress and higher values might indicate idle behavior. For example, a lower threshold value for the Cache Holding Time Threshold metric might indicate a performance problem.

9. Assign a severity to an alert. Assigning a severity can help you more quickly identify and address the critical performance conditions that are detected on resources. The severity that you assign depends on the guidelines and procedures within your organization. Default assignments are provided for each alert.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Assign this severity to alerts that might not require any action to resolve and are primarily for informational purposes.</td>
</tr>
<tr>
<td>!</td>
<td>Assign this severity to alerts that are not critical, but represent potential problems. For example, assign a warning severity to alerts that notify you when the Port Send Bandwidth Percentage is greater than or equal to 75% but less than 85%.</td>
</tr>
<tr>
<td>✗</td>
<td>Assign this severity to alerts that are critical and need to be resolved. For example, assign a critical severity to alerts that notify you when the Port Send Bandwidth Percentage is greater than or equal to 85%.</td>
</tr>
</tbody>
</table>
10. Evaluate the current and historical performance of a resource to help determine the threshold value for an alert. In the performance chart, a yellow horizontal line represents the threshold value for warning alerts; a red horizontal line represents the threshold value for critical alerts.
   a. To customize the chart, click Top 10 or Bottom 10 to show resources according to their performance, click a time period, and change the start and end dates for the data that is displayed.
   b. To filter any violations when a performance threshold for a related alert is reached, select the check box to ignore that condition. Specify a threshold value for the related alert.

11. Click Done.

12. Specify how you are notified of alert violations and if you want a script to be run.

13. Specify how often you are notified of alerts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not suppress alerts</td>
<td>Receive alert notifications whenever an alert violation is detected.</td>
</tr>
<tr>
<td>Only alert once until problem clears</td>
<td>Receive one notification for an alert violation, even if the condition is violated multiple times.</td>
</tr>
<tr>
<td>Only generate alerts every</td>
<td>Receive one notification when an alert is initially violated. The alert is suppressed and no notifications are sent until both the specified time has passed and the alert is triggered again.</td>
</tr>
<tr>
<td>Do not alert until the condition is violated for more than</td>
<td>Do not receive notifications for an alert unless the violation is not cleared for longer than the specified time.</td>
</tr>
</tbody>
</table>

14. Optional: Duplicate an alert. Use this action when you want to define another alert for the same metric but with different criteria and settings. Duplicating alerts can be helpful in the following situations:
   • When you want to generate separate warning alerts and critical alerts for different thresholds on the same metric.
     For example, for the CRC Error Rate metric for ports, you might want to define the following alerts:
     - Define a warning alert to be generated when the number of frames per second that are received with cyclic redundancy check (CRC) errors is greater than or equal to .01 counts per second.
     - Duplicate the alert, but this time, specify a critical severity when the CRC error rate is greater than or equal to .033 counts per second.
   • When you want to send alert notifications to different people based on the severity of an alert.
     In the previous example for the CRC Error Rate metric, you can configure the notification settings so that warning alerts are sent to junior administrators, while critical alerts are sent to more senior administrators to resolve.
15. Click **Save**.

To determine whether alerts are generated, the performance metrics that are collected for resources are compared with the threshold values that you defined for those alerts. You can view information about alert violations at the following locations in the GUI:

**Table 23. Locations where you can view alert violations for performance metrics.**

<table>
<thead>
<tr>
<th>Task</th>
<th>Location in GUI</th>
</tr>
</thead>
</table>
| View all the alerts that were generated for storage systems | 1. In the menu bar, choose one of the following options:  
   - **Storage > Block Storage Systems**  
   - **Storage > File Storage Systems**  
2. Click the **Alerts** tab. |
| View all the alerts that were generated for switches | 1. In the menu bar, select **Network > Switches**.  
2. Click the **Alerts** tab. |
| View the alerts for a specific storage system | 1. In the menu bar, choose one of the following options:  
   - **Storage > Block Storage Systems**  
   - **Storage > File Storage Systems**  
2. Double-click a storage system.  
3. Click **Alerts** in the **General** section. |
| View the alerts for a specific switch | 1. In the menu bar, select **Network > Switches**.  
2. Double-click a switch.  
3. Click **Alerts** in the **General** section. |
| View all performance alerts | 1. In the menu bar, select **Home > Alerts**.  
2. Click the performance icon on the summary chart. |

**Tip:** If a performance monitor is already collecting data about a resource when you add, modify, or remove a performance alert for that resource, changes are applied dynamically. You do not have to stop and restart the performance monitor to apply the changes. A confirmation message is recorded in the log of the performance monitor when the alert is updated.

** Suppressing alerts**

Use suppression options to determine how often you receive alerts.

To specify a suppression option for an alert definition, complete the following steps:

1. To select a resource, choose one of the following options from the menu bar:
2. Right-click a resource in the list and click **Edit Alert Definitions**.

3. To suppress notifications for an alert, click the suppression icon 🗑. Specify how often you are notified of alerts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not suppress alerts</td>
<td>Receive alert notifications whenever an alert violation is detected.</td>
</tr>
<tr>
<td>Only alert once until problem clears</td>
<td>Receive one notification for an alert violation, even if the condition is violated multiple times.</td>
</tr>
<tr>
<td>Only generate alerts every</td>
<td>Receive one notification when an alert is initially violated. The alert is suppressed and no notifications are sent until both the specified time has passed and the alert is triggered again.</td>
</tr>
<tr>
<td>Do not alert until the condition is violated for more than</td>
<td>Do not receive notifications for an alert unless the violation is not cleared for longer than the specified time.</td>
</tr>
</tbody>
</table>

4. Click **Done**.

5. Click **Save**.

**Tip:** If a performance monitor is already collecting data about a resource when you add, modify, or remove a performance alert definition for that resource, changes are applied dynamically. You do not have to stop and restart the performance monitor to apply the changes. A confirmation message is recorded in the log of the performance monitor when the alert is updated.

**Viewing and modifying alert definitions**

View and modify the attributes and conditions that trigger alerts for resources and the notification settings for those conditions.

**Viewing alert definitions for a resource**

View the attributes, triggering conditions, notification settings, suppression settings, and threshold values that are defined in alerts.

To view an alert definition, complete the following steps:

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. Right-click a resource in the list and click **Edit Alert Definitions**.

3. Click a category to view the alert definitions for that category. For example, click **Performance** or **Capacity** to view the performance and capacity alerts that
are defined for a resource. Click a resource category, such as **Volumes**, to view all the alerts that are defined for that resource.

4. Optional: 
   View how you are notified of alert violations and if a script is specified.

5. Optional: 
   Evaluate the current and historical performance of a resource. In the performance chart, a yellow horizontal line represents the threshold value for warning alerts; a red horizontal line represents the threshold value for critical alerts.

6. Optional: 
   View how often you are notified of alerts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not suppress alerts</td>
<td>Receive alert notifications whenever an alert violation is detected.</td>
</tr>
<tr>
<td>Only alert once until problem clears</td>
<td>Receive one notification for an alert violation, even if the condition is violated multiple times.</td>
</tr>
<tr>
<td>Only generate alerts every</td>
<td>Receive one notification when an alert is initially violated. The alert is suppressed and no notifications are sent until both the specified time has passed and the alert is triggered again.</td>
</tr>
<tr>
<td>Do not alert until the condition is violated for more than</td>
<td>Do not receive notifications for an alert unless the violation is not cleared for longer than the specified time.</td>
</tr>
</tbody>
</table>

**Disabling or enabling alert definitions**

Disable an alert definition so that IBM Spectrum Control does not generate notifications for its specified condition. You can re-enable alert definitions at any time.

1. In the menu bar, select the resource that contains the alert definition to disable. For example, to disable the alert definition for a block storage system, select **Storage > Block Storage Systems**.
2. Right-click the resource that contains the alert definition and select **Edit Alert Definitions**.
3. Locate the alert definition that you want to disable.
4. Click the switch icon next to the definition so that it appears like this: ![Off](image). **Tip:** To enable the definition again, click the icon so that it appears like this: ![On](image).
5. Click **Save**.

**Modifying alert definitions**

Modify an alert definition to change its triggering conditions, notification settings, threshold values, and suppression settings.

To edit an alert definition for a resource, complete the following steps:

1. To select a resource, choose one of the following options from the menu bar:
2. Right-click the resource that contains the alert definition and select **Edit Alert Definitions**.

3. Locate the alert definition that you want to edit.

4. To enable or disable an alert definition, click the corresponding switch icon:
   - The alert is enabled.
   - The alert is disabled.

5. Edit the criteria for generating an alert. Criteria includes operators such as greater than or equal to, less than or equal to, is, is not, and contains, and it can include values for storage space, performance metrics, and time measurements.

6. Change the severity for the alert. Assigning a severity can help you more quickly identify and address the critical conditions that are detected on resources. The severity that you assign depends on the guidelines and procedures within your organization. Default assignments are provided for each alert.

7. For performance alerts, edit the threshold value by evaluating the current and historical performance of a resource. In the performance chart, a yellow horizontal line represents the threshold value for warning alerts; a red horizontal line represents the threshold value for critical alerts.

8. Change how you are notified of alerts and if you want a script to be run.

9. Specify how often you are notified of alerts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not suppress alerts</td>
<td>Receive alert notifications whenever an alert violation is detected.</td>
</tr>
<tr>
<td>Only alert once until problem clears</td>
<td>Receive one notification for an alert violation, even if the condition is violated multiple times.</td>
</tr>
<tr>
<td>Only generate alerts every</td>
<td>Receive one notification when an alert is initially violated. The alert is suppressed and no notifications are sent until both the specified time has passed and the alert is triggered again.</td>
</tr>
<tr>
<td>Do not alert until the condition is violated for more than</td>
<td>Do not receive notifications for an alert unless the violation is not cleared for longer than the specified time.</td>
</tr>
</tbody>
</table>

10. Click **Save** when you are done editing the definition.
Tip: If a performance monitor is already collecting data about a resource when you add, modify, or remove a performance alert for that resource, changes are applied dynamically. You do not have to stop and restart the performance monitor to apply the changes. A confirmation message is recorded in the log of the performance monitor when the alert is updated.

Viewing and modifying alert notification settings

View and modify the alert notification settings to determine the actions that are taken when alert conditions are detected for resources. The settings are applied to all of the conditions that are specified for the resources. You can view and modify the alert notification settings for a single resource or for multiple resources.

Viewing the alert notification settings for a resource

View the notification settings that determine the actions that are taken when alert conditions are detected for a resource. The settings are applied to all of the alert definitions that are enabled for the resource.

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. To view the alert notification settings for a resource, choose one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click the resource in the list and click Edit Alert Notification Settings.</td>
<td>Use this option to view the notification settings for an alert from the resource list page.</td>
</tr>
<tr>
<td>Right-click the resource and click View Details. The resource page is displayed. In the General section, click Alerts, and then click the Notification Settings tab.</td>
<td>Use this option to view the notification settings for an alert from the resource page.</td>
</tr>
</tbody>
</table>

3. View the notification settings that apply to all of the alert definitions that are enabled for the resource.

4. To close the Notification Settings page, click Cancel.

Viewing the alert notification settings for multiple resources

View the notification settings that determine the actions that are taken when alert conditions are detected for multiple resources. The settings are applied to all of the alert definitions that are enabled for the resources.

When you select multiple resources, the check box choice for each notification setting indicates how the setting is applied to the resources:
<table>
<thead>
<tr>
<th>Icon</th>
<th>Status of the alert notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>The notification setting applies to all of the selected resources.</td>
</tr>
<tr>
<td>☐</td>
<td>The notification setting does not apply to any of the selected resources.</td>
</tr>
<tr>
<td>❗</td>
<td>The notification setting has different values for the selected resources.</td>
</tr>
</tbody>
</table>

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. To view the alert notification settings for multiple resources, press Ctrl and right-click each resource. Click Edit Alert Notification Settings.

3. To close the Notification Settings page, click Cancel.

**Modifying the alert notification settings for a resource**

You can modify the alert notification settings to determine the actions that are taken when alert conditions are detected for a resource. The settings are applied to all of the alert definitions that are specified for the resource.

Configure IBM Spectrum Control to send alert notifications by using email, SNMP traps, or a Tivoli Netcool/OMNIbus server.

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. To modify the alert notification settings for a resource, choose one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click the resource in the list and click Edit Alert Notification Settings.</td>
<td>Use this option to edit the notification settings for an alert from the resource list page.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Right-click the resource and click View Details. The resource page</td>
<td>Use this option to edit the notification settings for an alert from the resource page.</td>
</tr>
<tr>
<td>is displayed. In the General section, click Alerts, and then</td>
<td></td>
</tr>
<tr>
<td>click the Notification Settings tab. Click Edit.</td>
<td></td>
</tr>
</tbody>
</table>

3. Specify the email addresses that you want to notify when an alert is generated. The email addresses that you specify override the addresses that were defined at Settings > Alert Notifications.

  **Tip:** The email addresses that you define are applied to all the alert definitions for a resource, unless overridden. To override these settings, edit the notification settings for a specific alert definition.

4. Optional: Send alert notifications to a Tivoli Netcool/OMNIbus server.
5. Optional: Send SNMP trap messages when an alert is generated.
6. Optional: Write alert messages to the OS log and select their level of severity.
7. Click Save.

### Modifying the alert notification settings for multiple resources

Modify the alert notification settings to determine the actions that are taken when alert conditions are detected for multiple resources. The settings are applied to all of the alert definitions that are enabled for the selected resources.

Configure IBM Spectrum Control to send alert notifications by using email, SNMP traps, or a Tivoli Netcool/OMNIbus server.

When you select multiple resources, the check box choice for each notification setting indicates how the setting is applied to the resources:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status of the alert notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>The notification setting applies to all of the selected resources.</td>
</tr>
<tr>
<td>❌</td>
<td>The notification setting does not apply to any of the selected resources.</td>
</tr>
<tr>
<td>✸</td>
<td>The notification setting has different values for the selected resources.</td>
</tr>
</tbody>
</table>

1. To select a resource, choose one of the following options from the menu bar:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Menu bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block storage systems</td>
<td>Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td>File storage systems</td>
<td>Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td>Object storage systems</td>
<td>Storage &gt; Object Storage Systems</td>
</tr>
<tr>
<td>Servers</td>
<td>Servers &gt; Servers</td>
</tr>
<tr>
<td>Hypervisors</td>
<td>Servers &gt; Hypervisors</td>
</tr>
<tr>
<td>Switches</td>
<td>Network &gt; Switches</td>
</tr>
<tr>
<td>Fabrics</td>
<td>Network &gt; Fabrics</td>
</tr>
</tbody>
</table>

2. To modify the alert notification settings for multiple resources, press Ctrl and right-click each resource. Click **Edit Alert Notification Settings**.
3. Specify the email addresses that you want to notify when an alert is generated. The email addresses that you specify override the addresses that were defined at Settings > Alert Notifications.

**Tip:** The email addresses that you define are applied to all the alert definitions for the selected resources, unless overridden. To override these settings, edit the notification settings for a specific alert definition.

4. Optional: Send alert notifications to a Tivoli Netcool/OMNibus server.
5. Optional: Send SNMP trap messages when an alert is generated.
6. Optional: Write alert messages to the OS log and select their level of severity.
7. Click **Save**.

**Viewing alerts**

View the alerts that were detected on monitored resources.

**Viewing all alerts**

Use the Alerts page in the GUI as a central location to view and manage all the alerts that were detected by IBM Spectrum Control.

The Alerts page is organized into two sections:

**Alerts summary chart**

The summary chart at the top of the page is a visual representation of the alerts that were detected on monitored resources. The chart consists of stacked bars with the number and severity of current alerts on the y-axis and the resource type on the x-axis. The y-axis labeling scales dynamically according to the highest number of alerts in any of the categories.

**Alerts list**

The alerts list shows information about all the alerts that were detected on monitored resources. Information in the list is organized into columns. These columns include information about the condition that was detected, the severity of the alert, when the alert was detected, and the names of the resources where the alert condition was detected.

The version of IBM Spectrum Control that detected an alert determines where information about the alert is displayed. Alerts that were generated in versions of the product before Tivoli Storage Productivity Center version 5.1 are only displayed on the Alerts page. Alerts that were generated in Tivoli Storage Productivity Center version 5.1 or later are displayed on the Alerts page and in the Alerts tab on the pages for the related resources.

1. In the menu bar in the GUI, go to **Home > Alerts**. Information about alerts is shown in the list of alerts.

   **Tip:** Hover the mouse pointer over a condition to view a summary of the event that triggered the alert.

2. Optional: To view the number of alerts for a specific type of resource, hover the mouse pointer over the related icon in the summary chart. For example, if you want to view the number of Critical, Warning, and Informational alerts that were triggered by hypervisors, hover the mouse pointer over the **Hypervisors** icon.
3. Optional: To filter the list of alerts for a specific type of resource, click the icon for that resource in the summary chart. For example, if you only want to view a list of alerts for hypervisors, click the Hypervisors icon.

**Tip:** To view descriptions of the icons and columns on the Alerts page, click the Help icon in the upper-right corner of the page.

### Viewing alerts for a type of resource

Use resource list pages in the IBM Spectrum Control GUI to view only the alerts for a specific type of top-level resource. Each resource list page has an Alerts tab that lists only the alerts for monitored storage systems, servers, hypervisors, switches, or fabrics. For example, you can use the list page for block storage systems to view only the alerts that were detected on monitored block storage systems.

1. In the menu bar in the GUI, go to a type of top-level resource. For example, if you want to view the alerts that are related to block storage systems, go to Storage > Block Storage Systems.
2. Click the Alerts tab to view a list of all the alerts for the monitored resources of that type.

   The information about alerts is organized into columns. These columns include information about the condition that was detected, the severity of the alert, when the alert was detected, and the names of the resources where the alert condition was detected. Hover the mouse pointer over a condition to view a summary of the event that triggered the alert.

   **Tip:** The icon on the Alerts tab represents the most severe alert condition that was detected on the monitored resources. For example, if one of the jobs for storage systems failed, the following icon is shown on the tab:

   ![Alerts](image)

3. Optional: View the icons at the top of the Alerts tab for a summary of alert severities. This summary includes the number of alerts that have a Critical, Warning, Informational, or Acknowledged status.

   **Tip:** To view descriptions of the icons and columns on the Alerts tab, click the Help icon in the upper-right corner of the page.

### Viewing alerts for a specific resource

Use resource detail pages in the IBM Spectrum Control GUI to view only the alerts for a specific top-level resource. Each resource details page has an Alerts link that lists only the alerts for a monitored storage system, server, hypervisor, switch, or fabric. For example, you can use the details page for a storage system to view only the alerts that were detected for that storage system.

1. In the menu bar in the GUI, go to a type of top-level resource. For example, if you want to view the alerts that are related to storage systems, go to Storage and select the type of storage system you want to monitor.
2. Right-click a resource in the list and select **View Details**. In the **General** section, the number next to **Alerts** represents the number of alert conditions that were detected on the resource. For example, **Alerts (25)** indicates that 25 alerts were detected on the resource.
The icon next to the Alerts link represents the most severe alert condition that was detected on the resource. For example, if alerts with a Warning severity were detected the following icon is shown:

![Alerts (25) icon]

3. **Click the Alerts link in the General section to view a complete list of the alerts that were detected on the resource.**

The information about alerts is organized into columns. These columns include information about the condition that was detected, the severity of the alert, when the alert was detected, and the names of the resources where the alert condition was detected. Hover the mouse pointer over a condition to view a summary of the event that triggered the alert.

**Tip:** To view descriptions of the icons and columns that are shown for alerts, click the Help icon in the upper-right corner of the page.

4. **Optional: View the icons at the top of the page for a summary of alert severities that were detected.** This summary includes the number of alerts that have a Critical, Warning, Informational, or Acknowledged status.

### Acknowledging alerts

Some alerts in IBM Spectrum Control are triggered by conditions that commonly occur and can be ignored. In such cases, you acknowledge these alerts to indicate that they were reviewed and do not require immediate resolution. By acknowledging alerts, you can more quickly identify the other alerts in lists that must still be reviewed and resolved.

**Tip:** Acknowledging alerts does not affect the status of resources. The status of a resource is determined by its consolidated status and the propagated status of its internal resources, not by alerts that are generated. For information about how to acknowledge the status of a resource, see “Acknowledging the condition and status of resources” on page 146.

To acknowledge an alert, complete the following steps:

1. **In the IBM Spectrum Control GUI, go to a list of alerts that includes the alerts that you want to acknowledge.** For example, if you want to acknowledge the alerts for a specific server, complete the following steps.
   a. In the menu bar, go to Servers > Servers.
   b. Right-click the server that has alerts you want to acknowledge and select View Details.
   c. Click the Alerts link.

2. **Right-click the alert that you want to acknowledge and select Acknowledge alerts.** The severity of the alert is changed to Acknowledged on the Alerts page, resource list page, and resource details page.

   For example, if you acknowledge a server alert that has a Warning severity, it is shown on the Alerts page, Servers page, and Server details page with the following severity:

   ![Warning - Acknowledged]

3. **Optional: To acknowledge multiple alerts at the same time, press Ctrl and click each alert.** To select a series of alerts, select the first alert, and then press Shift and click the last alert. When the alerts are selected, right-click a row in the list and select Acknowledge alerts.
4. Optional: To acknowledge all the alerts that are shown in a list, select **Acknowledge all alerts** from the **Actions** menu.

5. Optional: To acknowledge all the alerts with an Informational severity in a list, select **Acknowledged informational alerts** from the **Actions** menu. You might want to acknowledge all Informational alerts when you want to view only alerts that represent potential or serious problems that require action to resolve.

**Removing alerts**

Remove alerts when you no longer require to view them.

By default, alerts are automatically removed based on retention settings that are defined on the History Retention page in the IBM Spectrum Control GUI. However, you can use the following procedure to manually remove alerts at any time.

1. In the GUI, go to a list of alerts that includes the alerts that you want to remove. For example, if you want to remove alerts for all different types of top-level resources, go to **Home > Alerts**. If you want to remove alerts for a specific type of resource such as storage systems, go to **Storage** and select the type of storage system you want to monitor, and click the **Alerts** tab.

2. Right-click the alert that you want to remove and select **Remove alerts**.

3. Click **Remove** to remove the alert. When you remove an alert, it is no longer shown on the Alerts page or in the **Alerts** tabs on the related resource list and resource detail pages.

   For example, if you remove an alert for a fabric, that alert is removed from the Alerts page, Fabrics page, and Fabric details page.

4. Optional: To remove all the alerts that are shown in a list, select **Remove all alerts** from the **Actions** menu.

5. Optional: To remove all the acknowledged alerts that are shown in a list, select **Remove acknowledged alerts** from the **Actions** menu.

**Viewing information about resources**

You can view detailed information about the resources that are monitored by IBM Spectrum Control. Resources include storage systems, volumes, pools, servers, hypervisors, fabrics, and switches. You can also view information about internal and related resources.

**Remember:** Data collection jobs retrieve information about monitored resources. To ensure that the latest information about resources is available in the web-based GUI, run data collection jobs regularly. To learn about how to collect data, see "Collecting data" on page 98.

**How information is organized**

Information about monitored resources is organized into different pages in the web-based GUI. You can use the pages to view summary information about all types of monitored resources, such as storage systems, fabrics, and switches. You can see what resources are consuming storage and the alerts that are being detected on those resources. You can also view a chart of the most active storage systems in your environment.
Dashboard view

The dashboard is view displayed when you start a new session of IBM Spectrum Control or when you go to Home > Dashboard in the menu bar. Use the dashboard to view the following summary information about a storage environment:

- Condition of storage: block, file, and object storage systems
- Condition of storage consumers: hypervisors, servers, departments, and application
- Condition of network resources: fabrics and switches
- Number error, warning, and information alerts that are generated on resources
- Most active storage systems in your environment.

You can click on resource icons in the dashboard to add more resources for monitoring and to see detailed information about resources that IBM Spectrum Control is currently monitoring. Position the mouse pointer over the lines in the Most Active Storage Systems chart to see performance information about specific resources. For more information about the dashboard, see “Dashboard view” on page 133.

Resource list pages

Use a resource list page as a central location for viewing information about the top-level resources of a specific type. For example, use the File Storage Systems page to view a list of the file storage systems that are monitored by IBM Spectrum Control. Each resource list page corresponds to a specific type of resource, which includes block storage systems, file storage systems, object storage systems, volumes, pools, servers, hypervisors, switches, and fabrics. You can view the following information on resource list pages:

- Overall condition of the resources
- Key information about the resources
- Alerts that were generated for the resources
- Jobs that were run for the resources

To learn about how to access the list pages for resources, see “Viewing information about top-level resources” on page 137.

Note: Volumes and pools are internal resources of storage systems, but have their own resource list pages so that you can view them all in a central location.

Resource detail pages

Use resource details pages to view information about resources that are internal or related to a top-level resource. For example, use the File Storage System details page to view detailed information about a specific file storage system. You can view the following information on resource details pages:

- The overall capacity and storage usage for a resource
- The status of resources
- Key information about a resource
- Alerts that were generated for a resource
- Data collection that was run for a resource
- Information about components that exist in top-level resources
- Information about the resources that are related to another resource
To learn about how to access detail pages for resources, see "Viewing information about internal, object, and related resources" on page 138.

**Alerts page**

Use the Alerts page to view and manage the alert conditions that were detected on monitored resources. Specifically, you can complete the following actions:

- View the overall number of alerts that were detected on monitored resources. This information is presented in a bar chart for the following types of alerts:
  - Database
  - Fabric
  - Hypervisor
  - Other
  - Performance
  - Server
  - Storage system
  - IBM Spectrum Control
- View information about specific alerts, including severity, last occurrence, and the resources where they were detected.
- Acknowledge alerts that were reviewed but are not yet resolved.
- Unacknowledge alerts.
- Remove alerts from the page.

To access the Alerts page, go to **Home > Alerts** in the menu bar.

**Performance Monitors page**

IBM Spectrum Control can collect information about the performance of monitored storage systems and switches. This information includes key performance metrics. On the Performance Monitors page, you can view detailed information about performance monitors that are collecting data. Use this information to identify performance monitors that are encountering problems when they run. You can also view the metrics that are collected by a performance monitor for a resource.

To access the Performance Monitors page, select **Home > Performance Monitors**.

**Tasks page**

Use the Tasks page to view and manage the tasks that IBM Spectrum Control uses to optimize resources and provision storage. Tasks are created when you complete any of the following actions:

- Assign storage to servers, hypervisors, or a cluster by using the Provision Storage wizard.
- Move volumes to higher or lower tiers by using the Analyze Tiering wizard.
- Move or convert volumes by using the Transform Storage wizard.
- Distribute the workload of volumes across pools on the same tier by using the Balance Pools wizard.

To access the Tasks page, go to **Home > Tasks** in the menu bar.
System Management page

Use the System Management page to view information about the overall condition of IBM Spectrum Control. You can view information about the servers on which IBM Spectrum Control is installed. This information includes component server and database status, certain server alerts and database connection alerts, server file-system capacity information, and remote volume-performance information.

To access the System Management page, go to Home > System Management in the menu bar.

Reporting

Use the optional Cognos Business Intelligence reporting tool in the web-based GUI to view detailed reports about resources. The following reports are available:

Predefined reports

These reports are included with IBM Spectrum Control. The following types of predefined reports are available:

- Capacity and relationships of resources
- Performance
- Historical space
- Storage tiering

Custom reports

Unlike predefined reports, you can select the information that you want to include in custom reports. Custom reports can contain detailed information about the relationships between monitored resources, the properties of monitored resources, and detailed information about the performance of monitored resources.

To learn about how to use the Cognos Business Intelligence reporting tool, see Reporting in IBM Spectrum Control.

Dashboard view

Use the dashboard to monitor the overall condition of monitored resources and identify potential problem areas in a storage environment. You can also view the condition of the applications, groups, and other entities that consume storage on resources. The dashboard also displays alerts, as well as a chart showing the most active storage systems.

Viewing the status of monitored resources

The dashboard provides status information for the resources that IBM Spectrum Control is monitoring.

The overall status for each resource type

A status symbol and number are shown below each resource icon on the dashboard. This symbol represents the most critical status that was detected on the internal resources for a resource type. For example, if 20 storage systems are monitored, and an error was detected on a volume for one of those storage systems, a 1 status is shown below the storage systems icon or label in the dashboard. If no errors, warnings, or unreachable statuses were detected on the monitored resources, then a green symbol is shown without a number.
Use the status to quickly determine the condition of your monitored resources and if any actions must be taken. On the dashboard, the following statuses might be shown for a resource type:

- **Error (red)**
  An error status was detected on one or more of the monitored resources for a resource type. Error statuses represent serious problems on a resource. Resolve these problems as soon as possible. View the details of a resource to learn more about the status of its internal resources.

- **Unreachable (orange)**
  One or more of the monitored resources for a resource type are not responding. This status might be caused by a problem in the network or by a Storage Resource agent that is no longer running and did not communicate that it was shutting down.

- **Warning (yellow)**
  A warning status was detected on one or more of the monitored resources for a resource type. Warning conditions are not critical, but represent potential problems. View the details of a resource to learn more about the status of its internal resources.

- **Normal (green)**
  No warnings or errors were detected on the monitored resources for a resource type.

- **Unknown status (gray)**
  One or more of the monitored resources for a resource type have an unknown status. This status might occur if no data was collected about a resource. To change an unknown status, use a data collection job to collect status information about the resource.

For information about how status is determined, see “How the condition of a resource is determined” on page 141.

The number of statuses that were detected and acknowledged for each resource type

To view the total number of statuses for a resource type, move the mouse pointer over the related status symbol. Hover help shows the total number of occurrences for each status, and the number of statuses that were acknowledged by a IBM Spectrum Control user. An acknowledged status indicates that a status was reviewed and is either resolved or can be ignored.

**Viewing the status of monitored storage systems**

Storage systems can be configured for block storage, file storage, a combination of block and file storage, or a combination of file and object storage. The top left section of the dashboard shows the type, number, and status of the storage systems that IBM Spectrum Control is monitoring. The number in the circle next to the storage system type shows how many storage systems of that type are being monitored. The status icon below each storage system type shows the status of the monitored systems. Click the storage system type, for example Block Storage Systems, to see more detailed status and information about those storage systems.
Use the information in the horizontal bar charts to view details about the used and free space of the monitored storage systems in your environment:

**Storage systems that are configured for block data**

The following information is shown for monitored storage systems that are configured for block data:

**Used Block Storage Space**
Amount of space that is being used for block data on all the storage systems that are configured for block data.

**Available Block Storage Space**
Amount of unused space on all the storage systems that are configured for block data.

**Storage systems that are configured for file data**

The following information is shown for monitored storage systems that are configured for file data:

**Used File System Space**
Amount of file system space that is being used by files and directories on the storage systems and filers that are configured for file data.

**Available File System Space**
Amount of unused storage space on the storage systems and filers that are configured for file data.

**Storage systems that are configured for object data**

The following information is shown for monitored storage systems that are configured for object data:

**Used Object Storage Space**
Amount of file system space on the GPFS object clusters that is being used by object data.

**Available Object Storage Space**
Amount of file system space on the GPFS object clusters that is available for object data.

**Viewing the status of monitored resources that are consuming storage**

The diagram in the top middle section of the dashboard provides a visual representation of the monitored resources that are consuming storage. You can click the icons in this section to add resources of that type or to see detailed information about the resources you have already added. The number next to each icon shows the number of those resources that are being monitored by IBM Spectrum Control. If IBM Spectrum Control is monitoring resources of a particular type, such as departments, you will see a status icon that shows the overall status of those types of resources.

**The types of resources that are consuming storage**
Each type of resource in the diagram is represented by an icon. To learn more detailed information about the individual resources that are monitored, click the icon in the diagram. For example, if you click the departements icon, a new page shows detailed information about the individual departments that are being monitored.

**The number of resources that are monitored for each resource type**
A number in a circle is shown next to each resource icon. This number
represents the number of monitored resources for each resource type. For example, if 4 file storage systems are monitored, the value \( \text{4} \) is shown. This number excludes resources that are not monitored by IBM Spectrum Control.

**Tip:** If no resources are being monitored for a resource type, click its icon on the dashboard to add a resource of that type. For example, if the dashboard shows a 0 next to the departments icon, you can click the icon or the circle for departments to add a department. The GUI guides you through the process for adding the resource for monitoring. For more information about adding resources, see “Adding resources” on page 75.

**Viewing the status of monitored network fabrics and switches**

The top right section of the dashboard shows the number and status of the fabrics and switches that IBM Spectrum Control is monitoring. The number in the circle next to the fabric or switch icon shows how many fabrics and switches are being monitored. The status icon below the fabric or switch shows the status of those entities. Click the icon to see more detailed status and information about those fabrics and switches. The dashboard shows the following information for the monitored fabrics and switches in your environment:

**Fabrics**
- The number of fabrics that are being monitored.
- The most critical status of the monitored fabrics. If more than one fabric is monitored, the dashboard shows the most critical status level of those fabrics.

**Switches**
- The number of switches that are being monitored.
- The most critical status of the monitored switches. If more than one fabric is monitored, the dashboard shows the most critical status level of those switches.

**Viewing the status of alerts that were detected on monitored resources**

Alerts are generated when IBM Spectrum Control detects certain conditions or events on monitored resources. The Alerts section of the dashboard shows a status summary of the alerts that were detected in your environment during a specified time period. This summary includes the number of alerts that have the following statuses: Critical, Warning, and Informational.

Use the following actions to manage the display of statuses for alerts:
- To select the time period in which you want to view alert statuses, click the down arrow and select a time period. You can view the status of all alerts that were detected in the last hour, last day, or last week.
- To view more detailed information about alerts, click View all alerts to access the Alerts page.

**Viewing the most active storage systems in your environment**

The Performance chart provides information about the most active storage systems in your storage environment. Position your cursor over a data point in the chart to see the total I/O rate for a particular storage system. The I/O rate is displayed in
operations per second (ops/s) on the left vertical axis, and in milliseconds per operation (ms/ops) on the right vertical axis. The horizontal axis shows the time of the performance data in hourly increments.

**Viewing information about top-level resources**

Use a resource list page as a central location for viewing information about all the monitored resources of a specific type. Resources that have a list page include storage systems, volumes, pools, shares, servers, hypervisors, switches, and fabrics.

1. In the menu bar, hover the mouse pointer over the menu item for the type of resource that you want to view. You can access the following types of resources:
   - **Storage**: block storage systems, file storage systems, object storage systems, volumes, pools, shares
   - **Servers**: servers, hypervisors
   - **Network**: switches, fabrics
2. Select the type of resource that you want to view. For example, if you want to view information about servers, go to **Servers > Servers**. A list of monitored servers is displayed on Servers page.
3. Locate the resource that you want to view in the list. Each column in the list shows information about the resource.
4. Optional: To view key attributes of a specific top-level resource without leaving the page, right-click the resource and select **View Properties**. A properties notebook is displayed. Information in a properties notebook can include storage statistics, hardware attributes, volume assignments, disk assignment, and performance metrics.
5. Optional: To view more detailed information about a specific top-level resource, including its internal and related resources, right-click the resource and select **View Details**. A resource details page is displayed. This page includes information about storage statistics, alerts, jobs, internal resources, and related resources.

A resource list page shows information about the monitored resources for the selected type. You can view the following information on this page:
- The overall status of the resources for a specific type
- Key information about the resources
- Alerts that were generated for the resources
- Jobs that were run for the resources

**Tip:** To view descriptions of the information that is available on a resource list page, click the **Help** icon in the upper-right corner of the page.

**Related reference:**

“Resources that you can monitor” on page 75

You can use IBM Spectrum Control to monitor storage systems, servers, hypervisors, fabrics, and switches. Information about these top-level resources includes information about their internal resources and related resources. Internal resources are components that exist in a top-level resource. Related resources are external to a top-level resource, but are related to it through assigned storage, a network connection, or virtual hosting.
Viewing information about internal, object, and related resources

Use resource details pages to view information about a specific top-level resource and its internal, object, and related resources.

1. In the menu bar, hover the mouse pointer over the menu item for the type of resource that you want to view. You can access the following types of resources:
   - **Storage**: block storage systems, file storage systems, object storage systems, volumes, pools, shares
   - **Servers**: servers, hypervisors
   - **Network**: switches, fabrics
2. Select the type of the resource that you want to view. A resource list page shows the monitored resources for the selected type. For example, if you want to view a block storage system, go to **Storage > Block Storage Systems**. A list of monitored block storage systems is displayed.
3. In the list of resources, right-click the resource that you want to view and select View Details. A resource details page is displayed. This page includes information about storage statistics, alerts, jobs, internal resources, object resources, and related resources.
4. To view information about the internal resources of the top-level resource, click the name of the internal resource in the **Internal Resources** section. A list of the internal resources is displayed. Each column in the list shows information about the resources. For example, on the details page for a server, click Controllers to view a list of the controllers that are associated with the server.
5. Optional: To view key attributes of a specific internal resource without leaving the page, right-click the resource and select View Properties.
6. To view information about the object resources in an object storage system, click the name of the object resource in the **Object Resources** section. Object resources are associated only with object storage systems, such as IBM Spectrum Scale that is configured for object storage.
7. To view information about resources that are related to the top-level resource, click the name of the related resource in the **Related Resources** section. A list of the related resources is displayed. For example, on the server details page, click **Block Storage Systems** to view a list of the block storage systems that have at least one disk (volume) assigned to the server.
8. Optional: To view key attributes of a specific related resource without leaving the page, right-click the resource and select View Properties.
9. Optional: To view the resource details page for a related resource, right-click the resource and select View Details.

A resource details page shows information about a top-level resource. The information is available in the following links and sections on the page:

- **Overview**: The overall capacity and storage usage for a resource.
- **Properties**: Key information about a resource.
- **Alerts**: Alerts that were generated for a resource.
- **Tasks**: Jobs that were run for a resource.
- **Internal Resources**: Information about the components that exist in a higher-level resource.
- **Object Resources**: Information about the resources in a GPFS cluster, such as accounts and containers, that enable the GPFS cluster to be used as an object storage system.
• **Related Resources**: Information about the resources that are related to another resource. A related resource is external to a higher-level resource, but is related to it through assigned storage, a network connection, or virtual hosting.

**Tip**: To view descriptions of the information that is available on a resource details page, click the **Help** icon 🎨 in the upper-right corner of the page.

**Related reference**: “Resources that you can monitor” on page 75

You can use IBM Spectrum Control to monitor storage systems, servers, hypervisors, fabrics, and switches. Information about these top-level resources includes information about their internal resources and related resources. Internal resources are components that exist in a top-level resource. Related resources are external to a top-level resource, but are related to it through assigned storage, a network connection, or virtual hosting.

### Monitoring the status and condition of resources

Monitor the operational condition of storage systems, servers, hypervisors, fabrics, and switches and the status of their internal resources. Use this information to identify potential problem areas in a storage environment.

**Table 24. Monitoring the status and condition of resources**

<table>
<thead>
<tr>
<th>Status</th>
<th>Explanation</th>
<th>Steps to view status or condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The status of a resource that is reported by its own hardware to IBM Spectrum Control. For example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the cooling fans in a storage system are stopped and the internal temperature is too high, an error status ✗ is reported by that storage system.</td>
<td>1. In the menu bar, go to the resource type that you want to view. For example, if you want to view the status of switches, go to <strong>Network &gt; Switches</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If a disk on a storage system is starting, a warning status ! is reported for that disk by the storage system.</td>
<td>2. Right-click a resource and select <strong>View Details</strong>. A status icon is shown next the image of the resource and its internal resources.</td>
</tr>
<tr>
<td>Tip:</td>
<td>The status of internal resources is used to determine the operational condition of the associated top-level resources.</td>
<td></td>
</tr>
</tbody>
</table>
Table 24. Monitoring the status and condition of resources (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Explanation</th>
<th>Steps to view status or condition</th>
</tr>
</thead>
</table>
|           | The overall operational condition of a storage system, server, hypervisor, fabric, or switch. This condition represents the most critical status that was detected on the resource itself and on its internal resources. For example, if an error status was detected on a storage system pool, an error icon is shown for the overall condition of the storage system. If no errors, warnings, or unreachable statuses were detected on a resource or on its internal resources, then a green symbol is shown for the condition of the storage system. | Dashboard view  
In the menu bar, go to Home > Dashboard. The icons that show overall condition are shown next to the image of a resource type.  
Resource list pages  
In the menu bar, go to the resource type that you want to view. For example, if you want to view the condition of switches, go to Network > Switches.  
The overall condition of a resource is shown in the Condition column, and aggregated in the condition icons at the top of the page. |

IBM Spectrum Control provides a number of different icons to help you quickly determine the health of resources.

Table 25. Possible statuses and conditions of resources

<table>
<thead>
<tr>
<th>Icon</th>
<th>Health</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Error icon]</td>
<td><strong>Error</strong></td>
<td>A serious problem was detected on a resource or on its internal resources. Resolve these problems as soon as possible.</td>
</tr>
</tbody>
</table>
| ![Error - Acknowledged icon] | **Error - Acknowledged**       | An Error status was detected and acknowledged. An Error - Acknowledged status indicates that a status was reviewed and is either resolved or can be ignored.  
An acknowledged status is not used when determining the condition of related, higher-level resources. For example, if the status of a volume is Error, the condition of the associated storage system is also Error. If the Error status of the volume is acknowledged, its status is not used to determine the overall condition of the storage system. |
| ![Unreachable icon] | **Unreachable**  | A resource is not responding to requests from the IBM Spectrum Control server. This status might be caused by a problem in the network or by a Storage Resource agent that is no longer running and did not communicate that it was shutting down. |
| ![Unreachable - Acknowledged icon] | **Unreachable - Acknowledged** | An Unreachable status was detected and acknowledged. An Unreachable - Acknowledged status indicates that a status was reviewed and is either resolved or can be ignored.  
An acknowledged status is not used when determining the condition of related, higher-level resources. For example, if the status of a controller is Unreachable, the condition of the associated server is also unreachable. If the Unreachable status of the controller is acknowledged, its status is not used to determine the overall condition of the server. |
Table 25. Possible statuses and conditions of resources (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Health</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Warning Icon]</td>
<td>Warning</td>
<td>A Warning status represents potential problems on a resource or on its internal resources. This status is not critical.</td>
</tr>
<tr>
<td>![Check Mark Icon]</td>
<td>Warning - Acknowledged</td>
<td>A Warning status was detected and acknowledged. An Warning - Acknowledged status indicates that a status was reviewed and is either resolved or can be ignored. An Warning - Acknowledged status is not used when determining the condition of related, higher-level resources. For example, if the status of a controller is Warning, the condition of the associated server is also Warning. If the Warning status of the controller is acknowledged, its status is not used to determine the overall condition of the server.</td>
</tr>
<tr>
<td>![Check Mark Icon]</td>
<td>Normal</td>
<td>No warnings or errors were detected on a monitored resource.</td>
</tr>
<tr>
<td>![Warning Icon]</td>
<td>Unknown</td>
<td>A resource is known to IBM Spectrum Control but is not monitored. To change an Unknown status, run a probe to collect status information about the resource.</td>
</tr>
</tbody>
</table>

How the condition of a resource is determined

The operational condition of a resource represents the most critical status that was detected on the resource itself and on its internal resources.

To determine the condition of top-level resources (storage systems, servers, hypervisors, fabrics, and switches), IBM Spectrum Control uses the status of those resources and the status of their internal resources. The statuses of the following internal resources are used to calculate the overall condition of a top-level resource.

Table 26. Internal resources that are used to determine the condition of top-level resources

<table>
<thead>
<tr>
<th>Top-level resource</th>
<th>Internal resources that are used to determine the condition of a top-level resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fabric</td>
<td>![Ports Icon] ![Switches Icon]</td>
</tr>
<tr>
<td>Switch</td>
<td>![Blades Icon] ![Inter-switch connections Icon] ![Logical switches Icon] ![Ports Icon]</td>
</tr>
<tr>
<td>Hypervisor</td>
<td>![Disks Icon] ![Virtual machines Icon] ![VMDKs Icon]</td>
</tr>
</tbody>
</table>
Table 26. Internal resources that are used to determine the condition of top-level resources (continued)

<table>
<thead>
<tr>
<th>Top-level resource</th>
<th>Internal resources that are used to determine the condition of a top-level resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Controllers, Disks</td>
</tr>
<tr>
<td>Block storage system</td>
<td>Disks, External disks, Host connections, I/O groups, Managed disks, Modules, Nodes, Pools, Ports, RAID arrays, Volumes</td>
</tr>
<tr>
<td>File storage system</td>
<td>Network shared disks, Nodes</td>
</tr>
<tr>
<td>Object storage system</td>
<td>Network shared disks, Nodes</td>
</tr>
</tbody>
</table>

The following statuses of internal resources are used to help calculate the condition of top-level resources:
Tip: Statuses that are acknowledged are not used to calculate the overall condition of a top-level resource.

Internal resources for a top-level resource might have different statuses. IBM Spectrum Control uses the most critical status of an internal resource to help determine the overall condition of a top-level resource. For example, in a storage system, a port might have an Error status, a pool might have a Warning status, and multiple controllers might have an Unknown status. In this case, if the storage system itself has a normal status, its overall condition is Error because it is the most critical status that was detected on internal resources.

The following table shows some of the possible combinations of statuses and the resulting, overall condition for a top-level resource.

Table 27. Propagation of the statuses for resources

<table>
<thead>
<tr>
<th>Error</th>
<th>Unreachable</th>
<th>Warning</th>
<th>Normal</th>
<th>Unknown</th>
<th>Resulting condition for a top-level resource</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X Unknown</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X Normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X Normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X Normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X Warning</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X Warning</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X Warning</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X Unreachable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X Unreachable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X Unreachable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X X Unreachable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X X X Error</td>
</tr>
</tbody>
</table>

Chapter 5. Managing resources 143
### Table 27. Propagation of the statuses for resources (continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Unreachable</th>
<th>Warning</th>
<th>Normal</th>
<th>Unknown</th>
<th>Resulting condition for a top-level resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Error</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Error</td>
</tr>
</tbody>
</table>

#### Note:
1. The Unreachable status applies only to top-level resources.
2. The Unknown status of an internal resources is not used to determine the condition of a top-level resource.

### Viewing the overall condition of resources

Use the dashboard to view the overall, operational condition of resources, and identify potential problem areas in a storage environment. The dashboard shows the total number of different conditions on storage systems, servers, hypervisors, fabrics, switches, and on the resources in departments and applications.

The condition of a resource represents the most critical status that was detected on that resource or on its internal resources. For example, if an error status was detected on a storage system pool, the overall condition of the storage system is error ✗.

1. In the menu bar, go to Home > Dashboard.
2. View the condition icons that are shown with each resource type.

For example, if 20 block storage systems are monitored, but 10 storage systems have internal resources with an error status, 2 storage systems are unreachable, and 4 storage systems have internal resources with a warning status, the following conditions icons are shown for block storage systems:

**Block Storage Systems**

[Error] 10 [Unreachable] 2 [Warning] 4

If no Error or Warning statuses were detected on the internal resources for block storage systems, the normal condition icon ✓ is shown.

#### Related reference:

“[How the condition of a resource is determined](#)” on page 141

The operational condition of a resource represents the most critical status that was detected on the resource itself and on its internal resources.

### Viewing the condition of specific types of resources

Use resource list pages as a central location for viewing the condition of storage systems, servers, hypervisors, switches, and fabrics.

1. In the menu bar, go to the type of top-level resource that you want to view. For example, if you want to view the condition of switches, go to **Network > Switches**.
2. To view the total number of different conditions that were detected for the type of resource, check the condition icons at the top of the resource list page. The
number next to the icon represents how many occurrences of each condition were detected. For example, if 15 switches are monitored, but 5 switches have internal resources with a warning status, 2 switches have internal resources with an unreachable status, and 3 switches have internal resources with an error status, and the following condition information is displayed at the top of the page:

- 5 Normal
- 5 Warning
- 2 Unreachable
- 3 Error

3. To view the condition for specific resources, check the Condition column in the list of resources.

4. Optional: Click the Search icon to filter the list so that only resources with a specified condition are shown. You can use filtering to identify the resources with the most serious conditions in your environment.

5. Optional: Select Condition.

6. Optional: In the Choose Value list, select the condition on which you want to filter. The list of resources is automatically refreshed and only resources with the filtered status are shown. For example, select Warning to view only the resources with a Warning condition.

**Viewing the status of resources**

Use detail pages to view the status of storage systems, servers, hypervisors, switches, and fabrics and the status of their internal resources. The status of a resource is reported to IBM Spectrum Control by its hardware.

The status of a resource is different than the operational condition that is calculated by IBM Spectrum Control for top-level resources:

- **Condition** is determined by propagating the statuses of resources and is only shown for top-level resources.
- **Status** represents the status of a resource as reported by its hardware and is shown for top-level resources and internal resources. The following examples illustrate statuses that might be reported by a resource:
  - If the cooling fans in a storage system are stopped and the internal temperature is too high, an error status is reported by that storage system.
  - If a disk on a storage system is starting, a warning status is reported for that disk by the storage system.

**Tip:** View condition to identify which top-level resources might be encountering problems. View status to identify the specific resources that are causing the problems in a top-level resource.

1. In the menu bar, go to the resource type that you want to view. For example, if you want to view the status of block storage systems and their internal resources, go to **Storage > Block Storage Systems.**
2. Right-click a resource and select View Details.

3. To view the status of the top-level resource, view the status icon that is displayed next to its image in the upper-left corner of the page.

4. To view the aggregated status of an internal resource, view the status icon that is displayed next to its image in the Internal Resources section. If a resource has a status other than normal, an icon is displayed for the most critical status.

   For example, if a server has three controllers with an error status and two controllers with a warning status, the error status icon is shown for controllers in the Internal Resources section:

   ![Controllers (5)](image)

5. To view the status of a specific internal resource, click the name of that internal resource in the Internal Resources section. A list of the monitored internal resources is displayed. For example, on the details page for a server, click Controllers (5) to view a list of the five controllers that are associated with the server.

6. Check the Status column to view the status for each internal resource.

   **Tip:** When you view information about some internal resources, the Status column might show values that are more specific than Error, Unreachable, Warning, Unreachable, Unknown, and Normal. Use this additional status to determine the cause of the problem for an internal resource.

   For example, in the Internal Resources section on the details page for a storage system, an error status might be shown for managed disks:

   ![Managed Disks (5)](image)

   When you view the list of managed disks, the Status column might show an Offline status for a specific managed disk. When a managed disk is reported as offline, IBM Spectrum Control uses an error status icon ✗ to reflect that status.

### Acknowledging the condition and status of resources

Sometimes the status of resources might represent problems that commonly occur but can be ignored. In such cases, you can acknowledge those statuses so that they are not used when determining the overall condition of storage systems, servers, hypervisors, fabrics, and switches.

#### Acknowledging the condition of top-level resources

A summary of the conditions for storage systems, servers, hypervisors, fabrics, and switches is available in the Dashboard view and on resource list pages. You can acknowledge the condition of a top-level resource so that its condition is not shown as Error, Unreachable, or Warning on those pages.

1. In the menu bar, go to the type of resource that has a condition you want to acknowledge. For example, if you want to acknowledge the condition of a switch, go to Network > Switches.

2. In the list of resources, locate the resource with the Error, Unreachable, or Warning condition that you want to acknowledge.

3. Right-click the resource and select Acknowledge condition. A window shows that the condition for the specified resource was acknowledged.
4. Optional: To acknowledge the condition of multiple resources at the same time, press Ctrl and click each resource. To select a series of resources, select the first resource, and then press Shift and click the last resource. When the resources are selected, right-click a row in the list and select Acknowledge condition.

5. Click Close.

When you acknowledge the condition of a top-level resource, the following actions are taken:

Dashboard view

- The condition of the acknowledged resource is not used to determine the condition icon that is displayed for that resource type on the Dashboard view. For example, if you acknowledge the unreachable condition for a switch, the condition of that switch is not used to determine the number of unreachable conditions that is shown for switches on the Dashboard view.
- The acknowledged condition is shown as Acknowledged for a resource on the Dashboard view. For example, if 10 switches have Unreachable conditions and you acknowledge the condition for one of them, the following information is shown for switches:

9 Unreachable (1 Acknowledged)

Resource details page

- The condition icons at the top of the page are updated. For example, if 10 switches have Unreachable conditions, and you acknowledge one of them, the total number Unreachable conditions decreases by one and the number of Unreachable - Acknowledged conditions increases by one. The following information is updated at the top of the Switches page:

9 Unreachable 1 Unreachable - Acknowledged

- The value in the Condition column for the resource is updated to show an acknowledged condition. For example, if you acknowledge the Unreachable condition for a switch, the following value is shown in the Condition column:

Unreachable

Related reference:

“Resources that you can monitor” on page 75
You can use IBM Spectrum Control to monitor storage systems, servers, hypervisors, fabrics, and switches. Information about these top-level resources includes information about their internal resources and related resources. Internal resources are components that exist in a top-level resource. Related resources are external to a top-level resource, but are related to it through assigned storage, a network connection, or virtual hosting.

“How the condition of a resource is determined” on page 141
The operational condition of a resource represents the most critical status that was detected on the resource itself and on its internal resources.

Acknowledging the status of internal resources

The statuses of internal resources are used to determine the condition of the associated storage systems, servers, hypervisors, fabrics, and switches. Sometimes these statuses might represent problems that commonly occur or are known, but can be ignored. In such cases, you can acknowledge the status of an internal resource so that it is not used to determine the condition of a top-level resource.
For example, if the status of a volume is Error, the condition of the associated storage system is also Error. If the Error status of the volume is acknowledged, its status is not used to determine the overall condition of its storage system. In this case, if the other internal resources of the storage system are Normal, then the condition of the storage system is also Normal.

1. In the menu bar, go to the type of resource in which the internal resource is located. For example, if you want to acknowledge the status of internal resources for a switch, go to Network > Switches.

2. Right-click a resource and select View Details. For example, if you want to acknowledge the status of a port on a switch, right-click that switch and select View Details.

3. In the Internal Resources section of the resource details page, click the name of the internal resource. For example, if you want to acknowledge the status of a port on a switch, click Ports.

4. Right-click the resource and select Acknowledge status. A window shows that the status for the specified resource was acknowledged. For example, if you want to acknowledge the status of a port, right-click the port and select Acknowledge status.

5. Optional: To acknowledge multiple resources at the same time, press Ctrl and click each resource. To select a series of resources, select the first resource, and then press Shift and click the last resource. When the resources are selected, right-click a row in the list and select Acknowledge status.

6. Click Close. The status of the related, top-level resource might take several minutes to update.

When you acknowledge the status of an internal resource, the following actions occur:

- The status of the internal resource is no longer used to determine the condition of the associated top-level resource.
- The status icons at the top of the page for the internal resource are updated.

For example, if you acknowledge the Error status for a controller on a server, the total number of Error statuses decreases by one and the number of Error - Acknowledged statuses increases by one on the Controllers page. If originally there were five controllers with Error statuses, the following updated status information is shown:

4 Error 1 Error - Acknowledged

Related reference:

"Resources that you can monitor" on page 75
You can use IBM Spectrum Control to monitor storage systems, servers, hypervisors, fabrics, and switches. Information about these top-level resources includes information about their internal resources and related resources. Internal resources are components that exist in a top-level resource. Related resources are external to a top-level resource, but are related to it through assigned storage, a network connection, or virtual hosting.

"How the condition of a resource is determined" on page 141
The operational condition of a resource represents the most critical status that was detected on the resource itself and on its internal resources.
Monitoring the performance of resources

IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes key performance metrics that can help you measure, identify, and troubleshoot performance issues and bottlenecks in your storage.

You can use the performance monitoring to complete the following tasks:
- Measure, compare, and troubleshoot the performance of switches, storage systems, and their internal resources.
- Review the alerts that were triggered when the performance if a resource fell outside of a specific range.
- Customize views of performance so that you can analyze specific resources and metrics during time ranges that you specify.
- View performance information in a chart or table format to help you quickly identify where and when performance issues are occurring. The chart is a visual representation of how the performance of resources trend over time.
- Drill down into resources to view detailed information about the performance of internal and related resources. For example, if a SAN Volume Controller is shown in the chart, you can quickly view and compare the performance of its internal and related resources, such as disks, volumes, ports, managed disks, and back-end storage.
- Implement server-centric monitoring of SAN resources without requiring a Storage Resource agent. When you add an agentless server, IBM Spectrum Control correlates the server with the known host connections on monitored storage systems. If matches are found, you can view the amount of storage that is assigned to the server, and trace that storage back to the storage system. You can then view details about the internal resources of the related storage system, including performance information.
- Export performance information to a CSV file. A CSV file is a file that contains comma-delimited values and can be viewed with a text editor or imported into a spreadsheet application.

Before you begin

Before you can view performance information for resources, you must complete the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Learn more</th>
</tr>
</thead>
</table>
| Add storage systems and switches for monitoring by IBM Spectrum Control. | For information about how to add these resources, see the following topics:  
  - “Adding storage systems” on page 81  
  - “Adding fabrics and switches” on page 85 |
| Ensure that performance data is being collected for a resource. Typically, data collection is scheduled when resources are added for monitoring. | For information about verifying data collection and scheduling performance monitors, see the following topics:  
  - “Verifying that a performance monitor is running for a resource” on page 105  
  - “Creating performance monitors” on page 104 |

Chapter 5. Managing resources 149
Define performance alerts to be notified if the performance of a resource falls outside a specified range and might represent a potential problem.

When you define a performance alert for a resource, select a specific metric that you want to measure. For example, you can define a threshold that notifies you when the total I/O port rate for a storage system falls outside a specified range.

**Related reference:**

“Performance metrics” on page 283

IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes metrics that measure the performance of volumes, ports, and disks. You can view performance information or specify alerts for when the performance of a resource falls outside a specified range.

**Viewing performance information**

View the performance of storage systems, switches, and their internal resources. You can also view the performance of resources that violated a performance threshold and generated an alert.

Before you view the performance of resources, ensure that performance data was collected for those resources during the time ranges that you want to analyze. IBM Spectrum Control uses performance monitors to collect metrics for measuring the performance of storage systems and switches. For information about how to verify that performance monitors were run, see “Verifying that a performance monitor is running for a resource” on page 105.

You can access the performance view for a resource from different locations in the web-based GUI.
<table>
<thead>
<tr>
<th>Task</th>
<th>Accessing the performance view in the web-based GUI</th>
</tr>
</thead>
</table>
| View the performance of specific storage systems, switches, and their internal resources. | 1. In the menu bar, go to the type of resource that you want to view. For storage systems, depending on the type of storage system that you want to view, go to Storage > Block Storage Systems, Storage > File Storage Systems, or Storage > Object Storage Systems. For switches, go to Network > Switches.
2. Right-click a resource and select View Performance. By default, the following information is displayed in a chart for each type of resource:
   • For storage systems, the top 5 storage systems with the highest total I/O rate are shown.
   • For switches, the top 5 switches with the highest total port data rate are shown.
3. To view the performance of an internal resource, right-click the top-level resource in the chart legend and select the option for the internal resource that you want to view. For example, for a SAN Volume Controller, right-click its name in the chart legend and select MDisk Performance to view the performance of its managed disks. For managed disks, the top 5 contributors to the storage system workload are shown on the chart. The default metrics are total back-end I/O rate and total back-end response time.

Tips:
• To add or change the metrics that are displayed for a resource, click the select metrics icon and select the metrics to display.
• You can also view the performance of internal resources on the details page for the related, top-level resource. For more information, see Table 28 on page 153.
• To view the performance of multiple resources at the same time, press Shift or Ctrl and click the resources that you want to view. Press Shift and click to select consecutive rows in the list of resources; press Ctrl and click to select non-consecutive rows. Then, right-click any of the selected resources and select View Performance. Each resource is represented by a separate line in the performance chart and separate rows in the table view. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Accessing the performance view in the web-based GUI</th>
</tr>
</thead>
</table>
| View the overall performance of resources of the same type. | 1. In the menu bar, go to the type of resource that you want to view. For storage systems, depending on the type of storage system that you want to view, go to **Storage > Block Storage Systems**, **Storage > File Storage Systems**, or **Storage > Object Storage Systems**. For switches, go to **Network > Switches**.  
2. Click the **Performance** tab. By default, the following information is displayed in a chart:  
  - For storage systems, the top 5 storage systems with the highest total I/O rate are shown.  
  - For switches, the top 5 switches with the highest total port data rate are shown.  
**Tip:** To add or change the metrics that are displayed for a resource, click the select metrics icon and select the metrics to display. |
| View the real-time performance of a SAN Volume Controller or Storwize storage system. | 1. Depending on the type of storage system that you want to view, go to **Storage > Block Storage Systems**, **Storage > File Storage Systems**, or **Storage > Object Storage Systems**.  
2. Right-click a storage system and select **View Real-Time Performance**. A graphical representation of the processor usage of the system, and the bandwidth of the volumes, interfaces, and MDisks of the system is displayed.  
You can view the real-time performance of a storage system when the following conditions apply:  
  - The storage system is a SAN Volume Controller, Storwize V3500, Storwize V3700, Storwize V5000, Storwize V7000, or Storwize V7000 Unified system.  
  - The storage system must be at microcode level 7.3 or later.  
  - The storage system is running. To test the connection, right-click the storage system, and select **Connections > Test Connection**.  
  - The storage system must be available to the system where the browser is running, through the local area network. To check if the storage system is available, right-click the storage system and click **Open Storage System GUI**. |
### Accessing the performance view in the web-based GUI

<table>
<thead>
<tr>
<th>Task</th>
<th>Accessing the performance view in the web-based GUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the alerts that were generated by threshold violations and the performance of the resources where the violation occurred.</td>
<td>For information about how to view performance alerts, see &quot;Viewing performance alerts and threshold violations&quot; on page 164.</td>
</tr>
</tbody>
</table>
| View the performance of a resource that is included in a specific performance monitor. | 1. In the menu bar in the web-based GUI, go to **Home > Performance Monitors**.  
2. In the Name column, locate the name of the resource that you want to view.  
3. Right-click the performance monitor and select **View Performance**. |
| View predefined reports and create custom reports that show the performance of resources. In the optional Cognos Business Intelligence reporting tool, you can view reports about storage systems, components of storage systems, switches, and switch ports. | 1. In the menu bar in the web-based GUI, go to **Cognos > View predefined reports**.  
2. To view predefined reports, navigate to the performance report that you want to view and click the name of the report.  
To create a custom report about the performance of resources, in the menu bar, go to **Cognos > Create performance reports**. |

In the web-based GUI, you can also view the performance of internal resources on the details pages for the related, top-level resources. For example, you can view the performance of the controllers for a storage system on the details page for that storage system. To access the performance view for an internal resource on a details page, select the type of internal resource and click the **Performance** tab.

The following information summarizes the internal resources and locations where you can access a performance view.

**Table 28. Internal resources and locations where you access the performance view**

<table>
<thead>
<tr>
<th>Internal resource</th>
<th>Locations in the GUI where you can access the performance view</th>
</tr>
</thead>
</table>
| Pools             | • **Storage > Pools**  
                    • Click **Storage**, and then click **Block Storage Systems**, **File Storage Systems**, or **Object Storage Systems**, depending on the storage system that you require.  
                    Right-click the storage system, click **View Details**, and click **Pools**  
                    Available only for pools that are associated with the following storage systems and virtualizers: System Storage DS series, ESS, SAN Volume Controller, the IBM Storwize family, IBM Spectrum Accelerate, and XIV systems. |
| Volumes           | • **Storage > Volumes**  
                    • Click **Storage**, and then click **Block Storage Systems**, **File Storage Systems**, or **Object Storage Systems**, depending on the storage system that you require.  
                    Right-click the storage system, click **View Details**, and click **Volumes** |
<table>
<thead>
<tr>
<th>Internal resource</th>
<th>Locations in the GUI where you can access the performance view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controllers</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Controllers</td>
</tr>
<tr>
<td>Disks</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Disks</td>
</tr>
<tr>
<td></td>
<td>Available only for disks that are associated with storage virtualizers such as SAN Volume Controller and the IBM Storwize family.</td>
</tr>
<tr>
<td>Host Connections</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Host Connections</td>
</tr>
<tr>
<td></td>
<td>Available only for host connections that are associated with the following storage systems and virtualizers: System Storage DS series, ESS, SAN Volume Controller, the IBM Storwize family, and XIV systems.</td>
</tr>
<tr>
<td>I/O Group</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click I/O Groups</td>
</tr>
<tr>
<td>Modules</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Modules</td>
</tr>
<tr>
<td>Nodes</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Nodes</td>
</tr>
<tr>
<td>Managed Disks</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Managed Disks</td>
</tr>
<tr>
<td></td>
<td>Available only for nodes that are associated with storage virtualizers such as SAN Volume Controller and the IBM Storwize family.</td>
</tr>
<tr>
<td>Ports on storage systems</td>
<td>Click Storage, and then click Block Storage Systems, File Storage Systems, or Object Storage Systems, depending on the storage system that you require. Right-click the storage system, click View Details, and click Ports</td>
</tr>
<tr>
<td>Ports on switches</td>
<td>Network &gt; Switches, and click Ports</td>
</tr>
</tbody>
</table>
Table 28. Internal resources and locations where you access the performance view (continued)

<table>
<thead>
<tr>
<th>Internal resource</th>
<th>Locations in the GUI where you can access the performance view</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Arrays</td>
<td>Click <strong>Storage</strong>, and then click <strong>Block Storage Systems</strong>, <strong>File Storage Systems</strong>, or <strong>Object Storage Systems</strong>, depending on the storage system that you require. Right-click the storage system, click <strong>View Details</strong>, and click <strong>RAID Arrays</strong>. Available only for RAID arrays that are associated with System Storage DS series and ESS storage systems.</td>
</tr>
</tbody>
</table>

Related information:

- **Performance statistics (for SAN Volume Controller systems)**
  Real-time performance statistics provide short-term status information for the SAN Volume Controller system. The statistics are shown as graphs in the management GUI.

- **Performance statistics (for Storwize V7000 Unified systems)**
  Real-time performance statistics provide short-term status information for the Storwize V7000 Unified system. The statistics are shown as graphs in the management GUI.

How performance information is displayed

The performance view is displayed when you view the performance of resources, which includes resources in threshold violations, alerts, and performance monitors. Information in the performance view is organized into two main sections: a chart or table and a legend.

Performance chart

The top section of the performance view shows information about the selected resources. You can view this information in the following formats:

- **Chart**
  The chart shows a visual representation of how the performance of a resource trends over time. Each line on the chart represents a metric and a resource. For example, if you select two metrics and three resources, six lines are shown on the chart. The y-axis shows the unit of measurement for a metric. If more metrics were selected with a different unit of measurement, an extra y-axis is shown on the right side of the chart window.

- **Table**
  The table shows performance and asset information that is formatted into rows and columns. Each row represents a resource and a time stamp from the chart; each column represents a metric from the chart. For example, if two metrics and three resources are displayed on a chart, and each of the lines on the chart have 10 data points, 30 rows and 2 columns are shown in the table.

  To view other metrics and asset information for a resource, right-click anywhere in the header row of the table and select extra columns. The type of resource determines the metrics and information that is available.

Performance chart legend

The bottom section of the performance view shows more information about the resources in the chart. The information is formatted into rows...
and columns. Each row represents a resource that was selected for the view. Each column provides asset and performance information about a resource.

Each metric on the chart is represented by two columns in the legend. The first column includes the weighted average of the metric for each resource in the selected time range. The second column represents the peak data point of the metric for each resource in the selected time range. For example, if a metric in the chart is Total I/O Rate, the following columns are displayed in the legend: Avg Total I/O Rate, Worst Total I/O Rate. The worst value can be the minimum or the maximum number, depending on the metric. For example, the worst value for an I/O rate metric is a maximum number, while the worst value for the Cache Hit Percentage metric is a minimum number.

You can also view information about the resources that are related to the resources in the legend. For example, if a SAN Volume Controller is listed in the legend, right-click it to view the performance of its internal and related resources, such as disks, volumes, ports, managed disks, and back-end storage. For more information about the resources that you can view in the chart legend, see “Resources in the chart legend” on page 160.

Tip:

- If you hide a resource in the performance chart, the row for that resource remains visible in the chart legend.

- In the chart legend, information about a resource represents the state of that resource during the selected time range. Specifically, this information does not represent the current state of a resource, but instead shows the final state of the resource during the selected time range.

For example, if the current date is January 1, and you view a volume with the time range set to December 1 to December 7, the legend shows the capacity of that volume on December 7. If the capacity of the volume was changed between December 7 and January 1, this historical capacity is different from the current capacity of the volume on January 1.

Related concepts:

- “Customizing lists of resources, tasks, and alerts” on page 233

The web-based GUI uses lists to show information about resources, tasks, and alerts. The information in each list is organized into columns and rows. You can customize these lists by filtering information, sorting rows, and showing, hiding, and reordering columns.

Controls:

Each performance view includes controls for customizing how information is displayed. The type of view and the resources that you are viewing determine which controls are available.

View chart

View performance information in a chart format. The chart shows a visual representation of how resource performance trends over time. Each line on the chart represents a metric and a resource. The y-axis shows the unit of
measurement for a metric. If more metrics were selected with a different unit of measurement, an extra y-axis is shown on the right side of the chart window.

Hover the mouse pointer over points on a line to view a snapshot of performance information at a specific time.

**View table**

View performance information in a table format. Each row represents a resource and a time stamp. Each column represents a metric. You can view other metrics and information for a resource by right-clicking anywhere in the header row for the table and selecting more columns. The type of resource determines the metrics and information that is available.

For information how to filter, sort, and customize the columns in a table, see “Customizing lists of resources, tasks, and alerts” on page 233.

**Metrics**

Add metrics to the performance chart. On the Select Chart Metrics window, metrics are organized into three tabs: Volume Metrics, Disk Metrics, and Port Metrics. The metrics and tabs that are available depend on the type of resource that is being shown in the chart. The number next to the name of the tab represents the number of metrics that are currently selected from that tab.

You can select multiple metrics at the same time and from different tabs, but you cannot include more than two unit types in the same view. For example, if you select metrics that use % and ops/s as units of measurement, you cannot select more metrics that use different units of measurement such as KiB/op or MiB/s.

For a list of metrics that you can view for resources, see “Performance metrics” on page 283.

**Hide and show resources**

When the chart includes multiple resources, you can click the icon next to a resource to show only the line for that resource. Each icon is shown in a different color to match the color of line for the resource.

You can also show and hide resources in the chart by selecting resources in the chart legend. To select multiple resources at the same time, press Shift or Ctrl and click those resources. Press Shift and click to select consecutive rows in the legend; press Ctrl and click to select non-consecutive rows.

You can show up to 10 resources in a chart at the same time.

**Specify granularity**

Determine the granularity of the data that is shown in a performance view. Granularity determines the points that are shown on the y-axis of a chart, the points on the lines in a chart, and the rows in a table. When you first
view performance information, the default time range is the last 12 hours and the granularity matches the frequency of data collection by the performance monitor (sample).

To change the granularity of chart or table, select one of the following options from the granularity menu:

- **(daily)**
  
  Set the granularity to show 1-day increments for performance information that is shown on the chart and table.

  This granularity is only available if the time range of the chart is more than 1 day.

- **(hourly)**
  
  Set the granularity to show one-hour increments for performance information that is shown on the chart and table.

  This granularity is only available if the time range of the chart is more than 1 hour.

- **(Sample)**
  
  Set the granularity to match the frequency of data collection by a performance monitor. For example, if a performance monitor is scheduled to collect sample data every 15 minutes, each point on the chart is shown in 15-minute increments.

  This granularity is only available if the time range of the chart is less than 2 weeks.

  If the performance monitor collects sample data at 1-minute intervals, data is displayed as 1-minute intervals in the chart only when data is available for all of the selected time range. If data is not available at 1-minute intervals for any portion of the selected time range, the data is displayed in 5-minute intervals.

  For example, the performance monitor for a resource collects sample data every 5 minutes. Six hours ago, the performance monitor was changed to start collecting data every minute. You want to view sample data for the resource for the last 12 hours. However, the performance monitor did not collect sample data every minute for 6 of the last 12 hours. Therefore, the data is displayed in 5-minute intervals rather than 1-minute intervals.

**Restriction:** Each granularity has a maximum time range for displaying data. This time range is dynamically calculated based on the resources and metrics that are shown on the chart, and the data points per line. When the maximum range is exceeded, the granularity icon is disabled and a message indicates that there are too many lines on the chart. To avoid this problem, reduce the time range or the number of resources or metrics that are selected.

**Specify a time range**

The time range of the performance information is shown below the chart. You can change this range to display information for different times when data was collected. When you first access the performance view, the default time range is the last 12 hours.
Ensure that performance data was collected during the time range that you select. If data was not collected during the time range, the chart and table are blank. If data collection was interrupted during the time range, the chart and table show gaps for the time increments when data was not collected.

For example, if you select a time range for the last 7 days, but data was not collected on days 4 and 5, the lines in the chart do not show data for days 4 and 5.

Hide and show chart controls
The performance view lists the names of resources that are being shown in the chart and the controls for customizing that chart. Click the left arrow icon to hide the controls and display the chart in the entire window. Click the right arrow icon again to show the controls.

Export information about the chart to a file
Export information on a performance view to a CSV file.

Open the performance view in a separate web browser window
Open a duplicate of the current performance view in a separate web browser window. You can change the information that is displayed in this separate window while retaining the original performance view for comparison.

Synchronize the time range across all the open performance views
Synchronize the time range across all the performance views that are displayed in separate browser windows. Use this action when you change the time range in a performance view and want to apply the same time range to the other performance views.

Restriction: This action affects only the performance views that are displayed in separate browser windows. The time range of the performance view that is shown as part of the main window for the GUI is not affected.

For example, you can view the storage system volumes that are assigned to a server. You can then open separate browser windows for the host connections, pools, and managed disks that are related to one of the volumes. If you change the time range in the performance view for host connections, click the synchronize button to apply the same time range to the views for pools and managed disks. The performance view of the original volume is not changed.

Actions for managing the resources in the chart legend
The chart legend in bottom section of the view shows more information about the selected resources. This information is organized into rows and columns, where each row represents a resource.

When you select one or more resources in the legend, the following actions are available in the Actions menu:
View Properties
View key details about a resource, including asset, status, configuration, capacity, and performance information.

View resource Performance
View the performance of resources that are internal or related to a resource in the chart legend. For example, when you view the performance of a SAN Volume Controller, you can right-click it and view the performance of its internal resources, such as disks, volumes, ports, managed disks, and back-end storage.

Information about an internal or related resource is shown in a separate web browser window. This window uses the same time range as the performance view in the main window of the GUI.

Restriction: If performance data was not collected for an internal or related resource, that resource is not shown in the view. For example, if you right-click a storage system and select Volume performance, only the volumes for which performance data was collected are shown.

For more information about the resources that you can view in the chart legend, see "Resources in the chart legend."

Key Metrics View
View a set of predefined metrics for resources in the chart legend.

Custom View
Customize the set of metrics that are shown for resources in the chart legend.

Resources in the chart legend:
In the performance view, performance metrics and related information for resources are shown in a chart and in the chart legend. For resources in the chart legend, you can open separate performance views for their internal or related resources. The separate performance views use the same time range as the performance view in the main window of the GUI.

For example, when you view the performance of a SAN Volume Controller, you can right-click it in the chart legend to open a performance view for its internal and related resources, such as disks, volumes, ports, managed disks, and back-end storage.

The type of resource determines the internal and related resources that you can view. The following tables show the internal and related resources that are available when you right-click a resource in the chart legend.

Table 29. Resources that you can view for DS6000, DS8000, and ESS storage systems in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>Volume, RAID array, pool, controller, host connection, port</td>
<td>Storage virtualizer, switch</td>
</tr>
</tbody>
</table>
Table 29. Resources that you can view for DS6000, DS8000, and ESS storage systems in the chart legend (continued)

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>Storage system, RAID array, pool, controller, host connection</td>
<td>Managed disk</td>
</tr>
<tr>
<td>RAID array</td>
<td>Storage system, volume, pool, controller, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Pool</td>
<td>Storage system, volume, RAID array, controller, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Controller</td>
<td>Storage system, volume, RAID array, pool, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Host connection</td>
<td>Storage system, volume, RAID array, pool, controller</td>
<td>None</td>
</tr>
<tr>
<td>Storage system port</td>
<td>Storage system</td>
<td>Switch port</td>
</tr>
</tbody>
</table>

Table 30. Resources that you can view for SAN Volume Controller, Storwize V3500, Storwize V3700, Storwize V7000, and Storwize V7000 Unified storage systems in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>Volume, pool, node, I/O group, disk, managed disk, host connection, port</td>
<td>Back-end storage system, storage virtualizer, switch</td>
</tr>
<tr>
<td>Volume</td>
<td>Storage system, pool, node, I/O group, disk, managed disk, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Pool</td>
<td>Storage system, volume, node, I/O group, disk, managed disk, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Node</td>
<td>Storage system, volume, pool, I/O group, disk, managed disk, host connection</td>
<td>None</td>
</tr>
<tr>
<td>I/O group</td>
<td>Storage system, volume, pool, node, disk, managed disk, host connection, port</td>
<td>None</td>
</tr>
<tr>
<td>Disk</td>
<td>Storage system, volume, pool, I/O group, node, managed disk, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Managed disk</td>
<td>Storage system, volume, pool, node, I/O group, disk, host connection</td>
<td>Back-end volume</td>
</tr>
</tbody>
</table>
### Table 30. Resources that you can view for SAN Volume Controller, Storwize V3500, Storwize V3700, Storwize V7000, and Storwize V7000 Unified storage systems in the chart legend (continued)

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host connection</td>
<td>Storage system, volume, pool, node, I/O group, disk, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Storage system port</td>
<td>Storage system, I/O group, node</td>
<td>Switch port</td>
</tr>
</tbody>
</table>

### Table 31. Resources that you can view for IBM Spectrum Scale in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>File system, node</td>
<td>None</td>
</tr>
<tr>
<td>File system</td>
<td>Storage system, node</td>
<td>None</td>
</tr>
<tr>
<td>Node</td>
<td>Storage system, file system</td>
<td>None</td>
</tr>
</tbody>
</table>

### Table 32. Resources that you can view for IBM Spectrum Accelerate in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>Module, pool, volume, host connection, port</td>
<td>Storage virtualizer, switch</td>
</tr>
<tr>
<td>Module</td>
<td>Storage system, pool, volume, host connection, port</td>
<td>None</td>
</tr>
<tr>
<td>Pool</td>
<td>Storage system, module, volume, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Volume</td>
<td>Storage system, module, pool, host connection</td>
<td>Managed Disk</td>
</tr>
</tbody>
</table>

### Table 33. Resources that you can view for XIV systems in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>Module, pool, volume, host connection, port</td>
<td>Storage virtualizer, switch</td>
</tr>
<tr>
<td>Module</td>
<td>Storage system, pool, volume, host connection, port</td>
<td>None</td>
</tr>
<tr>
<td>Pool</td>
<td>Storage system, module, volume, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Volume</td>
<td>Storage system, module, pool, host connection</td>
<td>Managed Disk</td>
</tr>
</tbody>
</table>
### Table 33. Resources that you can view for XIV systems in the chart legend (continued)

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host connection</td>
<td>Storage system, module, pool, volume</td>
<td>None</td>
</tr>
<tr>
<td>Storage system port</td>
<td>Storage system, module</td>
<td>Switch port</td>
</tr>
</tbody>
</table>

### Table 34. Resources that you can view for IBM Spectrum Accelerate in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>Module, pool, volume, host connection, port</td>
<td>Storage virtualizer, switch</td>
</tr>
<tr>
<td>Module</td>
<td>Storage system, pool, volume, host connection, port</td>
<td>None</td>
</tr>
<tr>
<td>Pool</td>
<td>Storage system, module, volume, host connection</td>
<td>None</td>
</tr>
<tr>
<td>Volume</td>
<td>Storage system, module, pool, host connection</td>
<td>Managed Disk</td>
</tr>
</tbody>
</table>

### Table 35. Resources that you can view for SMI-S BSP systems in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>Volume, port</td>
<td>Storage virtualizer, switch</td>
</tr>
<tr>
<td>Volume</td>
<td>Storage system</td>
<td>Managed disk</td>
</tr>
<tr>
<td>Storage system port</td>
<td>Storage system</td>
<td>Switch port</td>
</tr>
</tbody>
</table>

### Table 36. Resources that you can view for switches in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch</td>
<td>Port</td>
<td>Storage system, switch</td>
</tr>
<tr>
<td>Port</td>
<td>Switch</td>
<td>Storage system port, switch port</td>
</tr>
</tbody>
</table>
Table 37. Resources that you can view for servers in the chart legend

<table>
<thead>
<tr>
<th>Resource in the chart legend</th>
<th>Right-click the resource in the chart legend to view the performance of the following resources</th>
<th>Right-click the resource in the chart legend to view the performance of the following related resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>None</td>
<td>Storage system, volume, pool, controller, module, node, I/O group, disk, managed disk, host connection, switch, storage system port, switch port</td>
</tr>
</tbody>
</table>

**Saving URLs for performance views**

You can create a bookmark or a favorite for a performance view.

The link in the bookmark or favorite stores details of the performance view, such as the resources, metrics, interval, and other details. The link also stores the time period that is specified in the time selector at the top of the chart.

You can also copy the URL from the address bar if you want to share the URL with colleagues.

Do one of the following steps:

- In Firefox, right-click in the performance view and click **Bookmark This Page**.
- In Internet Explorer, right-click in the performance view and click **Add to favorites**.

**Viewing performance alerts and threshold violations**

View the alerts that were generated when the measured value of a metric falls outside of the specified threshold for a resource.

To view violations of performance thresholds, you must collect performance data and define performance alerts for that resource. For information about how to collect performance data, see "Creating performance monitors" on page 104. For information about how to define performance alerts, see "Defining alerts for performance metrics" on page 117.

1. Complete one of the following tasks to view performance alerts:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the performance alerts for a specific storage system</td>
<td>1. In the menu bar, choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Storage &gt; Block Storage Systems</td>
</tr>
<tr>
<td></td>
<td>• Storage &gt; File Storage Systems</td>
</tr>
<tr>
<td></td>
<td>2. Double-click a storage system.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Alerts</strong> in the <strong>General</strong> section.</td>
</tr>
<tr>
<td>View all the performance alerts that were generated for switches</td>
<td>1. In the menu bar, select <strong>Network</strong> &gt; <strong>Switches</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Click the <strong>Alerts</strong> tab.</td>
</tr>
<tr>
<td>Task</td>
<td>Steps</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| View the performance alerts for a specific switch | 1. In the menu bar, select **Network > Switches**.  
2. Double-click a switch.  
3. Click **Alerts** in the **General** section. |

2. Right-click the performance alert that you want to view and select **View Alert**. In this view, a chart shows the performance of the resource that violated the threshold and generated the alert. The time range of the chart is 2 hours before and 2 hours after the violation occurred. The lines on the chart represent the following values:

- The blue line represents the performance of the resource for the selected metric.
- The red line represents the threshold that was violated.
- The dotted line represents the time when the violation occurred.

For certain storage systems, a ranked list of the 25 volumes that were the top contributors to the workload on the resource where the threshold violation occurred might be displayed below the chart. This list is shown under the following conditions:

- The performance threshold was violated on an internal resource other than a port.
- The performance threshold was violated on any of the following storage systems:
  - DS6000
  - DS8000
  - XIV
  - IBM Spectrum Accelerate
  - ESS
  - SAN Volume Controller
  - Storwize V3500
  - Storwize V3700
  - Storwize V7000
  - Storwize V7000 Unified

You can also view the servers or hosts to which those volumes are assigned.

3. Optional: To access the full performance view of a resource that violated the threshold, click the open performance view icon on the chart.

---

**Monitoring and administering applications and departments**

You create applications to monitor the storage capacity, space usage, and performance of applications, and you create departments to monitor the space usage of the applications in the department. You can structure your applications and departments hierarchically to match the structure of your business organization.

You can map the application to the storage resources that the application uses to do capacity trending, health monitoring, and performance troubleshooting tasks. For example, a department might use 15 applications and be part of another five departments. Also a department might share storage resources with another department, subdepartment or application even if they do not belong in the same
business hierarchy. Another example, might be if you are contacted because an application within a department is experiencing a performance issue. You carry out tasks like capacity reporting or trending on the behalf of the application.

**Application administration**

Go to the pages for creating and administering the applications that you want to monitor.

*Table 38. Create and administer applications and subcomponents*

<table>
<thead>
<tr>
<th>Actions</th>
<th>Navigation</th>
</tr>
</thead>
</table>
| Create applications and assign storage resources directly to the application. | 1. In the menu bar, go to Groups > Applications.  
2. On the Applications page, click Create Application.  
3. On the Select a Method page, click Assign storage resources to the application. |
| Create subcomponents that can have its own storage resources. | 1. In the menu bar, go to Groups > Applications.  
2. On the Applications page, click Create Application.  
3. On the Select a Method page, click Create a subcomponent that can have its own set of storage resources. |
| Create a filter to use in assigning resources. | 1. In the menu bar, go to Groups > Applications.  
2. On the Applications page, right-click a row in the Applications list and click View Details.  
3. In the General section, click Filters.  
4. On the Filters page, click Create Filter. |
| Add applications as subcomponents to an application. | 1. In the menu bar, go to Groups > Applications.  
2. Right-click the applications that you want to add as subcomponents, and then click Add to.. > Application.  
3. On the Add to Application page, select the applications and click Save. |
| Add applications to departments. | 1. In the menu bar, go to Groups > Applications.  
2. On the Applications page, select one or more applications, right-click and then click Add to.. > Department.  
3. On the Add to Department page, select the applications that you want to add as members and click Save. |
Table 38. Create and administer applications and subcomponents (continued)

<table>
<thead>
<tr>
<th>Actions</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add applications to subdepartments.</td>
<td>1. In the menu bar, go to Groups &gt; Departments.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the department, and then click View Details.</td>
</tr>
<tr>
<td></td>
<td>3. In the General section, click Subdepartments.</td>
</tr>
<tr>
<td></td>
<td>4. Right-click the subdepartment, and click View Details.</td>
</tr>
<tr>
<td></td>
<td>5. In the General section, click Applications.</td>
</tr>
<tr>
<td></td>
<td>6. Click Create Application.</td>
</tr>
<tr>
<td>Remove applications and subcomponents that you do not want to monitor.</td>
<td>1. In the menu bar, go to Groups &gt; Applications.</td>
</tr>
<tr>
<td></td>
<td>2. On the Applications page, select one or more applications, and click Remove.</td>
</tr>
<tr>
<td></td>
<td>3. If you select Remove Subcomponents, the subcomponents that belong only to the application are removed.</td>
</tr>
<tr>
<td>Remove subcomponents within the direct context of an application that you do not want to monitor.</td>
<td>1. In the menu bar, go to Groups &gt; Applications.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the application and click View Details.</td>
</tr>
<tr>
<td></td>
<td>3. In the General section, click Subcomponents.</td>
</tr>
<tr>
<td></td>
<td>4. Right-click the subcomponent, and click Remove from Application.</td>
</tr>
<tr>
<td>Remove resources within the direct context of an application.</td>
<td>1. In the menu bar, go to Groups &gt; Applications.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the application and click View Details.</td>
</tr>
<tr>
<td></td>
<td>3. In the Related Resources section, click an eligible resource.</td>
</tr>
<tr>
<td></td>
<td>4. On the resource page, right-click the resource, and click Remove from Application.</td>
</tr>
</tbody>
</table>

**Department administration**

Go to the pages for creating and administering the departments that you want to monitor.
Table 39. Create and administer departments and subdepartments

<table>
<thead>
<tr>
<th>Actions</th>
<th>Navigation</th>
</tr>
</thead>
</table>
| Create departments and associate members (applications and departments) to create a hierarchal structure. | 1. In the menu bar, go to Groups > Departments.  
2. On the Departments page, click Create Department.  
3. On the Add Members page, click Add one or more applications or Create subdepartment. |
| Add departments as subdepartments to a department.                      | 1. In the menu bar, go to Groups > Departments.  
2. On the Departments page, right-click the departments that you want to add as subdepartments, and then click Add to Department. |
| Add applications to departments.                                        | 1. In the menu bar, go to Groups > Departments.  
2. Right-click the department, and then click View Details.  
3. In the General section, click Applications.  
4. Click Create Application. |
| Add applications to subdepartments.                                     | 1. In the menu bar, go to Groups > Departments.  
2. Right-click the department, and then click View Details.  
3. In the General section, click Subdepartments.  
4. Right-click the subdepartment, and click View Details.  
5. In the General section, click Applications.  
6. Click Create Application. |
| Remove departments, subdepartments, and applications, that are members of the department. | 1. In the menu bar, go to Groups > Departments.  
2. On the Departments page, right-click one or more departments and click Remove.  
3. If you select Remove subdepartments and applications, the subdepartments and applications that belong only to the department, that is being removed, are removed. |
Table 39. Create and administer departments and subdepartments (continued)

<table>
<thead>
<tr>
<th>Actions</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove applications from a subdepartment.</td>
<td>1. In the menu bar, go to <strong>Groups &gt; Departments.</strong></td>
</tr>
<tr>
<td></td>
<td>2. Right-click the department, and then click <strong>View Details.</strong></td>
</tr>
<tr>
<td></td>
<td>3. In the <strong>General</strong> section, click <strong>Subdepartments.</strong></td>
</tr>
<tr>
<td></td>
<td>4. Right-click the subdepartment, and click <strong>View Details.</strong></td>
</tr>
<tr>
<td></td>
<td>5. In the <strong>General</strong> section, click <strong>Applications.</strong></td>
</tr>
<tr>
<td></td>
<td>6. Select and right-click the applications, and then click <strong>Remove</strong></td>
</tr>
<tr>
<td>Remove subdepartments within the direct context of a department that you do not want to monitor.</td>
<td>1. In the menu bar, go to <strong>Groups &gt; Departments.</strong></td>
</tr>
<tr>
<td></td>
<td>2. Right-click the department, and then click <strong>View Details.</strong></td>
</tr>
<tr>
<td></td>
<td>3. In the <strong>General</strong> section, click <strong>Subdepartments.</strong></td>
</tr>
<tr>
<td></td>
<td>4. Right-click the subdepartments that you want to remove, and then click <strong>Remove from Department.</strong></td>
</tr>
</tbody>
</table>

Related tasks:

“Monitoring capacity usage at different levels of a business hierarchy” on page 64

The monitoring and management of applications and departments enables you to monitor storage capacity usage, recognize trends, monitor health status, and troubleshoot performance of the storage resources in your business organization.

“Comparing storage usage in each department” on page 66

In this scenario, you compare the storage usage in each department within your organization to spot a potential storage usage issue.

“Using applications and subcomponents to monitor capacity and space usage” on page 68

To monitor the performance, capacity, and space usage of the applications in your business organization, create applications and subcomponents. You can also add applications to departments so that storage capacity and usage can be monitored in an overall business hierarchal manner.

“Viewing storage capacity and usage trends” on page 69

You can view the capacity and usage trends of storage resources used by an application and subcomponents to diagnose how much storage a particular application is using in relation to the other applications and departments in the business hierarchy.

Applications

View information about storage area network resources that you can model by using applications in your business environment. The monitoring and management of applications enables you to perform capacity trending, health monitoring, and performance troubleshooting tasks.

An application can be part of a department and have subcomponents (member applications) that can contain a five level deep hierarchy. Applications that are
grouped together can range from large line of business systems to specialized software, in a department that runs on either client computers or servers. For example, an application might be an automated billing system in the Finance department, VMware running in the Information Technology department or an email marketing system that is part of the Marketing department.

Another example might be an application named *Database* and the database contains logs and data, and a best practice is to place the logs and data on separate volumes. You might create subcomponents for the logs and data and these subcomponents become part of the *Database* application.

A storage administrator can use applications for planning purposes to diagnose how much storage a particular application is consuming in relation to the other applications in the business hierarchy. Another applicable usage for applications might be troubleshooting performance issues. The administrator checks the related resources that make up the application to see if there is a health status issue or can examine the performance of volumes that are used by the application, and, then troubleshoot along a particular data path.

The Applications page shows capacity information about the applications that are monitored by IBM Spectrum Control and the actions that you can use to view and manage them. To see more detailed information, view properties and details for the application. If the application is associated with a department, information about that department is also shown.

The following information shows the resources and objects that can be added to the application.

*Table 40. Resources and objects that can be added to the application*

<table>
<thead>
<tr>
<th>Object</th>
<th>Resources or objects that can be added to the application</th>
</tr>
</thead>
</table>
| Application | • Applications  
• Servers  
• Hypervisors  
• Volumes  
• Data Stores  
• Shares  
• File Systems (Only server file systems that are monitored through a Storage Resource Agent.)  
• Filesets  
• Volume Groups  
• Virtual Machines (Can only be added with the CLI `modifyappgroup` command) |

**Creating an application hierarchy**

To monitor, the capacity, space usage, and performance of the storage resources that your applications use, create application models.

In this scenario, you want to monitor the capacity, space usage, and performance of a DB2 application.

The DB2 application has two subcomponents, which you want to monitor separately:
To monitor the DB2 applications and the data and logs subcomponents, complete these tasks:

- Create an application that is named DB2.
- Create applications that are named data and logs.
- Associate storage resources with the data and logs applications. For example, in this case, associate the volumes that the data application uses, type data_vol* in the Volumes field of **A selection of volumes that match a pattern** filter. For the logs application, type logs_vol* in the Volumes field of **A selection of volumes that match a pattern** filter. Then click **Belonging to** and click **Storage System**. Type the name of the storage system or the pattern that matches the name of the storage system.
- Add the data application and the logs application as subcomponents to the DB2 application.

**Tip:**

When you create complex application models for applications, it is not necessary to create a filter to associate storage resources with the application because the application inherits the storage resources that are associated with its subcomponents. However, if you want to monitor storage resources that are not associated with the subcomponents, you must create a filter that associates the additional storage resources that you want to monitor with the application.

You can now view information about the capacity, space usage, and performance of the storage resources on the Overview page for the application and subcomponents.

You can create departments and add applications to the departments.

**Related concepts:**

- "Application and department hierarchies" on page 184

The interactive breadcrumb on the Overview page provides a visual representation of the hierarchical relationships for applications and departments and enables you to navigate quickly between the elements in the hierarchy.

**Creating applications:**

To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

Use the GUI to create applications, assign resources, and subcomponents for monitoring by IBM Spectrum Control.

To determine the storage capacity usage by the storage resources that the applications use, you create a data model of the applications for your storage environment.

To create an application, complete these steps:

1. In the menu bar, go to **Groups > Applications**.
2. On the Applications page, click **Create Application**.
3. On the Create Application page, enter information about the application.
Note: You cannot have a duplicate application name on the same level in your application hierarchy. For example, you create an application named Finance and create a subcomponent named Business. You can create another application named Business as a top level application, but you cannot add the new Business application as a subcomponent of the Finance application.

You can customize the icon for your application by clicking the existing icon on the Create Application page and selecting another icon from the Customize Icon page.

4. Click Create.

5. Optional: On the Select a Method page, select Assign storage resources to the application that was created and follow the instructions to add the resources directly to the application.

6. Click Preview to see a list of filter matches before you finalize your filtering criteria, otherwise, click Save.

7. Optional: Select Create a subcomponent that can have its own set of storage resources and follow the instructions to create a subcomponent of the application.

8. Click Create.

When the application creation is created, you can view status information, block and file capacity and additional data on the Applications page and in properties. For a detailed view of the application and related resources, on the Applications page, right-click the application and select View Details. To see the subcomponents for the application, click Subcomponent on the application details page.

Related tasks:

"Adding subcomponents" on page 175

You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.

"Using filters to assign resources to applications"

Instead of manually adding the resources that you want to assign to new or existing applications, you can create filters to assign resources based on name pattern matching.

"Viewing information about applications" on page 176

You can view information about the application that you created as related resources, filters that are used to populate the application with resources, any subcomponents, capacity trending and performance information.

Using filters to assign resources to applications:

Instead of manually adding the resources that you want to assign to new or existing applications, you can create filters to assign resources based on name pattern matching.

When you create a filter to assign storage resources to applications, the resources that match the criteria that are defined in the filter are automatically added to the application or subcomponent (member application).

The use of wildcard characters enables you to customize and expand your search to add related resources. The asterisk (*) and the question mark (?) can be used as wildcard characters. The asterisk matches one or more characters. The question mark matches a single character. Use a comma-separated list to add multiple resources. As new resources are added or modified and they match the existing
filter, they automatically become part of the application. For example, a new server is added, a volume is renamed or a share is mounted on a server.

If you edit a filter, the resources that no longer match the filter are removed from the application and the resources that now match the filter are added to the application.

If you remove the filter, all storage resources that match the filter criteria are removed from the application.

Filtering is extremely useful in storage environments where resources are predefined and named in a consistent format. Instead of adding each resource separately, you create filtering criteria that matches your naming format in your environment. You can use filtering when you create a new application or directly from the details page for an existing application.

You can only select one resource type filter at a time during the creation workflow, but you can create multiple filters for applications.

The filters are divided into the following categories:

**All storage that belongs to a set of servers/hypervisors**
You can add servers or hypervisors to the application or subcomponent (member application).

For example, in the Define Name Patterns section, enter *blade, in the Server/Hypervisor field and click Save. The filter adds all known servers or hypervisors that have a name that ends with blade to the application.

If you enter server???.abc.com, in the Server/Hypervisor field, the filter adds all servers, in the domain with names that begin with server followed by three characters and ends with .abc.com to the application. If you enter, accounting*.*, the filter adds all servers with names that begin with accounting regardless of the domain the system belongs to.

If you enter cs-blade47.lab.abc.com, cs-blade49.lab.abc.com or cs-blade47*, cs-blade49*, the filter adds multiple servers to the application.

**A selection of volumes that match a pattern**
You can add volumes of a certain name format, volumes that belong to a server or hypervisor, volumes from a specific storage system or volumes from a pool to the application or subcomponent. You can only select one resource option per filter creation.

For example, in the Define Name Patterns section, if you enter *vol, in the Volumes field, mark the Belonging to box, click Server/Hypervisor, enter *.lab.abc.com and click Save. The filter adds all volumes that have a name that ends with vol and are mapped to servers that have a name that ends with .lab.abc.com to the application.

If you enter *vol, in the Volumes field, mark the Belonging to box, click Storage System, and enter ds8000. The filter adds all volumes that have a name that ends with vol that belong to the ds8000 storage system.

**A selection of shares that match a pattern**
You can add shares and exports that are mounted on a server or hypervisor, or shares and exports that are exported from a specific storage system to the application or subcomponent. You can select only one resource option per filter creation.
For example, in the **Define Name Patterns** section, if you enter `*share` in the **Shares** field, mark the **Belonging to** box, click **Server/Hypervisor**, enter `*.lab.abc.com` and click **Save**. The filter adds shares that have a name that ends with `share` that are mounted on servers that have a name that ends with `*.lab.abc.com`.

If you enter `share3` in the **Shares** field, mark the **Belonging to** box, click **Storage System** and enter `SONAS`, the filter adds all the shares that are named `share3` and are exported from the `SONAS` storage system.

**A selection of filesets that match a pattern**

You can add filesets that are associated with file systems, from a storage system to the application or subcomponent. You can select only one resource option per filter creation.

For example, in the **Define Name Patterns** section, if you enter `*` in the **Filesets** field, mark the **Belonging to** box, click **Storage System**, enter `SONAS*` and click **Save**, the filter adds all the filesets that are exposed by storage systems that have names that begin with `SONAS` to the application.

If you enter `*` in the **Filesets** field, mark the **Belonging to** box, click **File System** and enter `fs1`, the filter adds all the filesets that are associated with the file systems named `fs1` to the application.

To create a filter, complete these steps:

1. In the menu bar, go to **Groups>Applications**.
2. On the Applications page, right-click a row in the Applications list and click **View Details**.
3. In the **General** section, click **Filters**.
4. On the Filters page, click **Create Filter**.
5. On the Create Filter page, select a resource type filter and enter the necessary information.
6. Click **Preview** to see a list of filter matches before you finalize your filtering criteria.
7. On the Filter Matches page, click **Save** to create the filter.

The **General** section of the details page shows the number of filters that you created, for example, **Filters (6)**. Click **Filters** to access the Filters page and see the filters that were created. For example, The number of matches: 26, which indicates there are 26 matches for the filter criteria. Click the link to see the resources for the filter matches that are available.

**Tip:** To view a description of a field on the Create Filter page, hover the mouse pointer over the help icon 📘 for that field.

**Related tasks:**

"Creating applications" on page 171

To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

"Adding subcomponents" on page 175

You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.
Adding subcomponents:

You created a new application and a subcomponent, with their own set of resources and added it to your business hierarchy. You now want to add another level to your business hierarchy.

To create a subcomponent for an existing application, complete these steps:
1. In the menu bar, go to Groups > Applications.
2. On the Applications page, select one or more applications, right-click and then, click Add to.. > Application.
3. On the Add to Application page, choose the applications that you want to become subcomponents of your selected applications. The Hierarchy column shows the path of only the ancestor applications; it does not show departments.
4. Click Save.
5. Optional: On the details page for the application, click Subcomponents.
6. On the Subcomponents page, click Create Subcomponent.
7. On the Create Subcomponent page, enter information including name, description, type, and subtype.
8. Click Create.

After the subcomponent is created, you can view the results on the Subcomponent page and in the properties. For a more detailed view of the subcomponent, select the subcomponent from the Subcomponent page and click Actions > View Details.

Adding resources manually to applications

You can add resources directly from a resource page to your applications.

Only the following resources can be added directly to applications:
- Servers
- Hypervisors
- Volumes
- Volume groups
- Data stores
- Shares
- File systems (Only server file systems that are monitored through a Storage Resource Agent.)
- Filesets

To add a resource directly to an application, complete these steps:
1. In the menu bar, go to Groups > Servers.
2. On the Servers page, select a server from the Servers list, right-click and click Add to Application.
3. On the Add to Application page, select one or more applications to assign the server to.
4. Click Save.

The resource is added to the application and is displayed on the Applications page.

Related tasks:
"Using filters to assign resources to applications" on page 172

Instead of manually adding the resources that you want to assign to new or existing applications, you can create filters to assign resources based on name
pattern matching.

**Adding resources with the command line interface**

You can use the `modifyappgroupviafile` command-line interface (CLI) command to automate your bulk assignment of eligible storage resources to applications. To add a single resource to an application, use the `modifyappgroup` command.

**Related information:**

- [modifyappgroupviafile command](#)
- [modifyappgroup command](#)

**Viewing information about applications**

You can view information about the application that you created as related resources, filters that are used to populate the application with resources, any subcomponents, capacity trending and performance information.

To view the details of an application, use these steps:

1. In the menu bar, go to **Groups > Applications**.
2. On the Applications page, right-click an application and select **View Details**.

The application details shows information about the specific application. The information is available from the following sections on the page:

- **Overview**: The overall capacity trending about the application and performance information. An interactive breadcrumb that shows the hierarchy of applications and departments and a list of all the top level applications.
- **Properties**: The key information about the application.
- **Filters**: The number of filters created and the filtering criteria used for the resources that were added to the application.
- **Subcomponents**: The number of subcomponents that are a members of the selected application. If there is more than one subcomponent, the number of subcomponents is displayed.
- **Related Resources**: The information about the resources that are related to the application.

**Tip**: To view descriptions of the information that is available on an application details page, click the **Help** icon in the upper-right corner of the page.

**Related concepts**: [“Application and department hierarchies” on page 184](#)

The interactive breadcrumb on the Overview page provides a visual representation of the hierarchical relationships for applications and departments and enables you to navigate quickly between the elements in the hierarchy.

**Related tasks**: [“Creating an application hierarchy” on page 170](#)

To monitor, the capacity, space usage, and performance of the storage resources that your applications use, create application models.

**Removing applications and subcomponents**

You can remove applications and their subcomponents. The data that was collected to monitor the applications is also removed from the database repository.

To remove applications and subcomponents from a level of the business hierarchy, complete the following steps:

1. In the menu bar, go to **Groups > Applications**.
2. On the Applications page, select one or more applications, and click **Remove**.
   a. If you select **Remove Subcomponents**, the subcomponents that belong only to the application are removed.
   b. If you do not select **Remove Subcomponents**, any subcomponents of the application, that is being removed, then become members of the parent application or department. If the application is a top level application, and, the subcomponents are not members of any other application, the subcomponents become top level applications.

The applications and subcomponents are removed and are no longer displayed on the Applications page.

To remove subcomponents from within the direct context of the application, use these steps:

1. In the menu bar, go to **Groups > Applications**.
2. On the Applications page, select an application from the Application list and right-click **View Details**.
3. Optional: Select a application from the Applications page and right-click **View Properties**.
   a. Click the **Subcomponents** tab and continue with steps 5-6.
4. On the application details page, click **Subcomponents** in the **General** section.
5. On the Subcomponents page, select the subcomponent and right-click **Remove from Application**.
6. Confirm that you want to remove the subcomponent and click **Remove**.

**Removing resources from applications**

Related resources within the context of an application can be removed from applications. The action is only available when viewing the related resources that belong to an application on the details page.

The following resources can be removed from an application:

- Volumes
- Shares
- Servers
- File systems (Only server file systems that are monitored through a Storage Resource Agent.)
- Filesets
- Volume Groups
- Hypervisors
- Data Stores

Resources that were added through a filter match are removed if the filter is modified and no longer includes the resource that was removed from the application, the filter is removed from IBM Spectrum Control, or the resource is removed from IBM Spectrum Control. Resources can be added back to the application if the filter is modified and includes the resource that was originally removed, a new filter is created that matches the resource, the resources are added to IBM Spectrum Control, or you use the **Add to Application** action.

For example, a server named, abc.xyz.com is added to an application named, ApplicationABC because it matched the server name filter, abc*. You decide to remove the abc.xyz.com server from the ApplicationABC application and remove...
the abc.xyz.com server from IBM Spectrum Control. Later you want to add the abc.xyz.com server back to IBM Spectrum Control. The abc.xyz.com server is added to the ApplicationABC application because the name matches the server resource filter that you originally created for the ApplicationABC application. If you do not want the resource added back to the application, you can further refine your filters. Click the View Filters link on the confirmation dialog to make any adjustments to the filtering criteria before creation.

Resources that are automatically added to an application because they are related to resources that were explicitly added to the application are not removed from the application. The resources are automatically removed when the corresponding related resource that was added to the application, is also removed from the application.

For example, you add a server to the application that has one volume from a storage system. The volume is added as a related resource of that server in the application. If you attempt to remove the volume from the application, the volume is not removed since it is a related resource. The volume is only removed when the server, that was explicitly added to the application, is removed.

To remove resources directly from an application, use these steps

1. In the menu bar, go to Groups > Applications.
2. On the Applications page, select an application from the Application list and right-click View Details.
3. On the application details page, click an eligible resource in the Related Resource section.
4. On the resource page, select the resource from the list, and right-click Remove from Application.
5. Confirm that you want to remove the resource.
6. Click Remove.

The resources that were added to the application are removed from the application.

**Related tasks:**

"Using filters to assign resources to applications" on page 172

Instead of manually adding the resources that you want to assign to new or existing applications, you can create filters to assign resources based on name pattern matching.

**Departments**

View information about departments and structure the hierarchy to mirror your business organization. Monitor the detailed information about capacity and space usage that is collected for departments and subdepartments, and monitor the performance of the applications and the application subcomponents that are added to departments and subdepartments.

A department can be hierarchical in its organizational layout. For example, a department might use 15 applications and be part of another five departments. A department might share storage resources with another department, subdepartment or application even if they do not belong in the same hierarchy. For example, in a collaboration scenario, a single IBM SAN Volume Controller might be shared by multiple departments. You can provide reports on the storage
capacity that is used at different levels of your business hierarchy to regulate and compare the capacity storage, and in turn, track the trending of storage usage by specific departments.

The Departments page shows storage capacity information about the top level departments, the subdepartments and any applications that belong to the department that are monitored by IBM Spectrum Control and the actions that you can use to view and manage the resources that are defined to them. To see more detailed information, view properties and details for the department.

The following information shows the objects that you can add using the Add to Department function.

Table 41. Objects that can be added to the department

<table>
<thead>
<tr>
<th>Object</th>
<th>Objects that can be added to the department</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>• Applications</td>
</tr>
<tr>
<td></td>
<td>• Departments</td>
</tr>
</tbody>
</table>

Creating a department hierarchy
To monitor the capacity and space usage of the department, you want to create a department hierarchy and associate applications with the department hierarchy. You can also monitor the performance of the storage resources that are associated with the applications that you add to the department hierarchy.

In this scenario, you want to monitor the capacity and space usage of departments in a business organization that sells books. You also want to monitor the performance of the storage resources that are associated with the applications or application subcomponents that are used by the departments.

The sales department of the organization, Book Sales, has these subdepartments:
- Wholesale
- Retail
- Online

To monitor the storage resources that the Books Sales department uses and that each of its subdepartments use, complete these tasks:

- Create a department for Book Sales.
- Create the Wholesale, Retail, and Online subdepartments that you want to add to the department:
  - Create the subdepartments as departments.
  - Add the departments as subdepartments to the department.
  - Add the applications to the subdepartments.

You can now view charts and information about the capacity and space usage of the department and each of the subdepartments on the Departments page and the Subdepartments page. You can also view charts and information about the
performance of the storage resources that are associated with the applications or application subcomponents that the departments and subdepartments use.

**Tip:** In the Subdepartments column for the department on the Departments page, the name of the subdepartment is shown. If you add two or more departments to a subdepartment, the number of subdepartments is shown. To view information about the subdepartments, click the name of the subdepartment or the number.

You can view the total capacity and space usage for the department and the capacity and space usage for each of the subdepartments. You can add to your department hierarchy by adding more applications and departments.

**Creating departments:**

To model the storage capacity that is consumed in a department for your business environment, in accordance with other department and application members, create departments for monitoring in IBM Spectrum Control.

Use the web-based GUI to create departments, subdepartments (member departments) and add applications for monitoring different levels of a business hierarchy.

To create a department, complete these steps:

1. In the menu bar, go to **Groups > Departments**.
2. On the Departments page, click **Create Department**.
3. On the Create Department page, enter information about the department. You cannot have a duplicate department name on the same level in your department hierarchy. For example, you create a department named *Finance* and create a subdepartment named *Business*. You can create another department named *Business* as a top level department, but if you want to make your new *Business* department a subdepartment of the *Finance* department, you see a message that indicates there is already a department named *Business* that is a member of the *Finance* department; your department creation is denied.

   You can customize the icon for your department by clicking the existing icon on the Create Department page and selecting another icon from the Customize Icon page.
4. Click **Create** and then **Close**.
5. Optional: On the Add Members page, click **Add one or more applications**.
   a. On the populate page, select the applications that to add to your department. If you do not want to add any of the applications that are listed, click **Create Application** to create a new application to add to the department.
   b. Click **Finish**.
6. Optional: On the Add Members page, click **Create subdepartment**.
   a. On the Create Subdepartment page, enter your information.
   b. Click **Create**.

To view the newly created department, go to the Departments page.

To see the applications that you added to your department, see the details page and click **Applications**.
To see the subdepartment you created, see the Subdepartments column on the Departments page or see the details page and click Subdepartments.

Continue to add to your department hierarchy by adding applications and departments.

Related tasks:

"Adding and creating subdepartments"
To further enhance your data modeling at the department level and to add to your overall business hierarchy for monitoring, add an existing subdepartment or create a new subdepartment.

"Adding applications to departments” on page 182
To further enhance the data storage modeling in a business environment and see the storage capacity that is used at the different levels of your business hierarchy, add applications to departments. The departments you select from the Add to Department page become parents of the selected applications.

Adding and creating subdepartments:

To further enhance your data modeling at the department level and to add to your overall business hierarchy for monitoring, add an existing subdepartment or create a new subdepartment.

To add a subdepartment to the department level hierarchy, use these steps:

1. In the menu bar, go to Groups > Departments.
2. On the Departments page, select one or more departments, right-click and click Add to Department.
3. On the Add to Department page, select one or more departments from the list and click Save. The department or departments you select from the Add to Department page become parents of the selected department. The Hierarchy column shows the longest ancestry path of the department. You can also view the applications that are members of the department on the Departments page.
4. Optional: Create a new subdepartment:
   a. Click Create Department to open the Create Department page.
   b. Enter information about the department.
   c. Click Create.
   d. On the Add Members page, click Create a subdepartment.
   e. On the Create Subdepartment page, enter your information.
   f. Click Create.
5. Optional: Create a new subdepartment from the details page of the existing department:
   a. In the General section, click Subdepartments to open the Subdepartments page.
   a. Click Create Subdepartment to open the Create Subdepartment page.
   b. Enter information about the subdepartment.
   c. Click Create.

To see the subdepartment you created, see the Subdepartments column on the Departments page or click Subdepartments on the details page.

You can continue to create or add subdepartments to the department or add applications to the department.
Related tasks:

“Creating departments” on page 180
To model the storage capacity that is consumed in a department for your business environment, in accordance with other department and application members, create departments for monitoring in IBM Spectrum Control.

“Adding applications to departments”
To further enhance the data storage modeling in a business environment and see the storage capacity that is used at the different levels of your business hierarchy, add applications to departments. The departments you select from the Add to Department page become parents of the selected applications.

Adding applications to departments:

To further enhance the data storage modeling in a business environment and see the storage capacity that is used at the different levels of your business hierarchy, add applications to departments. The departments you select from the Add to Department page become parents of the selected applications.

To add applications to departments, complete these steps:

1. In the menu bar, go to Groups > Applications.
2. On the Applications page, select one or more applications, right-click and then, click Add to.. > Department.
3. On the Add to Department page, select one or more departments to add to the selected application or applications. The Hierarchy column shows the longest ancestry path of the department.
4. Click Save.
5. Optional: On the Create Department page, enter information about the department.
6. Click Create.
7. On the Add Members page, click Add one or more applications.
8. On the populate page, select the applications that to add to your department. If you do not want to add any of the applications that are listed, click Create Application to create a new application to add to the department.
9. Click Finish.

View the added department or departments in the Departments column on the Applications page or the Departments tab of the application properties.

Related tasks:

“Creating applications” on page 171
To monitor storage capacity, troubleshoot performance, and view storage area network dependencies for applications, you can create applications for monitoring in IBM Spectrum Control.

“Creating departments” on page 180
To model the storage capacity that is consumed in a department for your business environment, in accordance with other department and application members, create departments for monitoring in IBM Spectrum Control.

Viewing information about departments
You can view detailed information about departments for use in storage capacity monitoring and performance troubleshooting. You can view additional information on the applications and subdepartments that are used to establish a hierarchal business structure.
To view the details of a department, use these steps:

1. In the menu bar, go to **Groups > Departments**.
2. On the Departments page, right-click a department in the list and select **View Details**.

The department details page shows information about the specific department. The information is available in the following sections on the page:

- **Overview**: The overall capacity trending and performance information about the department. An interactive breadcrumb that shows the hierarchy of the departments and applications and a list of all the top level departments.
- **Properties**: The key information about the department.
- **Applications**: The applications that belong to the department. If there is more than one application, the number of applications is displayed.
- **Subdepartments**: The subdepartments that belong to the department. If there is more than one subdepartment, the number of subdepartments is displayed.
- **Related Resources**: Information about related resources in the storage environment that the applications, which belong to the department, are using or are connected to.

**Tip**: To view descriptions of the information that is available on a department details page, click the **Help** icon in the upper-right corner of the page.

**Related concepts**:  
“Application and department hierarchies” on page 184

The interactive breadcrumb on the Overview page provides a visual representation of the hierarchical relationships for applications and departments and enables you to navigate quickly between the elements in the hierarchy.

**Related tasks**:  
“Creating a department hierarchy” on page 179

To monitor the capacity and space usage of the department, you want to create a department hierarchy and associate applications with the department hierarchy. You can also monitor the performance of the storage resources that are associated with the applications that you add to the department hierarchy.

### Removing departments and subdepartments

You can remove departments, subdepartments and applications that are members of the department. The data that is collected about the departments, subdepartments and applications is removed from the database repository.

To remove departments, subdepartments, and applications, that are members of the department, from a level of the business hierarchy, complete these steps:

1. In the menu bar, go to **Groups > Departments**.
2. On the Departments page, select one or more departments, right-click and click **Remove**.
3. Confirm the information and click **Remove**.
   a. If you select **Remove subdepartments and applications**, the subdepartments and applications that belong only to the department, that is being removed, are removed.
   b. If you do not select **Remove subdepartments and applications**, the subdepartments and applications of the department that are being removed become members of the parent department. If the department is a top level department, and the subdepartments are not members of any other department, they become top level departments.
The departments, subdepartments and applications are removed from the business level hierarchy and are no longer displayed on the Departments page.

To remove subdepartments from within the direct context of a department, use these steps:
1. In the menu bar, go to Groups > Departments.
2. On the Departments page, select a department from the list and right-click View Details.
3. Optional: Select a department from the Departments page and right-click View Properties.
   a. Click the Subdepartments tab and continue with steps 5-6.
4. On the department details page, double-click Subdepartments in the General section.
5. On the Subdepartments page, select the subdepartment and right-click Remove from Department.
6. Reply to the confirmation message and click Remove.

Removing applications from a department
You can remove an application from within a department. This action is only available from the department detail page or the properties for the department.

To remove applications from within the context of a department, use these steps:
1. In the menu bar, go to Groups > Departments.
2. On the Departments page, select a department from the list and right-click View Details.
3. Optional: Select a department from the Departments page and right-click View Properties.
   a. Click the Applications tab and continue with steps 5-6.
4. On the department details page, click Applications from the General section.
5. On the Applications page, select the application and right-click Remove from Department.
6. Confirm the information.
7. Click Remove.

The applications that were added within the context of a department are eligible for removal from within department.

Related tasks:
"Viewing information about departments" on page 182
You can view detailed information about departments for use in storage capacity monitoring and performance troubleshooting. You can view additional information on the applications and subdepartments that are used to establish a hierarchal business structure.

Application and department hierarchies
The interactive breadcrumb on the Overview page provides a visual representation of the hierarchical relationships for applications and departments and enables you to navigate quickly between the elements in the hierarchy.

The breadcrumb uses default or customized icons to represent the related applications and departments. The greater-than sign (>) serves as the hierarchy
separator and ends with the name of the selected application or department. Only
the ancestor names of the selected application are shown.

When you move your mouse pointer over an icon in the breadcrumb, you see the
siblings for that application or department. If you move your mouse pointer, for
example, over the Data subcomponent, the related application and department
elements are shown.

The visual representation of the hierarchy stops when either there are no
additional parents or multiple parents are encountered from the selected
application or department. When multiple parents are encountered, the number of
parents are shown in parenthesis. For example, Multiple (2). Moving the mouse
pointer over Multiple shows a list of the parents. The siblings of multiple parents
are not shown.

Move your mouse pointer over a sibling in the breadcrumb and it becomes a name
link. Click the application or department name link to navigate to the details for
that application or department and view the breadcrumb if it exists.

You can add resources directly on the Overview page for applications from the
breadcrumb. For example, in this case, you create an application named DB2 and
create two subcomponents, Logs and Data. On the Overview page for the Logs
subcomponent, click the Logs subcomponent name link in the breadcrumb and
click Filters to create a resource filter for that subcomponent. Then, click the Data
subcomponent name link and create a resource filter for that application
subcomponent. To see a visual representation of the hierarchy for applications,
subcomponents, departments, and subdepartments click View Details.

Related tasks:
"Creating an application hierarchy" on page 170
To monitor, the capacity, space usage, and performance of the storage resources
that your applications use, create application models.

"Creating a department hierarchy" on page 179
To monitor the capacity and space usage of the department, you want to create a
department hierarchy and associate applications with the department hierarchy.
You can also monitor the performance of the storage resources that are associated
with the applications that you add to the department hierarchy.

**Exporting information about applications and departments**

You can save information about applications and departments to a PDF, CSV, or
HTML file. Information that you can export from the GUI includes all the values
that are being shown in the columns for a list of applications and departments.
The information that you export to a file is organized according to the sorting, filtering, and column order that is defined for a list. Before you export information, complete the following tasks to configure a list:

- Change the order of columns in the list as you want them to appear in the generated file.
- Hide columns in the list that you do not want to include in the generated file. Information in hidden columns is not exported.
- Sort the rows in the list as you want them to appear in the generated file. Each list in the GUI has a column or set of columns that determines the order of its rows.
- Filter the list to show only the applications and departments that you want to export. Use filtering to limit the rows that are shown in a list based on value in a specific column or set of default columns.

You can export information that is shown on the application and department list and detail pages.

Applications and departments list and detail pages

You can export information about the top level applications and departments and the related resources that are shown on application and department list and detail pages.

For example, you can export information about monitored applications and their subcomponents and departments on the Applications page. When you select the export action, the generated file includes the column values for each monitored application in the list.

For example, you can export information about the servers that are associated with an application on the details page.

1. In the GUI, go to the Applications or Departments page and select applications or departments for which you want to export information.

2. Click Actions and select Export > file_format, where file_format represents the format that you want to use for a file. The following formats are available:

CSV (comma-separated values)

A CSV file is a file that contains comma-delimited values and can be viewed with a text editor or imported into a spreadsheet application. The information in a CSV file has the following format:

"Column_name","Column_name","Column_name","Column_name","Column_name","Column_name"
"data","data","data","data","data","data"

where Column_name represents the name of a column in a table and data represents the data that is associated with a column.

PDF

You can view a PDF file with Acrobat reader. The information that you export to a PDF file is formatted into a table.

Tip: When you export a table of data that contains many columns, the rows in that table might span multiple pages in the resulting PDF. For example, if a table contains 20 columns, then the row for a specific resource might be shown on more than one page (10 columns on the first page and 10 columns on the second page).

To reduce the number of pages that a table spans, before you select the export action, hide the columns that you do not want to include in the PDF. Continue hiding columns until the table no longer spans multiple pages.
HTML

You can view an HTML file with a web browser. The information that you export to an HTML file is formatted into a table.

3. Optional: Depending on how your web browser is configured, you can specify the name and location of the generated file.

4. Click the save option to export the information to a file.

Related concepts:

“Customizing lists of resources, tasks, and alerts” on page 233

The web-based GUI uses lists to show information about resources, tasks, and alerts. The information in each list is organized into columns and rows. You can customize these lists by filtering information, sorting rows, and showing, hiding, and reordering columns.

Viewing the data paths of resources

A data path shows the connectivity between host connections, servers, hypervisors, virtual machines, storage systems, and the fabrics through which they share storage. You can use the data path view to monitor status and pinpoint problem areas in selected data paths. This view includes graphical and tabular representations of the top-level resources in a data path.

If a resource does not map storage to other resources, or the resource is not assigned storage from other resources, the data path view is not available.

To view the data path for a resource, complete these steps:

1. In the menu bar, select the type of resource that you want to view. For example, if you want to view the data path for a server, go to Servers > Servers.

2. The type of resource that you select determines how to view a data path:
   • On the Servers page, right-click a server and select View Data Path.
   • On the Block Storage Systems page, File Storage Systems page, or Object Storage Systems page, right-click a storage system and select View Details.
     On the details page, click Data Path in the General section.

Depending on how resources are configured, a data path can show between three to six types of top-level resources. For example, a data path with three types of top-level resources might show the following relationships:

server <-> fabric <-> storage system

A data path with six types of top-level resources might show the following relationships:

virtual machine <-> hypervisor <-> fabric <-> storage virtualizer <-> fabric <-> storage system

Before you can view a data path, you must complete the following tasks:

• Add the resource that has the data path you want view. For information about how to add a resource, see “Adding resources” on page 75.

Tip: Resources that are not monitored by IBM Spectrum Control are also shown in a data path view. However, detailed information about their status and internal resources is not available.
• Schedule a probe to collect data about your monitored resources to ensure that the most recent information is shown for a data path. For information about probes, see “Collecting asset and status data” on page 99.

You can use the data path view to complete the following actions:
• View the path of data that is shared between resources. The data path view shows only the resources that have storage mapped between them. For example, if you view the data path for a storage system, only the host connections that are assigned volume space from that storage system are shown. Host connections that are connected to the storage system, but do not have storage assigned storage to them, are not shown.
• View the fabrics through which resources in a data path are communicating.
• View the propagated status of the top-level resources that are in a data path.
• View the status of the internal resources for top-level resources that are in a data path.
• Customize the appearance of the data path view to suit the needs of your environment.
• Export the data paths view as an image or CSV file.

Information about a data path is organized into two views: a topology view and a table view. The topology view shows icons for connected resources and uses lines to represent the path of data through them. The table view includes a row for each resource in a data path. The row is divided into columns that contain information about the resource.

**Resources that you can view in a data path**

The **Topology View** tab in the data path view includes a visual representation of the data path for a top-level resource. In a data path, icons represent the connected resources and lines represent the path of data through them. For example, resources that are storage systems are shown with an icon that resembles a storage system.

The following table shows the icons for each type of resource that can be shown in a data path.

**Table 42. Resource icons in a data path**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server (with agent)</td>
<td>![Server Icon]</td>
</tr>
<tr>
<td>Server (without agent)</td>
<td>![Server Icon]</td>
</tr>
</tbody>
</table>

---

1. IBM Spectrum Control: User's Guide
### Table 42. Resource icons in a data path (continued)

<table>
<thead>
<tr>
<th>Resource</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypervisor</td>
<td><img src="image" alt="Hypervisor Icon" /></td>
</tr>
<tr>
<td>Virtual machine</td>
<td><img src="image" alt="Virtual Machine Icon" /></td>
</tr>
<tr>
<td>Fabric</td>
<td><img src="image" alt="Fabric Icon" /></td>
</tr>
<tr>
<td>Virtual fabric</td>
<td><img src="image" alt="Virtual Fabric Icon" /></td>
</tr>
<tr>
<td>DS8000</td>
<td><img src="image" alt="DS8000 Icon" /></td>
</tr>
<tr>
<td>DS6000</td>
<td><img src="image" alt="DS6000 Icon" /></td>
</tr>
<tr>
<td>SAN Volume Controller</td>
<td><img src="image" alt="SAN Volume Controller Icon" /></td>
</tr>
<tr>
<td>Storwize V7000</td>
<td><img src="image" alt="Storwize V7000 Icon" /></td>
</tr>
<tr>
<td>XIV</td>
<td><img src="image" alt="XIV Icon" /></td>
</tr>
</tbody>
</table>
Table 42. Resource icons in a data path (continued)

<table>
<thead>
<tr>
<th>Resource</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESS</td>
<td><img src="image" alt="ESS Icon" /></td>
</tr>
<tr>
<td>Other storage systems</td>
<td><img src="image" alt="Other Storage System Icon" /></td>
</tr>
<tr>
<td>Unmanaged host connections</td>
<td><img src="image" alt="Unmanaged Host Connection Icon" /></td>
</tr>
</tbody>
</table>

**Tips and restrictions:**

- 1 When agentless servers and servers with agents are grouped together, the icon for servers with agents is used to represent that group.
- 2 If a Storwize V7000 is not monitored by IBM Spectrum Control, but is connected to a monitored hypervisor, it is shown in the data path with the icon for a SAN Volume Controller.

For example, when a virtual machine is monitored, a probe collects information about its disks. If the disks are attached to a SAN-attached storage system that is not monitored, IBM Spectrum Control uses the probe information to determine the type of storage system. If the storage system is a Storwize V7000, the icon for SAN Volume Controller is shown instead of the icon for a Storwize V7000.

- Only the resources that are sharing storage in a data path are shown.
- Servers and hypervisors that are not monitored by IBM Spectrum Control, but are assigned storage from a monitored storage system, are shown as unmanaged host connections. For example, if a storage system has a volume that is mapped to an unknown server, the server is represented by an unmanaged host connection in the view.
- For storage systems with multiple host connections, the host connections are included in the same resource box if they communicate with the storage system through the same fabric. For example, if a storage system has volumes that are mapped to 20 host connections that use the same fabric, a single resource box represents the 20 host connections.
- Storage systems can have volumes that are provisioned to more than one server in a clustered environment. Because all the clustered servers can be part of the data path, each server is shown in the view.

**The status of resources**

Each resource in a data path is represented by a resource box. A resource box contains an icon that represents the overall status of a resource. This status is determined by the propagated status of the internal resources for the resource. For example, in a storage system, a port might have an Error status and a pool might
have a Warning status. In this case, the Error icon is shown on the resource box for the storage system because the Error condition is the most severe status that was detected on its internal resources.

Some resources in a data path might be shown with an unknown status. Resources can have an unknown status if they not monitored by IBM Spectrum Control, but are connected to other, monitored resources. IBM Spectrum Control uses the information that it collects about monitored resources to determine basic information about the connected resources that are not monitored.

For example, if a host connection is assigned volumes, but IBM Spectrum Control is not monitoring the fabric through with the host connection communicates with the storage system, the fabric is shown with an unknown status.

Navigating in a data path

A data path might contain more resources that can be fit in the view at the same time. In these cases, you can scroll the view to show different parts of a data path.

1. In the Topology View tab, click the Pointer button .
2. Click an empty area in the view and drag the mouse pointer to scroll to different areas of a data path.
3. Optional: To view where you are in the overall topology of a data path, click the Topology overview button in the upper-right corner of the topology view. The red box shows the visible area within the overall topology view, and status icons are displayed for the resources in the data path.

Viewing information about top-level resources

You can view detailed information about the top-level resources in a data path. Top-level resources that can be shown in a data path include storage systems, servers, hypervisors, and fabrics.

1. To view key attributes of a specific top-level resource without leaving the Topology View tab, right-click the resource and select View Properties. A properties notebook is displayed. Information in a properties notebook can include storage statistics, hardware attributes, volume assignments, disk assignment, and performance metrics.
2. To view more detailed information about a specific top-level resource, including its internal and related resources, right-click the resource and select View Details. A resource details page is displayed and includes information about storage statistics, alerts, jobs, internal resources, and related resources.

Viewing information about internal resources

You can view information about the internal resources that are associated with the top-level resources in a data path. Internal resources are components that exist in a top-level resource.

1. In the Topology View tab, hover the mouse pointer over a top-level resource in the data path.
2. View the following information about internal resources:
   - The number of internal resources that are associated with a top-level resource. For example, if a server has 20 disks, the value **Disks (20)** is shown.
   - The overall status of the internal resources. For information about how the overall status of internal resources is determined, see “How the condition of a resource is determined” on page 141.

### Zooming in

You can use the zoom buttons in the toolbar or the mouse to magnify areas in a data path.

1. To zoom in on a specific area in a data path, click the **Zoom to selected** button and click and drag the mouse pointer over the area.
2. Optional: To use the mouse to zoom in on a specific area in a data path, move the mouse pointer over the area where you want to zoom in and scroll the middle mouse button forward.
3. Optional: To zoom in on the area that is in the center of the view, click the **Zoom in** button.
4. Optional: To adjust the zoom level of the view so that all the resources in a data path are shown at the same time, click the **Fit to view** button.

### Zooming out

You can use the zoom out button in the toolbar or the mouse to zoom out in the view.

1. To zoom out from the area that is in the center of the view, click the zoom out button.
2. Optional: To use the mouse to zoom out from a specific area in a data path, move the mouse pointer over the area where you want to zoom out and scroll the middle mouse button backward.
3. Optional: To adjust the zoom level of the view so that all the resources in a data path are shown at the same time, click the **Fit to view** button.

### Changing the layout

You can change the layout of the resources in a data path. The layout determines how resources are arranged in the view.

1. Click the **Layout** button in the toolbar. The icon that is displayed for the **Layout** button represents the current layout of the data path.
2. Select one of the following layouts:

   - **Hierarchical**
     - Organize resources in a vertical format. Resources that use storage are shown at the top of the view. Resources that provide storage are shown at the bottom of the view.
   - **Tree**
     - Organize resources in a vertical and horizontal layout.
**Customize**

Customize the layout of a data path. When you customize a layout, use the hierarchical or tree layouts as the base and specify values for the associated options.

3. Optional: If you selected **Customize**, click **OK** to apply your settings.

**Saving the display settings**

You can save the display settings that are defined for a data path view. The next time that you view the data path for the resource, the same display settings are applied.

1. In the **Topology View** tab, click the **Save** button.
2. Optional: To use the keyboard to save the display settings, press Ctrl+S.
3. Click **Save Customizations**.

**Printing a view**

You can print the current view of a data path in the **Topology View** tab. The printing capability is not available in the **Table View** tab.

1. Click the **Print** button.
2. Specify the following options when printing:
   - In the **Page margin** field, enter the amount of space between the edges of the page and the view. The default setting is 1 inch.
   - In the **Maximum pages in width or height** field, specify the number of pages across which the content of a view is printed. This number determines the maximum number of pages that are printed. For example, if you enter 1, the content of a view is printed on one page. If you enter 2, the view is printed across four pages: two pages horizontally and two pages vertically.
3. Click **OK**.
4. Select the printer settings and click **OK** to print the view.

**Exporting a data path to a file**

You can save the contents of a data path to an image file or CSV file for offline viewing.

1. In the **Topology View** tab, right-click on an empty area in the data path.
2. Complete one of the following actions to select an output format for the file:
   - Select **Export as Image** to save the data path as a JPEG or PNG file.
   - Select **Export** to save the data path to a CSV file. A CSV file is a file that contains comma-delimited values and can be viewed with a text editor or imported into a spreadsheet application. The information for a data path is organized into the following column in the CSV files: Name, Type, From, RelType, To.
3. Specify the location and name of the file.
4. Save the file.

**Provisioning storage**

You can assign storage to servers, hypervisors, and clusters on servers and hypervisors in the GUI. You can assign storage to hypervisors with the vSphere Web Client extension for IBM Spectrum Control.
You can assign the following types of storage to servers, hypervisors, and clusters on servers and hypervisors:

- Volumes
- NAS file shares

When you assign storage, you must associate the storage with a service class. You can associate the storage with a default service class such as gold, silver, or bronze, or you can create a user-defined service class. You can also create capacity pools to restrict the provisioning of storage to a defined set of storage resources such as pools on a storage system in a particular location.

**Configuring IBM Spectrum Control for provisioning**

Before you can use the simplified provisioning capabilities that are provided with IBM Spectrum Control, you must configure your environment.

To provision storage, you are required to specify only the storage capacity and storage quality that is required. After volumes are created, IBM Spectrum Control can analyze and optimize volume performance.

To configure IBM Spectrum Control for provisioning, complete the following tasks:

1. Assign storage pools to tiers by setting the tier level of each storage pool. The tier levels are number tags that can reflect any tier structure in the environment.

   You must assign storage pools to tiers to later provision volumes that require a certain tier level and to optimize the placement of volumes. Storage pools do not need to be assigned to tiers to provision volumes that do not require a tier level, or to provision file shares.

2. Create service classes. A service class is a set of properties that describe capabilities and characteristics of storage resources. A service class typically describes a particular quality of service, and is used during provisioning to describe storage requirements. For example, a block-storage service class specifies properties such as a required RAID level, and whether storage resources must be able to encrypt or thin provision volumes.

3. Optional: Create capacity pools. You can restrict provisioning requests to a capacity pool. Capacity pools are groups of storage resources. You can use capacity pools to separate storage resources in any way that serves the needs of your environment or business. For example, a capacity pool might contain the storage resources that are allocated to a particular department or division of your business, or to a particular application.

**Configuring service classes**

Configure service classes to represent the different levels or types of storage quality that you want to provision. When you are configuring service classes for your installation, consider whether certain storage requests must always be satisfied from a particular set of resources. Also, consider whether you want to allow users without administrator privileges to provision storage, and whether you want their provisioning requests to require administrator approval.

**Creating service classes:**

Create service classes to specify storage requirements for future provisioning requests. A service class describes attributes and capabilities of block storage or file storage resources, and typically describes particular quality of service.
You must have Administrator privileges to create a service class.

The Create Service Class wizard guides you through the steps to create a service class. When you provision a volume or share, you define storage requirements by specifying a service class. A block-storage service class specifies the requirements for the block-storage resource from which a new volume is allocated. A file-storage service class defines requirements for the file storage resources from which a new share is allocated.

You can associate a service class with one or more capacity pools. If you do, future provisioning requests can be satisfied only by storage resources in the specified capacity pools.

You can selectively grant users who do not have administrator privileges permission to provision storage by using the service class.

**Restrictions:**
- To create a block-storage service class, you must have the IBM Spectrum Control Advanced Edition license.
- To associate the service class with a capacity pool, one or more capacity pools must be defined in the IBM Spectrum Control database. If no capacity pool is defined, the Specify Capacity Pool page of the wizard is not displayed.

Start this task at the Service Classes page. To open the Service Classes page, select **Advanced Analytics > Cloud Configuration > Work With Service Classes**. To create a service class, complete the following steps:

1. From the Service Classes page, click **Create Service Class**. The Create Service Class wizard opens.
2. Select the type of service class that you want to create:
   - To create a block-storage service class, click the **Block** icon.
   - To create a file-storage service class, click the **File** icon.
3. In the Define Properties page, complete the following steps:
   a. Specify a name for the service class.
   b. Optional: Specify a service class description. Descriptions are displayed in the table of service classes on the Service Classes page.
   c. Specify the general attributes of the service class. Most of the general properties specify requirements for provisioning. Some of the general properties specify configuration instructions for the storage resources or for the volumes or shares that are provisioned from them.

   **Tip:** To display help information about a service class property, move the mouse pointer over the field or control. Then, move the mouse pointer over the question mark icon displayed next to the field.

4. Optional: Specify or modify the advanced properties of the service class.
   a. From the Define Properties page, click **Advanced**.
   b. If you are creating a block-storage service class, and thin provisioning is enabled for the service class, specify configuration instructions for thin provisioning.
   c. If you are creating a block-storage service class, select how the multipath driver on the host is configured. For hypervisors, the multipath driver is configured only if provisioning is initiated from the vSphere Web Client extension for IBM Spectrum Control.
d. Create custom requirements for the service class by specifying up to three custom tags. To provide the service class, storage resources must have all the same tags that are specified in the service class.

5. Optional: In the Specify Capacity Pool page, associate the service class with one or more capacity pools. If capacity pools are associated with the service class, future provisioning requests that specify the service class can be satisfied only by storage resources in the capacity pools.

6. Optional: Grant permission to individual users, who do not have administrator privileges, to provision storage by using the service class. By default, users must be assigned to the Administrator role to provision storage. However, you can selectively grant users who are limited to the Monitor or External Application role permission to provision by using this service class. You can also specify whether administrator approval is required to run provisioning tasks that are created by these users.

7. Click Finish The new service class is listed in the table of service classes on the Service Classes page, and can be specified in future provisioning requests.

Viewing the details of service classes:

You can view the provisioning requirements and storage constraints that a service class defines. You can also view the volumes or shares that were provisioned by using the service class.

From the Service Classes page, you can open a properties page to view the following information for a service class:

- The properties of a service class, such as the required RAID level or storage tier for a block-storage service class.
- The storage constraints that are imposed by the service class. The service class can allow provisioning from all available storage, or can limit provisioning to one or more capacity pools.
- The users who can provision storage by using the service class.
- The volumes or shares that were provisioned by using the service class.
- The candidate storage for the service class. The candidate storage is the set of storage resources that can provide the service class.

To open the service class properties window from the Service Classes page, complete the following steps:

1. In the menu bar in the web-based GUI, go to Advanced Analytics > Cloud Configuration, and click Work With Service Classes. The Service Classes page is displayed.
2. From the list of service classes, select the service class, and then select Actions > View / Modify. The service class properties window is displayed.

Modifying service classes:

You can modify the attributes of a service class to change the provisioning requirements, capacity pool storage constraints, user permissions, and service class name.

You must have Administrator privileges to modify a service class.

Important: When volumes or shares are provisioned by specifying a service class, they are associated with the service class. The Volumes page and the Shares page in the web-based GUI can display the name of the service class that was used to
provision the volume or share. If you modify a service class, the volumes or shares are still associated with the service class, but might be on storage resources that no longer satisfy the requirements of the service class. Depending on your changes to the service class, users might incorrectly assume that the new volumes or shares have attributes that they do not possess.

Start this task at the Service Classes page. To open the Service Classes page, select **Advanced Analytics > Cloud Configuration > Work With Service Classes**. To modify a service class, complete the following steps:

1. From the list of service classes, select a service class and then select **Actions > View / Modify**. The service class properties window is displayed.
2. Optional: Click the **General** tab to modify the general attributes of the service class. Most of the general properties specify requirements for provisioning. Some of the general properties specify configuration instructions for the storage resources or for the volumes or shares that are provisioned from them.

   **Tip:** To display help information about a service class property, move the mouse pointer over the field or control. Then, move the mouse pointer over the question mark icon displayed next to the field.

3. Optional: Specify or modify the advanced properties of the service class.
   a. From the **General** tab, click **Advanced**.
   b. If you are modifying a block-storage service class, and thin provisioning is enabled for the service class, specify configuration instructions for thin provisioning.
   c. If you are modifying a block-storage service class, select how the multipath driver on the host is configured. For hypervisors, the multipath driver is configured only if provisioning is initiated from the vSphere Web Client extension for IBM Spectrum Control.
   d. Create custom requirements for the service class by specifying up to three custom tags. To provide the service class, storage resources must have all the same tags that are specified in the service class.
4. Optional: Modify storage constraints. If one or more capacity pools are defined in the IBM Spectrum Control database, you can associate the service class with one or more capacity pools. If capacity pools are associated with the service class, future provisioning requests that specify the service class can be satisfied only by storage resources in the capacity pools. If a capacity pool was previously associated with the service class, you can disassociate it from the service class.
5. Optional: Modify user permissions. By default, users must be assigned to the Administrator role to provision storage. However, you can selectively grant users who are limited to the Monitor or External Application role permission to provision by using this service class. You can also specify whether administrator approval is required to run provisioning tasks that are created by these users.

   If users in the Monitor or External Application roles have permission to provision by using the service class, you can revoke that permission. You can specify that only administrators can provision by using the service class, or you can selectively remove users. To remove a user, right-click the user name in the table and then select **Remove** from the context-sensitive menu.
Deleting service classes:

You can delete a service class that is no longer needed.

You must have Administrator privileges to delete a service class.

Deleting a service class does not affect the storage volumes or NAS shares that are already provisioned by using the service class. However, the storage volumes or NAS shares are no longer associated with any service class. When a volume that is not associated with a service class is optimized by the Optimization wizard, the volume can be migrated to any available storage pool. The storage pool to which the volume is migrated might not satisfy the requirements of the service class that was specified when the volume was provisioned.

You delete a service class from the Service Classes page.
1. In the menu bar in the web-based GUI, go to Advanced Analytics > Cloud Configuration, and click Work With Service Classes. The Service Classes page is displayed.
2. From the list of service classes, select the service class, and then select Actions > Delete.

Tagging resources to satisfy custom requirements:

A service class can specify tags to create custom requirements for provisioning. Add the same tags to storage resources that satisfy the custom requirements. When the service class is specified during provisioning, only the tagged resources are candidates for provisioning.

You must have Administrator privileges to tag storage resources.

When you provision storage, you indicate your storage requirements by specifying a service class. Certain properties of the service class describe capabilities that storage resources must have to be a candidate for provisioning. In addition to the default properties, a service class can define custom requirements by specifying up to three custom tags. To provide the service class, a storage resource must have all the same tags as the service class. The ability to define custom requirements by tagging service classes and storage resources gives you more control over the selection of storage resources during provisioning. By using tags, you can filter the candidates for provisioning by using any criteria that you choose.

When you provision volumes, you specify the requirements by using a block-storage service class. Based on the requirements of the service class, IBM Spectrum Control identifies a storage pool for the volume. If the service class specifies tags, only pools that have all the same tags are candidates for provisioning. If a pool is not tagged, any tags on the containing storage system also apply to the pool.

When you provision shares, you specify the requirements by using a file-storage service class. Based on the requirements of the service class, IBM Spectrum Control identifies a file system or Network Shared Disk (NSD) for the share. If the service class specifies tags, only file systems and NSDs that have all the same tags are candidates for provisioning. If a file system or NSD is not tagged, any tags on the containing storage system also apply to the internal resource.
Tag only the storage resources that satisfy the intended custom requirements of the service class. During provisioning, only the tagged resources can provide the service class.

1. Open the resource list page for the type of storage resource that you want to tag. To satisfy the custom tag requirements of a block-storage service class, you can tag a storage pool or its containing block storage system. To satisfy the custom tag requirements of a file-storage service class, you can tag a file system or NSD, or the containing file storage system.

   Important: The tags on a containing storage system apply to an internal pool, file system, or NSD resource only if the internal resource is not tagged.
   • If you are tagging a storage pool, from the menu bar, go to Storage > Pools.
   • If you are tagging the block storage system that contains the pools, complete the following steps:
     a. In the menu bar, go to Storage > Block Storage Systems.
     b. Click the Block Storage tab.
   • If you are tagging a file system or NSD, complete the following steps:
     a. In the menu bar, go to Storage > Block Storage Systems.
     b. Click the File Storage tab.
     c. From the list of storage systems, select the storage system that contains the file system or NSD, and then select View Details. Alternatively, you can select Actions > View Details.
     d. In the Internal Resources area, click File Systems or Network Shared Disks.
     • If you are tagging the file storage system that contains the file systems or NSDs, complete the following steps:
       a. In the menu bar, go to Storage > Block Storage Systems.
       b. Click the Block Storage tab.
   2. In the table of storage systems, pools, file systems, or NSDs, select the storage resource that you want to tag, and then select View Properties. Alternatively, you can select Actions > View Properties.
   3. In the properties notebook for the storage system, pool, file system, or NSD, click Edit.
   4. In the custom tag fields of the properties notebook, specify tags that match the tags that are specified in the service class. To provide the service class, the resource must have all of the same tags.
   5. In the properties notebook, click Save.

Setting access path host replacements:

If you are going to use the VMware vSphere Web Client extension to provision file shares, verify whether you must provide IBM Spectrum Control with an access path host replacement.

You need to provide an access path host replacement if the cluster name of an IBM SONAS or Storwize V7000 Unified is not a valid host name that is registered with a Domain Name System (DNS) server.

Complete the following steps to verify cluster host names and to provide access host name replacements where necessary:

1. In the menu bar, go to Storage > Block Storage Systems.
2. Click the **File Storage** tab.

3. For each IBM SONAS and Storwize V7000 Unified system, complete the following steps to determine whether you must specify a replacement host name.
   a. From the **File System** tab of the Storage System page, select the storage system, and then select **Actions > View Details**.
   b. From the list of File Internal Resources, click **Clusters**.
   c. Determine whether the cluster name is a valid host name that is registered with a DNS server. If the cluster name is registered with a DNS server, the access path that is returned by the IBM Spectrum Control will be valid. If the cluster name is not valid, the VMware vSphere Web Client extension will not be able to access the share unless you specify a host name replacement for the access path.

4. For each IBM SONAS and Storwize V7000 Unified system that requires a host name replacement, complete the following steps:
   a. From the **File Storage** tab of the Storage Systems page, select the storage system, and then select **Actions > View Properties**.
   b. In the properties notebook for the storage system, click **Edit**.
   c. In either the Custom Tag 1, Custom Tag 2, or Custom Tag 3 field, enter a fully qualified host name that is mapped to one or more interface nodes of the storage system.

   **Requirement:** For all storage systems that require a replacement host name, ensure that you set the replacement host name by using the same custom tag. For all IBM SONAS and Storwize V7000 Unified systems that do not require a replacement host name, ensure that the custom tag is empty.

5. When you are creating or modifying file-storage service classes that might be used by the VMware vSphere Web Client extension, set the access host replacement to the custom tag that is set on the file storage systems. To set the access host replacement, complete these steps:
   a. From the list of general properties in the Create Service Class wizard or the service class properties window, click **Advanced**.
   b. On the **General** tab of the Advanced Properties window for the file-storage service class, set the access path host replacement to the custom tag that specifies the replacement host name. When the share is provisioned, the access path that is returned by IBM Spectrum Control includes the replacement host name if one is specified on the custom tag for the storage system. If the storage system does not specify a value for the custom tag, the cluster name is used in the access path.

**Configuring capacity pools**

Configure capacity pools to track the used and available space for block and file storage on any set of storage resources. Provisioning requests can also be restricted to resources in a capacity pool.

**Adding resources to capacity pools:**

Divide storage resources into capacity pools to later restrict provisioning or optimization to a specific set of resources. You can also use capacity pools to track the used and available space for block and file storage on any set of storage resources. You can add resources to an existing capacity pool, or you can create a new capacity pool.
You must have Administrator privileges to perform this task.

You can add storage resources to a capacity pool from resource list pages such as the Storage Systems page and the Pools page.

You can add the following resource types to a capacity pool:
- Storage systems
- Storage pools
- File systems of file storage systems
- IBM SONAS Network Shared Disks (NSDs)

When you add a storage system to a capacity pool, any storage pool, file system, or IBM SONAS NSD that is an internal resource of that storage system is also indirectly assigned to the capacity pool.

**Restriction:** A resource can be assigned to only one capacity pool. When you attempt to add one or more resources to a capacity pool that are already assigned to different capacity pool, IBM Spectrum Control displays a message that lists the resources and their capacity pool assignments. When a message is displayed, ensure that you want to change the capacity pool assignments for the listed resources.

To add one or more resources to a capacity pool, complete these steps:

1. Open the appropriate list page for the resource you want to add. You can add an entire storage system, or you can add individual pools, file systems, or IBM SONAS NSDs.
   - To add a storage system, in the menu bar, go to **Storage > Block Storage Systems** or **Storage > File Storage Systems**.
   - To add a storage pool, in the menu bar, go to **Storage > Pools**.
   - To add a file system or IBM SONAS NSD, complete the following steps:
     a. In the menu bar, go to **Storage > File Storage Systems**.
     b. Select the storage system that contains the file system or IBM SONAS NSD, and then select **View Details** from the context-sensitive menu.
     c. From the Internal Resources list, click **File Systems** or **Network Shared Disks**.

2. To add one or more resource to a capacity pool, select the resources in the list, and then select **Actions > Add to Capacity Pool**. If one or more capacity pools are defined, a list of capacity pools is displayed. If no capacity pools are defined, the Create Capacity Pool window is displayed so that you can add resources to a new capacity pool.

   **Tip:** The list of capacity pools and the Create Capacity Pool window shows capacity information. For the list of capacity pools, the Capacity column shows a bar that summarizes the used and free space in each capacity pool. In the Create Capacity Pool window, a capacity bar summarizes the used and free space of the resources that are being added to the new capacity pool. Move the mouse pointer over the bar to display a text summary and details of the capacity usage.

3. Take one of the following actions:
   - If the Create Capacity Pool window is displayed, go to step 4 on page 202
   - If a list of capacity pools is displayed, add the selected resources to an existing capacity pool or to a new capacity pool.
- To add the selected resource or resources to an existing capacity pool, select the appropriate row in the list of capacity pools, and click **Save**.
- To add the selected resource to a new capacity pool, click **Create Capacity Pool**. The Create Capacity Pool window is displayed.

4. In the Create Capacity Pool window, specify a name for the capacity pool.
6. Optional: Specify custom tags to associate any significant information with the capacity pool. You can specify up to three custom tags. The custom tags can be displayed in the list of capacity pools on the Capacity Pools page.
7. Save the new capacity pool by clicking **OK**.

**Viewing the details of capacity pools:**

You can view details of a capacity pool, such as its total capacity, used and available space, and member resources.

The Capacity Pools page lists all of the capacity pools that are defined in IBM Spectrum Control. For any capacity pool in the list, you can open a window to view more details about the capacity pool and its storage resources.

To view details of a capacity pool, complete these steps:

1. In the menu bar in the web-based GUI, go to **Advanced Analytics > Cloud Configuration**, and click **Work With Capacity Pools**. The Capacity Pools page is displayed.
2. From the list of capacity pools, select the capacity pool, and then select **Actions > View / Modify**. A window is displayed, showing the following details:
   - A bar summarizing the used and free space in the capacity pool in gibibytes. The bar represents the total capacity of the capacity pool. The bar is divided into sections that represent the following measurements:
     - The amount of space that is used for file storage
     - The amount of available space for file storage
     - The amount of space that is used for block storage
     - The amount of block storage space that is not used for volumes, and is not reserved by pending or scheduled provisioning tasks.
     - The amount of block storage space that is reserved by pending or scheduled provisioning tasks
   - Move the mouse pointer over the bar to display a text summary and details of the capacity usage, and a legend for interpreting the colors on the bar.
   - A table that lists the storage systems, storage pools, file systems, and IBM SONAS Network Shared Disks (NSDs) that are in the capacity pool. To view details of any of these resources, select the resource, and then select **Actions > View Properties**.

**Modifying capacity pools:**

You can modify the attributes of a capacity pool such as its name and description, and you can remove storage resources from a capacity pool.

You must have Administrator privileges to perform this task.

To modify a capacity pool, complete these steps:
1. In the menu bar in the web-based GUI, go to **Advanced Analytics > Cloud Configuration**, and click **Work With Capacity Pools**. The Capacity Pools page is displayed.

2. From the list of capacity pools, select the capacity pool, and then select **Actions > View / Modify**. A window that shows details of the capacity pool is displayed. A table lists the storage systems, storage pools, file systems, and IBM SONAS Network Shared Disks (NSDs) that are in the capacity pool.

3. Optional: Modify attributes of the capacity pool.

4. Optional: Remove one or more resources from the capacity pool. Removing a storage resource from a capacity pool does not delete the storage resource, but does remove its capacity from the capacity pool. To remove resources, select the appropriate resources in the list, and then select **Actions > Remove**. The resources are removed from the list, but are not removed from the capacity pool until you save your changes.

5. Click **Save**.

**Deleting capacity pools:**

You can delete a capacity pool that is no longer needed.

You must have Administrator privileges to perform this task.

When you delete a capacity pool, the storage resources that were added to the capacity pool are no longer members of any capacity pool. Deleting a capacity pool does not affect any volumes or NAS shares that were provisioned from the capacity pool. However, the volumes or NAS shares are no longer associated with a capacity pool.

To delete a capacity pool, complete the following steps:

1. In the menu bar in the web-based GUI, go to **Advanced Analytics > Cloud Configuration**, and click **Work With Capacity Pools**. The Capacity Pools page is displayed.

2. From the list of capacity pools, select the capacity pool, and then select **Actions > Delete**

3. In the confirmation window, click **Delete**.

**Block storage: Calculating available space and determining the placement of volumes**

For each block-storage service class, IBM Spectrum Control calculates the amount of available space for volumes of that service class. When you request volumes of a particular service class, IBM Spectrum Control recommends the best location for the volumes from the available space.

The Service Classes page in the web-based GUI displays the available space for each block-storage service class. The available space is the amount of space that is available across storage pools for new volumes of the service class. Typically, not all pools are used in the available-space calculation. Some pools might be eliminated because of the consolidated status of the pool or its storage system. Other pools might be eliminated because they do not satisfy the requirements of the service class. The set of storage pools that are used to calculate the available space are also the candidates for provisioning by using the service class.

When you request storage volumes by using the Provision Storage wizard, you specify the capacity that is required for one or more volumes, and you specify a
service class. You can also specify a capacity pool from which the volumes must be provisioned. Based on the volume size that is requested and if a capacity pool is specified, the candidates for provisioning are further refined to include only the pools that have enough available space and are in the specified capacity pool. From the remaining candidates for provisioning, IBM Spectrum Control creates a provisioning task that identifies the best location for the new volumes.

**How available space for a block-storage service class is calculated**

For each block-storage service class, IBM Spectrum Control calculates the available space for volumes of that service class. Only storage pools that are candidates for provisioning by using the service class are used to calculate the available space.

Identifying candidates for provisioning is a filtering process. For example, if the service class specifies that RAID 10 is required, then any storage pool that is not configured at RAID 10 is eliminated as a candidate for provisioning. IBM Spectrum Control filters the set of available storage resources against certain properties of the service class until only the storage resources that can satisfy all of the requirements remain. These remaining storage resources are the candidates for provisioning. Only certain properties of a service class are used to identify candidates for provisioning. More advanced properties contain configuration instructions, and are not used to identify candidates for provisioning.

The candidates for provisioning are identified by eliminating storage pools that cannot provide the service class, as follows:

- If a storage pool is a primordial pool or if it is formatted for count key data (CKD) volumes, it is not a candidate for provisioning.
- If a storage system has a condition of Error or Unreachable, none of its internal storage pools are candidates for provisioning. If a storage pool has a status of Error, it is not a candidate for provisioning.

**Remember:** *Status* is different from *condition*. Status is the status reported by a storage resource without considering the status of its internal resources. Condition is the combined status of the monitored, internal resources for the higher-level resource, and the status of the higher-level resource itself. The condition of a storage system is shown on the Storage Systems page and the condition for a pool is shown on the Pools page. The condition of a resource might not have the same value as the status, which is used to eliminate pools as candidates for provisioning.

Although the condition of a resource might not have the same value as its status, the condition is always at least as severe as the status. The condition reflects the most severe status of any internal resource or the status of the resource itself. If the condition of a resource is Normal, then its status is also Normal.

**Tip:** The Service Classes page in the web-based GUI displays both the available space and the unavailable space for a service class. The Unavailable Space column shows the amount of storage that satisfies the requirements of the service class, but is unavailable because of the consolidated status of the storage system or its internal resources.

- If a service class allows provisioning only from certain capacity pools, any storage pool that is not in a specified capacity pool is eliminated as a candidate for provisioning.
Tip: You can see whether a service class restricts provisioning to one or more capacity pools from the Service Classes page. On the Service Classes page, show the Capacity Pools column, which is hidden by default.

- A storage pool must satisfy the requirements of every service class property in the following table to be a candidate for provisioning. Other properties of a service class are instructions for provisioning and do not affect whether the storage pool is a candidate for provisioning.

Table 43. Filtering candidates for provisioning based on service class properties

<table>
<thead>
<tr>
<th>Service class property:</th>
<th>Candidates for provisioning:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage tier</td>
<td>If specified in the service class, storage pools that are assigned to any storage tier within the specified range are candidates for provisioning.</td>
</tr>
<tr>
<td>RAID level</td>
<td>If a RAID level is specified, only storage pools that are configured at the specified RAID level are candidates for provisioning. <strong>Exception:</strong> The IBM XIV Storage System uses a nontraditional approach to data redundancy and does not support any of conventional RAID levels. IBM Spectrum Control always considers XIV storage pools to be configured at RAID 10. <strong>Restriction:</strong> Storage pools that support multiple RAID levels are not candidates for provisioning when a service class specifies a RAID level. Storage pools that support multiple RAID levels are not candidates even when the specified RAID level is one of the RAID levels that are supported by the storage pool. Storage pools that support multiple RAID levels are only candidates for provisioning when the service class specifies that any RAID level is allowed.</td>
</tr>
<tr>
<td>Virtualization</td>
<td>If virtualization is required by the service class, only storage pools on IBM storage virtualizers are candidates for provisioning. The IBM storage virtualizers are SAN Volume Controller, Storwize V7000, and Storwize V7000 Unified. If virtualization is not allowed by the service class, only storage pools that are not on IBM storage virtualizers are candidates for provisioning.</td>
</tr>
<tr>
<td>Encryption</td>
<td>If encryption is required by the service class, only storage pools on DS8000 storage systems that are encrypted and configured to use the encryption group that is specified in the service class are candidates for provisioning. If encryption is not allowed by the service class, only pools that are not encrypted are candidates for provisioning.</td>
</tr>
<tr>
<td>Thin provisioning</td>
<td>If thin provisioning is required by the service class, only storage pools that are configured for thin provisioning are candidates for provisioning. Thin provisioning is supported by the XIV, DS8000, SAN Volume Controller, Storwize V7000, and Storwize V7000 Unified. During provisioning, a thin-provisioned volume is created. If thin provisioning is not allowed by the service class, any storage pool that is not thin provisioned is a candidate for provisioning. In addition, any DS8000, SAN Volume Controller, Storwize V7000, or Storwize V7000 Unified storage pool is a candidate for provisioning, regardless of whether it is configured for thin provisioning. During provisioning, the volume that is created is not thin provisioned.</td>
</tr>
<tr>
<td>Compression</td>
<td>If compression is required by the service class, at least one I/O group of an IBM storage virtualizer must be enabled for compression. Only pools of the IBM storage virtualizer are candidates for provisioning.</td>
</tr>
</tbody>
</table>
Table 43. Filtering candidates for provisioning based on service class properties (continued)

<table>
<thead>
<tr>
<th>Service class property:</th>
<th>Candidates for provisioning:</th>
</tr>
</thead>
</table>
| Overallocation limit    | If thin provisioning is required by the service class, IBM Spectrum Control identifies the storage pools that can thin provision volumes as candidates for provisioning. If an overallocation limit is specified, IBM Spectrum Control refines that list to include only the storage pools that have an overallocation percentage that does not exceed the overallocation limit. The overallocation percentage for a pool is determined by using the following measurements, as shown on the Pools page:  
  • For an XIV storage pool, the Soft Space divided by the Capacity.  
  • For other storage system pools, the Virtual Allocation. |
| Resource Tags           | Resource tags further refine the candidates for provisioning. A service class can specify up to 3 resource tags. If resource tags are specified for the service class, only pools that have all the same tags are candidates for provisioning. If a pool is not tagged, any tags on the containing storage system also apply to the pool. |

After the storage pools that can provide the service class are identified, IBM Spectrum Control calculates the amount of space that is available for provisioning new volumes of the service class. The calculated volume capacity is shown in the Available Space column on the Service Classes page.

The available-space calculation differs depending on whether the block-storage service class requires thin provisioning, as follows:

• If thin provisioning is not allowed, the available space is the sum of the following measurements, as shown on the Pools page:
  – For each XIV System pool, the Available Soft Space minus any Reserved Pool Space
  – For other storage system pools, the Available Pool Space minus any Reserved Pool Space.

• If thin provisioning is required, the available space is the total of the following measurements, as shown on the Pools page, and calculations:
  – For each XIV System pool, the Available Soft Space minus any Reserved Pool Space
  – For other storage system pools, the pool Capacity multiplied by the overallocation limit that is specified in the service class, minus the Total Volume Capacity. Any Reserved Pool Space is subtracted from the result. For DS8000 storage pools, any space that is used by Track Space Efficient (TSE) volumes is subtracted from the calculated available space.

**How the recommended placement of storage volumes is determined**

When you request one or more new volumes by using the Provision Storage wizard, the candidates for provisioning are further refined and a provisioning task is created which shows the recommended placement of the new volumes. The same filtering that was used to determine the available space for the service class is used, and is refined further as follows:

• A provisioning request specifies the set of storage pools from which the storage can be provisioned. This set can be all the storage pools that are known to IBM Spectrum Control, or can be limited to the storage pools in a particular capacity.
pool. Only the storage pools in the specified set are candidates for provisioning. This set might be more restrictive than the set used to calculate the available space for the service class.

- Any storage pool that cannot provide the requested volume capacity is eliminated as a candidate for provisioning.
- If virtualization and VDisk mirroring are specified by the service class, then a VDisk copy of the volume must be made in a second storage pool on the same IBM storage virtualizer. If the storage pools on the IBM storage virtualizer cannot provide the requested capacity for both the volume and its mirrored copy, the pools are eliminated as candidates for provisioning.
- If an overallocation limit is specified in the service class, only the storage pools that will not exceed the limit after the new volume or volumes are provisioned are candidates for provisioning.

**Remember:** Storage pools that have an overallocation percentage that does not exceed the overallocation limit, are included in the available-space calculation. However, if the overallocation percentage would exceed the overallocation limit after the requested volume space is included, the pools are not candidates for provisioning.

After the storage pools that can satisfy the provisioning request are identified, IBM Spectrum Control finds the best location for the storage. The best location for the storage is based on the unallocated volume space in the pool and performance data. Preference is first given to storage pools and systems that already contain volumes for the selected server or hypervisor. Preference is given to systems that have available performance data.

**File storage: Calculating available space and determining the placement of shares**

For each file-storage service class, IBM Spectrum Control calculates the amount of available space for NAS file shares of that service class. When you request file shares of a particular service class, IBM Spectrum Control recommends the best location for the shares from the available space.

For each file-storage service class, IBM Spectrum Control calculates the amount of available space for NAS file shares of that service class. When you request file shares of a particular service class, IBM Spectrum Control recommends the best location for the shares from the available space.

The Service Classes page displays the available space for each file-storage service class. The available space is the amount of space that is available across all IBM SONAS and IBM Storwize V7000 Unified file systems and unused IBM SONAS system NSDs that are known to IBM Spectrum Control, and that can satisfy the requirements of the service class. The set of file storage resources that are used to calculate the available space are also the candidates for provisioning by using the service class.

When you request a file share by using the Provision Storage wizard, you specify the capacity that is required for the share, and you specify a service class. You can also specify a capacity pool from which shares must be provisioned. Based on the requested size of the share and whether a capacity pool is specified, the candidates for provisioning are further refined to include only the file storage resources that have enough available space and are in the specified capacity pool. From the remaining candidates for provisioning, IBM Spectrum Control creates a provisioning task that identifies the best location for the new share.
How available space for a file-storage service class is calculated

For each file-storage service class, IBM Spectrum Control calculates the available space for file shares of the service class. Only the file storage resources that are candidates for provisioning by using the service class are used to calculate the available space.

Identifying candidates for provisioning is a filtering process. For example, if the service class requires dedicated storage, then the share must be created on an unused NSD within an IBM SONAS system. File systems that could be candidates for provisioning if shared storage is allowed are eliminated as candidates for provisioning when dedicated storage is required. IBM Spectrum Control filters the set of available storage resources against each attribute of the service class until only the storage resources that can satisfy all of the requirements remain. These remaining storage resources are the candidates for provisioning.

The candidates for provisioning are identified by eliminating storage resources that cannot provide the service class, as follows:

- Only IBM SONAS and IBM Storwize V7000 Unified systems are supported for provisioning file shares. No other storage system type is a candidate for provisioning file shares.
- If a storage system has a consolidated status of Error or Unreachable, none of its internal NSDs or file systems are included in the available-space calculation.
- If an NSD or file system has a consolidated status of Error, it is not included in the available-space calculation.

**Tip:** The status of file systems is not displayed in the web-based GUI. View the status on the NSD on which a file system resides to determine the file system status.

- If the storage volume or NSD on which a file system resides has a consolidate status of Error, the file system is not included in the available-space calculation.

**Remember:** Status is different from condition. Status is the status reported by a storage resource without considering the status of its internal resources. Condition is the combined status of the monitored, internal resources for the higher-level resource, and the status of the higher-level resource itself. The condition of a storage system is shown on the Storage Systems page, the condition of a volume is shown on the Volumes page, and the condition of an NSD is shown on the storage system details page. The condition might not have the same value as the status, which is used to eliminate file storage resources as candidates for provisioning.

Although the condition of a resource might not have the same value as its status, the condition is always at least as severe as the status. The condition reflects the most severe status of any internal resource or the status of the resource itself. If the condition of a resource is Normal, then its status is also Normal.

**Tip:** The Service Classes page in the web-based GUI displays both the available space and the unavailable space for a service class. The Unavailable Space column shows the amount of storage that satisfies the requirements of the service class, but is unavailable because of the consolidated status of the storage system or its internal resources.
• If a service class allows provisioning only from certain capacity pools, any storage resource that is not in a specified capacity pool is eliminated as a candidate for provisioning.

**Tip:** You can see whether a service class restricts provisioning to one or more capacity pools from the Service Classes page. On the Service Classes page, show the Capacity Pools column, which is hidden by default.

• A file system or NSD must satisfy the requirements of every service class property in the following table to be a candidate for provisioning. Other properties of a service class are instructions for provisioning and do not affect the storage placement determination.

**Table 44. Filtering candidates for provisioning based on service class properties**

<table>
<thead>
<tr>
<th>Service class attribute:</th>
<th>Candidates for provisioning:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared storage / Dedicated storage</td>
<td>If the service class specifies dedicated storage, the share can be created only on an unused NSD within an IBM SONAS system. File systems and other file storage resources are eliminated as candidates for provisioning.</td>
</tr>
<tr>
<td>Resource tags</td>
<td>Resource tags further refine the candidates for provisioning. A service class can specify up to 3 resource tags. If resource tags are specified for the service class, only file systems and NSDs that have all the same tags are candidates for provisioning. If a file system or NSD is not tagged, any tags on the containing storage system also apply to the internal resource.</td>
</tr>
</tbody>
</table>

After the file storage resources that can provide the service class are identified, IBM Spectrum Control calculates the amount of space that is available for providing new files shares of the service class.

The available-space calculation differs depending on whether the file-storage service class requires dedicated storage or allows shared storage, as follows:

• If the file-storage service class requires dedicated storage, the available space is the total available space on unused NSDs within each IBM SONAS system. You can verify that an NSD is unused, and view its available space, from the details page of an IBM SONAS system. To view information about the NSDs that are associated with an IBM SONAS system, click **Network Shared Disks**. If the NSD is unused, the File Systems column shows 0. The Available Space column shows the amount of space on the NSD, which is the measurement that is used in the available-space calculation for the service class.

• If the file-storage service class allows shared storage, the file system in which the NAS share is provisioned can contain other NAS shares. In this case the available space is the total of the following measurements:
  – The available space on unused NSDs within each IBM Scale Out Network Attached Storage (IBM SONAS) system.
  – The available space for each file system within each IBM SONAS and IBM Storwize V7000 Unified storage system. You can view the file system available space from the details page of a file storage system. To view information about the file systems that are in a storage system, click **File Systems**. The Available Space column shows the amount of available space on each file system, which is the measurement that is used in the available-space calculation for the service class.
How the recommended placement of file shares is determined

When you request a file share by using the Provision Storage wizard, the candidates for provisioning are further refined and a provisioning task is created which shows the recommended placement of the new share. The same filtering that was used to determine the available space for the service class is used, and is refined further as follows:

- A provisioning request specifies the set of file storage resources from which the storage can be provisioned. This set can be all the storage resources that are known to IBM Spectrum Control, or can be limited to the storage resources in a particular capacity pool. Only the storage resources in the specified set are candidates for provisioning. This set might be more restrictive than the set used to calculate the available space for the service class.
- Any storage resource that cannot provide the requested capacity for the share is eliminated as a candidate for provisioning.

The shares are created on file systems or IBM SONAS NSDs. After the file systems and NSDs that can satisfy the provisioning request are identified, IBM Spectrum Control identifies the best location for the storage. The best location for the storage is based on the available space on the file system or NSD.

Changing the default host definition for provisioned storage

Use the setdscfg command to change the default host definition for fibre-channel ports when provisioning storage from IBM Spectrum Virtualize devices.

You must have Administrator authority to use the setdscfg command.

When you provision storage from a SAN Volume Controller, IBM Storwize, or IBM FlashSystem family V840 or V9000 device, which does not have an existing host definition for the fibre-channel ports, IBM Spectrum Control creates a new host definition during the provisioning task. The new host definition can access only one I/O group on the source device that you specified when you created the provisioning task. To allow the new host definition to access any I/O group on the source device, use the management application for the source device or use the IBM Spectrum Control setdscfg command.

To change the host definition to allow access to any I/O groups on the source device:

1. Start the IBM Spectrum Control CLI by issuing the tpctool command.
2. Issue the setdscfg command with the following values for the -property and -context parameters:
   a. Specify Configuration.RestrictNewHostsToIogroup as the property value.
   b. Specify DiskManager as the context value and specify false as the context parameter.

   For example, to allow the new host definition to access any I/O groups on the source device of the provisioning task:

   tpctool setdscfg -url localhost:9550 -user ***** -pwd *****
   -property Configuration.RestrictNewHostsToIogroup -context DiskManager false

   The value of Configuration.RestrictNewHostsToIogroup is set to false in the IBM Spectrum Control database. This removes the default restriction on the new host definition and allows access to any I/O groups on the provisioning source device.
Tip: To verify that the host definition restriction is changed, enter the following command:

tpctool getdscfg -url localhost:9550 -user ***** -pwd *****
-property Configuration.RestrictNewHostsToIogroup -context DiskManager

Provisioning storage with the IBM Spectrum Control GUI

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

The prerequisites for provisioning storage are as follows:

- You must have the IBM Spectrum Control Advanced Edition license.
- You must have Administrator privileges or permission to use one or more of the service classes that are created for block-storage or file-service provisioning.
- You must add and probe block-storage or file-storage resources, or both.

The following restrictions apply to volume provisioning:

- If the service class that is associated with the provisioning request requires multipathing or if automatic zoning is enabled, the fabrics and switches must be managed by IBM Spectrum Control. If the fabric is not managed by IBM Spectrum Control, the fabric-related configuration options are ignored when the provisioning task is executed.
- If you provision volumes to physical servers and servers that are virtual machines, you must create separate provisioning tasks using the GUI.
- If you provision multiple servers with storage volumes, the servers must all run on the same operating system. If the servers are virtual machines, the hypervisors that manage the servers must all run on the same operating system.
- If the provisioning request involves assigning multiple volumes to a resource, the volumes are sourced from pools in the same storage system.

NAS file shares can be provisioned only from IBM SONAS or Storwize V7000 Unified storage systems.

Specify the capacity that is required and the service class that you want to associate with the provisioning task. For shares, you must also specify at least one file access protocol. IBM Spectrum Control identifies the storage resources that can provide the storage capacity and that meet the criteria that are specified for the service class. From the set of storage resources that can provide the capacity and service class, IBM Spectrum Control identifies the best location for the storage and creates a provisioning task. Depending on the privileges that are associated with your role, you can save, execute, or schedule the provisioning task.

Provisioning volumes to servers

You can provision volumes to one or more servers. The GUI guides you through the steps of requesting capacity and specifying requirements by using a service class.

You can provision volumes to one or more servers. If a server is a virtual machine, the storage is provisioned to the hypervisor that is managing the server.

1. In the menu bar, go to Servers > Servers.

   Tip: Alternatively, you can go to Advanced Analytics > Provisioning, and click Provision to Servers.

2. Select one or more servers, and then select Actions > Provision Storage.
3. Follow the instructions to assign the storage volumes.

The GUI enables you to create a provisioning task.

**Related tasks:**

“Provisioning storage with the IBM Spectrum Control GUI” on page 211

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning volumes to hypervisors**

You can provision volumes to one or more hypervisors. To provision volumes, the GUI guides you through the steps of requesting capacity and specifying requirements by using a service class.

**Restriction:** The multipath driver is configured only if provisioning is initiated from the vSphere Web Client extension for IBM Spectrum Control.

You can provision volumes to one or more hypervisors.

1. Servers > Hypervisors

   **Tip:** Alternatively, you can go to Advanced Analytics > Provisioning, and click Provision to Hypervisors.

2. Select one or more hypervisors, and then click Actions > Provision Storage.

3. Follow the instructions to assign the storage volumes.

The GUI enables you to create a provisioning task.

**Related tasks:**

“Provisioning block storage” on page 216

Use the vSphere Web Client extension for IBM Spectrum Control to provision block storage on IBM Spectrum Control. You can also have a data store created on the storage volume.

“Provisioning storage with the IBM Spectrum Control GUI” on page 211

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning volumes to a server cluster**

You can assign volumes to a cluster of servers with the GUI.

If the cluster is on servers that are virtual machines, the storage is assigned to the hypervisors that manage the servers. The volumes are assigned to all of the nodes in the cluster.

1. In the menu bar, go to Servers > Servers, and click Clusters.

   **Tip:** Alternatively, you can go to Advanced Analytics > Provisioning, click Provision to Servers, and click Clusters.

2. Select a cluster, and then click Actions > Provision Storage.

3. Follow the instructions to assign the storage volumes.

The GUI enabled you to create a provisioning task.

**Related tasks:**

“Provisioning storage with the IBM Spectrum Control GUI” on page 211

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.
**Provisioning volumes to a hypervisor cluster**
You can assign volumes to a cluster of hypervisors.

**Restriction:** The multipath driver is configured only if provisioning is initiated from the vSphere Web Client extension for IBM Spectrum Control.

The volumes are assigned to all of the nodes in the hypervisor cluster.
1. In the menu bar, go to **Servers > Hypervisors**, and click **Clusters**.

   **Tip:** Alternatively, you can go to **Advanced Analytics > Provisioning**, click **Provision to Hypervisors** and click **Clusters**.
2. Select a cluster, and then click **Actions > Provision Storage**.
3. Follow the instructions to assign the storage volumes.

The GUI enabled you to create a provisioning task.

**Related tasks:**
- “Provisioning block storage” on page 216
  Use the vSphere Web Client extension for IBM Spectrum Control to provision block storage on IBM Spectrum Control. You can also have a data store created on the storage volume.
- “Provisioning storage with the IBM Spectrum Control GUI” on page 211
  You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning shares to servers**
You can provision a network-attached storage (NAS) file share to one or more servers. The GUI guides you through the steps of requesting capacity, specifying requirements by using a service class, and providing information about how to export the share.

You can provision a NAS file share to one or more servers. The share is made available to the selected servers, but is not automatically mounted from the selected servers.
1. In the menu bar, go to **Servers > Servers**.

   **Tip:** Alternatively, you can go to **Advanced Analytics > Provisioning**, and click **Provision to Servers**.
2. Select one or more servers, and then select **Actions > Provision Storage**.
3. Follow the instructions to assign the share.

The GUI enabled you to create a provisioning task.

**Related tasks:**
- “Provisioning storage with the IBM Spectrum Control GUI” on page 211
  You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning shares to hypervisors**
You can provision a network-attached storage (NAS) file share to one or more hypervisors. The GUI guides you through the steps of requesting capacity, specifying requirements by using a service class, and providing information about how to export the share.
You can provision a NAS file share to one or more hypervisors. The share is made available to the selected hypervisors, but is not automatically mounted from the selected hypervisors.

1. In the menu bar, go to Servers > Hypervisors.

   **Tip:** Alternatively, you can go to Advanced Analytics > Provisioning, and click Provision to Hypervisors.

2. Select one or more hypervisors, and then select Actions > Provision Storage.

3. Follow the instructions to assign the share.

The GUI enabled you to create a provisioning task.

**Related tasks:**

- “Provisioning file storage” on page 217
- Use the vSphere Web Client extension for IBM Spectrum Control to provision file storage on IBM Spectrum Control.
- “Provisioning storage with the IBM Spectrum Control GUI” on page 211

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning shares to a server cluster**

You can assign a network-attached storage (NAS) file share to a server cluster using the GUI.

You can provision a NAS file share to a server cluster. The share is made available to the servers in the cluster, but is not automatically mounted from the selected servers.

To provision a NAS file share to a server cluster, follow these steps:

1. In the menu bar, go to Servers > Servers, and click Clusters.

   **Tip:** Alternatively, you can go to Advanced Analytics > Provisioning, click Provision to Servers, and click Clusters.

2. Select a cluster, and then select Actions > Provision Storage.

3. Follow the instructions to assign the share.

A provisioning task was created for a server cluster.

**Related tasks:**

- “Provisioning storage with the IBM Spectrum Control GUI” on page 211

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning shares to a hypervisor cluster**

You can assign a network-attached storage (NAS) file share to a hypervisor cluster.

You can provision a NAS file share to a hypervisor cluster. The share is made available to the hypervisors in the cluster, but is not automatically mounted from the selected hypervisors.

To provision a NAS file share to a hypervisor cluster, follow these steps:

1. In the menu bar, go to Servers > Hypervisors, and click Clusters.

   **Tip:** Alternatively, you can go to Advanced Analytics > Provisioning, click Provision to Hypervisors and click Clusters.
2. Select a cluster, and then select Actions > Provision Storage.

3. Follow the instructions to assign the share.

A provisioning task was created for a hypervisor cluster.

Related tasks:

“Provisioning storage with the IBM Spectrum Control GUI” on page 211

You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

**Provisioning with zone control**

When you provision storage, you can set a zoning policy to enable automatic zoning. When automatic zoning is enabled, IBM Spectrum Control can create zones during storage provisioning to connect a server to a storage system.

When IBM Spectrum Control creates a provisioning task, it identifies the best location for the new storage that satisfies the requirements of the service class. If automatic zoning is enabled, then, during provisioning, existing zones are used if the server already has connectivity to the storage system. Otherwise, one or more zones are created between a host initiator port and a controller, node, or module port.

IBM Spectrum Control provides the following support for zone control and management of Cisco switches and fabrics:

- the standard Cisco zone control capabilities
- the Cisco Enhanced Zoning features.

For Cisco zone control and management, SNMP agents must be configured for the Cisco fabrics and switches. SNMPv3 is the preferred version.

When you use IBM Spectrum Control for zone control and management of Brocade switches and fabrics, follow these guidelines:

- For Brocade fabrics, information is typically collected through Storage Management Initiative (SMI) agents, also referred to as CIM agents.
- For zone discovery for any fabrics with Brocade switches or vendor Brocade switches, you must have an SMI agent configured for the fabric.

To set or modify the zoning policy, complete the following steps:

1. In the menu bar in the web-based GUI, go to Advanced Analytics > Provisioning, and click Set Zoning Policy.

2. Enable or disable automatic zoning:

   - Enable automatic zoning to allow IBM Spectrum Control to create zones during storage provisioning. The naming convention for new zones is `host_storage-system_suffix-number`. When you enable automatic zoning, you can specify the following options:

     **Zone name prefix**

     If you specify a zone name prefix, all zones that are automatically created by IBM Spectrum Control are prefixed with a string you specify. This prefix can help you identify which zones were automatically created, and which were created manually.

     **Make changes to the active zone set**

     Whether changes are made to the active zone set, or to a new inactive active zone set. If this check box is selected, changes are
made to the active zone set. If the check box is cleared, changes are made to the inactive zone set. The new inactive zone will contain only the new zones.

- Disable automatic zoning if you want IBM Spectrum Control to use only existing zones.

3. Click **Save**.

**Provisioning storage with the vSphere Web Client extension**

You can use the vSphere Web Client extension for IBM Spectrum Control to manage and monitor your virtual environment and storage devices.

You can provision block and file storage to hypervisors from storage devices that are monitored by IBM Spectrum Control. You can monitor the progress of your storage provisioning activities in task information in the vSphere Web Client.

**Provisioning block storage**

Use the vSphere Web Client extension for IBM Spectrum Control to provision block storage on IBM Spectrum Control. You can also have a data store created on the storage volume.

Ensure that you complete the following tasks in IBM Spectrum Control:

- If you want to provision storage by using service classes to describe performance and storage requirements and to implement multipathing policies, ensure that the service classes are created in IBM Spectrum Control. IBM Spectrum Control provides a number of predefined service classes, which you can use, modify, or delete.

- If you want to provision storage by using capacity pools to specify your storage requirements, ensure that the capacity pools are created in IBM Spectrum Control.

- Before you provision storage to a hypervisor, ensure that the hypervisor is added into IBM Spectrum Control. If the hypervisor belongs to a cluster, all the hypervisors on that cluster must be managed by IBM Spectrum Control.

- Ensure that the hypervisor has fabric connectivity. If automatic zoning is enabled, the fabrics and switches must be managed by IBM Spectrum Control.

For more information about configuring for storage cloud provisioning, see [http://www.ibm.com/support/knowledgecenter/SS5R93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_c_cloud_config.html](http://www.ibm.com/support/knowledgecenter/SS5R93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_c_cloud_config.html).

Start the vSphere Web Client.

1. From the vSphere Web Client Inventories view, select **Hosts and Clusters**.
2. Select the hypervisor for which you want to provision storage.
3. Click **Actions** and select **All TPC Actions**.
4. Select **Provision Block Storage**....
5. Enter a size for the total usable storage space on the volume, and select the unit of measurement from the list.
6. Select the service class for the block storage that you want to associate with the volume. You can select only service classes with available capacity that you are authorized to use.
7. Select the capacity pool from which you want the volume to be provisioned. You can select only capacity pools with available capacity.
8. Optional: If you want to create a data store on the storage volume when it is provisioned, select the **Create datastore** check box, and enter a name for the data store. The minimum volume size for creating a data store is 2 GiB.

9. Click **OK** to provision the volume.

10. To monitor the progress of the provisioning task, click the **Monitor** tab, and click the **Tasks** tab.

11. You can monitor the progress of the creation of the data store by clicking the **Monitor** tab and then clicking the **Tasks** tab. The data store creation task is called **Create VMFS datastore**.

12. You can monitor the progress of the multipathing task by clicking the **Monitor** tab and clicking the **Tasks** tab. The multipathing task is called **Set logical unit policy**.

**Related concepts:**

- **“Service classes” on page 37**
  
  A service class is a set of properties that describe capabilities and characteristics of storage resources. A service class typically describes a particular quality of service, and is used during provisioning to describe storage requirements. For example, a block-storage service class specifies properties such as a required RAID level, and whether storage resources must be able to encrypt or thin provision volumes.

- **“Capacity pools” on page 41**
  
  Capacity pools are groups of storage resources. You can use capacity pools to separate storage resources in any way that serves the needs of your environment or business. Configure capacity pools to track the used and available space for block and file storage on any set of storage resources. Provisioning requests can also be restricted to resources in a capacity pool.

**Related tasks:**

- **“Provisioning file storage”**
  
  Use the vSphere Web Client extension for IBM Spectrum Control to provision file storage on IBM Spectrum Control.

**Provisioning file storage**

Use the vSphere Web Client extension for IBM Spectrum Control to provision file storage on IBM Spectrum Control.

Ensure that you complete the following tasks in IBM Spectrum Control:

- If you want to provision storage by using service classes to describe performance and storage requirements, ensure that the service classes are created in IBM Spectrum Control. IBM Spectrum Control provides a number of predefined service classes, which you can use, modify, or delete.

- If you want to provision storage by using capacity pools to specify your storage requirements, ensure that the capacity pools are created in IBM Spectrum Control.

- Before you provision storage to a hypervisor, ensure that the hypervisor is added into IBM Spectrum Control. If the hypervisor belongs to a cluster, all the hypervisors on that cluster must be managed by IBM Spectrum Control.

- Determine whether you must set access path host name replacements. For more information, see “Special consideration for provisioning by using the VMware vSphere Web Client extension” on page 41.

For more information, see “Cloud configuration” on page 37.

Start the vSphere Web Client.

1. From the vSphere Web Client Inventories view, select **Hosts and Clusters**.
2. Select the hypervisor for which you want to provision storage.
3. Click the Actions menu item, and select All TPC Actions.
4. To open the Provision File Storage wizard, select Provision File Storage.
5. In the Share Requirements page of the wizard, enter a name for the share.
6. Enter a size for the total usable storage space on the share, and select the unit of measurement from the list.
7. Select the service class for the file storage that you want to associate with the share. You can select only service classes with available capacity that you are authorized to use.
8. Select the capacity pool from which you want the share to be provisioned. You can select only capacity pools with available capacity.
9. Enter the name of the data store that you want to associate with the file system.
10. Click Next to continue.
11. In the Share Permissions page of the wizard, specify the user and group with permission to mount the share on the hypervisor.
12. Select the Read-only check box if you want to limit the user or group to viewing files on the share.
13. Select the Secure check box to create the share with the secure flag set.
14. Click OK to provision the share.
15. To monitor the progress of the provisioning task, click the Monitor tab, and click the Tasks tab.
16. You can also monitor the progress of the creation of the data store by clicking the Monitor tab and then clicking the Tasks tab. The data store creation task is called Create NAS datastore.

Related concepts:

“Service classes” on page 37
A service class is a set of properties that describe capabilities and characteristics of storage resources. A service class typically describes a particular quality of service, and is used during provisioning to describe storage requirements. For example, a block-storage service class specifies properties such as a required RAID level, and whether storage resources must be able to encrypt or thin provision volumes.

“Capacity pools” on page 41
Capacity pools are groups of storage resources. You can use capacity pools to separate storage resources in any way that serves the needs of your environment or business. Configure capacity pools to track the used and available space for block and file storage on any set of storage resources. Provisioning requests can also be restricted to resources in a capacity pool.

Related tasks:

“Setting access path host replacements” on page 199
If you are going to use the VMware vSphere Web Client extension to provision file shares, verify whether you must provide IBM Spectrum Control with an access path host replacement.

“Provisioning block storage” on page 216
Use the vSphere Web Client extension for IBM Spectrum Control to provision block storage on IBM Spectrum Control. You can also have a data store created on the storage volume.
Optimizing storage tiering

To optimize the placement of volumes on storage tiers, analyze the tiering of volumes in your storage environment.

Before you analyze tiering, complete the following tasks:
• Probe the storage virtualizers
• Collect performance data
• Set the tier level of the storage pools that you analyze and that you select as target pools

The purpose of analyzing tiering is to tier volumes based on the I/O rate or I/O density thresholds that you set. Depending on the conditions that are set, recommendations are generated.

Storage costs can be reduced, for example, by moving volumes with low workloads from higher and more expensive tiers to lower and less expensive tiers. Storage performance can be improved and used more efficiently by moving volumes with heavy workloads to the tiers that meet the workload requirements of the volumes. When you implement the recommendations, you ensure that the volumes are placed on the tiers that best match the workload requirements of the volumes.

You can optimize the placement of volumes on the following storage virtualizers:
• SAN Volume Controller
• Storwize V7000
• Storwize V7000 Unified block storage
• FlashSystem V9000 and FlashSystem V840

Learn more: For information about the components that can be used with IBM Spectrum Control Version 5.2 (or later), see IBM Spectrum Control interoperability matrix at http://www.ibm.com/support/docview.wss?uid=swg21386446

Volumes can be moved to tiered storage pools on the same storage virtualizer, but volumes cannot be moved from one storage virtualizer pool to another storage virtualizer pool.

Optimizing volumes with service classes: Recommendations are not generated to move volumes that are assigned a service class to a destination pool that does not meet the requirements of the service class.

Related tasks:
• “Analyzing and re-tiering volumes in pools on tier 1” on page 61
  In this scenario, you analyze the current placement of volumes in pools on tier 1 so that you can move volumes with low workloads from tier 1 to tier 2 or tier 3 pools.
• “Collocating volumes” on page 63
  In this scenario, you want to minimize the exposure of servers to multiple back-end storage systems by collocating volumes that are assigned to the same hypervisor or server. You can enforce the collocation of volumes when you enter the criteria for analyzing tiering and balancing pools.
Setting the tier level of storage pools

To analyze tiering and to balance pools, you must set the tier level of storage pools.

Before you analyze tiering or balance pools, you must set the tier level of pools.

To analyze tiering, you must set the tier level of the source pools and the target pools. The source pools are the pools that you select for analysis. The target pools are the pools that are used to relocate volumes to lower or higher tiers of storage.

Tip: You can also set or modify the tier level of pools on the General tab of the View Properties page for the storage pool.

Child pools have the same tier level as the parent pool. So if you change the tier level of the parent pool or of the child pool, all of the pools in the parent-child relationship are set to the same tier level.

You can assign tier levels to storage systems that are not storage virtualizers. However, you cannot balance the pools or analyze the tiering of pools other than storage virtualizer pools.

1. From the Storage menu, click Pools.
2. On the Pools page, select one or more storage pools.
3. Click Set > Tier, and then select a tier level. To remove the tier level, click None.

The tier level that you selected for the storage pools is shown in the Tier column.

Analyzing tiering by servers

Optimize tiering by analyzing the tiering of volumes on storage virtualizers that are connected to servers.

The servers that you select must be connected to one or more storage virtualizers.

1. From the Servers menu, click Servers.
2. Right-click one or more servers, and then click Analyze Tiering. Alternatively, you can click Actions > Analyze Tiering.

Analyzing tiering by hypervisors

Optimize tiering by analyzing the tiering of volumes on storage virtualizers that are connected to hypervisors.

The hypervisors that you select must be connected to one or more storage virtualizers.

1. From the Servers menu, click Hypervisors.
2. Right-click one or more hypervisors, and then click Analyze Tiering. Alternatively, you can click Actions > Analyze Tiering.

Analyzing tiering by storage virtualizers

Optimize tiering by analyzing the tiering of volumes on storage virtualizers.

1. From the Storage menu, click Storage Systems.
2. Right-click one or more storage virtualizers, and then click Analyze Tiering. Alternatively, you can click Actions > Analyze Tiering.
Analyzing tiering by storage pools

Optimize tiering by analyzing the tiering of volumes in storage pools.
1. From the Storage > Pools menu, click Pools.
2. Right-click one or more storage pools, and then click Analyze Tiering. Alternatively, you can click Actions > Analyze Tiering.

Analyzing tiering by volumes

Optimize tiering by analyzing the tiering of volumes on storage virtualizers.
1. From the Storage menu, click Volumes.
2. Right-click one or more volumes, and then click Analyze Tiering. Alternatively, you can click Actions > Analyze Tiering.

Tiering volumes by I/O density and I/O rate

Set thresholds for tiering volumes by I/O rate or I/O density.
1. Select the resources that you want to analyze. The source storage pools that are related to the resources that you selected are analyzed to determine whether they meet the workload requirements of the volumes. If the workload requirements of the volume in its current tier are not met, the volume is a candidate for relocation.
2. Select the target storage pools.
3. Include or exclude volumes in mirrored volume relationships from the analysis.

**Mirrored volumes:** If you want to optimize mirrored volumes, select one or more target pools that do not contain either the primary volume or the secondary volume. Primary volumes and secondary volumes cannot be placed in the same destination pool.
4. On the Optimize the Placement of Volumes page, specify the number of days for analyzing the resources.
5. Specify whether volumes that are in the same source storage pool and that are assigned to the same server or hypervisor must be placed in the same destination storage pool. Recommendations are only generated to move one or more of the related volumes when all of the related volumes can be placed in the same destination storage pool.

**Multiple host connections to the same hypervisor or server:** If the volumes in the source pool that are assigned to the same hypervisor or server are assigned to different host connections, the collocation of the volumes is affected. In such cases, if volumes require optimization, the volumes that are assigned to the same host connection are kept together. To view information about the host connection for the volume, right-click the volume, select View Details, and then click the Host Connections tab.
6. Specify the type of threshold and the threshold values for moving volumes to higher and lower tiers.
7. Click Analyze.

When you complete entering the information to analyze the tiering of the volumes, recommendations for tiering are shown on the Tiering Analysis page. You can create a schedule to run the analysis that is based on the analysis criteria that you entered.
Modifying the criteria for analyzing tiering

When a task is created after you run the tiering analysis, you can modify the criteria for tiering the volumes.

You must run the tiering analysis to create a tiering analysis task.

The criteria that you modify are used to analyze the source volumes and target volumes that were selected when you created the tiering analysis.

1. From the Home menu, click Tasks.
2. Right-click a tiering analysis task, and click Edit.
3. Modify the tiering thresholds, and then click Analyze.

The source volumes are analyzed to determine whether one or more of the volumes require re-tiering based on the criteria that you specified. If one or more of the volumes require re-tiering, recommendations are generated to move the volumes to the destination pools that meet the criteria that you specified.

Optimizing storage pools

Analyze the activity of pools and resolve performance hot spots by redistributing volumes across each storage tier.

Before you balance pools, complete the following tasks:

• Probe the storage virtualizer. You must probe the storage virtualizer to collect information about the logical devices, such as volumes and virtual disks, that are associated with the storage virtualizer.
• Collect performance data. To gauge the average activity level of the volumes and pools, you must collect sufficient performance data for the storage virtualizer.
• Assign a tier level to the pools that you want to balance.

You can balance the workload of volumes in pools on the same tier on the following storage virtualizers:

• SAN Volume Controller
• Storwize V7000
• Storwize V7000 Unified block storage
• FlashSystem V9000 and FlashSystem V840

Learn more: For information about the components that can be used with IBM Spectrum Control Version 5.2 (or later), see IBM Spectrum Control interoperability matrix at http://www.ibm.com/support/docview.wss?uid=swg21386446

To balance pools, you must select two or more pools on the same tier level and on the same storage virtualizer. For example, you select three tier 1 pools, and four tier 3 pools. The pools on tier 1 are analyzed and balanced, and the pools on tier 3 are analyzed and balanced.

Optimizing volumes with service classes: Recommendations are not generated to move volumes that are assigned a service class to a destination pool that does not meet the requirements of the service class.

Related tasks:
Balancing pools

You balance pools to distribute the workload of volumes across pools on the same tier and on the same storage virtualizer. To improve the performance of the pools, recommendations are generated to move volumes to other pools on the same tier and on the same storage virtualizer.

1. From the Storage menu, click Pools.
2. Right-click two or more pools on the same tier level and on the same storage virtualizer, and then click Balance Pools.

**Tip:** If you want to analyze pools that contain volumes in mirrored volume relationships, select one or more pools that do not contain either the primary volume or the secondary volume. The primary volume and the secondary volume cannot be placed in the same destination pool.
3. Choose whether to analyze volumes in mirrored volume relationships. These options are only available if you select one or more volumes with mirrored volumes.
4. Specify the number of days that are used to analyze the pools. By default, the value for the activity level of pools is estimated based on the performance data that was collected on the previous seven days.
5. Specify the placement of optimized volumes in capacity pools. These options are only available if you select one or more volumes in capacity pools.
6. Specify whether volumes that are in the same source storage pool and that are assigned to the same server or hypervisor must be placed in the same destination storage pool.
7. Click Analyze.

When you finish entering the information for balancing the pools, a task is created that shows the recommendations on the Balance Analysis page. You can implement the recommended changes, or you can create a schedule to implement the changes later.

**Analyzing volumes with service classes:** Recommendations are not generated to move volumes that are assigned a service class unless the destination pool can meet the requirements of the service class.

**Related tasks:**

**Modifying the criteria for balancing pools**

When a task is created after you run the analysis for balancing pools, you can modify the criteria that determine which pools are balanced.

To create a balance analysis task, you must run the analysis for balancing the pools.
The criteria that you modify are used to analyze the storage pools that you selected when you entered the criteria for balancing the pools.

1. From the Home menu, click Tasks.
2. Right-click a balance analysis task, and click Edit.
3. Make your changes, and then click Analyze.

Based on the criteria that you specified, the pools are analyzed to determine whether the pools require balancing. If one or more pools require balancing, recommendations are generated to redistribute the volumes to pools on the same tier of storage.

**Criteria for identifying the pools that require balancing**

To identify the pools that require balancing, performance data is collected to determine the relative activity of pools on the same tier. The performance capability of pools is preserved by setting an activity limit for each tier of storage.

To determine the relative activity of pools on the same tier and on the same back-end storage system, the following values are calculated:

- The current activity level of the pool is calculated.
- The activity deviation percentage of the pool is calculated.

**Tip:** On the Pools page, the activity level of the pool is shown in the Activity column. The difference between the activity level of the pool and all of the other pools on the same tier and storage system is shown in the Activity Deviation (%) column.

The following formulas are used to calculate the activity level and the activity deviation percentage for pools.

*Table 45. Formulas for calculating the activity level and activity deviation percentage values for pools*

<table>
<thead>
<tr>
<th>Value calculated</th>
<th>Formula that is used in the calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity level of the pool</td>
<td>( \frac{[\text{Read I/O Rate} \times (1- \text{Read I/O Cache Hit} %) + \text{Write I/O Rate}]}{\text{Total Pool Capacity}} )</td>
</tr>
<tr>
<td>Activity level of the pool on XIV systems</td>
<td>( \frac{\text{Total I/O Rate}}{\text{Total Capacity}} )</td>
</tr>
<tr>
<td>Activity deviation percentage of the pool</td>
<td>( \frac{[(\text{Pool Activity Level} - \text{Average Activity Level}) \div \text{Average Activity Level}] \times 100}{\text{A positive value indicates that the relative activity level of the pool is above average. A negative value indicates that the relative activity level of the pool is below average.}} )</td>
</tr>
</tbody>
</table>

If the activity deviation percentage of the pool lies within the range of \(-10\%\) to \(10\\%\), the pool is considered to be balanced. If the activity deviation percentage of the pool exceeds the deviation threshold of \(10\\%\), the pool is a candidate for balancing.

For example, you want to identify the tier-1 pools that require balancing on a storage environment that consists of a Storwize V7000 Unified storage virtualizer with one DS8000 storage system. You open the Pools page and view the activity deviation percentage values for the tier-1 pools.
The Pools page shows that three tier-1 pools have the following activity levels and activity deviation percentages.

Table 46. Tier-1 pools activity and activity deviation percentages

<table>
<thead>
<tr>
<th>Pool</th>
<th>Activity</th>
<th>Activity deviation percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>pool_1</td>
<td>110</td>
<td>-3%</td>
</tr>
<tr>
<td>pool_2</td>
<td>90</td>
<td>-20%</td>
</tr>
<tr>
<td>pool_3</td>
<td>140</td>
<td>24%</td>
</tr>
</tbody>
</table>

The pool_3 pool is a candidate for balancing because the activity deviation value for the pool is 14% higher than the deviation threshold of 10%.

The pool_1 pool is considered to be balanced because the activity deviation percentage of the pool lies within the range for balanced pools. The pool_1 pool and the pool_2 pool, are potential target pools for the volumes that must be moved from the pool_3 pool.

Reclaiming storage

You can view the amount of storage that can be reclaimed in your data center and for each of the block storage systems that are monitored. Based on volume reclamation recommendations, you can reclaim the unused space and more effectively allocate volume space on your storage systems.

Viewing storage reclamation

Use the storage reclamation analysis to see information about the reclaimable capacity in your data center. You can see the savings that can be made by reclaiming capacity for tiered and non-tiered storage and view a list of the reclaimable volumes.

Before you view recommendations for reclaiming storage, complete the following tasks:

- Add the storage systems for monitoring and schedule a storage systems probe.
- If your storage environment is configured for storage tiers, ensure that the amount of unused space on tier one is minimal.

By default, the period for analyzing performance data, which is used for generating reclamation recommendations, is set to 14 days. For a more thorough analysis, you can change this period.

View information about volumes that are analyzed and recommended for reclamation.

1. From the Advanced Analytics menu, click Reclamation.
2. On the View by Reclaimable Capacity page, view the charts and tables for information about reclaimable storage space, volumes that are recommended for reclamation, and volumes that are excluded from analysis.

On the reclamation donut chart, you can view the amount of storage space that is used and the amount of storage space that can be reclaimed. You can also see an estimate of the storage space that can be saved when the volumes that are listed in the table are reclaimed.
On the reclamation by tier bar charts, view the amount of storage space that can be reclaimed on each tier of storage that is defined in your data center.

On the **Recommendations** tab, view the volumes that are identified as potential candidates for reclamation.

On the **Excluded** tab, view the volumes that are excluded from the analysis for reclamation recommendations.

**Viewing storage reclamation by storage system**

Use the reclamation view of storage systems for detailed information about the reclaimable capacity in your data center. You can see the savings that can be made by reclaiming capacity for tiered and non-tiered storage and view information about the storage systems that contain the reclaimable volumes.

Before you view recommendations for reclaiming storage, complete the following tasks:

- Add the storage systems for monitoring and schedule a storage systems probe.
- If your storage environment is configured for storage tiers, ensure that the amount of unused space on tier one is minimal.

By default, the period for analyzing performance data, which is used for generating reclamation recommendations, is set to 14 days. For a more thorough analysis, you can change this period.

View reclamation information about storage systems that contain volumes that are analyzed and recommended for reclamation.

1. From the **Advanced Analytics** menu, click **Reclamation**.
2. On the View by Storage Systems page, view the charts and table for information about reclaimable storage space and for information about the storage systems that contain the reclaimable volumes.

On the reclamation donut chart, you can view the amount of reclaimable space and the non-reclaimable allocated space. If you defined storage tiers, you can view the amount of storage that can be saved for each tier. You can also see an estimate of the storage space that can be saved when the volumes of the storage systems that are listed in the table are reclaimed.

On the reclamation bar chart, view the amount of storage space that can be reclaimed on each storage system in your data center.

In the table, view space, capacity, and reclamation information about each storage system.

**Excluding volumes from reclamation analysis**

You can select volumes to not include them in the analysis for reclamation recommendations. The volumes are excluded from the reclamation charts.

On the View by Reclaimable Capacity page, you can select a volume or multiple volumes for exclusion from the analysis for reclamation recommendations.

1. From the **Advanced Analytics** menu, click **Reclamation**.
2. On the View by Reclaimable Capacity page, to exclude a volume from the analysis, right-click the volume on the Recommendations table, and select Exclude from Analysis.

The volume is removed from the Recommendations table and added to the Excluded table, and the charts are refreshed.

Tip: To include a volume in the analysis, on the Excluded table, right-click the volume and select Include in Analysis. The volume is removed from the Excluded table and added to the Recommendations table, and the charts are refreshed.

### Transforming and migrating volumes

You can transform fully allocated volumes to compressed or thin-provisioned volumes, or transform compressed or thin-provisioned volumes to fully allocated volumes. You can move volumes to other pools or to pools that are enabled for Easy Tier.

Before you transform storage, you must probe the storage virtualizers. The probe collects information about the logical devices, such as volumes and virtual disks, that are associated with the storage virtualizer.

You can convert or move volumes in pools on the following storage virtualizers:

- SAN Volume Controller
- Storwize V7000
- Storwize V7000 Unified
- FlashSystem V9000 and FlashSystem V840

For volumes in mirrored volume relationships, you can convert the primary volume, the secondary volume, or both volumes.

**Restrictions:** The restrictions for converting or moving volumes are as follows:

- To move volumes, the destination pool must be on the same storage virtualizer. You cannot move a volume from a pool on one storage virtualizer to a pool on another storage virtualizer.
- To convert or move volumes, image mode volumes must be converted to managed mode volumes.
- To convert fully allocated volumes to compressed volumes, you must have the IBM Real-time Compression™ license.

**Migrating volumes with service classes:** A warning is generated when you move one or more volumes that are assigned a service class to a destination pool that does not meet the requirements of the service class.

1. In the menu bar in the web-based GUI, go to Storage > Volumes.
2. Click one or more storage volumes, and then select Transform Storage from the context-sensitive menu. Alternatively, you can click Actions > Transform Storage.

When you complete entering criteria for transforming storage, the Transform Plan page is opened. A task is created which you can run to implement the recommendations.

**Related tasks:**
Modifying the period for analyzing performance data

To change the default period for analyzing performance data in storage virtualizer pools, issue the `setdscfg` command. You can extend or shorten the default period for a more accurate analysis.

You must have Administrator authority to use the `setdscfg` command.

By default, the period for analyzing performance data is set to 14 days. When you change the number of days, the period for analyzing performance data is modified for the advanced analytics about storage, that is, tiering, balancing, transforming, and reclamation.

When you transform storage, the performance data that is collected about the pools on storage virtualizers is analyzed. The period that is set for analyzing performance data is used to calculate the average workload activity of the volumes that are selected for analysis. To provide a more accurate analysis of the workload activity of the volumes in your storage environment, you can extend or shorten the period.

For reclamation, the performance data that is collected for the analysis period about all block storage pools is analyzed, regardless of whether the storage is virtualized.

To change the analysis period, complete the following steps:

1. To start the IBM Spectrum Control CLI, issue the `tpctool` command.
2. Issue the `setdscfg` command, and then set the following values by using the `-property` and the `-context` parameters:
   a. Specify `tiering_pm_days` as the property value.
   b. Specify `tiering` as the context value, and then specify the number of days for the analysis period.

For example, to change the analysis period from the default value of 14 days to 28 days, issue the following command:

```bash
tpctool setdscfg -url localhost:9550 -user ***** -pwd *****
-property tiering_pm_days -context tiering 28
```

The default value is changed to the number of days that you specified, for example 28.

**Tip:** To verify that the analysis period is changed, you enter the following command:

```bash
tpctool getdscfg -url localhost:9550 -user ***** -pwd ***** -context tiering
```

Modifying the properties of resources

In the web-based GUI, you can modify the properties of the resources that are monitored by IBM Spectrum Control.
The following information summarizes the resources and properties that you can modify, and the steps for modifying each type of resource.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Properties that can be modified</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage systems</td>
<td>• Name (label)</td>
<td>1. Depending on the type of storage system that you want to modify, go to Storage &gt; Block Storage Systems, Storage &gt; File Storage Systems, or Storage &gt; Object Storage Systems.</td>
</tr>
<tr>
<td></td>
<td>• Location</td>
<td>2. Right-click the storage system that you want to modify and select View Properties.</td>
</tr>
<tr>
<td></td>
<td>• Custom tags (3)</td>
<td>3. On the properties notebook, click Edit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Modify the properties and click Save.</td>
</tr>
<tr>
<td>Pools</td>
<td>• Tier</td>
<td>1. In the menu bar in the web-based GUI, go to Storage &gt; Pools.</td>
</tr>
<tr>
<td></td>
<td>• Back-end storage system type</td>
<td>2. Right-click the pool that you want to modify and select View Properties.</td>
</tr>
<tr>
<td></td>
<td>• Back-end storage RAID level</td>
<td>3. On the properties notebook, click Edit.</td>
</tr>
<tr>
<td>Tip: You can edit the back-end values if the back-end storage system for the related storage virtualizer was not probed and the values for the pool are unknown. If you manually enter values for these properties, IBM Spectrum Control uses the values to help calculate the approximate read I/O capability of the pool.</td>
<td>4. Modify the properties and click Save.</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Properties that can be modified</td>
<td>Steps</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| Servers  |  **Servers with Storage Resource agents**  
You can modify the following properties for servers where agents are deployed:  
- Location  
- Custom tags (3)  
- Fabric functions  
- Agent trace  
- Trace level  
- Number of trace files  
- Trace file size  
- Run scripts on agent  
**Servers without Storage Resource agents (agentless)**  
You can modify the following properties for agentless servers:  
- Name (label)  
- OS type  
- IP address  
- Virtual machine  
- Location  
- Custom tags (3) | 1. In the menu bar, go to **Servers > Servers**.  
2. Right-click the server that you want to modify and select **View Properties**.  
3. On the properties notebook, click **Edit**.  
4. Modify the properties and click **Save**. |
| Hypervisors |  
- Location  
- Custom tags (3) | 1. In the menu bar, go to **Servers > Hypervisors**.  
2. Right-click the hypervisor that you want to modify and select **View Properties**.  
3. On the properties notebook, click **Edit**.  
4. Modify the properties and click **Save**. |
| Switches  |  
- Name (label)  
- Location  
- Custom tags (3) | 1. In the menu bar, go to **Network > Switches**.  
2. Right-click the switch that you want to modify and select **View Properties**.  
3. On the properties notebook, click **Edit**.  
4. Modify the properties and click **Save**. |
<table>
<thead>
<tr>
<th>Resource</th>
<th>Properties that can be modified</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fabrics</td>
<td>• Name (label)</td>
<td>1. In the menu bar, go to Network &gt; Fabrics.</td>
</tr>
<tr>
<td></td>
<td>• Location</td>
<td>2. Right-click the fabric that you want to modify and select View Properties.</td>
</tr>
<tr>
<td></td>
<td>• Custom tags (3)</td>
<td>3. On the properties notebook, click Edit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Modify the properties and click Save.</td>
</tr>
</tbody>
</table>

**Tip:** To view the description of a property that you can modify for a resource, hover the mouse pointer over the hover icon for that property in the web-based GUI.

---

**Opening the management GUI for a resource**

Resources such as storage systems and switches can have their own management GUIs or element managers. In IBM Spectrum Control, you can open the start page in these GUIs from resource list pages, such as the Storage Systems page and Switches page.

The action for opening a management GUI is available for storage systems and switches under the following conditions:

- The resource is monitored by IBM Spectrum Control.
- The resource has a management GUI that is web-based

1. In the menu bar in the web-based GUI, go to a type of top-level resource. For example, if you want open the GUI for a block storage system, go to Storage > Block Storage Systems. If you want open the GUI for a switch, go to Network > Switches.
2. Right-click the resource and select the action to open the GUI. For storage systems, select Open Storage System GUI. For a switch, select Open Switch GUI. The start page for the management GUI is opened in a separate web browser window.

**Opening the DS Storage Manager GUI for a DS8000**

If the firmware level for a DS8000 is earlier than R6.2, you must complete extra configuration steps before you can open its management GUI. To determine the firmware version of a DS8000 and enable the ability to open its management GUI, complete the following steps:

1. Start IBM Spectrum Control.
2. In the menu bar, go to Storage > Block Storage Systems.
3. Right-click the DS8000 and select View Properties.
4. Check the version in the Firmware field. If the firmware version is earlier than R6.2, continue to the next step. If the version is R6.2 or later, you do not need to complete this procedure.
5. Download and start the PuTTY utility. PuTTY is a free implementation of Telnet and SSH for Windows and UNIX. You can download PuTTY from [http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html](http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html)
6. On the Session page in the PuTTY tool, complete the following actions:
a. In the **Host Name (or IP address field)**, enter the IP address of the Hardware Management Console (HMC) for the DS8000. You can determine this IP address by viewing the properties of the DS8000 in the IBM Spectrum Control web-based GUI.

b. Select **SSH** for a **Connection type**.

c. Click **Open**.

7. Enter the user name and password for logging in to the HMC.

8. Run the following command: `touch /opt/esshmc/data/config/ntvbrsen`

9. In the web-based GUI, right-click the DS8000 and select **Open Storage System GUI**.

---

### Exporting information to a file

You can save information about resources, jobs, or alerts to a PDF, CSV, or HTML file. Information that you can export from the web-based GUI includes all the values that are being shown in the columns for a list of resources, jobs, or alerts.

The information that you export to a file is organized according to the sorting, filtering, and column order that is defined for a list. Before you export information, complete the following tasks to configure a list:

- Change the order of columns in the list as you want them to appear in the generated file.
- Hide columns in the list that you do not want to include in the generated file. Information in hidden columns is not exported.
- Sort the rows in the list as you want them to appear in the generated file. Each list in the web-based GUI has a column or set of columns that determine the order of its rows.
- Filter the list to show only the resources, jobs, or alerts that you want to export. Use filtering to limit the rows that are shown in a list based on value in a specific column or set of default columns.

You can export information that is shown on the following pages:

#### Resource list and resource details pages

You can export information about the top-level resources, internal resources, or related resources that are shown on resource list pages and resource details pages. For top-level resources, you can also export information about related jobs or alerts.

For example, you can export information about monitored switches on the Switches page. When you select the export action, the generated file includes the column values for each monitored switch in the list. In the **Jobs** or **Alerts** tabs on the Switches page, you can export information about all the jobs or alerts that are related to switches.

#### The Alerts page

On the **Home > Alerts** page, you can export information about all the alerts that were detected for monitored resources. Information that you can export includes all the values that are being shown in the columns for the list of alerts.

#### The Jobs page

On the **Home > Jobs** page, you can export information about all the jobs that are associated with monitored resources. Information that you can export includes all the values that are being shown in the columns for the list of jobs.
1. In the web-based GUI, go to a list of resources, jobs, or alerts for which you want to export information.

2. Right click any row in the table and select Export > `<file_format>`, where `<file_format>` represents the format that you want to use for a file. The following formats are available:

   **CSV (comma-separated values)**
   A CSV file is a file that contains comma-delimited values and can be viewed with a text editor or imported into a spreadsheet application. The information in a CSV file has the following format:
   
   "Column_name","Column_name","Column_name","Column_name","Column_name","Column_name"
   "data","data","data","data","data","data"
   
   where Column_name represents the name of a column in a table and data represents the data that is associated with a column.

   **PDF**
   You can view a PDF file with Acrobat reader. The information that you export to a PDF file is formatted into a table.

   **Tip:** When you export a table of data that contains many columns, the rows in that table might span multiple pages in the resulting PDF. For example, if a table contains 20 columns, then the row for a specific resource might be shown on more than one page (10 columns on the first page and 10 columns on the second page).

   To reduce the number of pages that a table spans, before you select the export action, hide the columns that you do not want to include in the PDF. Continue hiding columns until the table no longer spans multiple pages.

   **HTML**
   You can view an HTML file with a web browser. The information that you export to an HTML file is formatted into a table.

3. Optional: Depending on how your web browser is configured, you can specify the name and location of the generated file.

4. Click the save option to export the information to a file.

**Related concepts:**

"Viewing information about resources” on page 130
You can view detailed information about the resources that are monitored by IBM Spectrum Control. Resources include storage systems, volumes, pools, servers, hypervisors, fabrics, and switches. You can also view information about internal and related resources.

"Customizing lists of resources, tasks, and alerts”
The web-based GUI uses lists to show information about resources, tasks, and alerts. The information in each list is organized into columns and rows. You can customize these lists by filtering information, sorting rows, and showing, hiding, and reordering columns.

---

**Customizing lists of resources, tasks, and alerts**

The web-based GUI uses lists to show information about resources, tasks, and alerts. The information in each list is organized into columns and rows. You can customize these lists by filtering information, sorting rows, and showing, hiding, and reordering columns.

**Related reference:**
The performance view is displayed when you view the performance of resources, which includes resources in threshold violations, alerts, and performance monitors. Information in the performance view is organized into two main sections: a chart or table and a legend.

**Filtering lists**

You can filter the items that are shown in a list. Use filtering when you want to limit the rows that are shown in a list based on values in a specific column or set of columns. For example, when viewing alerts, you can filter the list so that only alerts with a value of Warning in the Severity column are shown.

1. In the web-based GUI, go to a list of resources, jobs, or alerts that you want to filter.

2. Click the Filter icon to determine how to filter the list. The following options are available:

   **Filter by Default Columns**
   Select this option to apply the filter to the set of the default columns in a list. Each list contains a set of default columns on which you can filter.
   
   For example, in the lists of alerts on the Home > Alerts page, select this option to apply filter text to the following columns at the same time: Condition, Severity, Alert Category, Resource, Internal Resource, Total Occurrences, Alert Name.

   **Filter by a Specific Column**
   Select this option to apply filter text to a specific column in a list. For example, on the Home > Alerts page, select the Condition column if you want to apply filter text to values in that column only.

   **Restriction:** Some columns in lists cannot be used for filtering and are not shown under the Filter by a Specific Column option.

3. In Filter text box, type the text for filtering a list. You can type letters, whole words, partial words, and numbers. When filtering on certain columns, you can select from a list of values rather than typing in filter text.

   For example, when filtering on the Status column, you can select one of the following values as the filter text: Error, Unreachable, Warning, Normal, Unknown.

4. Press Enter to apply the filter to the list. Only rows with values that match or partially match the filter text are shown.

   For example, on the Home > Alerts page, if you select to filter on the Severity column and type critical as the filter text, only alerts that have a severity of critical and critical - acknowledged are shown in the list.

   **Tip:** The name of a column to which a filter applies is shown next to the Filter icon.

5. Optional: To remove the filtering for a list, click Reset.

**Sorting lists**

Each list of resources in the web-based GUI has a column or set of columns that determines the order of its rows. You can sort the columns in a list to organize the rows according to your requirements.
For example, the list of ports on a fabric is ordered by switch name, blade slot, and port number, in that order. You can change the sort order of these columns to organize a list of resources according to your requirements.

**Tip:** A visual indicator ▶️ is shown next to the primary column that determines the sort order of a list.

1. In the web-based GUI, go to a list of resources, jobs, or alerts that you want to sort.

2. Complete the following tasks to sort the rows in the list:
   - To change whether the rows in a list are sorted by ascending or descending order, click the name of the primary column in the heading row. Click the name of the column again to reverse the sort order.
   - To change the column that determines the sort order of resources, click the name of that column. For example, click the Name column to sort the list of resources alphabetically, or click the Status column to sort the list according to the status of resources.

   **Tip:** When you click a column other than the primary sort column, that column becomes the new primary sort column. However, the previous primary column maintains its sort order (ascending or descending).

For example, if a list of resources is ordered by the Name column in ascending order and you click the Status column, the rows are sorted according to the statuses of resources. At the same time, the resources for each type of status are still sorted in ascending order by the Name column. There is a maximum of three columns that can be sorted upon at the same time.

3. Optional: To reset the order of the rows for a column to the default setting, right-click the heading row in the list and select Reset Table Preferences.

### Showing, hiding, and reordering columns in lists

Each list in the web-based GUI has a set of columns that contain information about resources, jobs, or alerts. You can change the order of columns, show columns that are hidden, and hide columns that are shown in these lists.

1. In the web-based GUI, go to a list of resources, jobs, or alerts that you want to customize.

2. Complete the following tasks to customize the columns in the list:
   - To show or hide the columns in a list, right-click any of the column headings and select or clear the check box next to a column name.
   - To change the order of columns, click a column heading and drag it to a new position in the list.

   **Tip:** The changes that you make to column settings are saved from session to session.

3. Optional: To reset the order and display of columns to the default setting, right-click any of the column headings and select Restore Default View.
Managing tasks

Tasks are used to provision storage and optimize resources in your storage environment. Use the Tasks page to manage all the tasks that are used by IBM Spectrum Control to provision storage and optimize resources. Use resource list and resource details pages to manage the tasks for specific resources and resource types.

Tasks are created when you take any of the following actions in the web-based GUI:
- Assign storage to servers or hypervisors by using the Provision Storage wizard.
- Move volumes to higher or lower tiers by using the Analyze Tiering wizard.
- Move or convert volumes by using the Transform Storage wizard.
- Distribute the workload of volumes across pools on the same tier by using the Balance Pools wizard.

Use the following actions to manage tasks:
- View the status of tasks in a central location.
- Identify all the tasks that are related to a specific resource or a type of resource.
- Identify all the tasks that are encountering problems when the tasks are running.
- Administer the tasks. The actions that are available depend on the type of task that you select. For example, you can run or rename a tiering-analysis task, or export provisioning task details to a text file.
- Change the number of task runs that are displayed.

Tip: A task run is a single invocation of a task.

Viewing tasks

Use the Tasks page in the web-based GUI to view all the tasks that are used by IBM Spectrum Control to provision storage and optimize resources. Use resource list and resource details pages to view the tasks for specific resources and resource types.

Viewing all tasks

Use the Tasks page as a central location to view the tasks that IBM Spectrum Control is using to provision storage and optimize resources. You can view all the tasks for resources that are monitored by IBM Spectrum Control.

1. In the menu bar in the web-based GUI, go to Home > Tasks. The information about tasks is organized into columns. These columns include information about the status of tasks, the date and time of the last run for tasks, and the schedule for tasks.
2. Optional: View the status icons at the top of the page to view a summary of task statuses. This summary includes the number of tasks that have a Failed, Warning, Successful, or Running status.

Tip: To view descriptions of the icons and columns on the Tasks page, click the Help icon in the upper-right corner of the page.

Viewing pending tasks

Some tasks might be pending because they can be run or scheduled only by an administrator. If tasks are pending, the number of pending tasks is displayed in the title bar of the web-based GUI.
You must be assigned to the Administrator role to view the number of pending tasks in the title bar of the web-based GUI.

Pending tasks are tasks that were not run and are not scheduled to run. Pending tasks might be created by a user who is not authorized to run or schedule the task. For example, users who are assigned to the Monitor or External Application role can have permission to create provisioning tasks by using a service class. However, if the service class specifies that administrator approval is required, these users can only create the provisioning task. The provisioning task is pending until an administrator runs or schedules it.

To view pending tasks, complete the following steps:
1. In the title bar of the web-based GUI, look for the pending task count. If there are any pending tasks, the number of pending tasks is shown in the title bar of the web-based GUI. If no number appears in the title bar, there are no pending tasks.
2. To open a Tasks page that shows only the pending tasks, click the number of pending tasks in the title bar.

Viewing tasks for a type of resource
Use resource list pages to view only the tasks for a specific type of top-level resource. Each resource list page has a Tasks tab that lists only the tasks for that type of resource. For example, you can use the list page for storage systems to view only the tasks that are associated with storage systems.
1. In the menu bar, select a type of top-level resource. For example, to view the tasks that are related to storage systems, go to Storage and select the type of storage system you want to monitor.

   Exception: Provisioning tasks that provision network-attached storage (NAS) file shares to servers or hypervisors are not shown on the resource list pages for servers or hypervisors. You must use the Tasks page to view these tasks.

2. Click the Tasks tab to view a list of all the tasks for the monitored resources of that type.
   The information about tasks is organized into columns. These columns include information about the status of tasks, the most recent date and time when tasks ran, and the schedule for tasks.

   Tip: The status icon on the Tasks tab represents the most critical status of the tasks that are associated with the monitored resources. For example, if one of the tasks for storage systems failed, the following icon is shown on the tab:

   ![Tasks](image)

3. Optional: View the status icons on the Tasks page for a summary of task statuses. This summary includes the number of tasks that have a Failed, Warning, Successful, or Running status.

   Tip: To view descriptions of the icons and columns on the Tasks page, click the Help icon [？].

Viewing tasks for a specific resource
Use resource detail pages to view only the tasks for a specific monitored resource. Each resource detail page has a Tasks link that lists only the tasks for the associated storage system, server, hypervisor, switch, or fabric.
1. In the menu bar, select a type of top-level resource. For example, if you want to view the tasks for a storage system, go to Storage and select the type of storage system you want to monitor.

2. Right-click a resource in the list and select View Details. The resource detail page is displayed. In the General section, the number next to Tasks represents the number of tasks that are associated with the resource. For example, Tasks (3) indicates that you can view three tasks.

   The icon next to the Tasks link represents the most critical status of the tasks that are associated with the resource. For example, if a task failed, the following icon is shown:

   ![Tasks icon]

3. Click Tasks in the General section to view the tasks for the resource. The information about tasks is organized into columns. These columns include information about the status of tasks, the most recent date and time when tasks ran, and the schedule for tasks.

4. Optional: View the status icons on the Tasks pane to view a summary of task statuses. This summary includes the number of tasks that have a Failed, Warning, Successful, or Running status.

   Tip: To view descriptions of the icons and columns on the Tasks pane, click the Help icon 📚.

### Viewing task details

Use task detail pages to view detailed information about the tasks that IBM Spectrum Control uses to optimize resources and provision storage. You can use this information to troubleshoot the reason why a task failed, analyze details of a task before you implement task recommendations, or schedule future task runs.

On all the task detail pages, you can view information such as the task status, the duration and completion date of task runs, and the actions that you can take to manage the task. For tasks such as tiering analysis, balance analysis, and transform plan, you can view information about the recommendations that are generated by the most recent or earlier task runs. For provisioning tasks, you can view the status of the actions that the provisioning task completes for each of the resources that are configured in the task.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the tasks that are related to storage systems, go to Storage and select the type of storage system you want to monitor, and click the Tasks tab.

2. Locate the task that you want to view in more detail.

3. Right-click the task row and select View Details. The task details page opens in a separate window. For example, the Tiering Analysis page opens if you select a tiering-analysis task row.

4. Optional: To view task logs, click Open Logs. You can use the information in the log file to troubleshoot any errors that might occur when a task is run.

5. Optional: For provisioning tasks, you can export information about the provisioning task to a text file for offline viewing. To export information, click the 📝 icon at the top of the Provisioning page.

### Viewing task logs

Task logs include detailed information about the status, actions, and progress of a task. Status information includes informational, warning, and error messages that...
are related to each action in a task that is taken during processing. You can use this information to troubleshoot any errors that might occur when a task is run.

The following examples show the type of information that you can view in the task logs:

- View the number of recommendations that are generated by tiering-analysis, balance-analysis, or transform-plan task runs.
- View the options that you select when you use wizards, such as the Transform Storage, Analyze Tiering, or Balance Pools wizards. For example, when you use the Analyze Tiering wizard, a tiering-analysis task is generated and the options that you choose in the wizard are recorded in the task log.
- View error messages that are related to task processing.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the tasks that are related to storage systems, go to Storage and select the type of storage system you want to monitor, and click the Tasks tab.

2. Locate the task that has a log file that you want to view.

3. Right-click the task row and select Open Logs. The Logs page shows log entries for the most recent task run.

4. Optional: On the Logs page, to view the log for a previous task run, select a task run from the Select a log list.

5. Optional: To view only the actions in a task run that have a Warning or Error status, select an option from the Show all list. You can choose to view only actions that have the following statuses:

   - ❌ Only error entries
   - 🚨 Only warning entries
   - ❌ 🚨 Error and warning entries

6. Optional: To view an explanation of the message that is associated with an action, click the link in the ID column.

The information on the Logs page is automatically updated every 30 seconds. New entries are added to the end of a log. You can view the following information on the Logs page:

- The overall status of a task. The icon that is shown in the Select a log list represents the most critical status that was generated by an action in the task run.
- The status for each action in a task.
- The date and time when an action was completed. The date, time, and time zone of the action is shown in the Date and Time column.
- The ID of the message that is associated with an action. You can click the value in the ID column to view more information about a message.
- The description of an action.

Tip: You can use the navigation and search functions of the web browser to locate information on the page.
Setting the number of task runs that are displayed
You can change the number of task runs that are shown in the web-based GUI by configuring the settings on the History Retention page. By default, the information for the last five runs of a task is shown.
1. In the menu bar in the web-based GUI, go to Settings > History Retention.
2. Click Edit.
3. In the Job logs field, enter the number of runs that you want to retain for display.
4. Click Save to save your changes.

After you update the value for job logs, the list of task runs in the web-based GUI is automatically updated within a few minutes.

Managing tasks for provisioning
Provisioning tasks are used to create storage volumes and assign the volumes to servers or hypervisors. Provisioning tasks are also used to create network-attached storage (NAS) file shares. Use the Tasks page in the web-based GUI to manage all the tasks that are used by IBM Spectrum Control to provision storage. Use resource list and resource details pages to manage the provisioning tasks for specific resources and resource types.

Use the web-based GUI to complete the following provisioning actions:
• Create provisioning tasks by using the Provision Storage wizard
• Run provisioning tasks immediately
• Schedule provisioning tasks to run at a specified date and time
• Export information about provisioning tasks to text files
• Delete provisioning tasks

Related concepts:
“Provisioning storage” on page 42
The Provision Storage wizard simplifies the steps for submitting provisioning requests. When you use the Provision Storage wizard, you concern yourself only with which service class is needed for the new volumes or shares, and how much capacity you require.

Creating provisioning tasks
You can create provisioning tasks with the GUI and assign storage volumes or NAS file shares to servers or hypervisors.

You must have Administrator privileges to create provision tasks.

Related tasks:
“Provisioning storage with the IBM Spectrum Control GUI” on page 211
You can provision volumes or shares to servers, hypervisors, and clusters with the GUI.

“Collecting information about shares on storage systems” on page 110
To collect information about shares in file systems, you must modify the TPCD.config file. When you provision shares, you can then view such information as the name of the share, the name of the file system, and the protocols that are used to share files.

Running provisioning tasks
Use the Tasks page to run provisioning tasks. You can run provisioning tasks immediately or you can schedule tasks to run at a date and time that you specify.
When you run a provisioning task, the configuration changes that are contained in the task are implemented. For example, storage volumes are created and assigned to servers.

To run provisioning tasks, you must be the owner of the task or have Administrator privileges.

Provisioning tasks can run only once. You can run the task when you complete the steps of the Provision Storage wizard or you can save the provisioning task and run the task later.

The Run Now and Schedule actions are available for a provisioning task when the task is not running, and was not previously run.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the provisioning tasks that are related to servers, go to Servers > Servers, and click the Tasks tab.

2. Locate the provisioning task that you want to run.

3. Depending on when you want the provisioning task to run, choose one of the following options:
   - To run the provisioning task immediately, right-click the task row and select Run Now. The task status changes to Running and the provisioning task runs immediately.
   - To schedule the provisioning task to run at a specific date and time, complete the following steps:
     a. Right-click the task row and select Schedule.
     b. From the Schedule page, select a future date and time from the Provision lists, and click Save.

You can also run or schedule the provisioning task from the Provisioning detail page. On the Provisioning detail page, click Execute to run the task immediately or click Schedule to schedule the task to run at a specific date and time.

The provisioning task runs immediately or on the scheduled date and time. To check the progress of the task, you can take the following actions:
   - View the task status on the Tasks page.
   - View detailed information about the progress of the task on the Provisioning detail page. You can view the task duration and the status of the actions that the provisioning task completes for each of the resources that are configured in the task.
   - View the task logs from the Tasks page or from the Provisioning detail page. You can view detailed informational, warning, and error messages that are related to the task. You can use this information to troubleshoot any errors that might occur when a task is run.

Exporting provisioning task information
Use the Provisioning detail page to export details of a provisioning task to a text file. The task details that are shown on the Provisioning page are saved to the generated text file.
If you do not have authority to provision storage, you can export the provisioning task details to a file and email the file to a user with Administrator privileges. The administrator can run or schedule the provisioning task if they approve the task details.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the provisioning tasks that are related to servers, go to Servers > Servers, and click the Tasks tab.

2. Locate the provisioning task that you want to export.

3. Right-click the task row and select View Details.

4. From the Provisioning page, to start the export, click the icon in the upper-right corner of the page.

5. Save the generated text file. Depending on how your web browser is configured, you can specify the file name and the location where the file is saved.

The provisioning task information is exported to a text file. The generated file includes all the provisioning task details that are listed on the Provisioning page. Columns that are hidden on the Provisioning page are included in the generated file. The information in the file is organized according to a default order and is not affected by the column order that is defined on the Provisioning page.

**Managing tasks for tiering storage, balancing pools, and transforming storage**

To optimize the resources in your storage environment, use tiering storage, balancing pools, and transforming-storage tasks. Use the Tasks page in the web-based GUI to manage all the tasks that are used by IBM Spectrum Control to optimize storage. Use resource list and resource detail pages to manage the optimization tasks for resource types and for specific resources.

To schedule, run, edit, or delete tiering storage, balancing pools, and transforming-storage tasks, you must have Administrator privileges.

To complete any of the optimization tasks, such as balancing pools, you must complete the following steps:

1. Create the analysis task. Use a IBM Spectrum Control wizard to create the optimization analysis task. For example, use the Balance Pools wizard to create a balance-analysis task.

2. Run the analysis task to generate the optimization recommendations. For example, run the balance-analysis task to generate the recommendations to move volumes.

3. Edit analyze tiering and balancing pool tasks. You can modify the thresholds that were set in the Analyze Tiering and Balance Pools wizards.

4. Implement the recommendations to optimize storage. For example, implement the recommendations to balance pools by running the analysis-execution task.

Use the Tasks, resource list, and resource detail pages in the web-based GUI to take the following actions for optimization tasks:

- Run the optimization analysis immediately to generate optimization recommendations.
- Schedule the optimization analysis to run at a specified date and time.
- Implement optimization recommendations immediately.
Schedule the implementation of optimization recommendations for a specified date and time.

- Pause, cancel, and resume the implementation of optimization recommendations.
- Delete optimization tasks.
- View task logs.

**Related tasks:**

- "Modifying the criteria for analyzing tiering" on page 222
  When a task is created after you run the tiering analysis, you can modify the criteria for tiering the volumes.
- "Modifying the criteria for balancing pools" on page 223
  When a task is created after you run the analysis for balancing pools, you can modify the criteria that determine which pools are balanced.

**Creating analysis tasks**

To create tasks for optimizing resources in your storage environment, use IBM Spectrum Control wizards.

To use the wizards, you must have Administrator privileges.

Storage optimization tasks are created when you take any of the following actions in the web-based GUI:

- **Tier storage**
  Move volumes to higher or lower tiers by using the Analyze Tiering wizard. A tiering-analysis task is created.

- **Balance pools**
  Distribute the workload of volumes across pools on the same tier by using the Balance Pools wizard. A balance-analysis task is created.

- **Transform storage**
  Move or convert volumes by using the Transform Storage wizard. A transform-plan task is created.

**Related tasks:**

- "Tiering volumes by I/O density and I/O rate" on page 221
  Set thresholds for tiering volumes by I/O rate or I/O density.
- "Balancing pools" on page 223
  You balance pools to distribute the workload of volumes across pools on the same tier and on the same storage virtualizer. To improve the performance of the pools, recommendations are generated to move volumes to other pools on the same tier and on the same storage virtualizer.
- "Transforming and migrating volumes" on page 227
  You can transform fully allocated volumes to compressed or thin-provisioned volumes, or transform compressed or thin-provisioned volumes to fully allocated volumes. You can move volumes to other pools or to pools that are enabled for Easy Tier.

**Running analysis tasks**

To run tiering analysis, balance analysis, and transform-plan tasks, use the Tasks page. When you run the analysis for any of these optimization tasks, recommendations are generated to optimize the storage resources that are configured in the task. For example, when you run a tiering-analysis task, recommendations are generated to tier volumes based on the criteria that you set in tiering policies.
To run tiering analysis, balance analysis, and transform-plan tasks, you must have Administrator privileges.

You can run tasks immediately or schedule tasks to run at a future date and time.

**Tip:** The **Run Now** action is available when the task is enabled and the task is not running.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the tiering-analysis tasks that are related to servers, go to **Servers > Servers**, and click the **Tasks** tab.
2. Locate the tiering analysis, balance analysis, or transform-plan task that you want to run.
3. Right-click the task row and select **Run Now**. The task status changes to Running.
4. Optional: To schedule future task runs for tiering analysis or balance-analysis tasks, right-click the task row and select **Schedule Analysis**. On the Schedule Analysis page, select the time that the task is run and how often the task is run.

   **Restriction:** You cannot schedule future task runs for transform-plan tasks.
5. Optional: To enable or disable a tiering analysis or balance-analysis task, select **Enabled** or **Disabled** on the Schedule Analysis page. When the task is enabled, the task runs according to the defined schedule. If the task is disabled, you can modify the task schedule but the task cannot run at the scheduled time.

When the task run completes, you can view the recommendations that are generated on the task detail page. For example, you can view the recommendations that are generated for a tiering-analysis task on the Tiering Analysis page. To check the progress of the task run, you can take the following actions:

• View the task status on the Tasks page.
• View information about the progress of the task on the task detail page. You can view the duration of the task run, and the date and time that the task run completed.
• View the task logs from the Tasks page or from the task detail page. You can view detailed informational, warning, and error messages that are related to the task. You can use this information to troubleshoot any errors that might occur when a task is run.

**Related tasks:**

“Modifying the criteria for analyzing tiering” on page 222

When a task is created after you run the tiering analysis, you can modify the criteria for tiering the volumes.

**Implementing recommendations to optimize storage**

Use the Tasks page and task detail pages to implement optimization recommendations to tier storage, balance pools, and transform storage. You can implement recommendations immediately or you can schedule the implementation of the recommendations for a future date and time.

**Related tasks:**

“Modifying the criteria for analyzing tiering” on page 222

When a task is created after you run the tiering analysis, you can modify the criteria for tiering the volumes.
Implementing recommendations immediately:

To implement optimization recommendations to tier storage, balance pools, and transform storage, use the task detail pages. For example, use the Balance Analysis page to implement the recommendations to balance pools.

To implement storage optimization recommendations, you must have Administrator privileges.

IBM Spectrum Control uses analysis-execution tasks to implement optimization recommendations. When you implement recommendations for a tiering analysis, balance analysis, or transform-plan task, the following process takes place:

- An analysis-execution task is automatically created so that the recommendations can be implemented.
- The analysis-execution task runs immediately and the optimization recommendations are implemented. For example, volumes are moved to higher or lower tiers when storage-tiering recommendations are implemented.

You can view analysis-execution tasks on the Tasks page. The Related Task column shows the related tiering analysis, balance analysis, or transform-plan task.

The Execute action is available under the following conditions:

- Recommendations were generated by the latest run of the tiering analysis, balance analysis, or transform-plan task.
- An analysis-execution task was not already run for the latest set of recommendations.
- An analysis-execution task is not running or paused.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the analysis-execution tasks that are related to servers, go to Servers > Servers, and click the Tasks tab.
2. Locate the tiering analysis, balance analysis, or transform-plan task that you want to implement.
3. Right-click the task row and select View Details. For example, the Balance Analysis page opens if you select a balance-analysis task.
4. Click Execute. An analysis-execution task is created and immediately implemented.

The analysis-execution task runs immediately. To check the progress of the task, you can take the following actions:

- View the task status on the Tasks page.
- View the status of individual task recommendations on the Analysis Execution page.
- View the task logs from the Tasks page or from the Analysis Execution page. You can view detailed informational, warning, and error messages that are related to the task. You can use this information to troubleshoot any errors that might occur when a task is run.

Scheduling the implementation of recommendations:

To schedule the implementation of optimization recommendations to tier storage, balance pools, and transform storage, use the Tasks page.
To schedule the implementation of storage optimization recommendations, you must have Administrator privileges.

The Schedule Execution action is available under the following conditions:
- Recommendations were generated by the latest run of the tiering analysis, balance analysis, or transform-plan task.
- An analysis-execution task is not running or paused.
- An analysis-execution task was not already run for the latest set of analysis recommendations. For each run of the tiering analysis, balance analysis, or transform-plan task, you can complete only one run of the analysis-execution task.

When you define the schedule, an analysis-execution task is created for the implementation of the optimization recommendations.

Tip: The analysis-execution task implements the recommendations that were current when the analysis-execution task was defined. For example, you define a tiering-analysis task that runs daily. You review the recommendations every day and, on a Tuesday, you schedule an analysis-execution task to run on the following Friday. When the analysis-execution task runs on Friday, the recommendations that were current on Tuesday are implemented, even if more recent recommendations are available.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the tiering analysis tasks that are related to servers, go to Servers > Servers, and click the Tasks tab.
2. Locate the tiering analysis, balance analysis, or transform-plan task that you want to schedule.
3. Right-click the task row and select Schedule Execution.
4. On the Schedule Execution page, select the date and time that the recommendations are implemented and click Save.

An analysis-execution task is created that you can monitor on the Tasks page. The name of the analysis-execution task is based on the name of the related tiering analysis, balance analysis, or transform-plan task. The Related Task column shows the related tiering analysis, balance analysis, or transform-plan task.

When the analysis-execution task runs on the scheduled date, the optimization recommendations are implemented. For example, volumes are moved to higher or lower tiers when storage-tiering recommendations are implemented.

Pausing, resuming, and canceling the implementation of recommendations
IBM Spectrum Control uses analysis-execution tasks to implement optimization recommendations to tier storage, balance pools, and transform storage. To pause, resume, and cancel analysis-execution tasks, use the Tasks page.

To pause, resume, or cancel analysis-execution tasks, you must have Administrator privileges.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the analysis-execution tasks that are related to servers, click Servers > Servers, and click the Tasks tab.
2. Locate the analysis-execution task that you want to pause, resume, or cancel.
3. Right-click the task row and select **Pause**, **Resume**, or **Cancel**.
   The **Pause** action is only available when the analysis-execution task is running.
   The **Resume** action is only available when the analysis-execution task is paused.
   The **Cancel** action is available when the task is running or paused.

When you pause, resume, or cancel analysis-execution tasks, the following processing occurs:

**Pause**
The status of the analysis-execution task changes to Paused and the recommendations that are being implemented are suspended.

**Resume**
The status of the analysis-execution task changes to Running and the recommendations are resumed.

**Cancel**
The status of the analysis-execution task changes to Canceled and the recommendations that are being implemented are stopped. Any recommendations that are already implemented for this analysis-execution task are not rolled back. For example, a recommendation is generated to move a volume from pool_a to pool_b. If this recommendation is already implemented before the task is canceled, the volume remains in pool_b.

Use the **Analysis Execution** page to determine which recommendations were implemented for the task before the task was canceled.

You cannot restart an analysis-execution task that is canceled. If you want to implement the same set of recommendations again, you must complete the following steps:

1. Delete the analysis-execution task that you canceled.
2. Use the **Schedule Execution** action for the tiering analysis, balance analysis, or transform-plan task to create an analysis-execution task.

**Restriction:** The implementation of recommendations for optimizing the volumes is canceled except for the recommendations to optimize the volumes with mirrored volume copies. The implementation of recommendations for optimizing volumes with mirrored volume copies cannot be canceled.

### Renaming tasks

You can change the name of a task by using the task detail page. For example, use the Provisioning page to change the name of a provisioning task. A task name is automatically generated when the task is created. If the original name is ambiguous or is not clear enough, you can change the task name to a unique task name that you provide.

You must have the following privileges to rename the different task types:

**Provisioning**
To rename provisioning tasks, you must be the owner of the task or have Administrator privileges.

**Other task types**
To rename all other tasks, such as tiering analysis, balance analysis, transform plan, and analysis-execution tasks, you must have Administrator privileges.
1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view the tasks that are related to servers, go to **Servers > Servers**, and click the **Tasks** tab.

2. Locate the task that you want to rename.

3. Right-click the task row and select **View Details**. The task detail page opens in a separate window. For example, the Provisioning page opens if you select a provisioning task.

4. Type the new name in the task name field. The naming conventions for task names are:
   - The maximum length is 64 characters.
   - Uppercase and lowercase letters are allowed.
   - Spaces and numbers are allowed.
   - The following special characters are allowed:
     ```
     ! # % & * + - / = ? ^ _ [ ] ( )
     ```

5. Click **Rename**.

The task is renamed. You can view the renamed task on the Tasks page.

**Deleting tasks**

Use the Tasks page to delete tasks, such as provisioning, tiering analysis, balance analysis, transform plan, and analysis-execution tasks.

You must have the following privileges to delete the different task types:

**Provisioning**

To delete provisioning tasks, you must be the owner of the task or have Administrator privileges.

**Other task types**

To delete all other tasks, such as tiering analysis, balance analysis, transform plan, and analysis-execution tasks, you must have Administrator privileges.

The following conditions apply for the different task types:

**Analysis-execution**

You can delete analysis-execution tasks that were canceled, already run, or scheduled to run in the future. You cannot delete tasks that are running or paused.

**Other task types**

You can delete all other tasks if the tasks were already run or if the tasks are scheduled to run in the future. For example, you can delete provisioning, tiering analysis, balance analysis, and transform-plan tasks that were already run. You cannot delete tasks that are running.

1. From the menu bar, go to the Tasks page, a resource list page for a resource type, or a resource detail page for a specific resource. For example, to view tasks that are related to servers, go to **Servers > Servers**, and click the **Tasks** tab.

2. Locate the task that you want to delete.

3. Right-click the task row and select **Delete**. Alternatively, you can delete the task by clicking **Delete** on the task detail page. The Delete page opens in a separate window.
4. If you are deleting a provisioning task that was not yet run, enter the reason that you are deleting the task.
5. Click **Delete**. To exit the window without deleting the task, click **Cancel**.
Appendix A. Reference

View reference information that is related to IBM Spectrum Control. Topics include information about alerts, fabrics, commands, configuration and log files, performance metrics, protocols, standards, and accessibility features.

Alerts

Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.

Conditions that generate alerts are detected during data collection and event processing. For some storage systems such as IBM Spectrum Accelerate and the XIV, events are polled every minute from the resource.

For other resources, events are subscription-based, where the resource itself or a data source such as a CIM agent sends the events to IBM Spectrum Control when conditions change on the resource. Examples of storage systems that use subscription-based event processing include SAN Volume Controller, Storwize V7000, Storwize V7000 Unified, FlashSystem V840, and FlashSystem V9000. For these storage systems, a probe is automatically run when many events are received from the storage system in a short time period. To avoid performance bottlenecks, probes are run only every 20 minutes.

Triggering conditions for alerts

The conditions that trigger alert notifications depend on the type of resource that you are monitoring. In general, the following types of conditions can trigger alerts:

- An attribute or configuration of a resource changed
- The capacity of a resource fell outside a specified range
- The performance of a resource fell outside a specified range
- The storage infrastructure was changed, such as a new or removed resource
- Data is not being collected for a resource

For example, you can use performance thresholds to be notified when the total I/O rate for storage systems falls outside a specified range. This information can help you identify areas in your storage infrastructure that are over used or under used. IBM Spectrum Control provides many metrics for measuring performance and determining violations of the thresholds that you specify.

Alert notifications and triggered actions

When an event occurs and triggers an alert, the alert is written to a log. You can also select one or more other ways to be notified of the event. These alert notifications include SNMP traps, IBM Tivoli Netcool/OMNIbus events, login notifications, entries in Windows event log or UNIX syslog, and emails.
Additionally, if a Storage Resource agent is deployed on a monitored server, you can run a script or start an IBM Tivoli Storage Manager job in response to the alert.

**Acknowledging alerts:** Some alerts are triggered by conditions that commonly occur and can be ignored. In such cases, you acknowledge these alerts to indicate that they were reviewed and do not require immediate resolution. By acknowledging alerts, you can more quickly identify other alerts that must be reviewed and resolved.

**Prerequisites for using alerts**

The following conditions must be met to successfully use alerts:

- Data collection schedules are configured and scheduled to run regularly. For example, to detect violations of performance thresholds, you must run performance monitors to collect performance data about resources. Running performance monitors regularly also helps to establish a history of performance for trending analysis.

- If you want to be notified about an alert in some way other than an entry in the log file, such as using SNMP traps, IBM Tivoli Netcool/OMNIbus events, or email, you must configure those alert destinations before you use the alert.

- If an alert is triggered based on an SNMP trap from the monitored resource, you must properly configure the SNMP server of the monitor resource to enable IBM Spectrum Control to listen to SNMP traps. The default port number is 162, and the default community is public.

**Related concepts:**

“Alerting and event processing” on page 111

Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.

**Related tasks:**

“Acknowledging alerts” on page 129

Some alerts in IBM Spectrum Control are triggered by conditions that commonly occur and can be ignored. In such cases, you acknowledge these alerts to indicate that they were reviewed and do not require immediate resolution. By acknowledging alerts, you can more quickly identify the other alerts in lists that must still be reviewed and resolved.

**Triggering conditions for alerts**

Define alerts so that IBM Spectrum Control automatically notifies you when certain conditions or events are detected on monitored resources. Such conditions are the *triggering conditions* for the alert. The specific conditions that can trigger alerts depend on the type of resource that is being monitored.

**Related concepts:**

“Alerting and event processing” on page 111

Determining when and how you are alerted to configuration and performance conditions within your storage environment is important to helping you maintain and administer storage resources. Many conditions can trigger alerts. You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a resource and notifies you when changes or violations are detected.
Related tasks:

“Adding resources” on page 75

You must add resources to IBM Spectrum Control before you can collect data, generate reports, and manage storage that is related to those resources.

Triggering conditions for storage system alerts

You can set up IBM Spectrum Control so that it examines the attributes, capacity, and performance of a storage system and notifies you when changes or violations are detected.

Alerts can notify you of general changes and performance issues on the following resources:

- “Storage Systems (performance)” on page 254
- “Storage Systems (general changes)” on page 254
- “Internal resources (common conditions)” on page 257
- “Clusters” on page 258
- “Disks” on page 258
- “Filesets” on page 258
- “File Systems” on page 259
- “File System Pools” on page 259
- “Host Connections” on page 259
- “I/O Groups” on page 259
- “Managed Disks” on page 259
- “Modules” on page 260
- “Network Shared Disks” on page 260
- “Nodes” on page 260
- “Pools” on page 261
- “Ports” on page 263
- “Quotas” on page 263
- “RAID Arrays” on page 264
- “Shares” on page 264
- “Volumes” on page 264

Important: Not all the attributes upon which you can alert are listed here. A number of other attributes are available for alerts and are based on the key properties of a storage system. To view a complete list of attributes upon which you can alert, go to the Block Storage Systems page, File Storage Systems page, or Object Storage Systems page, right-click the storage system, and select Edit Alert Definitions.

Attributes that are automatically configured for alerts are marked with an asterisk (*).

Tips:

- The type of storage system determines which attributes and performance conditions are available for alerts. For example, triggering conditions for shares are available only for storage systems that are configured for file storage, such as Storwize V7000 Unified.
- For capacity attributes, you can generate alerts when the amount of storage is greater than, less than, or equal to a specified value. You can also determine the unit of measurement for the attribute, such as KiB, MiB, GiB, or TiB.
**Storage Systems (performance)**

Define alerts that notify you when the performance of a storage system falls outside a specified threshold. In alerts, you can specify conditions based on metrics that measure the performance of volumes, disks, ports, ports, and nodes. By creating alerts with performance conditions, you can be informed about potential bottlenecks in your storage infrastructure.

For example:

- You can define an alert to be notified when the average number of I/O operations per second for read and write operations on a storage system’s volumes is greater than or equal to a specified threshold. Use this alert to be notified when the workload of a volume is high and you might need to balance that load across other volumes to improve overall performance.
- You can define an alert to be notified when the percentage of the average response time that can be attributed to delays from host systems is greater than or equal to a specified threshold. Use this alert to be notified of slow hosts and fabrics that might not be working efficiently.

You can also define an alert that notifies you when a metric is less than a specified threshold, such as if you want to identify volumes that might be under used.

The type of storage system determines the metrics that can be alerted upon. For a list of the metrics that are available for each type of storage system, see "Performance metrics" on page 283.

**Tips for performance conditions:**

- A performance monitor must collect data about a resource before IBM Spectrum Control can determine whether a threshold is violated and an alert is generated for a performance condition.
- When you set thresholds for performance conditions, try to determine the best value so you can derive the maximum benefit without generating too many false alerts. Because suitable thresholds are highly dependent on the type of workload that is being run, hardware configuration, the number of physical disks, exact model numbers, and other factors, there are no easy or standard default rules.

A recommended approach is to monitor the performance of resources for a number of weeks and by using this historical data, determine reasonable threshold values for each performance condition. After that is done, you can fine-tune the condition settings to minimize the number of false alerts.

**Storage Systems (general changes)**

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Firmware</strong></td>
<td>The firmware version of the microcode on a storage system. For the DS-series of storage systems, this value represents the SEA version of the firmware. To view information about the code bundles for the firmware versions of the DS-series, go to the <a href="http://www.ibm.com/support/entry/portal/Overview">IBM support site</a> at <a href="http://www.ibm.com/support/entry/portal/Overview">http://www.ibm.com/support/entry/portal/Overview</a> and search for code bundle information. An internet connection is required to access the support site.</td>
</tr>
</tbody>
</table>
Table 47. Triggering attributes and conditions for general changes on storage systems (continued)

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Successful Probe</td>
<td>A specified amount of time has passed since a probe or performance monitor was able to collect data about a storage system. You can use this alert to be notified when up-to-date configuration, status, or performance data is not being collected about a storage system and its existing data might be stale. This situation might occur if the resource, network, or IBM Spectrum Control server is unavailable.</td>
</tr>
<tr>
<td>Last Successful Monitor</td>
<td></td>
</tr>
<tr>
<td>Performance Monitor Status*</td>
<td>One of the following statuses is detected for a performance monitor:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a performance monitor did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A performance monitor completed, but did not collect a complete set of performance data. This status might occur if the resource was rebooted during data collection, no valid performance data was provided by the resource, or a communication error occurred with the resource or its associated agent.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>A performance did not complete when it attempted to collect performance data about the resource. This status might occur if the resource cannot be reached during data collection, or if no configuration data is available for the resource.</td>
</tr>
<tr>
<td></td>
<td>For details about why a specific status occurred, check the log for the performance monitor. To check the log, go to the details page for a resource, click Data Collection, and select Actions &gt; Open Logs in the Performance Monitor section on the Data Collection page.</td>
</tr>
<tr>
<td>Probe Status*</td>
<td>One of the following statuses is detected for a probe:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Successful</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a probe did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A probe completed, but might not have collected a complete set of data. This status might occur if data cannot be collected about one or more of the internal resources of a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>A probe did not complete when it attempted to collect asset data about the resource. This status might occur if the resource cannot be reached during data collection.</td>
</tr>
<tr>
<td></td>
<td>For details about why a specific status occurred, check the log for the probe. To check the log, go to the details page for a resource, click Data Collection, and select Actions &gt; Open Logs in the Probe section on the Data Collection page.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected for a storage system:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected for a storage system.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning status was detected for a storage system. This status might occur if a storage system comes online or if its version changes.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>An error status was detected for a storage system. This status might occur if the cooling fans in a storage system are stopped and the internal temperature is too high or if a storage system goes offline.</td>
</tr>
</tbody>
</table>
### Table 48. Triggering attributes and conditions for capacity changes on storage systems.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned Volume Space</td>
<td>The total volume space in the storage system that is mapped or assigned to host systems, including child pool capacity.</td>
</tr>
</tbody>
</table>
| Available Pool Space                | The total amount of the space in the pools that is not allocated to the volumes in the pools. To calculate available space, the following formula is used: *(pool capacity - allocated space)*  
For XIV systems, pool capacity is the physical capacity of the pools and does not include the virtual capacity of the pools. For other storage systems, pool capacity might also include the overhead space for the pools that are not formatted. |
| Free Capacity                       | The amount of space in the pools on the storage system that is available for creating volumes.                                                                                                                                               |
| Physical Allocation                 | The percentage of physical space in pools that is allocated to volumes, including child pools. The value is always less than or equal to 100% because you cannot allocate more physical space to the volumes than is available in the pools. This value is determined by the formula, *Allocated Space ÷ Capacity × 100*. For example, if the space that is reserved for volumes is 50 GiB for a volume size of 200 GiB, physical allocation is 25%. |
| Pool Shortfall                      | The difference between the amount of virtual space that is committed to the volumes in the pools and the actual physical space that is available in the pools, which is expressed as a percentage. As the virtual space is allocated to the thin-provisioned and compressed volumes, the shortfall increases and becomes more critical.  
This value is determined by the formula, *Unallocatable Volume Space ÷ Unallocated Volume Space × 100*.  
A pool shortfall occurs when you commit more space to the volumes in the pools than is physically available to the pools. If the physical space available to the pools is less than the committed virtual space, then the pools do not have enough space to fulfill the commitment to the virtual space.  
For example, the physical capacity of the pools is 70 GiB, but 150 GiB of virtual space was committed to the thin-provisioned volumes. If the volumes are using 50 GiB, then there is still 100 GiB committed to those volumes (150 GiB − 50 GiB) with only 20 GiB of available pool space (70 GiB − 50 GiB). Because only 20 GiB of the pool space is available, 80 GiB of the committed space cannot be allocated (100 GiB - 20 GiB). In this case, the percentage of committed space that is unavailable is 80% [80 GiB ÷ 100 GiB × 100]. |
| Pool Space                          | The amount of space in pools that are on the storage system.                                                                                                                                                                               |
| Raw Disk Capacity                   | The total unformatted disk capacity of a storage system. When this value is calculated, IBM Spectrum Control does not include the capacity of storage system disks that become missing after data collection. |
| Remaining Unallocated Volume Space  | The amount of the total volume capacity in the storage pool that is not allocated.                                                                                                                                                           |
Table 48. Triggering attributes and conditions for capacity changes on storage systems (continued).

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved Pool Space</td>
<td>The amount of unallocated space in the pool that is reserved for provisioning and optimization tasks.</td>
</tr>
<tr>
<td></td>
<td>Pool space is reserved when a provisioning or optimization task is created, and allocated when the task is run.</td>
</tr>
<tr>
<td>Shortfall</td>
<td>The difference between the amount of virtual space that is committed to the volumes in the pools and the actual physical space that is available in the pools. As the virtual space is allocated to the thin-provisioned and compressed volumes, the shortfall increases and becomes more critical.</td>
</tr>
<tr>
<td></td>
<td>This value is determined by the formula, $\frac{Unallocatable\ Space}{Committed\ but\ Unallocated\ Space}$</td>
</tr>
<tr>
<td></td>
<td>For example, the physical capacity of the pools is 70 GiB, but 150 GiB of virtual space was committed to the thin-provisioned volumes. If the volumes are using 50 GiB, then there is still 100 GiB committed to those volumes (150 GiB - 50 GiB) with only 20 GiB of available pool space (70 GiB - 50 GiB). Because only 20 GiB of the pool space is available, 80 GiB of the committed space cannot be allocated (100 GiB - 20 GiB).</td>
</tr>
<tr>
<td>Snapshot Space</td>
<td>The amount of space that is used by all of the snapshots of the file systems that are associated with the GPFS cluster.</td>
</tr>
<tr>
<td>Total File System Capacity</td>
<td>The total amount of storage space on all of the file systems on the storage system or filer.</td>
</tr>
<tr>
<td>Unassigned Volume Space</td>
<td>The total volume space in the storage system that is not mapped or assigned to host systems.</td>
</tr>
<tr>
<td>Used Capacity</td>
<td>The amount of space in the pools on the storage system that is used by volumes.</td>
</tr>
<tr>
<td>Used Pool Space</td>
<td>The amount of space in the pool that is allocated to and used by volumes.</td>
</tr>
<tr>
<td>Used Volume Space</td>
<td>The amount of space in the storage system that is allocated to and used by volumes.</td>
</tr>
<tr>
<td>Volume Capacity</td>
<td>The total storage space on all the volumes in pools. For thin-provisioned and compressed volumes, this value includes virtual space. For volumes with parent pools, this value includes child pool capacity.</td>
</tr>
</tbody>
</table>

### Internal resources (common conditions)

There are a number of alert conditions that are common to many of the internal resources in a storage system. These common conditions represent key changes in your storage infrastructure. For example, you can specify conditions that generate alerts when specific internal resources are added to or deleted from a storage system, or when current data isn't being collected about resources.

Table 49. Triggering attributes and conditions that are common to internal resources

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New resource</td>
<td>A resource is detected for the first time. Use this alert to be notified when new physical and logical resources are added to a storage system.</td>
</tr>
</tbody>
</table>
Table 49. Triggering attributes and conditions that are common to internal resources (continued)

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removed physical resource</td>
<td>A previously monitored resource can no longer be found. Historical data about the resource is retained, but no current data is being collected. Use these alerts to be notified if a physical or logical resource is removed, deleted, or becomes unavailable.</td>
</tr>
<tr>
<td>Deleted logical resource</td>
<td>Physical resources include disks, RAID arrays, I/O groups, ports, nodes, host connections, clusters, and file systems. Logical resources include volumes, pools, filesets, and shares.</td>
</tr>
</tbody>
</table>

Clusters

Table 50. Triggering attributes and conditions for general changes on clusters

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Cluster</td>
<td>A cluster is detected for the first time.</td>
</tr>
<tr>
<td>Removed NAS Cluster</td>
<td>A previously monitored NAS cluster can no longer be found. Historical data about the cluster is retained, but no current data is being collected. Use this alert to be notified if a cluster is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

Disks

Table 51. Triggering attributes and conditions for general changes on storage system disks

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Disk</td>
<td>A disk is detected for the first time.</td>
</tr>
<tr>
<td>Removed Disk</td>
<td>A previously monitored disk can no longer be found. Historical data about the disk is retained, but no current data is being collected. Use this alert to be notified if a disk is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

Table 52. Triggering attributes and conditions for capacity changes on disks.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Disk Space</td>
<td>The amount of storage space that is available (not allocated) on the disk.</td>
</tr>
<tr>
<td>Disk Capacity</td>
<td>The total amount of storage space that is on the disk.</td>
</tr>
</tbody>
</table>

Filesets

Table 53. Triggering attributes and conditions for general changes on filesets

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted NAS Fileset</td>
<td>A previously monitored NAS fileset can no longer be found. Historical data about the fileset is retained, but no current data is being collected. Use this alert to be notified if a fileset is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Fileset</td>
<td>A fileset is detected for the first time.</td>
</tr>
<tr>
<td>State</td>
<td>A fileset is linked to a file system, unlinked from a file system, or deleting.</td>
</tr>
</tbody>
</table>
## File Systems

Table 54. Triggering attributes and conditions for general changes on file systems

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New File System</td>
<td>A file system is detected for the first time.</td>
</tr>
<tr>
<td>Removed NAS File System</td>
<td>A previously monitored NAS file system can no longer be found. Historical data about the file system is retained, but no current data is being collected. Use this alert to be notified if a file system is deleted or becomes unavailable.</td>
</tr>
</tbody>
</table>

## File System Pools

Table 55. Triggering attributes and conditions for general changes on file system pools

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Pool</td>
<td>A previously monitored NAS pool can no longer be found. Historical data about the pool is retained, but no current data is being collected. Use this alert to be notified if a pool is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Pool</td>
<td>A NAS pool is detected for the first time.</td>
</tr>
</tbody>
</table>

## Host Connections

Table 56. Triggering attributes and conditions for general changes on host connections

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Host Connection</td>
<td>A host connection is detected for the first time.</td>
</tr>
<tr>
<td>Removed Host Connection</td>
<td>A previously monitored host connection can no longer be found. Historical data about the host connection is retained, but no current data is being collected. Use this alert to be notified if a host connection is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

## I/O Groups

Table 57. Triggering attributes and conditions for general changes on I/O groups

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New I/O Group</td>
<td>A new I/O group was detected for the first time.</td>
</tr>
<tr>
<td>Removed I/O Group</td>
<td>A previously monitored I/O group can no longer be found. Historical data about the I/O group is retained, but no current data is being collected. Use this alert to be notified if an I/O group is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

## Managed Disks

Table 58. Triggering attributes and conditions for general changes on managed disks

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed Disk Status</td>
<td>One of the following statuses is detected for a managed disk:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on a managed disk.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on a managed disk.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>An error status was detected on a managed disk.</td>
</tr>
<tr>
<td>New Managed Disk</td>
<td>A new managed disk was detected for the first time.</td>
</tr>
</tbody>
</table>

Table 58. Triggering attributes and conditions for general changes on managed disks (continued)

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removed Managed Disk</td>
<td>A previously monitored managed disk can no longer be found. Historical data about the managed disk is retained, but no current data is being collected. Use this alert to be notified if a managed disk is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

Table 59. Triggering attributes and conditions for capacity changes on managed disks.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Space</td>
<td>The amount of unused storage space on the managed disk.</td>
</tr>
<tr>
<td>Total Space</td>
<td>The total amount of storage space that is on the managed disk on the storage system. This attribute is only available for Storwize V7000 storage systems that are configured as back-end storage.</td>
</tr>
</tbody>
</table>

Modules

Table 60. Triggering attributes and conditions for general changes on modules

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Module</td>
<td>A previously monitored module can no longer be found. Use this alert to be notified if a module is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

Network Shared Disks

Table 61. Triggering attributes and conditions for general changes on NSDs

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New NSD</td>
<td>A newNSD was detected for the first time.</td>
</tr>
<tr>
<td>Removed NSD</td>
<td>A previously monitored NSD can no longer be found. Historical data about the NSD is retained, but no current data is being collected. Use this alert to be notified if an NSD is removed or becomes unavailable.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected for an NSD:</td>
</tr>
<tr>
<td>Not Normal</td>
<td>An error or warning status was detected on an NSD.</td>
</tr>
<tr>
<td>Warning</td>
<td>A warning status was detected on an NSD. This status might occur if a storage system comes online or if its version changes.</td>
</tr>
<tr>
<td>Error</td>
<td>An error status was detected on an NSD.</td>
</tr>
</tbody>
</table>

Nodes

Table 62. Triggering attributes and conditions for general changes on nodes

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Node</td>
<td>A new node was detected for the first time.</td>
</tr>
<tr>
<td>Removed Node (Block storage)</td>
<td>A previously monitored node can no longer be found. Historical data about the node is retained, but no current data is being collected. Use this alert to be notified if a node is removed or becomes unavailable.</td>
</tr>
<tr>
<td>Removed NAS Node (File storage)</td>
<td>A previously monitored NAS node can no longer be found. Historical data about the node is retained, but no current data is being collected. Use this alert to be notified if a node is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>
### Pools

#### Table 63. Triggering attributes and conditions for general changes on pools

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Pool</td>
<td>A previously monitored pool can no longer be found. Historical data about the pool is retained, but no current data is being collected. Use this alert to be notified if a pool is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Storage Pool</td>
<td>A new pool was detected for the first time.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected for a pool:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning condition is detected on a pool.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning condition is detected on a pool. This condition might occur if a pool goes offline.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>An error condition is detected on a pool. This condition might occur under the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• The percentage of remaining, unallocated volume space in a pool that is not available to be allocated is too high.</td>
</tr>
<tr>
<td></td>
<td>• The available space in a pool that is not reserved for volumes is too low.</td>
</tr>
<tr>
<td></td>
<td>• The pool virtual allocation exceeds the warning or critical threshold boundary value.</td>
</tr>
</tbody>
</table>

#### Table 64. Triggering attributes and conditions for capacity changes on pools

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated Space</td>
<td>The amount of space that is reserved for all the volumes in a pool.</td>
</tr>
<tr>
<td>Assigned Volume Space</td>
<td>The amount of space on all the volumes in a pool that are mapped or assigned to host systems.</td>
</tr>
<tr>
<td></td>
<td>For a thin-provisioning pool, this value includes the virtual capacity of thin-provisioned volumes, which might exceed the total space in the pool. For Hitachi VSP non-thin provisioning pool space, this value is the sum of assigned regular host-accessible volumes. Volumes that are used for thin-provisioning (pool volumes) are not included.</td>
</tr>
<tr>
<td>Available Repository Space</td>
<td>The amount of available, unallocated storage space on all extents in the repository of a pool for Track Space-Efficient (TSE) thin-provisioning. This attribute applies only to the DS8000 storage systems. You can use this alert to be notified about space-efficient volumes.</td>
</tr>
<tr>
<td>Available Virtual Capacity</td>
<td>The amount of virtual capacity in a thin-provisioned pool that is not used by volumes.</td>
</tr>
<tr>
<td>Physical Allocation</td>
<td>The percentage of physical space in a pool that is reserved for volumes. This value is determined by the formula, Allocated Space = Capacity \times 100. For example, if the space that is reserved for volumes is 50 GiB for a volume size of 200 GiB, physical allocation is 25%.</td>
</tr>
<tr>
<td>Capacity Attributes</td>
<td>Triggering Conditions for Attributes</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Pool Shortfall              | The difference between the amount of virtual space that is committed to the volumes in the pools and the actual physical space that is available in the pools, which is expressed as a percentage. As the virtual space is allocated to the thin-provisioned and compressed volumes, the shortfall increases and becomes more critical.  
This value is determined by the formula, \( \frac{Unallocatable \ Volume \ Space}{Unallocated \ Volume \ Space} \times 100. \)  
A pool shortfall occurs when you commit more space to the volumes in the pools than is physically available to the pools. If the physical space available to the pools is less than the committed virtual space, then the pools do not have enough space to fulfill the commitment to the virtual space.  
For example, the physical capacity of the pools is 70 GiB, but 150 GiB of virtual space was committed to the thin-provisioned volumes. If the volumes are using 50 GiB, then there is still 100 GiB committed to those volumes (150 GiB - 50 GiB) with only 20 GiB of available pool space (70 GiB - 50 GiB). Because only 20 GiB of the pool space is available, 80 GiB of the committed space cannot be allocated (100 GiB - 20 GiB). In this case, the percentage of committed space that is unavailable is 80% \( \left(\frac{80 \ GiB}{100 \ GiB} \times 100\right) \). |
| Repository Space            | The amount of space on all extents in the repository of a pool. This attribute applies only to the DS8000 storage systems. |
| Reserved Pool Space         | The amount of unallocated space in a pool that is reserved for provisioning and optimization tasks.  
Pool space is reserved when a provisioning or optimization task is created, and allocated when the task is run. |
| Shortfall                   | The difference between the amount of virtual space that is committed to the volumes in the pools and the actual physical space that is available in the pools. As the virtual space is allocated to the thin-provisioned and compressed volumes, the shortfall increases and becomes more critical.  
This value is determined by the formula, \( \frac{Unallocatable \ Space}{Committed \ but \ Unallocated \ Space} \)  
For example, the physical capacity of the pools is 70 GiB, but 150 GiB of virtual space was committed to the thin-provisioned volumes. If the volumes are using 50 GiB, then there is still 100 GiB committed to those volumes (150 GiB - 50 GiB) with only 20 GiB of available pool space (70 GiB - 50 GiB). Because only 20 GiB of the pool space is available, 80 GiB of the committed space cannot be allocated (100 GiB - 20 GiB). |
| Total Reserved Capacity     | The total amount of space on the pool that is reserved for provisioning and optimization tasks. Pool space is reserved when a provisioning or optimization task is created, and allocated when the task is run. |
| Unused Space                | The amount of space that is allocated to the volumes in a pool and is not yet used. This value is determined by the formula, \( Allocated \ Space - Used \ Space. \) |
### Table 64. Triggering attributes and conditions for capacity changes on pools (continued).

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used Repository Space</td>
<td>The amount of used space on all extents in the repository of a pool. This attribute applies only to the DS8000 storage systems. You can use this alert to be notified about space-efficient volumes.</td>
</tr>
<tr>
<td>Used Volume Space</td>
<td>The amount of space on the storage system that is used by volumes.</td>
</tr>
<tr>
<td>User Reserved Capacity</td>
<td>The amount of space in the pools on the storage system that is reserved for user-defined purposes.</td>
</tr>
<tr>
<td>Virtual Allocation</td>
<td>The percentage of physical space in a pool that is committed to the total virtual capacity of the volumes in the pool. You can use this alert to be notified about space-efficient volumes.</td>
</tr>
<tr>
<td>Virtual Capacity Limit</td>
<td>The maximum amount of virtual storage space available to allocate to volumes in the storage pools that are associated with the storage system. You can use this alert to be notified about space-efficient volumes.</td>
</tr>
<tr>
<td>Virtual Volume Space</td>
<td>The total amount of physical space in a pool that is committed to the total virtual capacity of the volumes in the pool. You can use this alert to be notified about space-efficient volumes.</td>
</tr>
</tbody>
</table>

### Ports

### Table 65. Triggering attributes and conditions for general changes on ports

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Port</td>
<td>A new port was detected for the first time.</td>
</tr>
<tr>
<td>Removed Port</td>
<td>A previously monitored port can no longer be found. Historical data about the port is retained, but no current data is being collected. Use this alert to be notified if a port is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected for a port:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning condition is detected on a port.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning condition is detected on a port.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>An error condition is detected on a port.</td>
</tr>
</tbody>
</table>

### Quotas

### Table 66. Triggering attributes and conditions for general changes on quotas

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Quota</td>
<td>A previously monitored quota can no longer be found. Historical data about the quota is retained, but no current data is being collected. Use this alert to be notified if a quota is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Quota</td>
<td>A new quota was detected for the first time.</td>
</tr>
</tbody>
</table>
RAID Arrays

Table 67. Triggering attributes and conditions for general changes on RAID arrays

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New RAID Array</td>
<td>A new RAID array was detected for the first time.</td>
</tr>
<tr>
<td>Removed RAID Array</td>
<td>A previously monitored RAID array can no longer be found. Historical data about the RAID array is</td>
</tr>
<tr>
<td></td>
<td>retained, but no current data is being collected. Use this alert to be notified if a RAID array is</td>
</tr>
<tr>
<td></td>
<td>removed or becomes unavailable.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected for a RAID array:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning condition is detected on a RAID array.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning condition is detected on a RAID array.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>An error condition is detected on a RAID array.</td>
</tr>
</tbody>
</table>

Table 68. Triggering attributes and conditions for capacity changes on RAID arrays.

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAIDArrayFreeSpace</td>
<td>The amount of unused storage space in the RAID array.</td>
</tr>
<tr>
<td>Total Space</td>
<td>The total amount of storage space in the RAID array.</td>
</tr>
</tbody>
</table>

Shares

Table 69. Triggering attributes and conditions for general changes on shares

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Share</td>
<td>A new share was detected for the first time.</td>
</tr>
<tr>
<td>Deleted Share</td>
<td>A previously monitored share can no longer be found. Historical data about the share is retained,</td>
</tr>
<tr>
<td></td>
<td>but no current data is being collected. Use this alert to be notified if a share is deleted or</td>
</tr>
<tr>
<td></td>
<td>becomes unavailable.</td>
</tr>
</tbody>
</table>

Volumes

Table 70. Triggering attributes and conditions for general changes on volumes

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Volume</td>
<td>A previously monitored volume can no longer be found. Historical data about the volume is retained,</td>
</tr>
<tr>
<td></td>
<td>but no current data is being collected. Use this alert to be notified if a volume is deleted or</td>
</tr>
<tr>
<td></td>
<td>becomes unavailable.</td>
</tr>
<tr>
<td>New Volume</td>
<td>A new volume was detected for the first time.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected for a volume:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning condition is detected on a RAID array.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning condition is detected on a RAID array.</td>
</tr>
<tr>
<td></td>
<td><strong>Error</strong></td>
</tr>
<tr>
<td></td>
<td>An error condition is detected on a RAID array.</td>
</tr>
<tr>
<td>Capacity Attributes</td>
<td>Triggering Conditions for Attributes</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allocated Space</td>
<td>The total amount of storage space on a pool that is physically allocated to a volume.</td>
</tr>
<tr>
<td>Real Capacity</td>
<td>The total amount of storage space that is physically allocated to a volume. For thin-provisioned volumes, this value is less than the virtual capacity of the volume. In an XIV and IBM Spectrum Accelerate, this value represents the physical (&quot;hard&quot;) capacity of the volume, not the virtual (&quot;soft&quot;) capacity. For other storage systems, this value might also include overhead space if the pool is unformatted.</td>
</tr>
<tr>
<td>Remaining Managed Space</td>
<td>The amount of storage space that is available on a managed disk. This value is only available for Storwize V7000 storage systems that are configured as back-end storage.</td>
</tr>
<tr>
<td>Space</td>
<td>The amount of space in a pool that is allocated to a volume.</td>
</tr>
<tr>
<td>Unallocatable Space</td>
<td>The amount of space by which the capacity of a volume exceeds the physical capacity of the associated pool. In thin-provisioned environments, it is possible to over commit (over provision) storage in a pool by creating volumes with more virtual capacity than can be physically allocated in the pool. This value represents the amount of volume space that cannot be allocated based on the current capacity of the pool.</td>
</tr>
<tr>
<td>Unallocated Space</td>
<td>The amount of space in a pool that is not reserved for a volume. This value is determined by the formula: ( \text{Capacity} - \text{Allocated Space} ).</td>
</tr>
<tr>
<td>Uncompressed Used Capacity</td>
<td>The amount of storage space that is used if the compressed volume space is uncompressed. For example, if 100 GiB of uncompressed data is compressed, and the size of the compressed data is 20 GiB, the value is 100.</td>
</tr>
<tr>
<td>Unused Space</td>
<td>The amount of space that is allocated to a volume and is not yet used. This value is determined by the formula, ( \text{Allocated Space} - \text{Used Space} ).</td>
</tr>
<tr>
<td>Used Space</td>
<td>The amount of allocated space that is used by a volume. For SAN Volume Controller and Storwize family storage systems that are configured with block storage, you can pre-allocate thin-provisioned volume space when the volumes are created. In these cases, the Used Space might be different from the Allocated Space. For compressed volumes on SAN Volume Controller and Storwize family storage systems that are configured with block storage, the Used Space reflects the size of compressed data that is written to disk. As the data changes, the Used Space might at times be less than the Allocated Space. For volumes that are not thin provisioned in SAN Volume Controller, Storwize family storage systems that are configured with block storage, and other storage systems, the values for Used Space and Allocated Space are equal. This value is accurate as of the most recent time that data was collected about a volume. Data collection is run on a set schedule and the used space on a volume can change rapidly.</td>
</tr>
</tbody>
</table>
Triggering conditions for hypervisor alerts
You can set up IBM Spectrum Control so that it examines the attributes and capacity of a hypervisor and notifies you when changes are detected.

Alerts can notify you of general changes and capacity changes on the following resources:
- “Hypervisors”
- “Controllers” on page 267
- “Data Stores” on page 267
- “Disks” on page 268
- “Paths” on page 268
- “Virtual Machines” on page 269
- “VMDKs” on page 269

Important: Not all the attributes upon which you can alert are listed here. A number of other attributes are available for alerts and are based on the key properties of a hypervisor. To view a complete list of hypervisor attributes upon which you can alert, go to Servers > Hypervisors, right-click the hypervisor, and select Edit Alert Definitions.

Attributes that are automatically configured for alerts are marked with an asterisk (*).

Tip: For capacity attributes, you can generate alerts when the amount of storage is greater than, less than, or equal to a specified value. You can also determine the unit of measurement for the attribute, such as KiB, MiB, GiB, or TiB.

Hypervisors

Table 72. Triggering attributes and conditions for general hypervisor changes.

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Successful Probe</td>
<td>A specified amount of time has passed since a probe was able to collect data about a hypervisor. You can use this alert to be notified when up-to-date configuration and status data is not being collected about a hypervisor and its existing data might be stale. Data collection might be interrupted or not occur if the resource, network, or IBM Spectrum Control server is unavailable.</td>
</tr>
<tr>
<td>Probe Status*</td>
<td>One of the following statuses is detected for a probe:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Successful</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a probe did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A probe completed, but might not have collected a complete set of data. This status might occur if data cannot be collected about one or more of the internal resources of a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>A probe did not complete when it attempted to collect asset data about the resource. This status might occur if the resource cannot be reached during data collection.</td>
</tr>
<tr>
<td></td>
<td>For details about why a specific status occurred, check the log for the probe. To check the log, go to the details page for a resource, click Data Collection, and select Actions &gt; Open Logs in the Probe section on the Data Collection page.</td>
</tr>
</tbody>
</table>
Table 72. Triggering attributes and conditions for general hypervisor changes (continued).

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>One of the following statuses is detected on a hypervisor:</td>
</tr>
<tr>
<td>Not Normal</td>
<td>An error or warning status was detected on the hypervisor or its internal resources.</td>
</tr>
<tr>
<td>Warning</td>
<td>A warning status was detected on the hypervisor or its internal resources.</td>
</tr>
<tr>
<td>Error (default)</td>
<td>An error status was detected on the hypervisor or its internal resources. For example, an error status might occur when a hypervisor goes offline, or a server disk is disconnected or partially disconnected if it has multiple paths and one of the paths is disconnected.</td>
</tr>
<tr>
<td>Unreachable</td>
<td>One or more of the monitored resources for a hypervisor are not responding. This status might be caused by a problem in the network.</td>
</tr>
</tbody>
</table>

Controllers

Table 73. Triggering attributes and conditions for general changes on controllers.

<table>
<thead>
<tr>
<th>Controller Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Disk Controller</td>
<td>A disk controller is detected for the first time. Use this alert to be notified of hardware additions on servers.</td>
</tr>
<tr>
<td>Removed Disk Controller</td>
<td>A previously monitored disk controller can no longer be found. Historical data about the controller is retained, but no current data is being collected. Use this alert to be notified if a controller is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>

Data Stores

Table 74. Triggering attributes and conditions for general changes on data stores.

<table>
<thead>
<tr>
<th>Data Store Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Logical Volume</td>
<td>A previously monitored logical volume on a data store can no longer be found. Historical data about the volume is retained, but no current data is being collected. Use this alert to be notified if a volume is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Logical Volume</td>
<td>A logical volume on the data store is detected for the first time.</td>
</tr>
<tr>
<td>VMDKs</td>
<td>You can use a number of operators to determine when you are notified of the number of virtual machine disk files (VMDKs) on the data store. For example, you can select to be notified when the number of VMDKs changes, or when the number is or is not a specific number, or when the number lies outside a specific range.</td>
</tr>
</tbody>
</table>

Table 75. Triggering attributes and conditions for capacity changes on data stores.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Data Store Space</td>
<td>The amount of unused storage space on the hypervisor data store.</td>
</tr>
<tr>
<td>Available File System Space</td>
<td>The total amount of unused storage space on a file system.</td>
</tr>
<tr>
<td>Data Store Capacity</td>
<td>The total amount of storage space that is assigned to a data store.</td>
</tr>
</tbody>
</table>
### Table 75. Triggering attributes and conditions for capacity changes on data stores (continued).

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total File System Capacity</td>
<td>The total amount of storage space on a file system.</td>
</tr>
<tr>
<td>Used File System Space</td>
<td>The amount of used storage space on the hypervisor file system.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The percentage of storage space that is used on the hypervisor data store.</td>
</tr>
</tbody>
</table>

### Disks

Table 76. Triggering attributes and conditions for general changes on disks.

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware</td>
<td>The version of the Licensed Internal Code on the disk changes. You can use a number of operators to determine when you are notified of a firmware change, such as when the firmware is, or is not, a specific version, or when the version number contains a specific value.</td>
</tr>
<tr>
<td>Multipathing Policy</td>
<td>The multipathing policy that is in effect for a disk. For example, you can be notified when the policy changes, or when the policy is Round Robin, Load Balancing, Failover Only, or other another policy.</td>
</tr>
<tr>
<td>New Disk</td>
<td>A disk is detected for the first time. Use this alert to be notified of hardware changes on servers or hypervisors.</td>
</tr>
<tr>
<td>Paths</td>
<td>The number of access paths that are associated with the disk falls outside a specified range, or is equal to or not equal to a specified value.</td>
</tr>
<tr>
<td>Removed Disk</td>
<td>A previously monitored disk can no longer be found. Historical data about the disk is retained, but no current data is being collected. Use this alert to be notified if a disk is removed or becomes unavailable.</td>
</tr>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a disk:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the disk.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the disk.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the disk.</td>
</tr>
</tbody>
</table>

### Table 77. Triggering attributes and conditions for capacity changes on disks.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Disk Space</td>
<td>The amount of unused storage space on a hypervisor disk.</td>
</tr>
<tr>
<td>Capacity</td>
<td>The total amount of storage space assigned to a hypervisor disk.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The amount of used storage space on a hypervisor disk.</td>
</tr>
</tbody>
</table>

### Paths

Table 78. Triggering attributes and conditions for general changes on paths.

<table>
<thead>
<tr>
<th>Path Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Path</td>
<td>A previously monitored access path for a server disk can no longer be found. This change might or might not affect the availability of the disk because there might be more than one path available.</td>
</tr>
<tr>
<td>New Path</td>
<td>An access path for a disk is detected for the first time.</td>
</tr>
</tbody>
</table>
Table 78. Triggering attributes and conditions for general changes on paths (continued).

<table>
<thead>
<tr>
<th>Path Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a path:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the path.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the path.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the path.</td>
</tr>
</tbody>
</table>

Virtual Machines

Table 79. Triggering attributes and conditions for general changes on virtual machines.

<table>
<thead>
<tr>
<th>Virtual Machine Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Virtual Machine</td>
<td>A previously monitored access path for a virtual machine can no longer be found. Historical data about the virtual machine is retained, but no current data is being collected. Use this alert to be notified if a virtual machine is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Virtual Machine</td>
<td>A virtual machine is detected for the first time.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following statuses is detected on a virtual machine:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the virtual machine.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the virtual machine.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the virtual machine.</td>
</tr>
<tr>
<td>VMDKs</td>
<td>You can use a number of operators to determine when you are notified of the number of VMDKs on the virtual machine. For example, you can select to be notified when the number of VMDKs changes, or when the number is or is not a specific number, or when the number lies outside a specific range.</td>
</tr>
</tbody>
</table>

Table 80. Triggering attributes and conditions for capacity changes on virtual machines.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>The total amount of storage space assigned to a virtual machine hosted by the hypervisor.</td>
</tr>
</tbody>
</table>

VMDKs

Table 81. Triggering attributes and conditions for general changes on virtual machine disks (VMDKs).

<table>
<thead>
<tr>
<th>VMDK Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Virtual Disk</td>
<td>A previously monitored virtual disk can no longer be found. Historical data about the virtual disk is retained, but no current data is being collected. Use this alert to be notified if a virtual disk is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Virtual Disk</td>
<td>A virtual disk is detected for the first time.</td>
</tr>
</tbody>
</table>
Table 8.2. Triggering attributes and conditions for capacity changes on VMDKs.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>The size of the VMDK on the hypervisor data store.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The percentage of storage space that is used on the VMDK on the hypervisor data store. The used space is available if a Storage Resource agent is deployed.</td>
</tr>
</tbody>
</table>

**Triggering conditions for switch alerts**

You can set up IBM Spectrum Control so that it examines the attributes and performance of a switch and notifies you when changes or violations are detected.

Alerts can notify you of general changes and performance issues on the following resources:

- “Switches (performance)”
- “Switches (general changes)” on page 271
- “Ports” on page 272

**Important:** Not all the attributes upon which you can alert are listed here. A number of other attributes are available for alerts and are based on the key properties of a switch. To view a complete list of attributes upon which you can alert, go to Network > Switches, right-click a switch, and select **Edit Alert Definitions**.

Attributes that are automatically configured for alerts are marked with an asterisk (*).

**Switches (performance)**

Define alerts that notify you when the performance of a switch falls outside a specified threshold. In alerts, you can specify conditions based on metrics that measure the performance of switch ports, including I/O, data, and error rates, and frame transfer sizes. By creating alerts with performance conditions, you can be informed about potential bottlenecks in your network infrastructure.

For example, you can define an alert to be notified when the port congestion index for a port is greater than or equal to a specified threshold. Port congestion represents the estimated degree to which frame transmission was delayed due to a lack of buffer credits. Use this alert to help identify port conditions that might slow the performance of the resources to which those ports are connected.

You can also be notified when a metric is less than a specified threshold, such as when you want to identify ports that might be under used.

For a complete list of switch metrics that can be alerted upon, see “Performance metrics for switches” on page 333.

**Tips for performance conditions:**

- A performance monitor must collect data about a resource before IBM Spectrum Control can determine whether a threshold is violated and an alert is generated for a performance condition.
- When you set thresholds for performance conditions, try to determine the best value so you can derive the maximum benefit without generating too many false alerts. Because suitable thresholds are highly dependent on the type of workload...
that is being run, hardware configuration, the number of physical disks, exact model numbers, and other factors, there are no easy or standard default rules.

A recommended approach is to monitor the performance of resources for a number of weeks and by using this historical data, determine reasonable threshold values for each performance condition. After that is done, you can fine-tune the condition settings to minimize the number of false alerts.

**Switches (general changes)**

Table 83. Triggering attributes and conditions for general changes on switches

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware</td>
<td>The version of the Licensed Internal Code on the switch changes. You can use a number of operators to determine when you are notified of a firmware change, such as when the firmware is, or is not, a specific version, or when the version number contains a specific value.</td>
</tr>
<tr>
<td>Last Successful Probe</td>
<td>A specified amount of time has passed since a probe or performance monitor was able to collect data about a switch. You can use this alert to be notified when up-to-date configuration, status, or performance data is not being collected about a switch and its existing data might be stale. This situation might occur if the resource, network, or IBM Spectrum Control server is unavailable.</td>
</tr>
<tr>
<td>Last Successful Monitor</td>
<td></td>
</tr>
<tr>
<td>Probe Status*</td>
<td>One of the following statuses is detected for a probe:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Successful</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a probe did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A probe completed, but might not have collected a complete set of data. This status might occur if data cannot be collected about one or more of the internal resources of a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>A probe did not complete when it attempted to collect asset data about the resource. This status might occur if the resource cannot be reached during data collection.</td>
</tr>
</tbody>
</table>

For details about why a specific status occurred, check the log for the probe. To check the log, go to the details page for a resource, click **Data Collection**, and select **Actions > Open Logs** in the Probe section on the Data Collection page.
Table 83. Triggering attributes and conditions for general changes on switches (continued)

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Monitor Status*</td>
<td>One of the following statuses is detected for a performance monitor:</td>
</tr>
<tr>
<td>Not Normal</td>
<td>An error or warning occurred during data collection. This status indicates that a performance monitor did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td>Warning</td>
<td>A performance monitor completed, but did not collect a complete set of performance data. This status might occur if the resource was rebooted during data collection, no valid performance data was provided by the resource, or a communication error occurred with the resource or its associated agent.</td>
</tr>
<tr>
<td>Error</td>
<td>A performance did not complete when it attempted to collect performance data about the resource. This status might occur if the resource cannot be reached during data collection, or if no configuration data is available for the resource.</td>
</tr>
</tbody>
</table>

For details about why a specific status occurred, check the log for the performance monitor. To check the log, go to the details page for a resource, click Data Collection, and select Actions > Open Logs in the Performance Monitor section on the Data Collection page.

Ports

Table 84. Triggering attributes and conditions for general changes on ports

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removed Port</td>
<td>A previously monitored port can no longer be found. Historical data about the port is retained, but no current data is being collected. Use this alert to be notified if a port is removed or becomes unavailable.</td>
</tr>
<tr>
<td>Speed</td>
<td>The negotiated speed of a port, which is measured in GiB per second. You can generate an alert when the port speed changes, or when it is greater than, less than, equal to, or is not equal to a specific value.</td>
</tr>
<tr>
<td>State</td>
<td>A port is online, enabled but offline, or disabled.</td>
</tr>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected for a port:</td>
</tr>
<tr>
<td>Not Normal</td>
<td>An error or warning status is detected on a port.</td>
</tr>
<tr>
<td>Warning</td>
<td>A warning status is detected on a port. This status might occur if the switch is stopped, starting, or in service (being maintained, cleaned, or administered).</td>
</tr>
<tr>
<td>Error</td>
<td>An error status is detected on a port.</td>
</tr>
</tbody>
</table>

Triggering conditions for fabric alerts

You can set up IBM Spectrum Control so that it examines the attributes of a fabric and notifies you when changes are detected.

Alerts can notify you of general changes on the following types of fabric resources:

- “Fabrics” on page 273
- “Switches” on page 274
Important: Not all the attributes upon which you can alert are listed here. A number of other attributes are available for alerts and are based on the key properties of a fabric. To view a complete list of attributes upon which you can alert, go to Network > Fabrics, right-click the fabric, and select Edit Alert Definitions.

Attributes that are automatically configured for alerts are marked with an asterisk (*).

**Fabrics**

*Table 85. Triggering attributes and conditions for general changes on fabrics*

<table>
<thead>
<tr>
<th>Fabric Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Successful Probe</td>
<td>A specified amount of time has passed since a probe was able to collect data about a fabric. You can use this alert to be notified when up-to-date configuration and status data is not being collected about a fabric and its existing data might be stale. This situation might occur if the fabric, network, or IBM Spectrum Control server is unavailable.</td>
</tr>
<tr>
<td>Probe Status*</td>
<td>One of the following statuses is detected for a probe:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Successful</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a probe did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A probe completed, but might not have collected a complete set of data. This status might occur if data cannot be collected about one or more of the internal resources of a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>A probe did not complete when it attempted to collect asset data about the resource. This status might occur if the resource cannot be reached during data collection.</td>
</tr>
<tr>
<td></td>
<td>For details about why a specific status occurred, check the log for the probe. To check the log, go to the details page for a resource, click Data Collection, and select Actions &gt; Open Logs in the Probe section on the Data Collection page.</td>
</tr>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a fabric:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the fabric or its internal resources.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the fabric or its internal resources.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the fabric or its internal resources.</td>
</tr>
<tr>
<td></td>
<td><strong>Unreachable</strong></td>
</tr>
<tr>
<td></td>
<td>One or more of the monitored resources for a fabric are not responding.</td>
</tr>
</tbody>
</table>
Switches

Table 86. Triggering attributes and conditions for changes on switches

<table>
<thead>
<tr>
<th>Fabric Attributes</th>
<th>Triggering Conditions for Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Successful Monitor</td>
<td>A specified amount of time has passed since the last successful performance monitor for switches in the fabric. You can use this alert to be notified when performance data is not being collected for a fabric’s switches. This situation might occur if a switch, network, or IBM Spectrum Control server is unavailable during data collection.</td>
</tr>
<tr>
<td>Performance Monitor Status*</td>
<td>One of the following statuses is detected for performance monitors that are collecting data about switches in the fabric:</td>
</tr>
<tr>
<td></td>
<td>Not Normal</td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a performance monitor did not collect any data, or only collected a partial set of data about a switch.</td>
</tr>
<tr>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>A performance monitor completed, but did not collect a complete set of performance data. This status might occur if a switch was restarted during data collection, no valid performance data was provided by the switch, or a communication error occurred.</td>
</tr>
<tr>
<td></td>
<td>Error</td>
</tr>
<tr>
<td></td>
<td>A performance did not complete when it attempted to collect performance data about a switch. This status might occur if a switch cannot be reached during data collection, or if no configuration data is available for a switch.</td>
</tr>
<tr>
<td></td>
<td>For details about why a specific status occurred, check the log for the performance monitor. To check the log, go to the details page for a switch, click Data Collection, and select Actions &gt; Open Logs in the Performance Monitor section on the Data Collection page.</td>
</tr>
</tbody>
</table>

Triggering conditions for server alerts

You can set up IBM Spectrum Control so that it examines the attributes and capacity of a server and notifies you when changes are detected.

Alerts can notify you of general changes and capacity changes on the following resources:

- “Servers” on page 275
- “Controllers” on page 276
- “Disks” on page 277
- “Disk Groups” on page 278
- “File Systems and Logical Volumes” on page 278
- “Paths” on page 279
- “Shares” on page 280
- “Triggering conditions for the IBM Spectrum Control server” on page 280
Important: Not all the attributes upon which you can alert are listed here. A number of other attributes are available for alerts and are based on the key properties of a server. To view a complete list of server attributes upon which you can alert, go to Servers > Servers, right-click the server, and select Edit Alert Definitions.

Attributes that are automatically configured for alerts are marked with an asterisk (*).

Tip: For capacity attributes, you can generate alerts when the amount of storage is greater than, less than, or equal to a specified value. You can also determine the unit of measurement for the attribute, such as KiB, MiB, GiB, or TiB.

**Servers**

*Table 87. Triggering attributes and conditions for general changes on servers.*

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent State*</td>
<td>A Storage Resource agent is in one of the following states:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Normal</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning state was detected on a Storage Resource agent.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A warning state was detected on a Storage Resource agent. For example,</td>
</tr>
<tr>
<td></td>
<td>a warning state might occur when an agent must be upgraded to the</td>
</tr>
<tr>
<td></td>
<td>same version level as the IBM Spectrum Control server to which it is</td>
</tr>
<tr>
<td></td>
<td>communicating.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>An error state was detected on a Storage Resource agent. For example,</td>
</tr>
<tr>
<td></td>
<td>an error state might occur when an agent was not able to be upgraded.</td>
</tr>
<tr>
<td>Last Successful Probe</td>
<td>A specified amount of time has passed since a probe was able to collect data about a server. You can use this alert to be notified when up-to-date configuration and status data is not being collected about a server and its existing data might be stale. Data collection might be interrupted or not occur if the resource, network, or IBM Spectrum Control server are unavailable.</td>
</tr>
<tr>
<td>Probe Status*</td>
<td>One of the following statuses is detected for a probe:</td>
</tr>
<tr>
<td></td>
<td><strong>Not Successful</strong></td>
</tr>
<tr>
<td></td>
<td>An error or warning occurred during data collection. This status indicates that a probe did not collect any data, or only collected a partial set of data about a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>A probe completed, but might not have collected a complete set of data. This status might occur if data cannot be collected about one or more of the internal resources of a resource.</td>
</tr>
<tr>
<td></td>
<td><strong>Error (default)</strong></td>
</tr>
<tr>
<td></td>
<td>A probe did not complete when it attempted to collect asset data about the resource. This status might occur if the resource cannot be reached during data collection.</td>
</tr>
<tr>
<td></td>
<td>For details about why a specific status occurred, check the log for the probe. To check the log, go to the details page for a resource, click Data Collection, and select Actions &gt; Open Logs in the Probe section on the Data Collection page.</td>
</tr>
</tbody>
</table>
**Table 87. Triggering attributes and conditions for general changes on servers (continued).**

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a server:</td>
</tr>
<tr>
<td>Not Normal</td>
<td>An error or warning status was detected on the server or its internal resources.</td>
</tr>
<tr>
<td>Warning</td>
<td>A warning status was detected on the server or its internal resources. For example, a warning status might occur when an HBA or HBA to a server node is newly discovered, is missing, or is rediscovered.</td>
</tr>
<tr>
<td>Error (default)</td>
<td>An error status was detected on the server or its internal resources. For example, an error status might occur when a server goes offline, or a server disk is disconnected or partially disconnected if it has multiple paths and one of the paths is disconnected.</td>
</tr>
<tr>
<td>Unreachable</td>
<td>One or more of the monitored resources for a server are not responding. This status might be caused by a problem in the network or by a Storage Resource agent that is no longer running and did not communicate that it was shutting down.</td>
</tr>
</tbody>
</table>

**Table 88. Triggering attributes and conditions for capacity changes on servers.**

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Disk Space</td>
<td>The amount of unused disk space on the local and SAN-attached storage for the server. SAN-attached storage is assigned to the server from storage systems.</td>
</tr>
<tr>
<td>Available File System Space</td>
<td>The amount of unused storage space in the file systems on the server. Unused file system space does not include space that is reserved for the operating system. For example, the unused space for tmpfs on UNIX operating systems is not included in this value.</td>
</tr>
<tr>
<td>Disk Space from Storage Systems</td>
<td>The amount of disk space that is assigned to the server from storage systems. The disk space from storage systems is only available when SAN-attached storage is assigned to the server.</td>
</tr>
<tr>
<td>File System Capacity</td>
<td>The amount of file system space on the server.</td>
</tr>
<tr>
<td>File System Space from Storage Systems</td>
<td>The amount of file system space that is assigned to the server from storage systems. The file system space from storage systems is only available when SAN-attached storage is assigned to the server.</td>
</tr>
<tr>
<td>Total Disk Space</td>
<td>The total amount of disk space for all the local and SAN-attached storage on the server. SAN-attached storage is assigned to the server from storage systems.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The amount of used disk space on the local and SAN-attached storage for the server. SAN-attached storage is assigned to the server from storage systems.</td>
</tr>
</tbody>
</table>

**Controllers**
Table 89. Triggering attributes and conditions for changes on disk controllers.

<table>
<thead>
<tr>
<th>Controller Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver Version</td>
<td>The version of the driver, firmware, or read-only memory (ROM) on a disk controller changes. You can use a number of operators to determine when you are notified of a version change, such as when the driver, firmware, or ROM is, or is not, a specific version, or when the version number contains a specific value. Use this alert for HBAs only.</td>
</tr>
<tr>
<td>Firmware</td>
<td></td>
</tr>
<tr>
<td>ROM Version</td>
<td></td>
</tr>
<tr>
<td>Last Data Collection</td>
<td>A specified amount of time since data was collected about a controller. Use this alert to be notified if data is not being collected about a controller or if the existing data is becoming too stale.</td>
</tr>
<tr>
<td>New Disk Controller</td>
<td>A disk controller is detected for the first time. Use this alert to be notified of hardware additions on servers.</td>
</tr>
<tr>
<td>Removed Disk Controller</td>
<td>A previously monitored disk controller can no longer be found. Historical data about the controller is retained, but no current data is being collected. Use this alert to be notified if a controller is removed or becomes unavailable.</td>
</tr>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a disk controller:</td>
</tr>
<tr>
<td></td>
<td>Not Normal</td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the controller.</td>
</tr>
<tr>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the controller.</td>
</tr>
<tr>
<td></td>
<td>Error (default)</td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the controller.</td>
</tr>
</tbody>
</table>

Disks

Table 90. Triggering attributes and conditions for general changes on disks.

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware</td>
<td>The version of the Licensed Internal Code on the disk changes. You can use a number of operators to determine when you are notified of a firmware change, such as when the firmware is, or is not, a specific version, or when the version number contains a specific value.</td>
</tr>
<tr>
<td>Multipathing Policy</td>
<td>The multipathing policy that is in effect for a disk. For example, you can be notified when the policy changes, or when the policy is Round Robin, Load Balancing, Failover Only, or other another policy.</td>
</tr>
<tr>
<td>New Disk</td>
<td>A disk is detected for the first time. Use this alert to be notified of hardware changes on servers or hypervisors.</td>
</tr>
<tr>
<td>Paths</td>
<td>The number of access paths that are associated with the disk falls outside a specified range, or is equal to or not equal to a specified value.</td>
</tr>
<tr>
<td>Removed Disk</td>
<td>A previously monitored disk can no longer be found. Historical data about the disk is retained, but no current data is being collected. Use this alert to be notified if a disk is removed or becomes unavailable.</td>
</tr>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a disk:</td>
</tr>
<tr>
<td></td>
<td>Not Normal</td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the disk.</td>
</tr>
<tr>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the disk.</td>
</tr>
<tr>
<td></td>
<td>Error (default)</td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the disk.</td>
</tr>
</tbody>
</table>
Table 91. Triggering attributes and conditions for capacity changes on disks.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Disk Space</td>
<td>The amount of unused storage space on a disk that is attached to the server.</td>
</tr>
<tr>
<td>Capacity</td>
<td>The total amount of storage space on a disk that is attached to the server.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The amount of used storage space on a disk that is attached to the server.</td>
</tr>
</tbody>
</table>

Disk Groups

Table 92. Triggering attributes and conditions for general changes on disk groups (volume groups).

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Volume Group</td>
<td>A previously monitored volume group can no longer be found. Historical data about the volume group is retained, but no current data is being collected. Use this alert to be notified if a volume group is deleted or becomes unavailable.</td>
</tr>
<tr>
<td>New Volume Group</td>
<td>A volume group is detected for the first time.</td>
</tr>
<tr>
<td>Status*</td>
<td>One of the following statuses is detected on a disk group:</td>
</tr>
<tr>
<td></td>
<td>Not Normal</td>
</tr>
<tr>
<td></td>
<td>An error or warning status was detected on the disk group.</td>
</tr>
<tr>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>A warning status was detected on the disk group.</td>
</tr>
<tr>
<td></td>
<td>Error (default)</td>
</tr>
<tr>
<td></td>
<td>An error status was detected on the disk group.</td>
</tr>
</tbody>
</table>

Table 93. Triggering attributes and conditions for capacity changes on disk groups (volume groups).

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Space</td>
<td>The amount of unused storage space on a server disk group.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The amount of used storage space on a server disk group.</td>
</tr>
<tr>
<td>Volume Group Capacity</td>
<td>The total amount of storage space on a server volume group. This value is inclusive of all storage space and applies to all space values related to volume groups.</td>
</tr>
</tbody>
</table>

File Systems and Logical Volumes

Table 94. Triggering attributes and conditions for general changes on file systems and logical volumes.

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Inodes</td>
<td>The number of unused inodes on file systems on the operating system changes, falls outside a specified range, or is equal to or not equal to a specified value.</td>
</tr>
<tr>
<td>Deleted File System</td>
<td>A previously monitored file system is deleted or unmounted from a server. Historical data about the file system is retained, but no current data is being collected. This attribute applies to file systems on the following resources:</td>
</tr>
<tr>
<td></td>
<td>• Storage systems that are configured for file storage, including Storwize V7000 Unified and IBM Spectrum Scale</td>
</tr>
<tr>
<td></td>
<td>• Servers that are managed by Storage Resource agents</td>
</tr>
</tbody>
</table>
Table 94. Triggering attributes and conditions for general changes on file systems and logical volumes (continued).

<table>
<thead>
<tr>
<th>General Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Logical Volume</td>
<td>A previously monitored logical volume can no longer be found. Historical data about the logical volume is retained, but no current data is being collected. Use this alert to be notified if a logical volume is removed or becomes unavailable.</td>
</tr>
</tbody>
</table>
| New File System              | A file system was detected for the first time. This alert applies to file systems on the following resources:  
  • Storage systems that are configured for file storage, including Storwize V7000 Unified and IBM Spectrum Scale  
  • Servers that are managed by Storage Resource agents |
| New Logical Volume           | A logical volume is detected for the first time. |
| Used Inodes                  | The number of used inodes on file systems on the operating system changes. You can use a number of operators to determine when you are notified, such when the number of used inodes falls outside a specified range, or is equal to or not equal to a specified value. |

Table 95. Triggering attributes and conditions for capacity changes on file systems and logical volumes.

<table>
<thead>
<tr>
<th>Capacity Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available File System Space</td>
<td>The amount of unused storage space on a file system on the server disk.</td>
</tr>
<tr>
<td>File System Capacity</td>
<td>The total amount of storage space on a file system on the server disk.</td>
</tr>
<tr>
<td>Logical Volume Capacity</td>
<td>The total amount of storage space on a logical volume on the server disk.</td>
</tr>
<tr>
<td>Used File System Space</td>
<td>The amount of used storage space on a file system on the server disk.</td>
</tr>
<tr>
<td>Used Space</td>
<td>The percentage of used storage space on a file system or logical volume on the server disk.</td>
</tr>
</tbody>
</table>

Paths

Table 96. Triggering attributes and conditions for general changes on paths.

<table>
<thead>
<tr>
<th>Path Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Path</td>
<td>A previously monitored access path for a server disk can no longer be found. This change might or might not affect the availability of the disk because there might be more than one path available.</td>
</tr>
<tr>
<td>New Path</td>
<td>An access path for a disk is detected for the first time.</td>
</tr>
</tbody>
</table>
| Status*         | One of the following statuses is detected on a path:  
  Not Normal  
  An error or warning status was detected on the path.  
  Warning  
  A warning status was detected on the path.  
  Error (default)  
  An error status was detected on the path. |
Shares

Table 97. Triggering attributes and conditions for general changes on shares.

<table>
<thead>
<tr>
<th>Share Attributes</th>
<th>Descriptions of Triggering Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted Share</td>
<td>A previously monitored share can no longer be found. Historical data about the share is retained, but no current data is being collected. Use this alert to be notified if a share is removed or becomes unavailable.</td>
</tr>
<tr>
<td>New Share</td>
<td>A new share was detected for the first time.</td>
</tr>
</tbody>
</table>

Triggering conditions for the IBM Spectrum Control server

The server on which IBM Spectrum Control is installed is automatically monitored for conditions that might cause an interruption in product functions. When these conditions are detected, alerts are triggered and shown on the Home > Alerts page. You do not need to manually define alerts for these product-related conditions; they are automatically enabled.

Table 98. Triggering conditions for the IBM Spectrum Control server.

<table>
<thead>
<tr>
<th>Triggering Condition</th>
<th>Explanation</th>
<th>Related Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database unavailable</td>
<td>The product database is not available. This database is the repository for information that is collected about the monitored resources in your environment.</td>
<td>ALR4112E, ALR4113E</td>
</tr>
<tr>
<td>High memory usage*</td>
<td>A high amount of memory is being used by a server process and might cause stability problems.</td>
<td>ALR4103W</td>
</tr>
<tr>
<td>Database alarm*</td>
<td>The system database or the database manager that hosts the product's database repository is reporting an alarm.</td>
<td>ALR4104W</td>
</tr>
<tr>
<td>High workload</td>
<td>The workload queue for the Device server is high and might cause performance issues.</td>
<td>ALR4105W</td>
</tr>
<tr>
<td>High number of external events</td>
<td>The server is receiving a high number of external events, such as CIM indications or SNMP traps. The high number of events might cause performance issues.</td>
<td>ALR4106W</td>
</tr>
</tbody>
</table>

Alert suppression actions

When you select triggering conditions for alerts, you can specify the conditions under which alerts are triggered and choose whether you want to suppress repeating alerts. Alerts can be suppressed to avoid generating too many alert log entries or too many actions when the triggering condition occurs often. You can view suppressed alerts in the constraint violation reports.

You can define the following options that enable you to specify conditions that suppress alerts.

Do not suppress alerts
Receive alert notifications whenever an alert violation is detected.

Only alert once until problem clears
Receive one notification for an alert violation, even if the condition is violated multiple times. This option is the default.

Only generate alerts every
Receive one notification when an alert is initially violated. The alert is suppressed and no notifications are sent until both the specified time has passed and the alert is triggered again.
Use this option when a single occurrence of an alert violation might be insignificant, but repeated occurrences can represent a potential problem.

**Do not alert until condition has been violated for more than**

Do not receive notifications for an alert unless the violation has not cleared for longer than the specified time.

Use this option to avoid email messages and other disruptive notifications if the same violation occurs repeatedly during the specified time period. In these cases, an alert is generated only for the first occurrence of the violation. Alerts for other occurrences during the time period are suppressed. When the suppression period ends, the cycle starts again.

**Triggering actions and notifications for alerts**

Specify how you are notified when alert conditions are detected on resources and any actions to take as a result of those alerts. These settings can be defined globally for a resource, or for specific alert definitions that apply to a resource.

**Table 99. Locations where you can specify alert actions and notification settings.**

<table>
<thead>
<tr>
<th>Task</th>
<th>Location in GUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the notification settings for all the alert definitions that apply to a resource</td>
<td>Resource page and resource details page. For example, to specify the global notification settings for a block storage system, go to Storage &gt; Block Storage Systems, right-click a storage system, and select Edit Alert Notification Settings. These notification settings are applied globally to all the alert definitions that are specified for the selected storage system. You can override the global settings by specifying different settings for each alert definition.</td>
</tr>
<tr>
<td>Specify alert actions and notification settings for a specific alert definition</td>
<td>Resource page and resource details page. For example, to specify the notification settings for an alert definition that applies to a block storage system, go to Storage &gt; Block Storage Systems, right-click a storage system, and select Edit Alert Definitions. Click the envelope icon next to the alert definition that you want to edit. The notification settings that you define override any global settings for the resource.</td>
</tr>
</tbody>
</table>

You can specify that the following actions are taken when alert conditions are detected on monitored resources:

**Run script**

Run a script when an alert is triggered for the condition. Use a script to call external programs or run commands that take action as the result of an alert. By using a script, you can automatically address potential storage issues when they are detected to avoid unplanned downtime or performance bottlenecks. [Learn more.]

**Email**

Send emails to specific email addresses when an alert is detected on a monitored resource.

**Netcool or OMNIbus EIF Probe Server**

Send alert notifications to a Netcool server or OMNIbus EIF probe server within your environment that was configured to receive IBM Spectrum Control alerts.
SNMP trap
Generate SNMP trap messages to any network management station (NMS), console, or terminal when an alert condition is detected. System administrators must set up their SNMP trap ringer with the provided management information base (MIB) files to receive SNMP traps from the product.

Windows event log or UNIX syslog
Write alert messages to the OS log. If you already have an administrator monitoring OS logs, this method is a way to centralize your priority messages for quick notification and viewing.

How scripts are run
After an alert is triggered, scripts can be run from the server where IBM Spectrum Control is installed or from any server where a Storage Resource agent is deployed. For some alert conditions, scripts can be specified to run on the server where the change was detected.

You must include the script files that you want to run in the /scripts directory on the server where IBM Spectrum Control is installed. The default path of /scripts is determined by the operating system of the server:

- Windows: C:\Program Files\IBM\TPC\Data\scripts
- UNIX or Linux: /opt/IBM/TPC/Data/scripts or /usr/IBM/TPC/Data/scripts

Note: When you run a script against a NAS filer, the script is run from the Storage Resource agent that is assigned to the file system where the condition was detected.

How script names are resolved
When you run scripts in response to alerts, the names of those scripts are resolved by using the following criteria:

- The operating system of the server where the product is installed.
- The script name that you specify on the Script name field when you define or edit an alert definition.

The operating system of the server or Storage Resource agent where you choose to run a script determines how that script that is run:

UNIX, Linux operating systems
A Storage Resource agent that is deployed on a UNIX or Linux operating system runs scripts that do not have an extension. If the specified script name contains an extension, the agent ignores the extension and searches for a file of the same name (without an extension). For example, if you enter backup.vbs in the Script name field, a UNIX or Linux agent searches for a file with the name backup. If the script exists, the first line of the script is read and the appropriate interpreter is used to run the script. If a file cannot be found, no action is taken.

Windows operating systems
A Storage Resource agent that is deployed on a Windows operating system runs scripts that have an extension. The extension of a script file determines which interpreter is used to run the script. If you specify a script name that does not contain an extension, the agent searches for the file name in the following order (based on its extension): .com, .exe, .bat, .cmd, .vbs, .vbe, .js, .jse. If a file cannot be found, no action is taken.
Tip: You can run scripts with the same name across multiple operating systems. To run a script on both a UNIX or Linux and Windows operating systems, you must have two versions of that file in the /scripts directory. For example, if you want to run a provisioning script against Storage Resource agents on UNIX or Linux and Windows servers, you must have two versions of that file (provision.bat and provision) in /scripts.

Performance data

Use the IBM Spectrum Control to view the performance data of devices in your environment.

Performance metrics

IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes metrics that measure the performance of volumes, ports, and disks. You can view performance information or specify alerts for when the performance of a resource falls outside a specified range.

You can view performance metrics at the following locations:

Resource pages

To access a view of performance metrics for a resource, go to the following pages:
- Storage systems page, Storage system details page
- Volumes page
- Pools page
- Switches page, Switch details page
- Server details page > Related Resources
- Hypervisor details page > Related Resources

Cognos BI reports

To view detailed performance reports for multiple resources in the Cognos BI reporting tool, hover the mouse pointer over Cognos in the menu bar and select an option.

Related concepts:

"Monitoring the performance of resources" on page 149

IBM Spectrum Control can collect information about the performance of storage systems and switches. This information includes key performance metrics that can help you measure, identify, and troubleshoot performance issues and bottlenecks in your storage.

Performance metrics for DS6000 and DS8000

Monitor the performance metrics that are collected for DS8000 and DS6000 storage systems.

Overview

Performance metrics are available for the following resources:
- "Volume metrics" on page 284
- "Disk metrics" on page 288
- "Port metrics" on page 290
A performance metric might apply to one or more storage resources. To check which resources the performance metric applies to, see the tips and the table footnotes.

**Volume metrics**

Volume performance metrics are divided into the following categories:

- **Key volume metrics**
- **I/O rate metrics**
- **Cache hit percentage metrics**
- **Average transfer size and HPF I/O metrics**

**Tip:** Unless otherwise noted, you can view the volume metrics in Table 100 on page 285, Table 101 on page 286 and Table 102 on page 287 for the following resources:

- Host connections
- Nodes
- Pools
- RAID arrays
- Storage systems
- Volumes

**Table 100. Key volume metrics.**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Holding Time[^1]</td>
<td>The average number of seconds that I/O data for a storage system node is held in the cache. A short cache-holding time indicates adverse performance.</td>
</tr>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Read)</td>
<td>The average number of read operations per second. This value includes both sequential and nonsequential read operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Write)</td>
<td>The average number of write operations per second. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Total)</td>
<td>The average number of read operations and write operations per second. This value includes both sequential and nonsequential operations.</td>
</tr>
<tr>
<td>Pool Activity Score[^2]</td>
<td>The activity level of pools, which is set to the following value:</td>
</tr>
</tbody>
</table>
|                             | \[
|                             | \text{[Read I/O Rate} \times (1 - \text{Read I/O Cache Hit} \%))} \div \text{Total Pool Capacity} \]                                                                                                     |
| Response Time (Read)        | The average number of milliseconds to complete a read operation.                                                                                                                                             |
Table 100. Key volume metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds to complete a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete an I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Volume Utilization</td>
<td>The average percentage of time that the volume is busy.</td>
</tr>
<tr>
<td>Write-Cache Delay Percentage</td>
<td>The percentage of I/O operations that are delayed because of space constraints in the write cache, or because of other conditions. The value is a percentage of all operations. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3. The metric is an approximation because actual transfer rates are different for each cache layer. Therefore, you cannot directly compare this metric from storage systems that are V7.3 or later with earlier versions.</td>
</tr>
</tbody>
</table>

Notes:
1. This metric is only available when you view the performance of nodes or storage systems.
2. This metric is only available when you view the performance of pools.
3. This metric is only available when you view the performance of volumes.

Table 101. I/O Rates.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Rate (Cache-to-Disk)</td>
<td>The average number of sectors or tracks per second that are transferred from the cache to the disks.</td>
</tr>
<tr>
<td>Average Transfer Rate (Disk-to-Cache)</td>
<td>The percentage of cache hits for record-mode read operations. For record-mode read operations, only the requested data, rather than a full track of data, is managed in the cache.</td>
</tr>
<tr>
<td>High Performance FICON® (Read)</td>
<td>The average number of read operations per second that are issued by the High Performance FICON feature of the storage system.</td>
</tr>
<tr>
<td>High Performance FICON (Write)</td>
<td>The average number of write operations per second that are issued by the High Performance FICON feature of the storage system.</td>
</tr>
<tr>
<td>High Performance FICON (Total)</td>
<td>The average number of I/O operations per second that are issued by the High Performance FICON feature of the storage system. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Normal I/O Rate (Read)</td>
<td>The average number of nonsequential read operations per second.</td>
</tr>
</tbody>
</table>
Table 101. I/O Rates (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal I/O Rate (Write)</td>
<td>The average number of nonsequential write operations per second.</td>
</tr>
<tr>
<td>Normal I/O Rate (Total)</td>
<td>The average number of nonsequential I/O operations per second. This value includes both read and write operations.</td>
</tr>
<tr>
<td>PPRC Transfer Rate</td>
<td>The average number of tracks per second that are transferred to the secondary device of a Peer-to-Peer Remote Copy (PPRC) pair. This value shows the activity for the source of the PPRC relationship, but shows no activity for the target.</td>
</tr>
<tr>
<td>Record Mode Read I/O Rate</td>
<td>The average number of I/O operations per second for record-mode read operations. For record-mode read operations, only the requested data is managed in the cache rather than a full track of data.</td>
</tr>
<tr>
<td>Sequential I/O Rate (Read)</td>
<td>The average number of sequential read operations per second.</td>
</tr>
<tr>
<td>Sequential I/O Rate (Write)</td>
<td>The average number of sequential write operations per second.</td>
</tr>
<tr>
<td>Sequential I/O Rate (Total)</td>
<td>The average number of sequential I/O operations per second. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Write-Cache Delay I/O Rate</td>
<td>The average number of I/O operations per second that are delayed because of space constraints in the write cache, or because of other conditions.</td>
</tr>
</tbody>
</table>

Notes:
1. This metric is only available when you view the performance of volumes, RAID arrays, pools, nodes, and host connections.
2. This metric applies only to DS8000 storage systems.

Table 102. Cache hit percentages.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal I/O Cache Hits (Read)</td>
<td>The percentage of nonsequential read operations that find data in the cache. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Normal I/O Cache Hits (Write)</td>
<td>The percentage of nonsequential write operations that are handled in the cache.</td>
</tr>
<tr>
<td>Normal I/O Cache Hits (Total)</td>
<td>The percentage of nonsequential I/O operations that are handled in the cache. This value includes both read and write operations. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Metric</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Read)</td>
<td>The percentage of all read operations that find data in the cache. This value includes both sequential and random read operations, and read operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because in the event of cache miss, the data must be read from the back-end storage resources.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Write)</td>
<td>The average percentage of all write operations that are handled in the cache, across all volumes on the server. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Total)</td>
<td>The percentage of all read operations and write operations that are handled in the cache. This value includes both sequential and random read and write operations, and read and write operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Record Mode Read Cache Hit Percentage</td>
<td>The percentage of cache hits for record-mode read operations. For record-mode read operations, only the requested data, rather than a full track of data, is managed in the cache.</td>
</tr>
<tr>
<td>Sequential I/O Cache Hits (Read)</td>
<td>The percentage of sequential read operations that find data in the cache. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Sequential I/O Cache Hits (Write)</td>
<td>The percentage of sequential write operations that are handled in the cache.</td>
</tr>
<tr>
<td>Sequential I/O Cache Hits (Total)</td>
<td>The percentage of sequential I/O operations that are handled in the cache. This value includes both read and write operations. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
</tbody>
</table>

**Note:**
1. This metric is only available when you view the performance of volumes, RAID arrays, pools, nodes, and host connections.
Table 103. Average transfer size, HPF I/O, and miscellaneous metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>HPF I/O Percentage</td>
<td>The percentage of all I/O operations that are issued by the High Performance FICON feature of the storage system.</td>
</tr>
<tr>
<td>Sequential I/O Percentage</td>
<td>Percentage of all I/O operations that were completed for a RAID array over a specified time interval that were sequential operations.</td>
</tr>
</tbody>
</table>

**Note:**
1. This metric is only available when you view the performance of RAID arrays.

**Disk metrics**

Disk performance metrics are divided into the following categories:
- **Key disk metrics**
- **Transfer size metrics**

**Tip:** Unless otherwise noted, you can view the volume metrics in Table 104 and Table 105 on page 289 for the following resources:
- Nodes
- Pools
- RAID arrays
- Ranks
- Storage systems

Table 104. Key disk metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are read from the back-end storage resources.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are written to the back-end storage resources.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transmitted between the back-end storage resources and the component. The rate is measured in MiB per second and includes both read and write operations.</td>
</tr>
</tbody>
</table>
Table 104. Key disk metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Utilization Percentage</td>
<td>The average percentage of time that the disks that are associated with an array are busy. No value is calculated for this property if there are multiple ranks in the extent pool where the thin-provisioned volumes are allocated. In this case, the value N/A is displayed for this property. This limitation applies only to DS8000 storage systems. If there is only a single rank in the extent pool, the value for this property is calculated regardless of the thin-provisioned volumes.</td>
</tr>
<tr>
<td>I/O Rate (Read)</td>
<td>The average number of read operations per second that are issued to the back-end storage resources.</td>
</tr>
<tr>
<td>I/O Rate (Write)</td>
<td>The average number of write operations per second that are issued to the back-end storage resources.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of I/O operations per second that are transmitted between the back-end storage resources and the component. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read operation.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read or a write operation.</td>
</tr>
</tbody>
</table>

**Note:**
1. This metric is only available when you view the performance of RAID arrays.

Table 105. Transfer size metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation from the back-end storage resources.</td>
</tr>
<tr>
<td>Average Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation to the back-end storage resources.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average transfer size, in KiB, of a read or a write operation to the back-end storage resources.</td>
</tr>
</tbody>
</table>
Port metrics

Port performance metrics are divided into the following categories:

- **Key port metrics**
- **Port I/O rate metrics**
- **Port data rate metrics**
- **Port response time metrics**
- **Error rate metrics**
- **Remote mirror metrics**
- **Transfer size metrics**

**Tip:** Unless otherwise noted, you can view the port metrics in Table 106, Table 110 on page 292, Table 111 on page 295, and Table 112 on page 295 for ports and storage systems. The port metrics in Table 107 on page 291, Table 108 on page 291, and Table 109 on page 292 are only available for ports.

**Table 106. Key port metrics.**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Receive)</td>
<td>The average rate at which data is received by the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Send)</td>
<td>The average rate at which data is sent through the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transferred through the port. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
<tr>
<td>I/O Rate (Receive)</td>
<td>The average number of I/O operations per second for operations in which the port receives data.</td>
</tr>
<tr>
<td>I/O Rate (Send)</td>
<td>The average number of I/O operations per second for operations in which data is sent from a port.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of send operations and receive operations per second.</td>
</tr>
<tr>
<td>Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation.</td>
</tr>
<tr>
<td>Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send or receive operation.</td>
</tr>
<tr>
<td>Port Utilization (Receive)</td>
<td>The average percentage of time that the port is busy receiving data.</td>
</tr>
<tr>
<td>Port Utilization (Send)</td>
<td>The average percentage of time that the port is busy sending data.</td>
</tr>
<tr>
<td>Port Utilization (Overall)</td>
<td>The average percentage of time that the port is busy sending or receiving data.</td>
</tr>
</tbody>
</table>
Table 106. Key port metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth (Receive)</td>
<td>The percentage of the port bandwidth that is used for receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth (Send)</td>
<td>The percentage of the port bandwidth that is used for send operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth (Overall)</td>
<td>The percentage of the port bandwidth that is used for send operations and receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
</tbody>
</table>

**Note:**
1. This metric is only available when you view the performance of ports.

Table 107. Port I/O rate metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON I/O Rate (Send)</td>
<td>The average number of send operations per second for Fibre Channel connection (FICON) usage.</td>
</tr>
<tr>
<td>FICON I/O Rate (Receive)</td>
<td>The average number of receive operations per second for FICON usage.</td>
</tr>
<tr>
<td>FICON I/O Rate (Total)</td>
<td>The average number of send and receive operations per second for FICON usage.</td>
</tr>
<tr>
<td>FCP I/O Rate (Send)</td>
<td>The average number of send operations per second for Fibre Channel Protocol (FCP) usage.</td>
</tr>
<tr>
<td>FCP I/O Rate (Receive)</td>
<td>The average number of receive operations per second for FCP usage.</td>
</tr>
<tr>
<td>FCP I/O Rate (Total)</td>
<td>The average number of send operations and receive operations per second for FCP usage.</td>
</tr>
</tbody>
</table>

Table 108. Port data rates.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON Data Rate (Send)</td>
<td>The average number of MiB per second that is sent for FICON usage.</td>
</tr>
<tr>
<td>FICON Data Rate (Receive)</td>
<td>The average number of MiB per second that is received for FICON usage.</td>
</tr>
<tr>
<td>FICON Data Rate (Total)</td>
<td>The average number of MiB per second that is transferred for FICON usage. This value includes both send and receive FICON operations.</td>
</tr>
<tr>
<td>FCP Data Rate (Send)</td>
<td>The average number of MiB per second that are sent for FCP usage.</td>
</tr>
<tr>
<td>FCP Data Rate (Receive)</td>
<td>The average number of MiB per second that are received for FCP usage.</td>
</tr>
</tbody>
</table>
Table 108. Port data rates (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCP Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for FCP usage. This value includes both send and receive FCP operations.</td>
</tr>
</tbody>
</table>

Table 109. Port response times.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation for FICON usage.</td>
</tr>
<tr>
<td>FICON Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation for FICON usage.</td>
</tr>
<tr>
<td>FICON Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send or receive operation for FICON usage. This value includes both send and receive FICON operations.</td>
</tr>
<tr>
<td>FCP Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation for FCP usage.</td>
</tr>
<tr>
<td>FCP Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation for FCP usage.</td>
</tr>
<tr>
<td>FCP Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send or receive operation for FCP usage.</td>
</tr>
</tbody>
</table>

Table 110. Error rate metrics.

Tip: You can view the following metrics for ports and storage systems.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Errors (CRC Errors)</td>
<td>The average number of frames per second that are received in which a cyclic redundancy check (CRC) error is detected. A CRC error is detected when the CRC in the transmitted frame does not match the CRC computed by the receiver. For Brocade switches, this metric includes only the CRC Errors with a good end-of-frame (EOF) indicator.</td>
</tr>
<tr>
<td>Frame Errors (Error Frame)</td>
<td>The average number of error frames per second that are received. An error frame is a frame that violates the Fibre Channel Protocol.</td>
</tr>
<tr>
<td>Frame Errors (Invalid Relative Offset Rate)</td>
<td>The average number of times per second that frames are received with an invalid relative offset in the frame header.</td>
</tr>
<tr>
<td>Link Errors (Invalid Link Transmission)</td>
<td>The average number of times per second that an invalid transmission word was detected by the port while the link did not experience any signal or synchronization loss.</td>
</tr>
<tr>
<td>Link Errors (Invalid Transmission Words)</td>
<td>The average number of bit errors per second that are detected.</td>
</tr>
</tbody>
</table>
Table 10. Error rate metrics (continued).

Tip: You can view the following metrics for ports and storage systems.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Errors (Link Failures)</td>
<td>The average number of miscellaneous fibre channel link errors per second for ports. Link errors might occur when an unexpected Not Operational (NOS) is received or a link state machine failure was detected.</td>
</tr>
<tr>
<td>Link Errors (Primitive Sequence Protocol Error Rate)</td>
<td>The average number of primitive sequence protocol errors per second that are detected. This error occurs when there is a link failure for a port.</td>
</tr>
<tr>
<td>Link Errors (Sequence Timeouts)</td>
<td>The average number of times per second that the port detects a timeout condition after the port receives a sequence initiative for a Fibre Channel exchange.</td>
</tr>
<tr>
<td>Link Errors (Signal Loss)</td>
<td>The average number of times per second at which the port lost communication with its partner port. These types of errors usually indicate physical link problems, caused by faulty SFP modules or cables, or caused by faulty connections at the switch or patch panel. However, in some cases, this error can also occur when the maximum link distance between ports is exceeded, for the type of connecting cable and light source.</td>
</tr>
<tr>
<td>Link Errors (Sync Loss)</td>
<td>The average number of times per second that the port lost synchronization with its partner port. These types of errors usually indicate physical link problems, caused by faulty SFP modules or cables, or caused by faulty connections at the switch or patch panel. However, in some cases, this can also occur due to mismatching port speeds between the partner ports, when auto-negotiation of link speed is disabled.</td>
</tr>
<tr>
<td>Overload Errors (Extreme I/O Concurrency Percentage)</td>
<td>The average percentage of I/O operations for which the port on DS8000 had more than 1500 concurrent I/O operations or exchanges. The number of concurrent I/O operations for ports on DS8000 cannot exceed 2000.</td>
</tr>
<tr>
<td>Overload Errors (Extreme I/O Concurrency Rate)</td>
<td>The average number of times per second that the port on DS8000 had more than 1500 concurrent I/O operations or exchanges. The number of concurrent I/O operations for a port on DS8000 cannot exceed 2000.</td>
</tr>
<tr>
<td>Overload Errors (I/O Busy Percentage)</td>
<td>The average percentage of I/O operations or exchanges for which the port on DS8000 returned a SCSI Queue Full or a Busy status to the server. Ports can return these statuses if the number of I/O operations exceeds an internal DS8000 threshold.</td>
</tr>
</tbody>
</table>
Table 110. Error rate metrics (continued).
Tip: You can view the following metrics for ports and storage systems.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overload Errors (I/O Busy Rate)</td>
<td>The average number of times per second that the port on DS8000 returned a SCSI Queue Full or a Busy status to the server. Ports can return these statuses if the number of I/O operations or exchanges exceeds an internal DS8000 threshold.</td>
</tr>
<tr>
<td>Overload Errors (I/O Overrun Percentage)</td>
<td>The average percentage of I/O operations that the port on DS8000 had to discard because the number of concurrent I/O operations or exchanges for the port exceeded 2000.</td>
</tr>
<tr>
<td>Overload Errors (I/O Overrun Rate)</td>
<td>The average number of times per second that the port on DS8000 had to discard commands because the number of concurrent I/O operations or exchanges for the port exceeded 2000.</td>
</tr>
<tr>
<td>Port Protocol Errors (Credit Recovery Link Resets)</td>
<td>The estimated average number of link resets per second that a switch or port completed to recover buffer credits. This estimate attempts to disregard link resets that were caused by link initialization. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Port Protocol Errors (Duplicate Frames)</td>
<td>The average number of duplicate frames per second that are received. A duplicate frame is a frame that the system previously processed for the port.</td>
</tr>
<tr>
<td>Port Protocol Errors (Link Reset Received)</td>
<td>The average number of times per second that the port changes from an active (AC) state to a Link Recovery (LR2) state.</td>
</tr>
<tr>
<td>Port Protocol Errors (Link Reset Transmitted)</td>
<td>The average number of times per second that the port changes from an active (AC) state to a Link Recovery (LR1) state.</td>
</tr>
<tr>
<td>Port Protocol Errors (Out of Order ACK)</td>
<td>The average number of times per second that an out-of-order acknowledge (ACK) frame is detected. An ACK frame is used for end-to-end flow control and is sent to verify receipt of a frame.</td>
</tr>
<tr>
<td>Port Protocol Errors (Out of Order Data)</td>
<td>The average number of times per second that an out-of-order frame is detected.</td>
</tr>
<tr>
<td>Zero Receive Buffer Credit Percentage</td>
<td>The amount of time, as a percentage, that the port on DS8000 had depleted its receive buffer credits. That is, the percentage of time that the port on DS8000 had no credit to provide to the sending port.</td>
</tr>
<tr>
<td>Zero Send Buffer Credit Percentage</td>
<td>The amount of time, as a percentage, that the port on DS8000 had depleted its send buffer credits. That is, the percentage of time that the receiving port had no credit to provide to the port on DS8000.</td>
</tr>
</tbody>
</table>
**Table 110. Error rate metrics (continued).**

**Tip:** You can view the following metrics for ports and storage systems.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td>1. This metric is only available when you view the performance of ports.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 111. Remote mirror metrics.**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPRC Data Rate (Receive)</td>
<td>The average number of MiB per second that are received by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Data Rate (Send)</td>
<td>The average number of MiB per second that are sent by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred by using the Peer-to-Peer Remote Copy (PPRC) protocol. This value includes both send and receive PPRC operations.</td>
</tr>
<tr>
<td>PPRC I/O Rate (Receive)</td>
<td>The average number of operations per second that are received by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC I/O Rate (Send)</td>
<td>The average number of operations per second that are sent by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC I/O Rate (Total)</td>
<td>The average number of send operations and receive operations per second using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send or receive operation by using the Peer-to-Peer Remote Copy (PPRC) protocol.</td>
</tr>
</tbody>
</table>

**Table 112. Transfer size metrics.**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Receive)</td>
<td>The average number of KiB that are transferred per receive operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Send)</td>
<td>The average number of KiB that are transferred per send operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both send and receive operations.</td>
</tr>
</tbody>
</table>
Performance metrics for storage systems that run IBM Spectrum Virtualize

Monitor the performance metrics that are collected for SAN Volume Controller, Storwize, FlashSystem V840, and FlashSystem V9000 storage systems.

Overview

Definitions are provided for the performance metrics that are collected for the following storage systems:

- FlashSystem V840
- FlashSystem V9000
- SAN Volume Controller
- Storwize V3500
- Storwize V3700
- Storwize V5000
- Storwize V7000
- Storwize V7000 Unified

The performance metrics are divided into the following categories:

- “Volume performance metrics”
- “Disk performance metrics” on page 305
- “Port performance metrics” on page 307
- “Node performance metrics” on page 312

Volume performance metrics

Volume performance metrics are divided into the following categories:

- Key metrics for volumes
- I/O rate metrics for volumes
- Cache hit percentage metrics for volumes
- Response time metrics for volumes
- Remote mirror metrics for volumes
- Volume cache metrics for volumes
- Volume copy cache metrics for volumes
- Miscellaneous metrics for volumes
- Legacy cache metrics for volumes

Tip: Unless otherwise noted, you can view the volume metrics in Table 113 on page 297, Table 114 on page 298, Table 115 on page 298, Table 116 on page 299, Table 117 on page 299, Table 118 on page 299, Table 119 on page 301, Table 120 on page 303, and Table 121 on page 304 for the following resources:

- Host connections
- I/O groups
- Nodes
- Pools
- Storage systems
- Volumes
<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>Overall Host Attributed Response Time Percentage</td>
<td>The percentage of the average response time that can be attributed to delays from host systems. This value includes both read response times and write response times, and can help you diagnose slow hosts and fabrics that are not working efficiently. For read response time, the value is based on the time that it takes for hosts to respond to transfer-ready notifications from the nodes. For write response time, the value is based on the time that it takes for hosts to send the write data after the node responds to a transfer-ready notification.</td>
</tr>
<tr>
<td>Overall I/O Rate (Read)</td>
<td>The average number of read operations per second. This value includes both sequential and nonsequential read operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Write)</td>
<td>The average number of write operations per second. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Total)</td>
<td>The average number of nonsequential I/O operations per second. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Pool Activity Score[1]</td>
<td>The activity level of pools, which is set to the following value: [Read I/O Rate × (1− Read I/O Cache Hit %)] ÷ Total Pool Capacity[2]</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds to complete a read operation.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds to complete a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete an I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Volume Utilization[3]</td>
<td>The average percentage of time that the volume is busy.</td>
</tr>
<tr>
<td>Write Cache Delay</td>
<td>The percentage of I/O operations that are delayed because of space constraints in the write cache, or because of other conditions. The value is a percentage of all operations. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3. The metric is an approximation because actual transfer rates are different for each cache layer. Therefore, you cannot directly compare this metric from storage systems that are V7.3 or later with earlier versions.</td>
</tr>
</tbody>
</table>

Notes:
1. This metric is also available when you view the performance of pools.
2. This metric is only available when you view the performance of volumes.
### Table 114. I/O rate metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer Rate (Cache-to-Disk)</td>
<td>The average number of sectors or tracks per second that are transferred from the cache to the disks.</td>
</tr>
<tr>
<td>Transfer Rate (Disk-to-Cache)</td>
<td>The average number of sectors or tracks per second that are transferred per second from the disks to the cache.</td>
</tr>
<tr>
<td>Write-Cache Delay I/O Rate</td>
<td>The average number of I/O operations per second that are delayed because of space constraints in the write cache, or because of other conditions. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3. The metric is an approximation because actual transfer rates are different for each cache layer. Therefore, you cannot directly compare this metric from storage systems that are V7.3 or later with earlier versions.</td>
</tr>
</tbody>
</table>

**Note:** This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3. The metric is an approximation because actual transfer rates are different for each cache layer. Therefore, you cannot directly compare this metric from storage systems that are V7.3 or later with earlier versions.

### Table 115. Cache hit percentages metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall I/O Cache Hits (Read)</td>
<td>The percentage of all read operations that find data in the cache. This value includes both sequential and random read operations, and read operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because in the event of cache miss, the data must be read from the back-end storage resources.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Write)</td>
<td>The percentage of all write operations that are handled in the cache. This value includes both sequential and random write operations, and write operations in the volume cache and volume copy cache where applicable.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Total)</td>
<td>The percentage of all read operations and write operations that are handled in the cache. This value includes both sequential and random read and write operations, and read and write operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
</tbody>
</table>
Table 116. Response time metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Response Time (Read)</td>
<td>The worst response time measured for a read operation in the sample interval.</td>
</tr>
<tr>
<td>Peak Response Time (Write)</td>
<td>The worst response time measured for a write operation in the sample interval.</td>
</tr>
</tbody>
</table>

Table 117. Remote mirror metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Mirror (Overlapping Write I/O Rate)</td>
<td>The average number of overlapping write operations per second that are issued by the Global Mirror primary site. Some overlapping writes are processed in parallel and are excluded from this value.</td>
</tr>
<tr>
<td>Global Mirror (Overlapping Write Percentage)</td>
<td>The percentage of overlapping write operations that are issued by the Global Mirror primary site. Some overlapping writes are processed in parallel and are excluded from this value.</td>
</tr>
<tr>
<td>Global Mirror (Secondary Write Lag)</td>
<td>The average number of additional milliseconds that it takes to service each secondary write operation for Global Mirror. This value does not include the time to service the primary write operations. You monitor the value of Global Mirror Secondary Write Lag to identify delays that occurred during the process of writing data to the secondary site.</td>
</tr>
<tr>
<td>Global Mirror (Write I/O Rate)</td>
<td>The average number of write operations per second that are issued to the Global Mirror secondary site.</td>
</tr>
</tbody>
</table>

Volume cache metrics are only available for SAN Volume Controller, Storwize, and FlashSystem block storage systems whose firmware version is V7.3 or later.

Table 118. Volume cache metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Hits (Dirty Writes)</td>
<td>The percentage of all cache write hits that occur on data that is marked as modified in the volume cache. This value represents how effectively write operations are coalesced before the data is written to disk.</td>
</tr>
<tr>
<td>Cache Hits (Read)</td>
<td>The percentage of read operations that find data in the volume cache.</td>
</tr>
<tr>
<td>Cache Hits (Total)</td>
<td>The percentage of cache hits for read and write operations that are handled in the volume cache.</td>
</tr>
<tr>
<td>Cache Hits (Write)</td>
<td>The percentage of cache hits for write operations that are handled in the volume cache.</td>
</tr>
</tbody>
</table>
Table 118. Volume cache metrics for volumes (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate (Destage)</td>
<td>The average number of cache-to-disk transfer operations per second that are processed in the volume cache.</td>
</tr>
<tr>
<td>I/O Rate (Stage)</td>
<td>The average number of disk-to-cache transfer operations per second that are processed in the volume cache.</td>
</tr>
<tr>
<td>I/O Rate (Read)</td>
<td>The average number of read operations per second that are processed in the volume cache. This value includes operations that are started by hosts or by remote replication sources.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of read and write operations per second that are processed by the volume cache. This value includes requests sent by hosts and by remote replication sources.</td>
</tr>
<tr>
<td>I/O Rate (Write)</td>
<td>The average number of write operations per second that are processed by the volume cache. This value includes operations that are started by hosts or by remote replication sources.</td>
</tr>
<tr>
<td>Response Time (Destage)</td>
<td>The average number of milliseconds that it took to complete each destage operation in the volume cache. That is, the time that it took to do write operations from the volume cache to the disk.</td>
</tr>
<tr>
<td>Response Time (Stage)</td>
<td>The average number of milliseconds that it took to complete each stage operation in the volume cache. That is, the time that it took to do read operations from the disk to the volume cache.</td>
</tr>
<tr>
<td>Transfer Rates (Cache-to-Disk)</td>
<td>The average number of sectors that are transferred per second from the volume cache to the disks.</td>
</tr>
<tr>
<td>Transfer Rates (Disk-to-Cache)</td>
<td>The average number of sectors that are transferred per second from the disks to the volume cache.</td>
</tr>
<tr>
<td>Write Delay Percentage (Flush-through)</td>
<td>The percentage of write operations that are written to disk in flush-through mode in the volume cache.</td>
</tr>
<tr>
<td>Write Delay Percentage (Total Delay)</td>
<td>The percentage of I/O operations that are delayed because of space constraints in the write cache, or because of other conditions in the volume cache. The value is a percentage of all operations.</td>
</tr>
<tr>
<td>Write Delay Percentage (Write-through)</td>
<td>The percentage of write operations that are written to disk in write-through mode in the volume cache.</td>
</tr>
<tr>
<td>Write Delay Rate (Flush-through)</td>
<td>The average number of tracks per second that are written to disk in flush-through mode in the volume cache.</td>
</tr>
</tbody>
</table>
Table 118. Volume cache metrics for volumes (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write Delay Rate (Total Delay)</td>
<td>The average number of I/O operations per second that are delayed. The delay might occur because of space constraints in the write cache, or because of other conditions in the volume cache. The value is an average of all operations.</td>
</tr>
<tr>
<td>Write Delay Rate (Write-through)</td>
<td>The average number of sectors per second that are written to disk in write-through mode in the volume cache.</td>
</tr>
</tbody>
</table>

Volume copy cache metrics are only available for SAN Volume Controller, Storwize, and FlashSystem block storage systems whose firmware version is V7.3 or later.

Table 119. Volume copy cache metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Hits (Dirty Writes)</td>
<td>The percentage of all cache write hits that occur on data that is marked as modified in the volume copy cache. This value represents how effectively write operations are coalesced before the data is written to disk.</td>
</tr>
<tr>
<td>Cache Hits (Read-ahead)*</td>
<td>The percentage of all read cache hits that occur on pre-staged data.</td>
</tr>
<tr>
<td>Cache Hits (Read)</td>
<td>The percentage of read operations that find data in the volume copy cache.</td>
</tr>
<tr>
<td>Cache Hits (Total)</td>
<td>The percentage of cache hits for read and write operations that are handled in the volume copy cache.</td>
</tr>
<tr>
<td>Cache Hits (Write)</td>
<td>The percentage of cache hits for write operations that are handled in the volume copy cache.</td>
</tr>
<tr>
<td>I/O Rate (Destage)</td>
<td>The average number of cache-to-disk transfer operations per second that are processed in the volume copy cache.</td>
</tr>
<tr>
<td>I/O Rate (Prestage)</td>
<td>The average number of prefetch disk-to-cache transfer operations per second that are processed in the volume copy cache.</td>
</tr>
<tr>
<td>I/O Rate (Stage)</td>
<td>The average number of disk-to-cache transfer operations per second that are not prefetch operations and are processed in the volume copy cache.</td>
</tr>
<tr>
<td>I/O Rate (Read)</td>
<td>The average number of read operations per second that are processed in the volume copy cache. This value includes read operations that are associated with FlashCopy services, volume mirroring, and other internal processes. This value might also include some operations that are passed from the volume cache.</td>
</tr>
</tbody>
</table>
Table 119. Volume copy cache metrics for volumes (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of read and write operations per second that are processed by the volume copy cache. This value includes operations that are associated with FlashCopy services, volume mirroring, and other internal processes. This value might also include some operations that are passed from the volume cache.</td>
</tr>
<tr>
<td>I/O Rate (Write)</td>
<td>The average number of write operations per second that are processed by the volume copy cache. This value includes read operations that are associated with FlashCopy services, volume mirroring, and other internal processes. This value might also include some operations that are passed from the volume cache.</td>
</tr>
<tr>
<td>Response Time (Destage)</td>
<td>The average number of milliseconds that it took to complete each destage operation in the volume copy cache. That is, the time that it took to do write operations from the volume copy cache to the disk.</td>
</tr>
<tr>
<td>Response Time (Prestage)</td>
<td>The average number of milliseconds that it took to complete each prestage operation in the volume copy cache. That is, the time that it took to prefetch data from the disk into the volume copy cache.</td>
</tr>
<tr>
<td>Response Time (Stage)</td>
<td>The average number of milliseconds that it took to complete each stage operation in the volume copy cache. That is, the time that it took to do read operations from the disk to the volume copy cache.</td>
</tr>
<tr>
<td>Transfer Rates (Cache-to-Disk)</td>
<td>The average number of sectors that are transferred per second from the volume copy cache to the disks.</td>
</tr>
<tr>
<td>Transfer Rates (Disk-to-Cache)</td>
<td>The average number of sectors that are transferred per second from the disks to the volume copy cache.</td>
</tr>
<tr>
<td>Write Delay Percentage (Flush-through)</td>
<td>The percentage of write operations that are written to disk in flush-through mode in the volume copy cache.</td>
</tr>
<tr>
<td>Write Delay Percentage (Total Delay)</td>
<td>The percentage of I/O operations that are delayed because of space constraints in the write cache, or because of other conditions in the volume copy cache. The value is a percentage of all operations.</td>
</tr>
<tr>
<td>Write Delay Percentage (Write-through)</td>
<td>The percentage of write operations that are written to disk in write-through mode in the volume copy cache.</td>
</tr>
<tr>
<td>Write Delay Rate (Flush-through)</td>
<td>The average number of sectors per second that are written to disk in flush-through mode in the volume copy cache.</td>
</tr>
</tbody>
</table>
### Table 119. Volume copy cache metrics for volumes (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write Delay Rate (Total Delay)</td>
<td>The average number of I/O operations per second that are delayed. The delay might occur because of space constraints in the write cache, or because of other conditions in the volume copy cache. The value is an average of all operations.</td>
</tr>
<tr>
<td>Write Delay Rate (Write-through)</td>
<td>The average number of sectors per second that are written to disk in write-through mode in the volume copy cache.</td>
</tr>
</tbody>
</table>

**Note:** This metric is only available for SAN Volume Controller, Storwize, and FlashSystem block storage systems whose firmware version is V7.4 or later.

**Tip:** Unless otherwise noted, you can view the volume metrics in Table 120 for the following resources:
- Nodes
- I/O groups
- Host connections
- Storage systems

### Table 120. Miscellaneous metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache to Host Transfer Response Time</td>
<td>The average number of milliseconds that is taken to transfer a track from the cache to the host, including any queuing time that occurs because of throttling.</td>
</tr>
<tr>
<td>Non-Preferred Node Usage Percentage</td>
<td>The overall percentage of I/O operations that are not directed against the preferred node for each volume in an I/O Group. There is a small performance penalty when I/O does not go to the preferred node for each volume.</td>
</tr>
<tr>
<td>Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation.</td>
</tr>
<tr>
<td>Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation.</td>
</tr>
<tr>
<td>Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Unaligned Write I/O Rate</td>
<td>The average number of write operations per second that are not aligned on a boundary between 4 KB physical blocks. Unaligned write operations can cause a significant decrease in efficiency of write operations to some types of back-end disks. You can ignore this metric for iSeries servers.</td>
</tr>
</tbody>
</table>
Table 120. Miscellaneous metrics for volumes (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>1. The metric is only available for SAN Volume Controller, Storwize, and FlashSystem block storage systems whose firmware version is V7.3 or later.</td>
<td></td>
</tr>
<tr>
<td>2. This metric is only available when you view the performance of volumes, I/O groups, and host connections.</td>
<td></td>
</tr>
<tr>
<td>3. This metric is only available when you view the performance of pools, volumes, and host connections. The metric is only available for SAN Volume Controller, Storwize, and FlashSystem block storage systems whose firmware version is V7.4 or later.</td>
<td></td>
</tr>
</tbody>
</table>

Legacy cache metrics are only available for SAN Volume Controller and Storwize block storage systems whose firmware version is earlier than V7.3.

Table 121. Legacy cache metrics for volumes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write-Cache Percentages (Flush-through)</td>
<td>The percentage of tracks that are written to disk in flush-through mode. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3.</td>
</tr>
<tr>
<td>Write-Cache Percentages (Write-through)</td>
<td>The percentage of tracks that are written to disk in write-through mode. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3.</td>
</tr>
<tr>
<td>Write-Cache Percentages (Overflow)</td>
<td>The percentage of all write operations that are handled in the cache. This value includes both sequential and random write operations, and write operations in the volume cache and volume copy cache where applicable.</td>
</tr>
<tr>
<td>Write-Cache I/O Rate (Flush-through)</td>
<td>The average number of tracks per second that are written to disk in flush-through mode. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3.</td>
</tr>
<tr>
<td>Write-Cache I/O Rate (Overflow)</td>
<td>The average number of tracks per second that are written but are delayed because there is not enough space in the write cache. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3.</td>
</tr>
<tr>
<td>Write-Cache I/O Rate (Write-through)</td>
<td>The average number of tracks per second that are written to disk in write-through mode. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3.</td>
</tr>
</tbody>
</table>
Table 121. Legacy cache metrics for volumes (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dirty Write Percentage of Cache Hits</td>
<td>The percentage of all cache write hits that occur on data in the cache that is marked as modified. This value represents how effectively write operations are coalesced before the data is written to disk. This value applies only to storage systems that are running a version of IBM Spectrum Virtualize earlier than V7.3.</td>
</tr>
</tbody>
</table>

Disk performance metrics

Disk performance metrics are divided into the following categories:

- [Key metrics for disks](#)
- [Response time metrics for disks](#)
- [Miscellaneous metrics for disks](#)

Unless otherwise noted, you can view disk metrics for the following resources:

- Managed disks
- Pools
- Nodes
- I/O Groups
- Storage systems

Table 122. Key metrics for disks

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are read from the back-end storage resources.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are written to the back-end storage resources.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transmitted between the back-end storage resources and the component. The rate is measured in MiB per second and includes both read and write operations.</td>
</tr>
<tr>
<td>I/O Rate (Read)(^1)</td>
<td>The average number of read operations per second that are issued to the back-end storage resources.</td>
</tr>
<tr>
<td>I/O Rate (Write)(^2)</td>
<td>The average number of write operations per second that are issued to the back-end storage resources.</td>
</tr>
<tr>
<td>I/O Rate (Total)(^3)</td>
<td>The average number of I/O operations per second that are transmitted between the back-end storage resources and the component. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read operation.</td>
</tr>
</tbody>
</table>
Table 122. Key metrics for disks (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read or a write operation.</td>
</tr>
</tbody>
</table>

Notes:
1. The performance metrics for I/O Rate (Read) are available for pools, nodes, I/O groups, and storage systems.
2. The performance metrics for I/O Rate (Write) are available for pools, nodes, I/O groups, and storage systems.
3. The performance metrics for I/O Rate (Total) are available for pools, nodes, I/O groups, and storage systems.

Table 123. Response time metrics for disks

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Time (Read)</td>
<td>The average number of milliseconds that a read operation spends in the queue before the operation is sent to the back-end storage resources.</td>
</tr>
<tr>
<td>Queue Time (Write)</td>
<td>The average number of milliseconds that a write operation spends in the queue before the operation is sent to the back-end storage resources.</td>
</tr>
<tr>
<td>Queue Time (Overall)</td>
<td>The average number of milliseconds that a read or a write operation spends in the queue before the operation is sent to the back-end storage resources.</td>
</tr>
<tr>
<td>Peak Back-end Queue Time (Read)</td>
<td>The longest time that a read operation spends in the queue before the operation is sent to the back-end storage resources.</td>
</tr>
<tr>
<td>Peak Back-end Queue Time (Write)</td>
<td>The longest time that a write operation spends in the queue before the operation is sent to the back-end storage resources.</td>
</tr>
<tr>
<td>Peak Back-end Response Time (Read)</td>
<td>The longest time for a back-end storage resource to respond to a read operation.</td>
</tr>
<tr>
<td>Peak Back-end Response Time (Write)</td>
<td>The longest time for a back-end storage resource to respond to a write operation by a node.</td>
</tr>
</tbody>
</table>

Table 124. Miscellaneous metrics for disks

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation from the back-end storage resources.</td>
</tr>
<tr>
<td>Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation to the back-end storage resources.</td>
</tr>
</tbody>
</table>
Table 124. Miscellaneous metrics for disks (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer Size (Overall)</td>
<td>The average transfer size, in KiB, of a read or a write operation to the back-end storage resources.</td>
</tr>
<tr>
<td>Cache Destage (In-Flight I/O)</td>
<td>The actual number of concurrent operations that are issued from the cache to the managed disk. The number of in-flight operations cannot exceed the target, but also varies over time, depending on the type of I/O operations and on the performance of the managed disk.</td>
</tr>
<tr>
<td>Cache Destage (Target I/O)</td>
<td>The maximum number of concurrent operations that can be issued from the cache to the managed disk. This target changes over time, depending on changes in cache utilization and on changes in the performance of the managed disk.</td>
</tr>
</tbody>
</table>

Note: This metric is only available when you view the performance of managed disks. The metric is only available for SAN Volume Controller, Storwize, and FlashSystem block storage systems whose firmware version is V7.3 or later.

Port performance metrics

Port performance metrics are divided into the following categories:

- Key metrics for ports
- I/O rate metrics for ports
- Data rate metrics for ports
- Response time metrics for ports
- Error rate metrics for ports
- Miscellaneous metrics for ports

Unless otherwise noted, you can view port metrics for the following resources:

- Ports
- Nodes
- I/O Groups
- Storage systems

Table 125. Key metrics for ports

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate (Receive)</td>
<td>The average number of I/O operations per second for operations in which the port receives data.</td>
</tr>
<tr>
<td>I/O Rate (Send)</td>
<td>The average number of I/O operations per second for operations in which data is sent from a port.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of send operations and receive operations per second.</td>
</tr>
<tr>
<td>Data Rate (Receive)</td>
<td>The average number of I/O operations per second for operations in which the port receives data.</td>
</tr>
</tbody>
</table>
Table 125. Key metrics for ports (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Send)</td>
<td>The average number of I/O operations per second for operations in which data is sent from a port.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transferred through the port. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
</tbody>
</table>

Table 126. I/O rate metrics for ports

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port-to-Disk I/O Rate (Receive)</td>
<td>The average number of exchanges per second that are received from back-end storage resources.</td>
</tr>
<tr>
<td>Port-to-Disk I/O Rate (Send)</td>
<td>The average number of exchanges per second that are sent to back-end storage resources.</td>
</tr>
<tr>
<td>Port-to-Disk I/O Rate (Total)</td>
<td>The average number of exchanges per second that are transmitted between back-end storage resources and the component. This value includes both send and receive operations.</td>
</tr>
<tr>
<td>Port-to-Host I/O Rate (Receive)</td>
<td>The average number of exchanges per second that are received from host computers.</td>
</tr>
<tr>
<td>Port-to-Host I/O Rate (Send)</td>
<td>The average number of exchanges per second that are sent to host computers.</td>
</tr>
<tr>
<td>Port-to-Host I/O Rate (Total)</td>
<td>The average number of exchanges per second that are transmitted between host computers and the component.</td>
</tr>
<tr>
<td>Port-to-Local Node I/O Rate (Receive)</td>
<td>The average number of exchanges per second that are received from other nodes that are in the local cluster.</td>
</tr>
<tr>
<td>Port-to-Local Node I/O Rate (Send)</td>
<td>The average number of exchanges per second that are sent to other nodes that are in the local cluster.</td>
</tr>
<tr>
<td>Port-to-Local Node I/O Rate (Total)</td>
<td>The average number of exchanges per second that are transmitted between the component and other nodes that are in the local cluster.</td>
</tr>
<tr>
<td>Port-to-Remote Node I/O Rate (Receive)</td>
<td>The average number of exchanges per second that are received from nodes that are in the remote cluster.</td>
</tr>
<tr>
<td>Port-to-Remote Node I/O Rate (Send)</td>
<td>The average number of exchanges per second that are sent to nodes that are in the remote cluster.</td>
</tr>
<tr>
<td>Port-to-Remote Node I/O Rate (Total)</td>
<td>The average number of exchanges per second that are transmitted between the component and nodes that are in the remote cluster.</td>
</tr>
</tbody>
</table>
Table 127. Data rate metrics for ports

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port-to-Disk Data Rate (Receive)</td>
<td>The average rate at which data is received from back-end storage resources. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Disk Data Rate (Send)</td>
<td>The average rate at which data is sent to back-end storage resources. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Disk Data Rate (Total)</td>
<td>The average rate at which data is transmitted between back-end storage resources and the component. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
<tr>
<td>Port-to-Host Data Rate (Receive)</td>
<td>The average rate at which data is received from host computers. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Host Data Rate (Send)</td>
<td>The average rate at which data is sent to host computers. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Host Data Rate (Total)</td>
<td>The average rate at which data is transmitted between host computers and the component. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
<tr>
<td>Port-to-Local Node Data Rate (Receive)</td>
<td>The average rate at which data is received from other nodes that are in the local cluster. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Local Node Data Rate (Send)</td>
<td>The average rate at which data is sent to other nodes that are in the local cluster. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Local Node Data Rate (Total)</td>
<td>The average rate at which data is transmitted between the component and other nodes that are in the local cluster. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Remote Node Data Rate (Receive)</td>
<td>The average rate at which data is received from nodes that are in the remote cluster. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Remote Node Data Rate (Send)</td>
<td>The average rate at which data is sent to nodes that are in the remote cluster. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Port-to-Remote Node Data Rate (Total)</td>
<td>The average rate at which data is transmitted between the component and nodes that are in the remote cluster. The rate is measured in MiB per second.</td>
</tr>
</tbody>
</table>

Table 128. Response time metrics for ports

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port-to-Local Node Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation from another node that is in the local cluster. This value represents the external response time of the transfers.</td>
</tr>
</tbody>
</table>
### Table 128. Response time metrics for ports (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port-to-Local Node Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation to another node that is in the local cluster. This value represents the external response time of the transfers.</td>
</tr>
<tr>
<td>Port-to-Local Node Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send or receive operation with another node that is in the local cluster. This value represents the external response time of the transfers.</td>
</tr>
<tr>
<td>Port-to-Remote Node Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send operation to, or a receive operation from a node in the remote cluster. This value represents the external response time of the transfers.</td>
</tr>
<tr>
<td>Port-to-Remote Node Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation from a node that is in the remote cluster. This value represents the external response time of the transfers.</td>
</tr>
<tr>
<td>Port-to-Remote Node Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation to a node that is in the remote cluster. This value represents the external response time of the transfers.</td>
</tr>
<tr>
<td>Port-to-Remote Node Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send operation to, or a receive operation from a node in the remote cluster. This value represents the external response time of the transfers.</td>
</tr>
</tbody>
</table>

**Metrics availability restrictions:** The response time metrics are available for nodes, I/O groups, and storage system.

### Table 129. Error rate metrics for ports

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRC Error Rate</td>
<td>The average number of frames per second that are received in which a cyclic redundancy check (CRC) error is detected. A CRC error is detected when the CRC in the transmitted frame does not match the CRC computed by the receiver. For Brocade switches, this metric includes only the CRC Errors with a good end-of-frame (EOF) indicator.</td>
</tr>
<tr>
<td>Link Errors (Invalid Link Transmission Rate)</td>
<td>The average number of bit errors per second that are detected.</td>
</tr>
<tr>
<td>Link Errors (Invalid Transmission Word Rate)</td>
<td>The average number of bit errors per second that are detected.</td>
</tr>
<tr>
<td>Metric</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Link Errors (Link Failures)</td>
<td>The average number of miscellaneous fibre channel link errors per second for ports. Link errors might occur when an unexpected Not Operational (NOS) is received or a link state machine failure was detected.</td>
</tr>
<tr>
<td>Link Errors (Primitive Sequence Protocol Error Rate)</td>
<td>The average number of primitive sequence protocol errors per second that are detected. This error occurs when there is a link failure for a port.</td>
</tr>
<tr>
<td>Link Errors (Signal Loss)</td>
<td>The average number of times per second at which the port lost communication with its partner port. These types of errors usually indicate physical link problems, caused by faulty SFP modules or cables, or caused by faulty connections at the switch or patch panel. However, in some cases, this error can also occur when the maximum link distance between ports is exceeded, for the type of connecting cable and light source.</td>
</tr>
<tr>
<td>Link Errors (Sync Loss)</td>
<td>The average number of times per second that the port lost synchronization with its partner port. These types of errors usually indicate physical link problems, caused by faulty SFP modules or cables, or caused by faulty connections at the switch or patch panel. However in some cases this can also occur due to mismatching port speeds between the partner ports, when auto-negotiation of link speed is disabled.</td>
</tr>
<tr>
<td>Port Congestion Index*</td>
<td>The estimated degree to which frame transmission was delayed due to a lack of buffer credits. This value is generally 0 - 100. The value 0 means there was no congestion. The value can exceed 100 if the buffer credit exhaustion persisted for an extended amount of time. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Port Protocol Errors (Zero Buffer Credit Percentage)</td>
<td>The amount of time, as a percentage, that the port was not able to send frames between ports because of insufficient buffer-to-buffer credit. The amount of time value is measured from the last time that the node was reset. In Fibre Channel technology, buffer-to-buffer credit is used to control the flow of frames between ports.</td>
</tr>
</tbody>
</table>
Table 129. Error rate metrics for ports (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Protocol Errors (Zero Buffer Credit Timer)</td>
<td>The number of microseconds that the port is not able to send frames between ports because there is insufficient buffer-to-buffer credit. In Fibre Channel technology, buffer-to-buffer credit is used to control the flow of frames between ports. Buffer-to-buffer credit is measured from the last time that the node was reset.</td>
</tr>
</tbody>
</table>

Note: The performance metric for Port Congestion Index is only available for ports.

Table 130. Miscellaneous metrics for ports

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port-to-Local Node Queue Time (Receive)</td>
<td>The average time in milliseconds that a receive operation spends in the queue before the operation is processed. This value represents the queue time for receive operations that are issued from other nodes that are in the local cluster.</td>
</tr>
<tr>
<td>Port-to-Local Node Queue Time (Send)</td>
<td>The average time in milliseconds that a send operation spends in the queue before the operation is processed. This value represents the queue time for send operations that are issued to other nodes that are in the local cluster.</td>
</tr>
<tr>
<td>Port-to-Local Node Queue Time (Overall)</td>
<td>The average number of milliseconds that a send or receive operation spends in the queue before the operation is processed. This value is for send and receive operations that are issued between the component and other nodes that are in the local cluster.</td>
</tr>
<tr>
<td>Port-to-Remote Node Queue Time (Receive)</td>
<td>The average time in milliseconds that a receive operation spends in the queue before the operation is processed. This value represents the queue time for receive operations that are issued from a node that is in the remote cluster.</td>
</tr>
<tr>
<td>Port-to-Remote Node Queue Time (Send)</td>
<td>The average time in milliseconds that a send operation spends in the queue before the operation is processed. This value represents the queue time for send operations that are issued to a node that is in the remote cluster.</td>
</tr>
<tr>
<td>Port-to-Remote Node Queue Time (Overall)</td>
<td>The average number of milliseconds that a send or receive operation spends in the queue before the operation is processed. This value is for send and receive operations that are issued between the component and a node that is in the remote cluster.</td>
</tr>
</tbody>
</table>

Node performance metrics

Unless otherwise noted, you can view node metrics for the following resources:
- Nodes
• I/O Groups
• Storage systems

Table 131. Metrics for nodes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Utilization (System CPU)</td>
<td>The average percentage of time that the processors on nodes are busy doing system I/O tasks.</td>
</tr>
<tr>
<td>CPU Utilization (Compression CPU)</td>
<td>The average percentage of time that the processors used for data compression I/O tasks are busy.</td>
</tr>
<tr>
<td>System CPU Utilization (Core 1 to Core 4)</td>
<td>The approximate percentage of time that the processor core was busy with system I/O tasks.</td>
</tr>
<tr>
<td>Compression CPU Utilization (Core 1 to Core 4)</td>
<td>The approximate percentage of time that the processor core was busy with data compression tasks.</td>
</tr>
</tbody>
</table>

Performance metrics for XIV and IBM Spectrum Accelerate
Monitor the performance metrics that are collected for XIV systems and IBM Spectrum Accelerate.

For XIV systems, performance metrics are available for the following resources:
• “Volume metrics”
• “Port metrics” on page 317

For IBM Spectrum Accelerate, performance metrics are available for the following resource:
• “Volume metrics”

Restriction: XIV systems and IBM Spectrum Accelerate do not track performance statistics for volumes that were never used. Because there are no performance statistics, performance metrics are not shown for these volumes and their related components.

Volume metrics
Volume performance metrics are organized into the following categories:
• Key storage metrics
• Cache hit percentage metrics
• Response time metrics
• Miscellaneous metrics

Unless otherwise noted, you can view volume metrics for the following resources:
• Volumes
• Pools
• Modules
• Host connections
• Storage systems
Table 132. Key volume metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Read)</td>
<td>The average number of read operations per second. This value includes both sequential and nonsequential read operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Write)</td>
<td>The average number of write operations per second. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Total)</td>
<td>The average number of read operations and write operations per second. This value includes both sequential and nonsequential operations.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds to complete a read operation.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds to complete a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete an I/O operation. This value includes both read and write operations.</td>
</tr>
</tbody>
</table>

**Important:** For XIV systems, all the key storage metrics are available for version 10.2.2 or later.

Table 133. Cache hit percentage metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Cache Hits (Read)</td>
<td>The percentage of all read data that is read from the cache.</td>
</tr>
<tr>
<td>Data Cache Hits (Write)</td>
<td>The percentage of all write data that is written to cache slots that are marked as modified.</td>
</tr>
<tr>
<td>Data Cache Hits (Overall)</td>
<td>The percentage of all data that is handled in the cache. This value includes read data that is read from the cache and write data that is written to cache slots that are marked as modified.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Read)</td>
<td>The percentage of all read operations that find data in the cache. This value includes both sequential and random read operations, and read operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because in the event of cache miss, the data must be read from the back-end storage resources.</td>
</tr>
</tbody>
</table>
Table 133. Cache hit percentage metrics (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall I/O Cache Hits (Write)</td>
<td>The average percentage of all write operations that are handled in the cache, across all volumes on the server. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Total)</td>
<td>The percentage of all read operations and write operations that are handled in the cache. This value includes both sequential and random read and write operations, and read and write operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>SSD Read Cache Hits (I/O)</td>
<td>The percentage of read operations that find data in the cache on a solid-state drive (SSD). The value for this metric is also included in the value for the Overall Read Cache Hit Percentage metric. This metric is only available for XIV systems that use solid-state drives as drives for caching.</td>
</tr>
<tr>
<td>SSD Read Cache Hits (Data)</td>
<td>The percentage of all read data that was read from cache memory on a solid-state drive. This metric is only available for XIV systems that use solid-state drives as drives for caching.</td>
</tr>
</tbody>
</table>

Notes:
1. For XIV systems, this metric is available in version 10.2.2 or later.
2. For XIV systems, this metric is available in version 10.2.4 or later.

Table 134. Response time metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Hit Response Time (Read)</td>
<td>The average number of milliseconds to complete a read-cache hit operation.</td>
</tr>
<tr>
<td>Cache Hit Response Time (Write)</td>
<td>The average number of milliseconds to complete a write-cache hit operation.</td>
</tr>
<tr>
<td>Cache Hit Response Time (Overall)</td>
<td>The average number of milliseconds to complete a cache hit operation. This value includes the times for both read-cache hit and write-cache hit operations.</td>
</tr>
<tr>
<td>Cache Miss Response Time (Read)</td>
<td>The average number of milliseconds to complete a read-cache miss operation.</td>
</tr>
<tr>
<td>Cache Miss Response Time (Write)</td>
<td>The average number of milliseconds to complete a write-cache miss operation.</td>
</tr>
<tr>
<td>Cache Miss Response Time (Overall)</td>
<td>The average number of milliseconds to complete a cache miss operation. This value includes the times for both read-cache miss and write-cache miss operations.</td>
</tr>
</tbody>
</table>
### Table 134. Response time metrics (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Time by Transfer Size (Small)</td>
<td>The average number of milliseconds to complete an I/O operation that has a small data transfer size. A small data transfer has a size that is less than or equal to 8 KiB.</td>
</tr>
<tr>
<td>Response Time by Transfer Size (Medium)</td>
<td>The average number of milliseconds to complete an I/O operation that has a medium data transfer size. A medium data transfer has a size that is greater than 8 KiB and less than or equal to 64 KiB.</td>
</tr>
<tr>
<td>Response Time by Transfer Size (Large)</td>
<td>The average number of milliseconds to complete an I/O operation that has a large data transfer size. A large data transfer has a size that is greater than 64 KiB and less than or equal to 512 KiB.</td>
</tr>
<tr>
<td>Response Time by Transfer Size (Very Large)</td>
<td>The average number of milliseconds to complete an I/O operation with a data transfer size that is greater than 512 KiB.</td>
</tr>
<tr>
<td>SSD Read Cache Hit Response Time</td>
<td>The average number of milliseconds that it takes to complete a hit operation on the read cache on a solid-state drive. The value for this metric is also included in the value for the Read Cache Hit Response Time metric. This metric is only available for XIV systems that use solid-state drives as drives for caching.</td>
</tr>
</tbody>
</table>

**Note:** For XIV systems, all the response time metrics are available for version 10.2.2 or later.

### Table 135. Miscellaneous metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>I/O Transfer Size (Small)</td>
<td>The percentage of I/O operations with a small data transfer size. A small data transfer has a size that is less than or equal to 8 KiB.</td>
</tr>
<tr>
<td>I/O Transfer Size (Medium)</td>
<td>The percentage of I/O operations with a medium data transfer size. A medium data transfer has a size that is greater than 8 KiB and less than or equal to 64 KiB.</td>
</tr>
<tr>
<td>I/O Transfer Size (Large)</td>
<td>The percentage of I/O operations with a large data transfer size. A large data transfer has a size that is greater than 64 KiB and less than or equal to 512 KiB.</td>
</tr>
</tbody>
</table>
Table 135. Miscellaneous metrics (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Transfer Size (Very Large)</td>
<td>The percentage of I/O operations with a data transfer size that is greater than 512 KiB.</td>
</tr>
<tr>
<td>Data Transfer Size (Small)</td>
<td>The percentage of data that is transferred as a result of I/O operations with a small data transfer size. A small data transfer has a size that is less than or equal to 8 KiB.</td>
</tr>
<tr>
<td>Data Transfer Size (Medium)</td>
<td>The percentage of data that is transferred as a result of I/O operations with a medium data transfer size. A medium data transfer has a size that is greater than 8 KiB and less than or equal to 64 KiB.</td>
</tr>
<tr>
<td>Data Transfer Size (Large)</td>
<td>The percentage of data that is transferred as a result of I/O operations with a large data transfer size. A large data transfer has a size that is greater than 64 KiB and less than or equal to 512 KiB.</td>
</tr>
<tr>
<td>Data Transfer Size (Very Large)</td>
<td>The percentage of data that is transferred as a result of I/O operations with a data transfer size that is greater than 512 KiB.</td>
</tr>
<tr>
<td>Volume Utilization</td>
<td>The average percentage of time that the volume is busy.</td>
</tr>
<tr>
<td>Pool Utilization</td>
<td>The average percentage of time that the volumes in the pool are busy.</td>
</tr>
</tbody>
</table>

Notes:
1. For XIV systems, this metric is available in version 10.2.2 or later.
2. For XIV systems, this metric is available in version 10.2.4 or later.
3. This metric is only available when you view the performance of pools.

Port metrics

The following performance metrics for ports are available for XIV systems that are version 10.2.4 or later:
- I/O rate metrics
- Data rate metrics
- Response time metrics
- Miscellaneous port metrics

Restriction: Port metrics are not available for IBM Spectrum Accelerate.

Table 136. I/O rate metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate (Send)</td>
<td>The average number of I/O operations per second for operations in which data is sent from a port.</td>
</tr>
<tr>
<td>I/O Rate (Receive)</td>
<td>The average number of I/O operations per second for operations in which the port receives data.</td>
</tr>
</tbody>
</table>
Table 136. I/O rate metrics (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of send operations and receive operations per second.</td>
</tr>
</tbody>
</table>

Table 137. Data rate metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Send)</td>
<td>The average rate at which data is sent through the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Receive)</td>
<td>The average rate at which data is received by the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transferred through the port. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
</tbody>
</table>

Table 138. Response time metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Time (Send)</td>
<td>The average number of milliseconds to complete a send operation.</td>
</tr>
<tr>
<td>Response Time (Receive)</td>
<td>The average number of milliseconds to complete a receive operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete a send or receive operation.</td>
</tr>
</tbody>
</table>

Table 139. Miscellaneous port metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth (Send)</td>
<td>The percentage of the port bandwidth that is used for send operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth (Receive)</td>
<td>The percentage of the port bandwidth that is used for receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth (Overall)</td>
<td>The percentage of the port bandwidth that is used for send operations and receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
</tbody>
</table>

Performance metrics for ESS

Monitor the performance metrics that are collected for IBM TotalStorage Enterprise Storage Server® systems.

Performance metrics are available for the following resources:

- "Volume metrics" on page 319
- "Disk metrics” on page 322
When you view metrics for ESS systems, you must take into account the following differences between IBM Spectrum Control reports and the native reports of those systems:

- IBM Spectrum Control reports display port performance metrics as send and receive metrics, such as Data Rate (Send) and Data Rate (Receive).
- Reports that are included with storage systems (for example, reports based on data that is collected by the DS CLI) display port performance metrics as read and write metrics, such as Byteread and Bytewrite.

**Volume metrics**

Volume performance metrics are organized into the following categories:

- **Key volume metrics**
- **I/O rate metrics**
- **Cache hit percentage metrics**
- **Miscellaneous metrics**

Unless otherwise noted, you can view volume metrics for the following resources:

- Host connections
- Nodes
- Pools
- RAID arrays
- Storage systems
- Volumes

*Table 140. Key volume metrics.*

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>Cache Holding Time</td>
<td>The average number of seconds that I/O data for a storage system node is held in the cache. A short cache-holding time indicates adverse performance.</td>
</tr>
<tr>
<td>Write-Cache Delay Percentage</td>
<td>The percentage of I/O operations that are delayed because of space constraints in the write cache, or because of other conditions. The value is a percentage of all operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Read)</td>
<td>The average number of read operations per second. This value includes both sequential and nonsequential read operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Write)</td>
<td>The average number of write operations per second. This value includes both sequential and nonsequential write operations.</td>
</tr>
</tbody>
</table>
Table 140. Key volume metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall I/O Rate (Total)</td>
<td>The average number of read operations and write operations per second. This value includes both sequential and nonsequential operations.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds to complete a read operation.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds to complete a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete an I/O operation. This value includes both read and write operations.</td>
</tr>
</tbody>
</table>

Note: This metric is only available when you view the performance of nodes and storage systems.

Table 141. I/O rate metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Rate (Cache-to-Disk)</td>
<td>The average number of sectors or tracks per second that are transferred from the cache to the disks.</td>
</tr>
<tr>
<td>Average Transfer Rate (Disk-to-Cache)</td>
<td>The percentage of cache hits for record-mode read operations. For record-mode read operations, only the requested data, rather than a full track of data, is managed in the cache.</td>
</tr>
<tr>
<td>Normal I/O Rate (Read)</td>
<td>The average number of nonsequential read operations per second.</td>
</tr>
<tr>
<td>Normal I/O Rate (Write)</td>
<td>The average number of nonsequential write operations per second.</td>
</tr>
<tr>
<td>Normal I/O Rate (Total)</td>
<td>The average number of nonsequential I/O operations per second. This value includes both read and write operations.</td>
</tr>
<tr>
<td>PPRC Transfer Rate</td>
<td>The average number of tracks per second that are transferred to the secondary device of a Peer-to-Peer Remote Copy (PPRC) pair. This value shows the activity for the source of the PPRC relationship, but shows no activity for the target.</td>
</tr>
<tr>
<td>Record Mode Read I/O Rate</td>
<td>The average number of I/O operations per second for record-mode read operations. For record-mode read operations, only the requested data is managed in the cache rather than a full track of data.</td>
</tr>
<tr>
<td>Sequential I/O Rate (Read)</td>
<td>The average number of sequential read operations per second.</td>
</tr>
<tr>
<td>Sequential I/O Rate (Write)</td>
<td>The average number of sequential write operations per second.</td>
</tr>
<tr>
<td>Sequential I/O Rate (Total)</td>
<td>The average number of sequential I/O operations per second. This value includes both read and write operations.</td>
</tr>
</tbody>
</table>
## Table 141. I/O rate metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write-Cache Delay I/O Rate</td>
<td>The average number of I/O operations per second that are delayed because of space constraints in the write cache, or because of other conditions.</td>
</tr>
<tr>
<td>Write-Cache Delay Percentage</td>
<td>The percentage of I/O operations that are delayed because of space constraints in the write cache, or because of other conditions. The value is a percentage of all operations.</td>
</tr>
</tbody>
</table>

## Table 142. Cache hit percentage metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal I/O Cache Hits (Read)</td>
<td>The percentage of nonsequential read operations that find data in the cache. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Normal I/O Cache Hits (Write)</td>
<td>The percentage of nonsequential write operations that are handled in the cache.</td>
</tr>
<tr>
<td>Normal I/O Cache Hits (Total)</td>
<td>The percentage of nonsequential I/O operations that are handled in the cache. This value includes both read and write operations. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Read)</td>
<td>The percentage of all read operations that find data in the cache. This value includes both sequential and random read operations, and read operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because in the event of cache miss, the data must be read from the back-end storage resources.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Write)</td>
<td>The average percentage of all write operations that are handled in the cache, across all volumes on the server. This value includes both sequential and nonsequential write operations.</td>
</tr>
</tbody>
</table>
### Table 142. Cache hit percentage metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall I/O Cache Hits (Total)</td>
<td>The percentage of all read operations and write operations that are handled in the cache. This value includes both sequential and random read and write operations, and read and write operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Record Mode Read Cache Hit Percentage</td>
<td>The percentage of cache hits for record-mode read operations. For record-mode read operations, only the requested data, rather than a full track of data, is managed in the cache.</td>
</tr>
<tr>
<td>Sequential I/O Cache Hits (Read)</td>
<td>The percentage of sequential read operations that find data in the cache. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>Sequential I/O Cache Hits (Write)</td>
<td>The percentage of sequential write operations that are handled in the cache.</td>
</tr>
<tr>
<td>Sequential I/O Cache Hits (Total)</td>
<td>The percentage of sequential I/O operations that are handled in the cache. This value includes both read and write operations. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
</tbody>
</table>

### Table 143. Miscellaneous metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Volume Utilization[*]</td>
<td>The average percentage of time that the volume is busy.</td>
</tr>
</tbody>
</table>

**Note:** * This metric is only available when you view the performance of volumes.

### Disk metrics

Disk performance metrics are organized into the following categories:

- [Key disk metrics](#)
Transfer size metrics
Utilization metrics

Unless otherwise noted, you can view disk metrics for the following resources:

- Nodes
- Pools
- RAID arrays
- Rank
- Storage systems

Table 144. Key disk metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are read from the back-end storage resources.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are written to the back-end storage resources.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transmitted between the back-end storage resources and the component. The rate is measured in MiB per second and includes both read and write operations.</td>
</tr>
<tr>
<td>I/O Rate (Read)</td>
<td>The average number of read operations per second that are issued to the back-end storage resources.</td>
</tr>
<tr>
<td>I/O Rate (Write)</td>
<td>The average number of write operations per second that are issued to the back-end storage resources.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of I/O operations per second that are transmitted between the back-end storage resources and the component. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read operation.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read or a write operation.</td>
</tr>
</tbody>
</table>

Table 145. Transfer size metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation from the back-end storage resources.</td>
</tr>
<tr>
<td>Average Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation to the back-end storage resources.</td>
</tr>
</tbody>
</table>
Table 145. Transfer size metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average transfer size, in KiB, of a read or a write operation to the back-end storage resources.</td>
</tr>
</tbody>
</table>

Table 146. Utilization metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Internal resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Utilization</td>
<td>RAID array</td>
<td>The average percentage of time that the disks that are associated with an array are busy. No value is calculated for this property if there are multiple ranks in the extent pool where the thin-provisioned volumes are allocated. In this case, the value N/A is displayed for this property. This limitation applies only to DS8000 storage systems. Tip: IBM Spectrum Control does not calculate a value for this column if there are multiple ranks in the extent pool where thin-provisioned volumes are allocated. This column displays value of N/A for the reports in which it is displayed. However, if there is only a single rank in the extent pool, IBM Spectrum Control does calculate the value for this column regardless of the thin-provisioned volumes.</td>
</tr>
<tr>
<td>Sequential I/O Percentage</td>
<td>RAID array</td>
<td>Percentage of all I/O operations that were completed for a RAID array over a specified time interval that were sequential operations.</td>
</tr>
</tbody>
</table>

Port metrics

Port performance metrics are organized into the following categories:
- Key port metrics
- I/O rate metrics
- Data rate metrics
- Response time metrics
- Remote mirror metrics
- Transfer size metrics
<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth (Send)</td>
<td>Port</td>
<td>The percentage of the port bandwidth that is used for send operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth (Receive)</td>
<td>Port</td>
<td>The percentage of the port bandwidth that is used for receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth (Overall)</td>
<td>Port</td>
<td>The percentage of the port bandwidth that is used for send operations and receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Data Rate (Send)</td>
<td>Port, storage system</td>
<td>The average rate at which data is sent through the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Receive)</td>
<td>Port, storage system</td>
<td>The average rate at which data is received by the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>Port, storage system</td>
<td>The average rate at which data is transferred through the port. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
<tr>
<td>I/O Rate (Send)</td>
<td>Port, storage system</td>
<td>The average number of I/O operations per second for operations in which data is sent from a port.</td>
</tr>
<tr>
<td>I/O Rate (Receive)</td>
<td>Port, storage system</td>
<td>The average number of I/O operations per second for operations in which the port receives data.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>Port, storage system</td>
<td>The average number of send operations and receive operations per second.</td>
</tr>
<tr>
<td>Port Utilization (Send)</td>
<td>Port</td>
<td>The average percentage of time that the port is busy sending data.</td>
</tr>
<tr>
<td>Port Utilization (Receive)</td>
<td>Port</td>
<td>The average percentage of time that the port is busy receiving data.</td>
</tr>
</tbody>
</table>
### Table 147. Key port metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Utilization (Overall)</td>
<td>Port</td>
<td>The average percentage of time that the port is busy sending or receiving data.</td>
</tr>
<tr>
<td>Response Time (Send)</td>
<td>Port, storage system</td>
<td>The average number of milliseconds to complete a send operation.</td>
</tr>
<tr>
<td>Response Time (Receive)</td>
<td>Port, storage system</td>
<td>The average number of milliseconds to complete a receive operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>Port, storage system</td>
<td>The average number of milliseconds to complete a send or receive operation.</td>
</tr>
</tbody>
</table>

### Table 148. I/O rate metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON I/O Rate (Send)</td>
<td>Port</td>
<td>The average number of send operations per second for Fibre Channel connection (FICON) usage.</td>
</tr>
<tr>
<td>FICON I/O Rate (Receive)</td>
<td>Port</td>
<td>The average number of receive operations per second for FICON usage.</td>
</tr>
<tr>
<td>FICON I/O Rate (Total)</td>
<td>Port</td>
<td>The average number of send and receive operations per second for FICON usage.</td>
</tr>
<tr>
<td>FCP I/O Rate (Send)</td>
<td>Port</td>
<td>The average number of send operations per second for Fibre Channel Protocol (FCP) usage.</td>
</tr>
<tr>
<td>FCP I/O Rate (Receive)</td>
<td>Port</td>
<td>The average number of receive operations per second for FCP usage.</td>
</tr>
<tr>
<td>FCP I/O Rate (Total)</td>
<td>Port</td>
<td>The average number of send operations and receive operations per second for FCP usage.</td>
</tr>
</tbody>
</table>

### Table 149. Data rate metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON Data Rate (Send)</td>
<td>Port</td>
<td>The average number of MiB per second that is sent for FICON usage.</td>
</tr>
<tr>
<td>FICON Data Rate (Receive)</td>
<td>Port</td>
<td>The average number of MiB per second that is received for FICON usage.</td>
</tr>
<tr>
<td>FICON I/O Rate (Total)</td>
<td>Port</td>
<td>The average number of MiB per second that is transferred for FICON usage.  This value includes both send and receive FICON operations.</td>
</tr>
</tbody>
</table>
Table 149. Data rate metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCP Data Rate (Send)</td>
<td>Port</td>
<td>The average number of MiB per second that are sent for FCP usage.</td>
</tr>
<tr>
<td>FCP Data Rate (Receive)</td>
<td>Port</td>
<td>The average number of MiB per second that are received for FCP usage.</td>
</tr>
<tr>
<td>FCP Data Rate (Total)</td>
<td>Port</td>
<td>The average number of MiB per second that are transferred for FCP usage. This value includes both send and receive FCP operations.</td>
</tr>
</tbody>
</table>

Table 150. Response time metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON Response Time (Send)</td>
<td>Port</td>
<td>The average number of milliseconds to complete a send operation for FICON usage.</td>
</tr>
<tr>
<td>FICON Response Time (Receive)</td>
<td>Port</td>
<td>The average number of milliseconds to complete a receive operation for FICON usage.</td>
</tr>
<tr>
<td>FICON Response Time (Overall)</td>
<td>Port</td>
<td>The average number of milliseconds to complete a send or receive operation for FICON usage. This value includes both send and receive FICON operations.</td>
</tr>
<tr>
<td>FCP Response Time (Send)</td>
<td>Port</td>
<td>The average number of milliseconds to complete a send operation for FICON usage.</td>
</tr>
<tr>
<td>FCP Response Time (Receive)</td>
<td>Port</td>
<td>The average number of milliseconds to complete a receive operation for FICON usage.</td>
</tr>
<tr>
<td>FCP Response Time (Overall)</td>
<td>Port</td>
<td>The average number of send operations and receive operations per second for FCP usage.</td>
</tr>
</tbody>
</table>

Table 151. Remote mirror metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPRC Data Rate (Send)</td>
<td>Port, storage system</td>
<td>The average number of MiB per second that are sent by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
</tbody>
</table>
### Table 151. Remote mirror metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPRC Data Rate (Receive)</td>
<td>Port, storage system</td>
<td>The average number of MiB per second that are received by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Data Rate (Total)</td>
<td>Port, storage system</td>
<td>The average number of MiB per second that are transferred by using the Peer-to-Peer Remote Copy (PPRC) protocol. This value includes both send and receive PPRC operations.</td>
</tr>
<tr>
<td>PPRC I/O Rate (Send)</td>
<td>Port, storage system</td>
<td>The average number of operations per second that are sent by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC I/O Rate (Receive)</td>
<td>Port, storage system</td>
<td>The average number of operations per second that are received by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC I/O Rate (Total)</td>
<td>Port, storage system</td>
<td>The average number of send operations and receive operations per second using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Response Time (Send)</td>
<td>Port, storage system</td>
<td>The average number of milliseconds to complete a send operation by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Response Time (Receive)</td>
<td>Port, storage system</td>
<td>The average number of milliseconds to complete a receive operation by using the Peer-to-Peer Remote Copy protocol.</td>
</tr>
<tr>
<td>PPRC Response Time (Overall)</td>
<td>Port, storage system</td>
<td>The average number of milliseconds to complete a send or receive operation by using the Peer-to-Peer Remote Copy (PPRC) protocol.</td>
</tr>
</tbody>
</table>

### Table 152. Transfer size metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Send)</td>
<td>Port, storage system</td>
<td>The average number of KiB that are transferred per send operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Receive)</td>
<td>Port, storage system</td>
<td>The average number of KiB that are transferred per receive operation.</td>
</tr>
</tbody>
</table>
Table 152. Transfer size metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Resources</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>Port, storage system</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both send and receive operations.</td>
</tr>
</tbody>
</table>

Performance metrics for IBM Spectrum Scale

Monitor the performance metrics that are collected for IBM Spectrum Scale storage systems.

Overview

The performance metrics are divided into the following categories:
- “Node performance metrics”
- “File system performance metrics” on page 330

Node performance metrics

You can view the following metrics for each GPFS cluster node.

Table 153. Metrics for nodes.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Utilization (User)</td>
<td>The average percentage of time that the processors on a node are busy doing user tasks.</td>
</tr>
<tr>
<td>CPU Utilization (System)</td>
<td>The average percentage of time that the processors on a node are busy doing system tasks.</td>
</tr>
<tr>
<td>CPU Utilization (Total)</td>
<td>The average percentage of time that the processors on a node are busy doing user tasks and system tasks.</td>
</tr>
<tr>
<td>Memory Used (Cache and Buffer)</td>
<td>The average percentage of memory on a node that is used for cache and buffer memory.</td>
</tr>
<tr>
<td>Memory Used</td>
<td>The average percentage of memory that is used on a node. This value does not include the memory that is used for cache and buffer memory.</td>
</tr>
<tr>
<td>Memory Used (Total)</td>
<td>The average percentage of memory that is used on a node. This value includes the memory that is used for cache and buffer memory.</td>
</tr>
<tr>
<td>I/O Rate (Read)</td>
<td>The average number of read operations per second.</td>
</tr>
<tr>
<td>I/O Rate (Write)</td>
<td>The average number of write operations per second.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of read operations and write operations per second.</td>
</tr>
</tbody>
</table>
File system performance metrics

You can view file system metrics for the following resources:

- File systems
- IBM Spectrum Scale storage systems

**Tip:** For a storage system, the metrics contain summary values for all the file systems on the storage system.

*Table 154. Metrics for file systems.*

<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>Maximum Data Rate (Read)</td>
<td>The maximum number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Maximum Data Rate (Write)</td>
<td>The maximum number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Maximum Data Rate (Total)</td>
<td>The maximum number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>I/O Rate (Read)</td>
<td>The average number of read operations per second.</td>
</tr>
<tr>
<td>I/O Rate (Write)</td>
<td>The average number of write operations per second.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of read operations and write operations per second.</td>
</tr>
<tr>
<td>Maximum I/O Rate (Read)</td>
<td>The maximum number of read operations per second.</td>
</tr>
<tr>
<td>Maximum I/O Rate (Write)</td>
<td>The maximum number of write operations per second.</td>
</tr>
<tr>
<td>Maximum I/O Rate (Total)</td>
<td>The maximum number of read operations and write operations per second.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read operation from the file system.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a write operation from the file system.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds for the back-end storage resources to respond to a read operation or a write operation from the file system.</td>
</tr>
</tbody>
</table>

Performance metrics for other storage systems

Monitor the performance metrics that are collected for SMI-S BSP systems such as DS5000, DS4000, and DS3000, EMC, Hitachi, NetApp and other storage systems.
Overview

Performance metrics are available for the following resources:

- "Volume metrics"
- "Port metrics" on page 332

A performance metric might apply to one or more storage resources. To check which resources the performance metric applies to, see the tips and the table footnotes.

Volume metrics

Volume performance metrics are divided into the following categories:

- Key volume metrics
- Cache hit percentage metrics
- Average transfer size metrics

Tip: Unless otherwise noted, you can view the volume metrics in Table 155, Table 156 on page 332 and Table 157 on page 332 for the following resources:

- Volumes
- Nodes
- Storage systems

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall I/O Rate (Read)</td>
<td>The average number of read operations per second. This value includes both sequential and nonsequential read operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Write)</td>
<td>The average number of write operations per second. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Rate (Total)</td>
<td>The average number of read operations and write operations per second. This value includes both sequential and nonsequential operations.</td>
</tr>
<tr>
<td>Data Rate (Read)</td>
<td>The average number of MiB per second that are transferred for read operations.</td>
</tr>
<tr>
<td>Data Rate (Write)</td>
<td>The average number of MiB per second that are transferred for write operations.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average number of MiB per second that are transferred for read operations and write operations.</td>
</tr>
<tr>
<td>Response Time (Read)</td>
<td>The average number of milliseconds to complete a read operation.</td>
</tr>
<tr>
<td>Response Time (Write)</td>
<td>The average number of milliseconds to complete a write operation.</td>
</tr>
<tr>
<td>Response Time (Overall)</td>
<td>The average number of milliseconds to complete an I/O operation. This value includes both read and write operations.</td>
</tr>
<tr>
<td>Volume Utilization</td>
<td>The average percentage of time that the volume is busy.</td>
</tr>
</tbody>
</table>
Table 155. Key volume metrics (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>1. This metric is only available when you view the performance of volumes.</td>
</tr>
</tbody>
</table>

Table 156. Cache hit percentages.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall I/O Cache Hits (Read)</td>
<td>The percentage of all read operations that find data in the cache. This value includes both sequential and random read operations, and read operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because in the event of cache miss, the data must be read from the back-end storage resources.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Write)</td>
<td>The average percentage of all write operations that are handled in the cache, across all volumes on the server. This value includes both sequential and nonsequential write operations.</td>
</tr>
<tr>
<td>Overall I/O Cache Hits (Total)</td>
<td>The percentage of all read operations and write operations that are handled in the cache. This value includes both sequential and random read and write operations, and read and write operations in the volume cache and volume copy cache where applicable. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
</tbody>
</table>

Table 157. Average transfer size metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Read)</td>
<td>The average number of KiB that are transferred per read operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Write)</td>
<td>The average number of KiB that are transferred per write operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both read and write operations.</td>
</tr>
</tbody>
</table>

**Port metrics**

Port performance metrics are divided into the following categories:

- [Key port metrics](#)
- [Transfer size metrics](#)
**Tip:** You can view the port metrics in [Table 158](#) and [Table 159](#) for ports and storage systems.

***Table 158. Key port metrics.***

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Rate (Receive)</td>
<td>The average number of I/O operations per second for operations in which the port receives data.</td>
</tr>
<tr>
<td>I/O Rate (Send)</td>
<td>The average number of I/O operations per second for operations in which data is sent from a port.</td>
</tr>
<tr>
<td>I/O Rate (Total)</td>
<td>The average number of send operations and receive operations per second.</td>
</tr>
<tr>
<td>Data Rate (Receive)</td>
<td>The average rate at which data is received by the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Send)</td>
<td>The average rate at which data is sent through the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transferred through the port. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
</tbody>
</table>

***Table 159. Transfer size metrics.***

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Transfer Size (Receive)</td>
<td>The average number of KiB that are transferred per receive operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Send)</td>
<td>The average number of KiB that are transferred per send operation.</td>
</tr>
<tr>
<td>Average Transfer Size (Overall)</td>
<td>The average number of KiB that are transferred per I/O operation. This value includes both send and receive operations.</td>
</tr>
</tbody>
</table>

**Performance metrics for switches**

Monitor the performance metrics that are collected for switches, switch ports, and inter-switch connections.

Performance metrics for switches are divided into the following categories:

- [Key port metrics](#)
- [I/O rate metrics](#)
- [Peak data rate metrics](#)
- [Frame error rate metrics](#)
- [Port protocol error rate metrics](#)
- [Link error rate metrics](#)
- [Miscellaneous metrics](#)
### Table 160. Key port metrics

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth Percentage (Send)</td>
<td>The percentage of the port bandwidth that is used for send operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth Percentage (Receive)</td>
<td>The percentage of the port bandwidth that is used for receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Bandwidth Percentage (Overall)</td>
<td>The percentage of the port bandwidth that is used for send operations and receive operations. This value is an indicator of port bandwidth usage that is based on the speed of the port.</td>
</tr>
<tr>
<td>Data Rate (Send)</td>
<td>The average rate at which data is sent by the port. A send operation is a read operation that is processed, or a write operation that is initiated by the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Receive)</td>
<td>The average rate at which data is received by the port. A receive operation is a write operation that is processed, or a read operation that is initiated by the port. The rate is measured in MiB per second.</td>
</tr>
<tr>
<td>Data Rate (Total)</td>
<td>The average rate at which data is transferred through the port. The rate is measured in MiB per second and includes both send and receive operations.</td>
</tr>
<tr>
<td>Total Port Error Rate</td>
<td>The average number of times per second that an error was detected on the port. This rate is a summation of all the other error rates for the port.</td>
</tr>
</tbody>
</table>

### Table 161. I/O rates

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Frame Rate (Send)</td>
<td>The average number of frames per second that are sent through the port.</td>
</tr>
<tr>
<td>Port Frame Rate (Receive)</td>
<td>The average number of frames per second that are received by the port.</td>
</tr>
<tr>
<td>Port Frame Rate (Total)</td>
<td>The average number of frames per second that are transferred. This value includes frames that are sent and frames that are received by the port.</td>
</tr>
</tbody>
</table>

### Table 162. Peak data rates

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Data Rate (Send)</td>
<td>The highest rate at which data is sent by the port. A send operation is a read operation that is processed, or a write operation that is initiated by the port.</td>
</tr>
</tbody>
</table>
### Table 162. Peak data rates (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Data Rate (Receive)</td>
<td>The highest rate at which data is received by the port. A receive operation is a write operation that is processed, or a read operation that is initiated by the port.</td>
</tr>
</tbody>
</table>

**Notes:**
1. This metric is only available for ports on Brocade switches. You must use a CIM agent to collect data for this metric.

### Table 163. Frame error rates.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bad EOF CRC Error Rate</td>
<td>The percentage of nonsequential read operations that find data in the cache. You can use this value to understand throughput or response times. Low cache-hit percentages can increase response times because a cache miss requires access to the back-end storage resources.</td>
</tr>
<tr>
<td>CRC Error Rate</td>
<td>The percentage of nonsequential write operations that are handled in the cache.</td>
</tr>
<tr>
<td>Discarded Class 3 Frame Rate</td>
<td>The average number of class 3 frames per second that are discarded.</td>
</tr>
<tr>
<td>Error Frame Rate</td>
<td>The average number of error frames per second that are received. An error frame is a frame that violates the Fibre Channel Protocol.</td>
</tr>
<tr>
<td>F-BSY Frame Rate</td>
<td>The average number of F-BSY frames per second that are generated. An F-BSY frame is issued by the fabric to indicate that a frame cannot be delivered because the fabric or destination N_port is busy.</td>
</tr>
<tr>
<td>F-RJT Frame Rate</td>
<td>The average number of F-RJT frames per second that are generated. An F-RJT frame is issued by the fabric to indicate that delivery of a frame was denied.</td>
</tr>
<tr>
<td>Long Frame Rate</td>
<td>The average number of frames that are received per second that are longer than 2140 octets. This number excludes start-of-frame bytes and end-of-frame bytes. The 2140 octet limit is calculated based on the assumption that a frame has 24 header bytes, 4 CRC bytes, and 2112 data bytes.</td>
</tr>
<tr>
<td>Short Frame Rate</td>
<td>The average number of frames that are received per second that are shorter than 28 octets. This number excludes start-of-frame bytes and end-of-frame bytes. The 28 octet limit is calculated based on the assumption that a frame has 24 header bytes, and 4 CRC bytes.</td>
</tr>
</tbody>
</table>

**Notes:**
1. This metric is only available for ports on Brocade switches.
2. You must use an SNMP agent to collect data for this metric.
**Table 164. Port protocol error rates.**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class 3 Receive Timeout Frame Rate</td>
<td>The average number of class 3 frames per second that were discarded after reception because of a timeout condition. The timeout condition occurs while a transmitting port waits for buffer credit from a port at the other end of the fibre. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Class 3 Send Timeout Frame Rate</td>
<td>The average number of class 3 frames per second that were discarded before transmission because of a timeout condition. The timeout condition occurs while the switch or port waits for buffer credit from the receiving port at the other end of the fibre. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Credit Recovery Link Reset Rate</td>
<td>The estimated average number of link resets per second that a switch or port completed to recover buffer credits. This estimate attempts to disregard link resets that were caused by link initialization. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Discarded Frame Rate</td>
<td>The average number of frames per second that are discarded because host buffers are unavailable for the port.</td>
</tr>
<tr>
<td>Link Reset Received Rate</td>
<td>The average number of times per second that the port changes from an active (AC) state to a Link Recovery (LR2) state.</td>
</tr>
<tr>
<td>Link Reset Transmitted Rate</td>
<td>The average number of times per second that the port changes from an active (AC) state to a Link Recovery (LR1) state.</td>
</tr>
<tr>
<td>Port Congestion Index</td>
<td>The estimated degree to which frame transmission was delayed due to a lack of buffer credits. This value is generally 0 - 100. The value 0 means there was no congestion. The value can exceed 100 if the buffer credit exhaustion persisted for an extended amount of time. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
</tbody>
</table>
Table 164. Port protocol error rates (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY Priority Override Rate[^1]</td>
<td>The average number of times per second during which the sending of R_RDY or VC_RDY signals was a higher priority than the sending of frames. This condition occurs because of diminishing credit reserves in the transmitter at the other end of the fibre. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Zero Buffer Credit Rate[^2]</td>
<td>The average number of Zero Buffer Credit conditions per second that occurred. A Zero Buffer Credit condition occurs when a port is unable to send frames because of a lack of buffer credit since the last node reset. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
</tbody>
</table>

Notes:
1. This metric is available only for ports on Brocade switches.
2. You must use an SNMP agent to collect data for this metric.

Table 165. Link error rates.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoding Disparity</td>
<td>The average number of disparity errors per second that are received.</td>
</tr>
<tr>
<td>Invalid Link Transmission Rate</td>
<td>The average number of times per second that an invalid transmission word was detected by the port while the link did not experience any signal or synchronization loss.</td>
</tr>
<tr>
<td>Invalid Word Transmission Rate</td>
<td>The average number of bit errors per second that are detected.</td>
</tr>
<tr>
<td>Link Failure Rate</td>
<td>The average number of miscellaneous fibre channel link errors per second for ports. Link errors might occur when an unexpected Not Operational (NOS) is received or a link state machine failure was detected.</td>
</tr>
<tr>
<td>Loss of Signal Rate</td>
<td>The average number of times per second at which the port lost communication with its partner port. These types of errors usually indicate physical link problems, caused by faulty SFP modules or cables, or caused by faulty connections at the switch or patch panel. However, in some cases, this error can also occur when the maximum link distance between ports is exceeded, for the type of connecting cable and light source.</td>
</tr>
</tbody>
</table>
Table 165. Link error rates (continued).

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss of Sync Rate</td>
<td>The average number of times per second that the port lost synchronization with its partner port. These types of errors usually indicate physical link problems, caused by faulty SFP modules or cables, or caused by faulty connections at the switch or patch panel. However in some cases this can also occur due to mismatching port speeds between the partner ports, when auto-negotiation of link speed is disabled.</td>
</tr>
<tr>
<td>Port State Change Rate</td>
<td>The average number of times per second that the state of a port changes to offline, online, or faulty. When you troubleshoot a SAN, use this metric to help identify port conditions that might slow the performance of the resources to which those ports are connected.</td>
</tr>
<tr>
<td>Primitive Sequence Protocol Error Rate</td>
<td>The average number of primitive sequence protocol errors per second that are detected. This error occurs when there is a link failure for a port.</td>
</tr>
</tbody>
</table>

Notes:
1. This metric is only available for ports on Brocade switches. You must use an SNMP agent to collect data for this metric.

Table 166. Miscellaneous port metrics.

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Quality Percentage</td>
<td>The percentage is based on whether the port is an expansion port (E_port) or a fabric port (F_port), and on the numbers and types of errors that are detected by the port.</td>
</tr>
<tr>
<td>Port Frame Size (Overall)</td>
<td>The average frame transfer size. This value is measured in KiB and includes frames that are sent and frames that are received by the port.</td>
</tr>
<tr>
<td>Port Frame Size (Receive)</td>
<td>The average size of a frame, in KiB, that is received by the port.</td>
</tr>
<tr>
<td>Port Frame Size (Send)</td>
<td>The average size of a frame, in KiB, that is sent through the port.</td>
</tr>
</tbody>
</table>

Cinder driver for IBM Spectrum Control

The Cinder driver for IBM Spectrum Control enables cloud storage that is powered by OpenStack to use an IBM Spectrum Control installation for block storage provisioning.

IBM Spectrum Control provides block storage provisioning capabilities that the storage administrator can employ to define the properties and characteristics of storage volumes within a particular service class. For example, a block storage
service class can define RAID levels, tiers of storage, and various other storage characteristics. For more on service classes, see “Configuring IBM Spectrum Control for provisioning” on page 194.

The Cinder driver enables an OpenStack cloud to use these defined service classes, which are available in your Cinder environment as Cinder volume types. For each block storage service class, a Cinder volume type is created. Your cloud users can create and use volumes of this type.

To download the IBM Spectrum Control Cinder driver and installation instructions go to https://www.ibm.com/developerworks/servicemanagement/sm/spectrum_control/index.html and click the Downloads tab.

**Planning to deploy the Cinder driver**

Before using the Cinder driver for IBM Spectrum Control you need to create volume types and service classes for the service to use. You also need to decide the connection protocol your storage will be using (FC or iSCSI).

**Volume types within OpenStack**

New volumes are created within OpenStack by specifying the type of volume to be created. The volume types are high-level descriptions that identify the class of storage a volume can provide. For instance, a cloud user might want to create a new volume with Gold class storage. The user can employ the OpenStack Horizon GUI or Cinder CLI to provision a new volume. The user can then specify that the type of volume they want to create is of type Gold. The OpenStack Cinder scheduler then allocates from those volume drivers that can provision a volume of type Gold.

The Cinder driver works with this information through the medium of service classes. A service class is used to identify classes of storage within the storage infrastructure that can be configured for such services as thin provisioning, virtualized volumes, and varying RAID levels. Service classes can be configured to use storage across multiple devices and device types that still meet the constraints that are defined within the service class. The Cinder driver can discover the service classes that are configured within IBM Spectrum Control and create corresponding volume types within the OpenStack environment. The user can then provision a volume from the service classes that are already defined within IBM Spectrum Control.

**Creating a service class and volume type**

To provide a new class or type of volume, the storage administrator creates a service class within IBM Spectrum Control. The definition includes the characteristics of the service class and the storage pools that are available to the service class. When the service class is created, the Cinder driver detects the new service class and automatically creates a corresponding Volume Type entry within the OpenStack infrastructure.

**Specifying connection protocols for storage (FC and iSCSI)**

When the Cinder driver is requested to attach a volume to a Nova node, the Cinder driver submits required access information to the IBM Spectrum Control service. The service then assigns the volume to all available host ports associated with the Nova node.
When the IBM Spectrum Control service assigns the volume to the ports, the service returns all available access information back to the Cinder driver. The Cinder driver chooses the optimal access to give to the Nova node to initialize the connection. By default, the Cinder driver attempts to choose the Fibre Channel method of access. The Cinder driver determines whether the IBM Spectrum Control server can enable Fibre Channel access and if the Nova node can use Fibre Channel access. If both are available, Fibre Channel connection information is returned. If Fibre Channel access is not available, the Cinder driver checks whether the IBM Spectrum Control service is able to assign iSCSI access to the volume. If iSCSI access is available to the Nova node, the Cinder driver returns the iSCSI access information to the Nova node.

An OpenStack cloud administrator can change which access protocol the Cinder driver attempts to assign first. The setting is the tpc_preferred_protocol parameter in the cinder.conf driver configuration section. By changing the preferred protocol to iSCSI, the Cinder driver first attempts to provide iSCSI access. If unsuccessful, the Cinder driver falls back to Fibre Channel access. If the preferred protocol cannot be met but an alternative protocol is available, then the alternative protocol is chosen.

**Enabling an OpenStack cloud for IBM Spectrum Control**

Enabling your OpenStack cloud to leverage your IBM Spectrum Control installation is a two step process. Configuration scripts for enabling IBM Spectrum Control functionality and policies for the Cinder driver are available in the tpc-scripts directory.

Download this zip file and extract its contents to a location on the IBM Spectrum Control server. Open a command prompt to the tpc-scripts directory and run the setup script for your platform.

**Note:** You must restart the IBM Spectrum Control Device, Data, and Web servers to complete the setup process.

A natively installable package containing the Cinder driver is available in the cinder-packages directory. Copy the appropriate .rpm or .deb file to your Cinder node and install it using the operating system’s native packaging tool.

For example, if the Cinder node is running Red Hat, copy the openstack-tpcdriver-1.0.0-1.x86_64.rhel.rpm file and install the file using the command `rpm -ivh openstack-tpcdriver-1.0.0-1.x86_64.rhel.rpm`.

Upon installation of the .rpm or .deb file, you can run the tpcdriver-config.sh utility to help determine appropriate Cinder settings for your installation.

Copy the appropriate settings into your cinder.conf file and restart the Cinder volume service to enable the Cinder driver.

Once the Cinder driver is installed and configured, you can verify the installation and configuration by navigating to the Volumes page of the Horizon Admin panel to check that the service classes configured within IBM Spectrum Control are now available as volume types.
Setting up the Cinder driver environment

To use the Cinder driver, you need to configure role-to-group mappings for an authorized Cinder user, add storage system mappings, and define capacity pools and service classes.

Configuring volume creation and attachment

After you install the IBM Spectrum Control, but before you configure the Cinder node, use the IBM Spectrum Control GUI to set up volume creation and attachment.

1. Log in to the IBM Spectrum Control GUI.
2. Configure role-to-group mappings for an authorized OpenStack Cinder user in a selected group to connect IBM Spectrum Control.
   a. In the menu bar, go to Settings > User Management.
   b. On the User Management window, click Add Group.
   c. On the Add Group window, enter the name of the group to which the user belongs, and click Search.
   d. Select the group name and assign the External Application role to this group.
   e. Click OK.
3. Add storage subsystems to manage to IBM Spectrum Control. For more information, see “Adding storage systems” on page 81.
   a. In the menu bar, go to Storage > Storage Systems.
   b. Click Add Storage System.
   c. Click the Storage System icon.
   d. On the Discover page, enter the information, and click Next.
   e. On the Configure page, enter the information, and click Configure.
4. Define capacity pools for the storage subsystems to be used by the service classes. For more information, see “Capacity pools” on page 41.
   a. In the menu bar, go to Storage > Pools.
   b. Select one or more pools of a storage system and select Action > Add to Capacity Pool.
   c. Click Create Capacity Pool.
   d. In the Create Capacity Pool page, specify a name for the capacity pool.
   e. Click OK.
5. Define the service classes to be used by the Cinder driver. For more information, see “Service classes” on page 37.
   a. In the menu bar, go to Advanced Analytics > Cloud Configuration, and click Work With Service Classes.
   b. Click Create Service Class.
   c. In the Select Type page, click on the Block icon to create a block storage service class.
   d. In the Define Properties page, specify a name for the service class.
   e. Specify the requirement for provisioning block-storage of this service class, and click Next.
   f. In the Capacity Pool page, select Only allow provisioning from selected capacity pools, select the capacity pools, and click Next.
   g. In the Authorize Users page, disable Approval required. Select Allow administrators and specified users to provision.
   h. Select the user name
i. Click **Add User**, and then click **Finish**.

6. Install the IBM Spectrum Control OpenStack patch and the Cinder driver. See “Installing the Cinder driver” on page 344.

7. Use the OpenStack Horizon GUI to verify that the service classes are listed as volume types on Cinder nodes.
   a. Log in to the OpenStack Horizon GUI as a user with admin roles.
   b. Select **Admin tab > System Panel > Volumes**.
   c. Verify that the service classes created on IBM Spectrum Control are listed under Volume Types.
   • OR
   a. Log in to the OpenStack Cinder node.
   b. Use the CLI `cinder` command to list volume type: `# cinder type-list`.
   c. Verify that the service classes you created on IBM Spectrum Control are listed.
   d. Ensure that the correct settings for IBM Spectrum Control are added to the Cinder configuration file `/etc/cinder/cinder.conf`. Check that the Cinder volume service was restarted.

8. iSCSI volume attachment
   To use iSCSI connections, the storage system must be configured for iSCSI access. You must assign IP addresses to specific Ethernet ports on the storage subsystem itself. For each storage subsystem, consult the product documentation on how to configure Ethernet ports for iSCSI access.
   After the storage system is configured for iSCSI access, the IBM Spectrum Control server populates information about the iSCSI access with the next probe of the storage subsystem. You can manually trigger this action from the IBM Spectrum Control GUI by running the Start Probe command under the **Data Collection** menu for storage subsystems.
   When you assign a volume to a server with iSCSI host ports, the IBM Spectrum Control generates and assigns a pseudo-random 16 character CHAP secret to any host definitions it creates on the storage subsystem. If the host port already belongs to a host definition on the storage system, the server does not carry out any CHAP secret modification.

   **Note:** In IBM Spectrum Control version 5.2.1, iSCSI ports appear as Fibre Channel ports within the IBM Spectrum Control GUI. The WWPN of the iSCSI port is the iSCSI name of the port itself.
   In IBM Spectrum Control 5.2.2, iSCSI ports appear as Fibre Channel ports within the IBM Spectrum Control GUI. The WWPN of the iSCSI port is the iSCSI name of the port itself.

**Requirements for installing the Cinder driver**
To offer cloud services for provisioning block files, you must ensure that you have the correct versions of IBM Spectrum Control and OpenStack.

**Requirements for IBM Spectrum Control**
You need to install IBM Spectrum Control with IBM Spectrum Control Advanced Edition license. You also need:

• A local operating system, LDAP, or Windows Domain group to add to IBM Spectrum Control
• A user added as a member of this group for use by the Cinder driver to connect to IBM Spectrum Control
• A supported version of DB2 client or DB2 server
• Service classes available to the OpenStack Cinder node(s) as volume types
• Storage systems available for OpenStack volume creation and attachment support

Storage platform support

The following storage platforms are supported:
• DS8000
• IBM SAN Volume Controller 6.1 or later
• Storwize V7000 6.1 or later
• XIV 11.0 or later

Requirements for OpenStack

You will need:
• OpenStack (Havana release)
• The OpenStack Cinder node must run on one of the following operating systems:
  – Red Hat Enterprise Linux 6.4 or higher
  – Ubuntu 12.04
• The python-cinder (included in python-cinderclient package) and python-rdflib library packages installed on the Cinder node:
  – Red Hat Enterprise Linux 6.4 or higher.
  The Red Hat python-rdflib library is available in the Extra Packages for Enterprise Linux (EPEL) repository. Visit the [Fedora wiki](https://fedorawiki.fedoraproject.org/wiki/Extra_Packages) for information on installing the EPEL repository on your system.
    # yum install python-cinderclient
    # yum install python-rdflib
  – Ubuntu 12.04
    # sudo apt-get install python-cinderclient
    # sudo apt-get install python-pip
    # sudo pip install rdflib>=3.2.1

  Note: The python-rdflib debian package available in the Ubuntu precise archives contains rdflib 2.4.2. The IBM Spectrum Control Cinder driver requires version 3.2.1 or higher of the rdflib library. Use the pip command above in order to install the correct version of the rdflib library.

Cinder driver package contents

To enable an OpenStack cloud to leverage a IBM Spectrum Control installation, run the installation script and use a configuration utility to determine appropriate Cinder settings for your installation.

The tpc-scripts directory contains the platform-specific IBM Spectrum Control Server OpenStack scripts to enable or disable the IBM Spectrum Control functionality and policies for the Cinder driver:
• AIX Scripts: setup_aix.sh and unsetup_aix.sh
• Linux Scripts: setup_linux.sh and unsetup_linux.sh
• Windows Scripts: setup_windows.bat and unsetup_windows.bat

The setup script configures a IBM Spectrum Control server with the files required to enable the supported OpenStack functionality on the IBM Spectrum Control server. For more information about installing the Cinder driver, see "Requirements for installing the Cinder driver" on page 342 and "Installing the Cinder driver." The unsetup script reconfigures a IBM Spectrum Control server with the files required to disable supported OpenStack functionality on the a IBM Spectrum Control server. For more information about uninstalling the Cinder driver, see "Uninstalling the Cinder driver" on page 345.

When IBM Spectrum Control Cinder driver is installed, you are ready to enable OpenStack and IBM Spectrum Control to work together. The cinder-packages directory contains the platform specific Cinder driver installer packages . Both the IBM Spectrum Control server and the OpenStack Cinder node need to be patched.

- Red Hat Enterprise Linux 6.4 or higher: openstack-tpcdriver-1.0.1-1.x86_64.rhel.rpm
- Ubuntu 12.04: openstack-tpcdriver_1.0.1-1_all.deb

1. Log on to IBM Spectrum Control server as root for Linux/AIX or as Administrator for Windows.
2. Change directory to tpc-scripts.
3. Run the setup script, providing the path to the IBM Spectrum Control installation location. For example:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td># ./setup_aix.sh /opt/IBM/TPC</td>
</tr>
<tr>
<td>Linux</td>
<td># ./setup_linux.sh /opt/IBM/TPC</td>
</tr>
<tr>
<td>Windows</td>
<td>&gt; setup_windows.bat &quot;C:\Program Files\IBM\TPC&quot;</td>
</tr>
</tbody>
</table>

4. The installer package installs the OpenStack tpc.py driver in the proper location. It also installs the tpcdriver-config.sh script which generates the additional Cinder driver-related entries needed for the Cinder configuration file (/etc/cinder/cinder.conf).

Installing the Cinder driver

To install the Cinder driver, run the installation script and use a configuration utility to determine appropriate Cinder settings for your installation.

The IBM Spectrum Control server and all OpenStack Cinder nodes need to be patched to enable IBM Spectrum Control OpenStack functions and policies for the Cinder driver. Review "Requirements for installing the Cinder driver" on page 342 before you proceed with the installation.

1. Run the IBM Spectrum Control OpenStack patch installation script for AIX, Linux, or Windows. On IBM Spectrum Control:
   a. Log on as root for Linux/AIX or Administrator for Windows.
   b. Change directory to tpc-scripts.
   c. Run the setup script, specifying the path to the IBM Spectrum Control server installation location:
      • AIX# ./setup_aix.sh /opt/IBM/TPC
      • Linux# ./setup_linux.sh /opt/IBM/TPC
      • Windows: setup_windows.bat "C:\Program Files\IBM\TPC"
d. When prompted if you want to proceed with the update, enter Y or y.

**Note:** You must restart the IBM Spectrum Control Device, Data, and Web servers to complete the setup process.

2. The IBM Spectrum Control OpenStack patch installation script attempts to determine the DB2 settings. If the script cannot find a setting, you are prompted to enter the value. Descriptions of the settings are in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname of the DB2 server</td>
<td>The host name of the IBM Spectrum Control database server.</td>
</tr>
<tr>
<td>Port of the DB2 server</td>
<td>The port that the IBM Spectrum Control database server is running on.</td>
</tr>
<tr>
<td>DB2 profile user (AIX/Linux only)</td>
<td>The user name of the DB2 user on the server this installation script is being run on. This setting is only relevant for AIX and Linux.</td>
</tr>
<tr>
<td>DB2 user</td>
<td>The user name of the DB2 user with permissions to access the IBM Spectrum Control database.</td>
</tr>
<tr>
<td>DB2 password</td>
<td>Password for the DB2 user.</td>
</tr>
<tr>
<td>Database name</td>
<td>The name of the IBM Spectrum Control database.</td>
</tr>
<tr>
<td>Schema name</td>
<td>The schema name of the IBM Spectrum Control database.</td>
</tr>
</tbody>
</table>

3. Run the Cinder driver installation script for Red Hat and Ubuntu installations.
   On the OpenStack Cinder nodes:
   a. Ensure that the current user has administrative privileges - `root` for Red Hat and Ubuntu.
   b. Change directory to `cinder-packages`.
   c. Install the package for your OpenStack distribution:
      * Red Hat Enterprise Linux 6.4: `# rpm -ivh openstack-tpcdriver-1.0.0-1.x86_64.rhel.rpm`
      * Ubuntu 12.04: `# dpkg -i openstack-tpcdriver_1.0.0-1.x86_64.deb`

**Note:** If you installed any packages manually (for example, with `pip` or from source), you can force the installation by overriding dependency checks. On Red Hat systems, the `--nodeps` flag is passed to the `rpm` command. On Ubuntu systems, the `--force-depends` flag is passed to the `dpkg` command.

4. Run the `tpcdriver-config.sh` configuration script. You are prompted to provide IBM Spectrum Control server information as the script runs: `# /usr/local/bin/tpcdriver-config.sh` Refer to “Configuring the Cinder driver” on page 346 for more details on the Cinder configuration settings specific to IBM Spectrum Control.

5. Copy the Cinder driver settings that are generated by the `tpcdriver-config.sh` script to the `[DEFAULT]` section of the Cinder configuration file, `/etc/cinder/cinder.conf`.

6. Restart the Cinder volume service.

**Uninstalling the Cinder driver**

To uninstall the Cinder driver, run uninstallation scripts for AIX, Linux, and Windows installations.
Use IBM Spectrum Control OpenStack patch uninstallation scripts for AIX, Linux, and Windows to uninstall an instance of the Cinder driver.

1. Log on to IBM Spectrum Control with administrative privileges - root for Linux/AIX or Administrator for Windows.
2. Change directory to tpc-scripts.
3. Run the unsetup script, specifying the path to the IBM Spectrum Control server installation location:
   - AIX
     
     ```bash
     # ./unsetup_aix.sh /opt/IBM/TPC
     ```
   - Linux
     
     ```bash
     # ./unsetup_linux.sh /opt/IBM/TPC
     ```
   - Windows
     
     ```bash
     unsetup_windows.bat "C:\Program Files\IBM\TPC"
     ```
4. When prompted if you want to proceed with the update, enter Y or y.
5. You must restart the IBM Spectrum Control Device, Data, and Web servers to complete the unsetup process.
6. On the OpenStack Cinder node(s), log on as root for Red Hat and Ubuntu.
7. Configure the Cinder volume service to no longer use the IBM Spectrum Control Cinder volume driver by editing the Cinder configuration file `/etc/cinder/cinder.conf` and removing all references to the IBM Spectrum Control Cinder volume driver. Parameters for the driver are prefixed with the string `tpc_`.
8. Restart the Cinder volume service.
9. After the Cinder volume services are no longer configured to use the IBM Spectrum Control driver, the native package can be removed from the Cinder volume node. For example:
   - Red Hat
     
     ```bash
     # rpm -e openstack-tpcdriver
     ```
   - Ubuntu
     
     ```bash
     # dpkg -r openstack-tpcdriver
     ```

### Configuring the Cinder driver

To make IBM Spectrum Control volumes and service classes available to Cinder services, you must configure the Cinder driver.

On IBM Spectrum Control, you must plan user and service class details:

- Identify which IBM Spectrum Control user the Cinder driver can use to log on. The user's group must be added to User Management as External Application.
- Identify the preferred service class. This class is used when no volume type is specified in the Cinder configuration file. All block service classes available to the user are available to the Cinder driver as volume types.

The tpcdriver-config.sh script installed on the Cinder node as part of the rpm or deb file helps to configure the Cinder volume service to use the Cinder driver. Configure the Cinder driver by editing the Cinder configuration file `/etc/cinder/cinder.conf`.

Edit the following volume_ settings in the Cinder configuration file:
• volume_driver: The name of the Cinder driver to use for volume creation. By default, name is set as cinder.volume.drivers.lvm.LVMISCSIDriver in the Cinder configuration file. To use the Cinder driver, change the setting to cinder.volume.drivers.tpc.TPCDriver.

• volume_name_template: The template that is used by IBM Spectrum Control to name OpenStack volumes. By default, template is set as volume-%s in the Cinder configuration file. You can change this value to one more easily identifiable as an OpenStack volume (for example, openstackvol-%s) when you are viewing or searching volumes. The template is a global setting that affects volume names for all Cinder drivers.

You must add the following tpc_ settings to the Cinder configuration file:
• tpc_ip: The IP address of the IBM Spectrum Control server.
• tpc_login: The user name that the Cinder driver will log on with.
• tpc_password: The password that the Cinder driver will log on with.
• tpc_service_class: The default IBM Spectrum Control service class that the Cinder driver uses if no volume type is specified.
• tpc_preferred_protocol: The preferred protocol if more than one is available.
  The preferred protocol can be set to iSCSI or FC; these values are case-sensitive. This flag is optional - if not specified, the default is FC.

After you edit the Cinder configuration file, restart Cinder services with the command: service service-name restart. For Ubuntu, the service-name parameter is cinder-volume. For RedHat and SLES, the service-name parameter is openstack-cinder-volume.

Use the Horizon GUI to create, attach, and delete volumes.

Learn more about the Cinder driver
You can learn more about the Cinder driver from Service Management Connect resources such as developer wikis, updates, and Beta packages.

IBM Spectrum Control Service Management Connect contains the OpenStack package and links to
• IBM Spectrum Control developerWorks wiki
• IBM Spectrum Control forums
• Updates to this package
• IBM Spectrum Control Beta material

To learn more, go to https://www.ibm.com/developerworks/servicemanagement/sm/spectrum_control/index.html and click the Downloads tab.

The OpenStack website contains information on installing, configuring, and managing an OpenStack cloud. To learn more, go to http://www.openstack.org

Limitations and known issues for the Cinder driver
The Cinder driver is subject to the following limitations and known issues.
Decommissioning a service class and volume type

To remove a volume type from OpenStack, you must first remove the service class that is associated with the volume type in IBM Spectrum Control. After the service class is removed, the OpenStack Administrator must then remove the corresponding volume type in OpenStack.

For example, you can remove a service class (Gold) from IBM Spectrum Control, and then remove the type of volume that is associated with the Gold service class. If a user requests the type of volume that is associated with the Gold service class, the request is rejected.

If you remove the volume type from OpenStack but do not remove the associated service class, the volume type is re-created the next time the Cinder driver checks for available service classes.

iSCSI support with XIV Storage System

- For an XIV system with multiple Internet Small Computer System Interface (iSCSI) ports, only one port is populated by the Cinder driver.
- For the XIV system, IBM Spectrum Control is unable to use Challenge-Handshake Authentication Protocol (CHAP) secrets for iSCSI host definitions. CHAP information is not available through the CLI for the XiV system. iSCSI attachments that are made through the Cinder driver are assigned without CHAP secrets defined.

Mixed iSCSI and Fibre Channel Volume Assignments

IBM Spectrum Control attempts to assign all ports that belong to a Nova node. When the unmanaged server representing the Nova node contains both Fibre and iSCSI ports, the volume is available to the Fibre Channel and iSCSI ports on the Nova node. In some cases, when you detach a volume from a host, the ports for the access method in use by the Nova node are removed but the access for the alternative connectivity method remains. This access can cause errors to delete the volume from the storage system. In this case, the volume is removed from the Cinder database but it requires manual steps to remove the storage volume from the storage system.

Unable to Attach Storage Volumes

In some circumstances, attempts to attach a storage volume to a compute instance fails even though the volume is assigned to the Nova node’s host connection information. To resolve this problem, verify that the Nova node can connect to the storage system through the Ethernet LAN or Fibre SAN. If an XIV Storage System is added (regardless of whether the volume is on an XIV Storage System), restart the IBM Spectrum Control Device server. Use the startup scripts in the scripts directory where IBM Spectrum Control is installed.

Opening IBM Spectrum Control on Windows operating systems

You can open IBM Spectrum Control CLIs and GUIs and administer IBM Spectrum Control on Windows operating systems.

Opening IBM Spectrum Control GUIs and CLIs

To manage and monitor storage resources, open IBM Spectrum Control GUIs and CLIs.
You can open the following GUls and CLIs:

- “Opening IBM Spectrum Control GUI”
- “Opening DB2 Command Window”
- “Opening IBM Data Studio Administration client on Windows operating systems”
- “Opening IBM Tivoli Monitoring Services” on page 350

Opening IBM Spectrum Control GUI
1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Server 2012   | 1. On the Dashboard page, hover the mouse over the lower left corner of the page next to the Server Manager taskbar button, and then click Start.  
2. On the Start page, right-click, and then click the All apps taskbar button. |

2. Click IBM Spectrum Control > IBM Spectrum Control.

Opening DB2 Command Window
1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Server 2012   | 1. On the Dashboard page, hover the mouse over the lower left corner of the page next to the Server Manager taskbar button, and then click Start.  
2. On the Start page, right-click, and then click the All apps taskbar button. |

2. Click IBM DB2 > Command Line Tools > Command Window.

Opening IBM Data Studio Administration client on Windows operating systems
1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Server 2012   | 1. On the Dashboard page, hover the mouse over the lower left corner of the page next to the Server Manager taskbar button, and then click Start.  
2. On the Start page, right-click, and then click the All apps taskbar button. |

2. Click IBM Data Studio > Data Studio Administration Client.
Opening IBM Tivoli Monitoring Services

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Windows Server 2012       | 1. On the Dashboard page, hover the mouse over the lower left corner of the page next to the Server Manager taskbar button, and then click Start.  
2. On the Start page, right-click, and then click the All apps taskbar button. |

2. Click IBM Tivoli Monitoring > IBM Tivoli Monitoring Services.

Accessing administration tools

To manage and maintain IBM Spectrum Control, access the Windows system administration tools.

To complete tasks in IBM Spectrum Control, you must open the following administration and maintenance facilities:

- “Accessing the Control Panel”
- “Accessing Administrative Tools”
- “Accessing Windows Services” on page 351
- “Accessing Computer Management” on page 351
- “Accessing Programs and Program Features” on page 351

Accessing the Control Panel

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>On the Dashboard page, hover the mouse over the lower left corner of the page next to the Server Manager taskbar button, and then click Start.</td>
</tr>
</tbody>
</table>

2. Click Control Panel

Accessing Administrative Tools

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>On the Dashboard page, hover the mouse over the lower left corner of the page next to the Server Manager taskbar button, and then click Start.</td>
</tr>
<tr>
<td>Windows 7, Windows 2008</td>
<td>Click Start.</td>
</tr>
<tr>
<td>Windows XP, Windows Vista</td>
<td>Click Start &gt; Control Panel.</td>
</tr>
</tbody>
</table>

2. Click Administrative Tools
**Accessing Windows Services**

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>On the Dashboard page, hover the mouse over the lower left corner of the page next to the <strong>Server Manager</strong> taskbar button, and then click <strong>Start</strong>.</td>
</tr>
<tr>
<td>Windows 7, Windows 2008</td>
<td>Click <strong>Start</strong>.</td>
</tr>
<tr>
<td>Windows XP, Windows Vista</td>
<td>Click <strong>Start &gt; Control Panel</strong>.</td>
</tr>
</tbody>
</table>

2. Click **Administrative Tools > Services**

**Accessing Computer Management**

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>On the Dashboard page, hover the mouse over the lower left corner of the page next to the <strong>Server Manager</strong> taskbar button, and then click <strong>Start</strong>.</td>
</tr>
<tr>
<td>Windows 7, Windows 2008, Windows Vista, Windows XP</td>
<td>Click <strong>Start</strong>.</td>
</tr>
</tbody>
</table>

2. Click **Control Panel > Computer Management**

**Accessing Programs and Program Features**

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>On the Dashboard page, hover the mouse over the lower left corner of the page next to the <strong>Server Manager</strong> taskbar button, and then click <strong>Start</strong>.</td>
</tr>
<tr>
<td>Windows 7, Windows 2008, Windows Vista, Windows XP</td>
<td>Click <strong>Start</strong>.</td>
</tr>
</tbody>
</table>

2. Click **Control Panel > Programs and Program Features**.

**Accessing Window Run**

1. Choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>On the Dashboard page, hover the mouse over the lower left corner of the page next to the <strong>Server Manager</strong> taskbar button, and then click <strong>Start</strong>.</td>
</tr>
<tr>
<td>Windows 7, Windows 2008, Windows Vista, Windows XP</td>
<td>Click <strong>Start</strong>.</td>
</tr>
</tbody>
</table>

2. Click **Run**.
Appendix B. Accessibility features for IBM Spectrum Control

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use information technology products successfully.

Accessibility features

The following list includes the major accessibility features in IBM Spectrum Control:

- Keyboard-only operation in the GUI.
- A Knowledge Center that includes the following accessibility features:
  - The Knowledge Center is provided in XHTML 1.0 format, which is viewable in most web browsers. With XHTML, you can view documentation according to the display preferences that are set in your browser. XHTML supports screen readers and other assistive technologies.
  - All documentation for IBM Spectrum Control is available in Adobe Portable Document Format (PDF) by using the Adobe Acrobat Reader. To access PDFs, go to [http://www.ibm.com/support/knowledgecenter/SS5R93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_r_printable_doc.html](http://www.ibm.com/support/knowledgecenter/SS5R93_5.2.9/com.ibm.spectrum.sc.doc/fqz0_r_printable_doc.html)
  - All images in the Knowledge Center are provided with alternative text, so that visually impaired users can understand the contents of the images.
- Interfaces that are commonly used by screen readers.

The setting for the automatic-refresh button in the screen reader is toggled to the ON position by default. If you want the screen reader to read the previous text, complete the following steps:

1. Navigate to the Accessibility Settings Navigation region by using the arrow keys. The region is located after the IBM Spectrum Control application title.
2. Click **Enter** to toggle the automatic-refresh button to the OFF position. (An alert sounds to make you aware that the turn-off automatic-refresh toggle button was pressed.)
3. To move backward to the previously read text so that the screen reader can read it again, use the arrow keys. You can move backwards and forwards through the page.
4. When you are ready to move on, click **Enter** to toggle the automatic-refresh button to the ON position and to refresh the page. (An alert sounds to make you aware that the turn-on, automatic-refresh toggle button was pressed.)

**Tip:** Alternatively, let the toggle setting persist, and refresh as needed by pressing the F5 key.

Keyboard navigation

Most of the features of the IBM Spectrum Control GUI are accessible by using the keyboard. For those features that are not accessible, equivalent function is available by using the command-line interface (CLI), except as noted in the product release notes.

You can use keys or key combinations to perform operations and initiate many menu actions that can also be done through mouse actions. The following sections describe the keys or key combinations for different parts of the GUI:
For navigating in the GUI and the context-sensitive help system:

- To navigate to the next link, button, or topic within a panel, press Tab.
- To move to the previous link, button, or topic within a panel, press Shift+Tab.
- To select an object, when the object is in focus, press Enter.

For actions menus:

- To navigate to the grid header, press Tab.
- To reach the drop-down field, press the Left Arrow or Right Arrow key.
- To open the drop-down menu, press Enter.
- To select the menu items, press the Up Arrow or Down Arrow key.
- To start the action, press Enter.

For filters:

To specify a filter option and text:
1. Press Tab to navigate to the magnifying glass icon.
2. Press the Up Arrow or Down Arrow key to navigate the filtering list.
3. Press Enter to select a filtering option.
4. When a filtering option is selected, the cursor moves to the filter text box. Type the filter text and press Enter. To reset a filter, press Enter.

For text fields:

- To navigate to text fields, press Tab.
- To navigate to the fields that are available for editing, press Tab.
- To navigate to the next field or to the Submit button, press Tab.

For tables or lists:

- To navigate between column headers, focus on a column header and use the Left Arrow and Right Arrow keys to move to other column headers.
- To navigate between data cells, focus on a data cell and use the Left, Right, Up, Down, Pageup, and Pagedown Arrow keys.
- To sort a column, focus on a column header and press Enter. The focus remains on the column header after the sort occurs.
- To change the size of a column, focus on the column header, hold Shift+Control, and press the Left or Right Arrow keys.
- To follow a link in a data cell, focus on a data cell and press Shift+F9.
- To open a menu for a table row, focus on the row and press Shift+F10.
- To select consecutive rows, select the first row and hold Shift, press the Up or Down Arrow keys to go to the last row in the range, and press the Space bar to add the new rows to the selection.
- To select non-consecutive rows, select a row and hold Control, press the Up or Down Arrow keys, and press the Space bar to add the new row to the selection.

Restriction: For Chinese languages, the keyboard combination Control+Space bar is not enabled for selecting multiple rows at the same time.

IBM and accessibility

For more information about IBM’s commitment to accessibility, see the IBM Human Ability and Accessibility Center website at [http://www.ibm.com/able/](http://www.ibm.com/able/)
Appendix C. Accessibility features for Tivoli Storage Productivity Center for Replication

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use information technology products successfully.

**Accessibility features**

The following list includes the major accessibility features in Tivoli Storage Productivity Center for Replication:

- Keyboard-only operation
- Interfaces that are commonly used by screen readers
- Keys that are discernible by touch but do not activate just by touching them
- Industry-standard devices for ports and connectors
- The attachment of alternative input and output devices
- A Knowledge Center that includes the following accessibility features:
  - The Knowledge Center is provided in XHTML 1.0 format, which is viewable in most web browsers. With XHTML, you can view documentation according to the display preferences that are set in your browser. XHTML supports screen readers and other assistive technologies.
  - All documentation for Tivoli Storage Productivity Center for Replication is available in Adobe Portable Document Format (PDF) by using the Adobe Acrobat Reader. To access the PDFs, go to [ftp://public.dhe.ibm.com/software/tivoli/tpc/](ftp://public.dhe.ibm.com/software/tivoli/tpc/) and select the v527 directory.
  - All images in the Knowledge Center are provided with alternative text so that visually impaired users can understand the contents of the images.

**Keyboard navigation**

Use the following key combinations to navigate the interface by keyboard:

- To go directly to the topic pane, press Alt+K, and then press Tab.
- In the topic pane, to go to the next link, press Tab.
- To go directly to the Search Results view, press Alt+R, and then press the Enter or Up-Arrow key to enter the view.
- To go directly to the Navigation (Table of Contents) view, press Alt+C, and then press the Enter or Up-Arrow key to enter the view.
- To expand and collapse a node in the navigation tree, press the Right and Left-Arrow keys.
- To move to the next topic node, press the Down-Arrow or Tab key.
- To move to the previous topic node, press the Up-Arrow key or Shift+Tab.
- To go to the next link, button, or topic node from inside on of the views, press Tab.
- To scroll all the way up or down in a pane, press Home or End.
- To go back, press Alt+Left Arrow; to go forward, press Alt+Right Arrow.
- To go to the next pane, press F6.
- To move to the previous pane, press Shift+F6.
- To print the active pane, press Ctrl+P.
Related accessibility information

The following list contains hints and tips that can help you more fully use the graphical user interface:

Drop-down lists are positioned directly over or before the radio button that activates it.

If you use a screen reader, you should be aware that there are radio buttons to activate drop-down lists for several GUI pages. The way to activate the drop-down list is by selecting the associated radio button. The drop-down list is positioned directly over or before the radio button that activates it. When you use a screen reader that processes the fields and controls of a page sequentially, you might select the radio button, but not know that the associated drop-down list has been activated. The screen reader processes inactive drop-down lists first, and then processes the next radio button. The drop-down list is activated if you select the radio button.

On the following pages, keep in mind that radio buttons activate a drop-down list:
- Administration
- ESS/DS Paths
- Sessions
- Session Details
- Storage Systems

Tables are best understood by reviewing the surrounding text and the table row and column number of the table.

On some graphical user pages, tables use the header or row ID attributes when reading a single cell. The screen reader reads the table row and column number, along with cell data. Therefore, you can infer the column header and row ID.

Experiment with and fine-tune the way your screen reader pronounces some of the product abbreviations.

Your screen reader might pronounce abbreviations as if they were words. For example, the common abbreviation for Enterprise Storage Server is ESS. Your screen reader might read ESS as the word "ess". With some screen readers you can hear alternate pronunciations. If you frequently use the software you might prefer to fine-tune such associations in your settings. When an association is created, the screen reader can recognize the abbreviation as a word. If you can add dictionary words with your screen reader, replace the capitalized character sequence with the sequence E space S space S.

Typically, this abbreviation is used in the combination form of ESS/DS. This term refers to TotalStorage Enterprise Storage Server Model 800, System Storage DS6000, or System Storage DS8000.

Some decorative artifacts might persist if the cascading style sheet is disabled.

Enable cascading style sheets when possible; otherwise, some decorative elements might persist in the web browser GUI. These artifacts do not affect performance. If they become too distracting, consider using the command-line interface instead.

For efficiency, confirmation dialogs place initial focus on the Yes button.
When a confirmation dialog box is displayed, focus is given to the **Yes** button. Therefore, the screen reader reads “Yes” but does not read the confirmation text. The software processes the information in this way when you do the following types of tasks:

- Perform an action on a session
- Remove a connection to a storage system
- Click the **About link**
- Create a high-availability connection

To read the confirmation text before clicking the **Yes**, **No**, or **OK** button, view the previous heading before the button.

**Dojo components are not read by all screen readers.**

The Job Access for Windows and Speech (JAWS) screen reader does not read some Dojo components on Windows Internet Explorer. Use the command-line interface instead of the GUI with JAWS on Windows Internet Explorer.

**Firefox is the preferred browser for use with a screen reader.**

Use Firefox as the screen reader because other browsers might not fully expose assistive technology content to the screen reader.

**IBM and accessibility**

For more information about IBM’s commitment to accessibility, see the IBM Human Ability and Accessibility Center website at [http://www.ibm.com/able](http://www.ibm.com/able)
Notices

This information was developed for products and services offered in the U.S.A. This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for
costume only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE: This information contains sample application programs in
source language, which illustrate programming techniques on various operating
platforms. You may copy, modify, and distribute these sample programs in any
form without payment to IBM, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are written.
These examples have not been thoroughly tested under all conditions. IBM,
therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Privacy policy considerations

IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.


Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corporation, registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at [http://www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

Intel, Intel logo, Intel Xeon, and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.
Glossary

This glossary provides terms and definitions for the IBM Spectrum Control software and products.

The following cross-references are used in this glossary:

- See refers you from a nonpreferred term to the preferred term or from an abbreviation to the spelled-out form.
- See also refers you to a related or contrasting term.

For other terms and definitions, see the IBM Terminology website (opens in new window).

A

active management server
A management server from which the storage environment can be monitored and managed. The active management server replicates its database to the standby server.

B

business continuity
The capability of a business to withstand outages and to operate mission-critical services normally and without interruption in accordance with predefined service-level agreements.

C

CIM
See Common Information Model

CIM agent
The code that consists of common building blocks that can be used instead of proprietary software or device-specific programming interfaces to manage devices that are compliant with the Common Information Model (CIM).

CKD
See count key data

cluster
1. In IBM System Storage DS8000, a partition capable of performing all DS8000 series functions. With two clusters in the DS8000 storage unit, any operational cluster can take over the processing of a failing cluster.
2. A collection of complete systems that work together to provide a single, unified computing capability.
3. In Storwize® V7000, a pair of nodes that provides a single configuration and service interface.
4. A loosely coupled collection of independent systems (or nodes) organized into a network for the purpose of sharing resources and communicating with each other.

Common Information Model (CIM)
An implementation-neutral, object-oriented schema for describing network management or systems management information. The Distributed Management Task Force (DMTF) develops and maintains CIM specifications.

community name
The part of an SNMP message that represents a password-like name and that is used to authenticate the SNMP message.

consistency group
A group of copy relationships between virtual volumes or data sets that are maintained with the same time reference so that all copies are consistent in time.

copy set
The set of source volumes or target volumes involved in a FlashCopy operation.

count key data (CKD)
A data recording format that uses self-defining record formats in which each record on a volume is represented by up to three fields: a count field identifying the record and specifying its format, an optional key field that can be used to identify the data area contents, and an optional data field that typically contains the user data.
D

data collection
The process of obtaining performance and availability monitoring data and providing that data to a metric evaluator. Examples of data collectors include Domain Name System (DNS) probes, web page analyzers, or database analyzers. See also discovery.

data source
A storage resource or agent that provides data about a storage environment.

discovery
The process of finding resources within an enterprise, including finding the new location of monitored resources that were moved. See also data collection.

E

ECKD See extended count key data.

enterprise repository
A component of the data server that records and stores all information about the monitored computers’ storage assets and their usage over time. The repository is organized into relational database tables and is accessed by the data server using Java Database Connectivity (JDBC).

event
An occurrence of significance to a task or system. Events can include completion or failure of an operation, a user action, or the change in state of a process.

extended count key data (ECKD)
An extension of the count-key-data (CKD) architecture. It includes additional commands that can be used to improve performance.

F

fileset See file set.

file set
1. A subset of a file system that provides granularity of functions such as snapshots or quotas within the file system.
2. A hierarchical grouping of files managed as a unit for balancing workload across a cluster.

FlashCopy
1. Pertaining to a point-in-time copy where a virtual copy of a volume is created. The target volume maintains the contents of the volume at the point in time when the copy was established. Any subsequent write operations to the source volume are not reflected on the target volume.
2. An optional feature of the Storage System DS family that can make an instant copy of data, that is, a point-in-time copy of a volume.

freeze
An operation in which a storage system blocks I/O from the host system to the affected volumes on the primary site. A freeze operation stops mirroring between the primary and secondary volumes to ensure data consistency at the secondary site. See also thaw.

G

Global Copy
A non-synchronous long-distance copy option for data migration and backup. See also Global Mirror, Metro Mirror, remote mirror and copy.

Globally Unique Identifier (GUID)
An algorithmically determined number that uniquely identifies an entity within a system.

Global Mirror
An optional capability of the remote mirror and copy feature that provides a two-site extended-distance remote copy. Data that is written by the host to the storage unit at the local site is automatically maintained at the remote site. See also Global Copy, Metro Mirror, remote mirror and copy.

grain size
The unit size for allocating space on thin-provisioned volumes, such as 32, 64, 128, and 256 kibibyte. The grain size is defined when a volume is created.

GUID See Globally Unique Identifier.
**H**

**Hardware Management Console (HMC)**
In a system storage environment, a system that acts as the focal point for configuration, management of Copy Services functions, and maintenance.

**heat map**
A color-coded data chart in which colors are used to differentiate values in a data set.

**heat map**
A color-coded data chart in which colors are used to differentiate values in a data set.

**HMC** See [Hardware Management Console](#).

**host volume**
A volume that represents the volume functional role from an application point of view. The host volume can be connected to a host or server. It receives read, write, and update application I/O, depending on the site to which the application is writing.

**hypervisor**
Software or a physical device that enables multiple instances of operating systems to run simultaneously on the same hardware.

**J**

**journal volume**
A volume that holds a consistent copy of data until a new consistent copy is formed. The journal volume restores the last consistent point during a recovery.

**L**

**launch-in-context**
An operation in which a user starts a secondary application from a primary application to perform a specific task. Using the parameters, navigation instructions, and user credentials that are supplied by the primary application, the secondary application opens to the specific place in which to complete the task.

**logical unit number (LUN)**
In the Small Computer System Interface (SCSI) standard, a unique identifier used to differentiate devices, each of which is a logical unit (LU).

**LUN** See [logical unit number](#).

**M**

**Management Information Base (MIB)**
In the Simple Network Management Protocol (SNMP), a database of objects that can be queried or set by a network management system.

**management server**
A system that provides a central point of control for managing data replication.

**management server relationship**
A connection between two replication servers, where one server acts as the active server and replicates the data that is necessary for the standby server to take control of the replication environment.

**Metro Global Mirror**
A three-site, high availability, disaster recovery solution. Metro Global Mirror uses synchronous replication to mirror data between a local site and an intermediate site, and asynchronous replication to mirror data from an intermediate site to a remote site.

**Metro Mirror**
A function of the remote mirror and copy feature that constantly updates a secondary copy of a volume to match changes made to a source volume. See also [Global Copy](#), [Global Mirror](#), [remote mirror and copy](#).

**MIB** See [Management Information Base](#).

**N**

**namespace**
The scope within which a Common Information Model (CIM) schema applies.

**native interface**
An interface that is specific to a system or subsystem.

**P**

**ping**
1. The command that sends an Internet Control Message Protocol (ICMP) echo-request packet to a gateway, router, or host with the expectation of receiving a reply.
2. A job that tracks the availability of assets and that is performed by an
agent. Several ping jobs can be used to monitor the availability of any computer or subset of computers in the network.

pool A grouping of storage space that consists of volumes, logical unit numbers (LUNs), or addresses that share a common set of administrative characteristics.

practice volume A volume that can be used to test disaster-recovery actions while maintaining disaster-recovery capability.

primary site A physical or virtual site that is made up of hardware, network, and storage resources. Typically, production operations run at the primary site. Data can be replicated to a secondary site for disaster recovery and failover operations. See also secondary site.

primordial pool Storage capacity that is unallocated on a storage device. Storage pools are created by allocating storage capacity from primordial pools.

probe A data collection job that itemizes and creates an inventory of assets, such as computers, controllers, disk drives, file systems, and logical units.

recovery point objective The maximum amount of data loss that can be tolerated during a service interruption.

remote mirror and copy A feature of a storage server that constantly updates a secondary copy of a logical volume to match changes made to a primary logical volume. The primary and secondary volumes can be on the same storage server or on separate storage servers. See also Global Copy, Global Mirror, Metro Mirror.

resource In a storage environment, an entity that is monitored. Resources can include fabrics, switches, computers, and storage systems.

role A job function that identifies the tasks that a user can perform and the resources to which a user has access. A user can be assigned one or more roles.

derole pair The association of two volume roles in a session that take part in a copy relationship. For example, in a Metro Mirror session, the role pair can be the association between host volumes at the primary site and host volumes at the secondary site (H1-H2).

scan A data collection job that monitors storage usage and file statistics on the resources in an environment.

secondary site A physical or virtual site that is made up of the hardware, network, and storage resources that support the recovery needs of the primary site. When a failure occurs at the primary site, operations can continue at the secondary site. See also primary site.

session A collection of source and target volumes that are managed to create consistent copies of data. The type of data replication that is associated with the session determines the actions that can be conducted for the volumes.

site awareness The association of a location with each storage system in a session. Site awareness ensures that a volume can only be selected for a session if it matches the location of the site. Site awareness helps to prevent both reversing a hardware relationship and selecting volumes at the wrong location.


standby management server A management server that is a backup for the active server. The replication environment cannot be monitored or managed from the standby server.

Storage Management Initiative Specification (SMI-S) A design specification developed by the Storage Networking Industry Association (SNIA) that specifies a secure and reliable
interface with which storage management systems (SMSs) can identify, classify, monitor, and control physical and logical resources in a storage area network (SAN). The interface integrates the various devices to be managed in a SAN and the tools used to manage them.

**storage pod**
A logical entity of components of a system consisting of two storage nodes, and one or two storage subsystems directly connected with these storage nodes.

**storage resource group**
A named collection of logically related resources that are monitored by IBM Spectrum Control. Monitored resources can include fabrics, switches, computers, storage systems, and other storage resource groups.

**target volume**
A volume that receives data from a host volume or another intermediate volume.

**thaw**
An operation in which a storage system releases the block of the I/O from the host system to the affected volumes on the primary site. A thaw operation can occur after a freeze operation ends and consistency is formed on the secondary site. See also freeze.

**thin provisioning**
A mechanism that provides the ability to define logical volume sizes that are larger than the physical capacity installed on the system.

**track space-efficient volume (TSE volume)**
A volume in which storage space is allocated on an as-needed basis by using space on the target volume only when tracks are copied from the source volume to the target volume.

**TSE volume**
See track space-efficient volume.

**virtual storage area network (VSAN)**
A fabric within the storage area network (SAN).

**VSAN**
See virtual storage area network.

**zone**
A logical grouping of switches, switch ports, and their attached devices in a fabric.

**zone alias**
A name that is given to a collection of one or more zone members to be managed together.

**zone set**
A group of zones that function together on a fabric.

**virtualization**
The substitution of virtual resources for actual resources, where the virtual resources have the same functions and external interfaces as their counterparts, but differ in attributes, such as size, performance, and cost. Virtualization is commonly applied to physical hardware resources by combining multiple physical resources into shared pools from which users receive virtual resources.
E

EB
See EiB

EiB 51

ESSperformance metrics 318

ESX and ESXi
adding 88

exported file systems 110

exporting information in the web-based
GUI 186, 232

F

fabric 53

fabric alerts

triggering conditions 272

Fabric Manager
zone 54

zone set 54

facades
adding 85, 88

agent types for monitoring 88

modifying properties 229

viewing data paths 187

viewing information in the web-based
GUI 130

viewing status in the web-based
GUI 139

FCID zoning 54

file share

access path 199

file storage provisioning

on vSphere Web Client extension 217

filtering lists in the web-based GUI 234

filters 172

assign resources 172

sorting rows 235

G

GiB 51

glossary 363

GUI

exporting information about

applications and departments 186

monitoring fabrics 54

monitoring switches 54

saving information about applications

and departments 186

H

hardware zoning 54

hierarchies

application 184

department 184

viewing information 184

host definition

default 210

for fibre_channel ports 210

provisioning 210

how the condition of resources is
determined 141

hypervisor alerts

triggering conditions 266

hypervisors 220

adding 88, 89

modifying properties 229

optimized volumes, colocate 63

tiering, analyze 220

user roles 80

viewing data paths 187

viewing information in the web-based
GUI 130

viewing status in the web-based
GUI 139

I

1/O rate

volumes, tiering 62

IBM Copy Services Manager 31

IBM Spectrum Control

architecture 23

component overview 23

overview 23

VASA provider 47

IBM Spectrum Control limitations and

known issues 348

IBM Spectrum Scale

file systems, view performance
metrics 329

nodes, view performance metrics 329

IBM Spectrum Virtualize

host connections, view performance
metrics 296

1/O groups, view performance
metrics 296

managed disks, view performance
metrics 296

nodes, view performance metrics 296

pools, view performance metrics 296

ports, view performance metrics 296

volumes, view performance
metrics 296

Installation

Cinder driver package contents 343

interfaces 31

overview 24

Tivoli Storage Productivity Center for
Replication 31

K

KB
See KIB

KIB 51

L

license restrictions 16

licenses 16

Linux 338, 339

lists

hiding columns 235

reorganizing columns 235

showing columns 235
performance view (continued)

bookmarks 164
controls 156
favorites 164
saving URLs 164
viewing the performance of internal resources 160
viewing the performance of related resources 160
PiB 51
pools
balance 60
balance, analyze 223
hot spots, identify 60
modifying properties 229
tiering, analyze 221
port name zoning 54
port zoning 54
PortId zoning 54
probes
configuring alerts 101
problems
report viii
 provisioning 110, 211
 custom requirements for 198
 overview 42, 194
 scenarios
 constrained set of storage 71
 using vSphere Web Client extension 71
 shares 213, 214
 volumes 211, 212, 213

reader feedback, sending vii
reclamation
block storage systems 225
excluding 226
recommendations 225, 226
storage systems 226
viewing volumes 225
volumes 225, 226
Reclamation
storage 46
volumes 46
Red Hat 338, 339
removing 176, 183
removing alerts
alerts
removing 130
removing applications 176
removing departments 183
removing resources 98
reporting
dashboard 133
reporting problems viii
resource alert definition
viewing 121
resources
adding 75
adding agentless servers for monitoring 92
adding fabrics for monitoring 85
adding hypervisors for monitoring 88, 89, 90
resources (continued)
adding storage systems for monitoring 81
adding switches for monitoring 85
adding to a capacity pool 201
manually adding resources to applications 175
modifying properties 229
removing 98
removing from a capacity pool 202
restrictions
based on license 16
based on role 16
role restrictions 16
roles 52

SAN Volume Controller publications v
sending comments vii
server alerts
triggerring conditions 274
servers
adding
importing servers from a list 94
importing servers with agents from a file 96
adding by deploying an agent 96
adding without agents 92
modifying properties 229
optimized volumes, colocate 63
tiering, analyze 220
viewing data paths 187
viewing information in the web-based GUI 130
viewing status in the web-based GUI 139
service viii
service class 37, 194, 195, 196
deleting 198
satisfying custom requirements of a 198
viewing properties of a 196
viewing storage constraints of 196
viewing users who can provision by using 196
viewing volumes or shares associated with 196
service management connect viii
shares 110
SMC viii
software zoning 54
sorting rows in lists 235
starting
IBM Spectrum Control web-based GUI 25
status of resources
viewing the status of resources 145
status of resources in the web-based GUI
acknowledging the status of a resource 146
acknowledging the status of a top-level resource 146
acknowledging the status of an internal resource 148
status of resources in the web-based GUI (continued)
viewing the overall status of resources 144
storage pools
tier level, setting 220
tiering, analyze 221
storage provisioning
vSphere Web Client extension 48
storage reporting
vSphere Web Client extension 48
storage system alerts
triggering conditions 253
storage systems
adding 81
IBM Spectrum Scale, adding
openstack access, configuring 85
performance data collection, configuring 84
probe, configuring 84
sudo access, configuring 83
modifying properties 229
user roles 80
viewing data paths 187
viewing information in the web-based GUI 130
viewing status in the web-based GUI 139
storage virtualizers 220
tiering, analyze 220
volumes, analyze placement 59
volumes, optimize 59
subcomponents
creating subcomponents for existing applications 175
subdepartments
creating 181
Support
contact viii
suppression actions 280
suppressions for alerts 280
switch alerts
triggering conditions 270
switches
adding 85, 88
agent types for monitoring 88
modifying properties 229
viewing information in the web-based GUI 130
viewing status in the web-based GUI 139

T

tasks (continued)
implementation of optimization
recommendations in the web-based GUI 244, 245
managing in the web-based GUI 236
managing provisioning tasks in the web-based GUI 240
managing tiering storage, balancing pools, and transforming-storage
tasks in the web-based GUI 242
pausing, resuming, and canceling
analysis-execution tasks in the web-based GUI 246
running provisioning tasks in the web-based GUI 241
running tiering analysis,
transform-plan, and balance-analysis
tasks in the web-based GUI 246
scheduling the implementation of
optimization recommendations in the web-based GUI 244
setting the number of task runs
displayed 240
viewing all tasks in the web-based GUI 236
viewing details in the web-based GUI 238
viewing in the web-based GUI 236
viewing pending tasks 237
viewing task logs in the web-based GUI 239
viewing tasks for a resource in the
web-based GUI 238
viewing tasks for a resource type in the
web-based GUI 237
\( T \)B
See TIB
temporary zone sets 54
thresholds
viewing violations pf performance 164
TIB 51
tier levels
storage pools, setting 220
tiering
analysis period 228
I/O density 221
I/O rate 221
tiering thresholds
I/O rate, modify 222
Tivoli Storage Productivity Center
Cinder driver requirements 342
Tivoli Storage Productivity Center for Replication 31
topology view for data paths 188
TPCD.cfg
saveNonRoot parameter, add 110
trademarks 361
translations
browser locale requirement vii
triggering actions 281
triggering conditions
alerts 252
canceling 274
cabinet alerts 274
cabinet alerts 272
canceling server alerts 266
server alerts 274
triggering conditions (continued)
storage system alerts 253
switch alerts 270
troubleshooting
performance 149

U

Ubuntu 338, 339
units of measurement 51
user roles
hypervisors 80
storage systems 80
VMware vSphere data sources 80
users
assigning roles 52
using 172

V

VASA provider
architecture 48
IBM Spectrum Control 47
VASA provider for IBM Spectrum Control
architecture 48
vCenter Server system
adding 88, 90
viewing
scenarios
connectivity information 72
NPIV connections 72
viewing details of a department 183
viewing details of an application 176
viewing
the overall status of a storage environment 133
viewing application details 176
viewing department details 183
viewing the status of resources 145
VMware vSphere
provisioning 71
volume collocation 63
volumes
tiering 62
tiering by I/O density 221
tiering by I/O rate 221
tiering, analyze 221
workload 223
volumes, shares 211
VSANs 56
vSphere resources
managing 216, 217
vSphere storage
provisioning 48
vSphere storage reports
viewing 48
vSphere Web Client extension
managing resources 216
provisioning block storage 216
provisioning file storage 217
provisioning storage 48
viewing storage reports 48
web-based GUI
acknowledging the status of a resource 146
acknowledging the status of a top-level resource 146
acknowledging the status of an internal resource 148
alert severities 113
customizing lists 233
data collection
creating performance monitors 104
modifying performance monitors 106
performance monitors 103
starting performance monitors 107
stopping performance monitors 107
verifying that a performance monitor is running 105
verifying that a probe is running 100
exporting information about resources, jobs, and alerts 232
filtering 234
how information is organized 131
internal, related, and object resources, list 75
managing tasks 236
Monitoring the status of resources 139
Opening the management GUI for a resource 231
resources that can be monitored 75
saving information about resources, jobs, and alerts 232
status of resources 139
tasks
analysis execution 245, 246
creating provisioning tasks 240
creating tiering storage, balancing pools, and transforming-storage tasks 243
deleting 246
exporting provisioning tasks 242
implementing optimization recommendations 244, 245
managing provisioning tasks 240
managing tiering storage, balancing pools, and transforming-storage tasks 242
pausing, resuming, and canceling analysis-execution tasks 246
running provisioning tasks 241
running tiering analysis, transform plan, and balance-analysis tasks 244
scheduling the implementation of optimization recommendations 246
viewing all performance monitors 108
viewing all tasks 236
viewing information about internal, object, and related resources 138
web-based GUI (continued)
viewing information about resources 130
viewing information about top-level resources 137
viewing pending tasks 237
viewing performance monitor logs 109
viewing performance monitors 108
viewing performance monitors for a resource 109
viewing task details 238
viewing task for a resource 238
viewing task for a resource type 237
viewing task logs 239
viewing tasks 236
viewing the condition of top-level resources 144
viewing the overall status of resources 144
Windows 349, 350
workload volumes 223
WWN zoning 54
X
XIV performance metrics 313
Z
zone 54
concepts 54
default 54
hardware 54
membership 54
non standard 56
port 54
software 54
supported switches 56
zone set 54
temporary 54
zones 53
zoning
automatic 54
during provisioning 54
Product Number: 5725-F93, 5725-G33, 5725-Y23, 5725-Y24

Printed in USA